
Welcome to RoboHELP. Click Topic (Ctrl+T) to add your first Help topic.



Conference Tab
Conferencing allows 
multiple callers to 
connect and view the 
activities on the host PC.

The conference host is 
remotely controlled by 
the first remote caller to 
connect. All other callers 
can only view the 
activities being run on the
host.

 Action bar

Use the buttons on the action bar to change pcANYWHERE’s mode and work with connection items in that mode.



 Select Folder dialog box



Folder history tool

Click the arrow to see 
a dropdown list of 
previous folders.

Choose a folder from 
the list to view 
connection items it 
contains, or to place 
new items in it.

Folder browse tool

Click to change the 
current folder.

File Transfer button

Click to change mode of
pcANYWHERE to File 
Transfer.

 Online Services button

Click to change mode of
pcANYWHERE to 
Online Service.

 Gateway button

Click to change the mode 
of pcANYWHERE to 
Gateway.

Note: If this button does 
not appear on the action 
bar, choose Application 
Options from the File 
menu and choose the 
Button bars tab.    Then 
check Gateway.

 Remote Networking button

Click to change the 
mode of pcANYWHERE
to Remote Networking..

 Be a Host PC button

Click to change the 
mode of pcANYWHERE
to Be a Host PC.

Remote Control button



Click to change the 
mode of pcANYWHERE
to Remote Control.

Remote Networking connection item

Double-click to dial in to a 
network.

Right-click to change this 
item’s properties.

Quick Start button

Click to run a 
pcANYWHERE wizard.

 Exit button

Click to exit 
pcANYWHERE.

Toolbar
Choose Toolbar from the 
View menu to display.
Choose Application Options
from the File menu to 
display or hide the folder 
tools.

 mode
pcANYWHERE has six modes.    Choose one from pcANYWHERE’s action bar to work with connection items in that mode:

1 Be a Host - to allow another PC to operate yours. 
2 Remote Control - to operate a host PC.
3 File Transfer - to send to, or receive files from, a host PC. 
4 Gateway - to allow other network PCs to use this PC’s connection devices. 
5 Remote Networking - to dial in to a network and operate as a node on the LAN. 
6 Call Online Service - to connect to an online service.



Remote Control connection item

Double-click to call a host 
PC.

Right-click to change this 
item, to rename it, or to 
initiate a call.

Host connection item

Double-click to wait for a 
call from a remote PC.

Right-click to change this 
item, to rename it, or to 
initiate a connection by 
calling a remote.

Gateway connection item

Double-click to activate your 
PC to act as a 
pcANYWHERE gateway for 
other PCs on the network. 
Right-click to change this 
item, to rename it, or to 
delete it.

Online Service connection item

Double-click to connect to an
online service.
Right-click to change this 
item, to rename it, or to 
delete it.

Online Session Menu Bar

Appears only during 
online sessions. 

Online status bar

Displays 
current 
settings 
during 
online 
session.

COM Port dialog box for setting up direct connections



Set options to 
customize this PC’s 
connection to a serial 
cable for direct 
connection.

COM Port dialog box for setting up modem connections

Displays only when you are
running pcANYWHERE under 
Windows NT 3.51.

Check Use Modem and select 
your modem from the drop-down 
list box. 

Advanced Modem Settings dialog box



Select options 
supported by your 
modem.    You may 
need to refer to your 
modem’s manual.      

Details tab for customizing network devices

Details tab of the NASI/NCSI dialog box

Choose server, 
service and port to 
use when making 
ACS connections.

User tab of the NASI/NCSI dialog box



Type information for 
access to the 
NASI/NCSI server.

In Session name, 
type the name 
identifying your 
workstation to other 
users after you have 
logged in.

Caller item

Caller items contain 
connection information, 
including passwords, for 
remote users accessing the 
host PC.    They are created 
and stored on the host PC. 
Right-click to modify options, 
rename, or delete.

Remote Drives dialog box

Select a drive on the remote 
PC that you want to access 
during the remote control 
session.

Remote Control context menu

Access this menu by 
right-clicking any 
remote control 
connection item.



Remote Networking context menu

Access this menu by 
right-clicking any 
remote networking 
connection item.

Online Service context menu

Access this menu by 
right-clicking any 
online service 
connection item.

Host context menu

Access this menu by right-clicking
any host connection item.

Caller context menu

Access this menu by right-clicking
any caller connection item.

Gateway context menu

Access this menu by right-clicking
any gateway connection item.

File Transfer context menu



Access this menu by right-clicking
any file transfer connection item.

Dial-Up Networking: Microsoft  ’  s Wizard  

Double-click the Dial-
Up Networking icon 
located in My 
Computer to access 
Microsoft’s Wizard.

Activity Log Processing dialog box

1    Click the log to process.

2    Do one:
-    Click Report to create a report of the 

log file selected. 

-    Click Archive/Delete to delete or 
archive the log file selected. 

Archive/Delete Host/Remote Log dialog box

Enter dates in the Date Range to 
specify the log entries you    want to 
archive and/or delete. 
Uncheck the Delete Log Entries 
from source checkbox if you want to
archive, but not delete, specified log 
entries. 
Uncheck Copy Log Entries to 
archive file checkbox if you want to 
delete, but not archive, specified log 
entries. 
By default, both checkboxes are 
checked.    To delete entries from 
current log file and add them to 
archived log file, just click OK.    

Playback control panel



Click Save Screen when playing 
back to save a the current screen.

Click Save Session to save the 
recorded session in a raw binary 
file.

Add . . . item

Double-click an Add ... item to 
create a new connection item in 
the current window.    A Quick Start
Wizard guides you.

Right-click and choose Properties 
to set default options for all items 
you create with this Add ... item.

Add ... items are 
always the first item 
in the 
pcANYWHERE 
window.

Remote online toolbar

Provides quick access to online 
features such as File Transfer, 
Chat, and Transfer Clipboard.

Place your mouse pointer over 
any tool for a moment to see a 
Tool Tip identifying that tool:

Reminder:    Connection items for Remote Control and File Transfer

When you change the properties of a connection item in
either of these two pcANYWHERE modes, you are 
changing the properties of that item as it appears in the 
other mode, as well.

Deleting an item in one mode deletes it in the other.

Host pcANYWHERE in Session button

Right-click this button, on the 
taskbar of the host PC, to access 
features during a session.    (You 
will not be able to do this if the host
PC is locked or blanked.)

Host control-menu box

Click this box to access 
online functions at the host 
PC.

pcANYWHERE Host menu



If the host PC is not locked, 
a host user can:

· end a session.
· initiate File Transfer. 
· open a Chat window.

Right-click

on the task bar of the host 
PC to access this menu.

New item tool

Click to create a new item in 
the current window.    Property
sheets for that item 
automatically open.

If the toolbar doesn’t display, 
choose Toolbar from the View 
menu.

List of network hosts

Displays 
when you 
connect to a
network host
without 
including the
name of the 
host in your 
connection 
item.

Double-click
an available 
host or 
gateway to 
make a 
connection.

Remote control-menu box

Appears in 
upper left 
corner of 
window of 
display on 
remote PC.

pcANYWHERE Remote menu



Includes options also 
available on remote 
online toolbar, but 
accessible even when 
toolbar is disabled.

File Transfer tool (Remote online toolbar)

Click to initiate file 
transfer during a remote
control session.

Chat tool (Remote online toolbar)

Click to open a Chat 
window during a remote 
control session.

Transfer Clipboard tool (Remote online toolbar)

Click to transfer 
clipboard during a 
remote control session.

Session Recording tool (Remote online toolbar)

Click to record part of a 
remote control session.

AutoXfer tool (Remote online toolbar)

Click to create or modify
an AutoXfer procedure.

End Session tool (Remote online toolbar)

Click to end a remote 
control session.

Restart Host tool (Remote online toolbar)



Click to restart the host 
PC.

Settings tool (Remote online toolbar)

Click to change settings 
during a remote control 
session.

Screen scaling tool (Remote online toolbar)

Click to make host’s screen fit on your 
monitor exactly.    Removes scroll bars.

Full window tool (Remote online toolbar)

Click to view host 
screen in a full window, 
without scroll bars, in a 
remote control session.

Save screen tool (Remote online toolbar)

Click to save current 
screen during a remote 
control session.

Send Control+Alt+Delete to host tool (Remote online toolbar)

Click to send 
Control+Alt+Delete to 
the host PC during a 
remote control session.

File Transfer connection item

This item is identical to a remote control 
connection item, except that when used from 
the File Transfer window it performs file 
transfer with the host PC.
Double-click to connect to a host PC and 
initiate file transfer.
Right-click to change this item, to rename it, or 
to initiate a call.

Transfer Clipboard dialog box

Use to transfer 
Clipboard contents 
during a remote control 
session.



Session Ending: Host menu

Displays when you have 
ended a remote control 
session from the host PC.    
Choose one:

· Wait for Connection to wait 
for another call.

· Call Remote to initiate a 
session.

· Go Offline to remain if you do
not want to close the host 
PC but are not ready for 
another session.

· Exit Host to close the host 
PC.

Minimized host button

Click to view Host waiting dialog
box.    

Appears on task bar.

Host waiting dialog box

Click Cancel to stop waiting 
for a connection with a 
remote PC.

Click  to continue waiting 
and minimize this box to the 
task bar.

Add Caller item

Double-click to create a 
new caller item.

Right-click and choose 
Properties to set default 
options for all caller items 
to be created with this item.

Arrange Icons menu



Choose an option to 
rearrange the connection 
items in the current 
window.

Caller tab toolbar

Use these tools to 
modify selected items
in the Caller window 
below.

If the folder tools do 
not display, you can 
add them by 
customizing toolbars. 
Choose Application 
Options from the File 
menu.    Then choose
the Button Bars tab.

Chat window

Pressing Enter sends 
your comments to the 
user at the other PC.

When you are finished 
chatting, choose Exit 
Chat from the File menu 
to close the chat window 
and resume the remote 
control session. 

Ending remote session dialog box

Uncheck Host accepts
another call to cancel 
the host PC.



Log Comment dialog box

Type any remarks you 
want to append to the 
log file for this session.

Connected to dialog box

Click Disconnect to 
end your remote 
networking session.

Click Details to view 
the network protocols 
you can use.

Administrator Password dialog box

Remember: 
Administrator 
passwords are case-
sensitive.

The password you 
enter here is required 
for access to 
Administrator options.

Windows NT User List

The users or groups 
listed are maintained 
by the Windows NT 
administrator.

You must have NT 
Administrator 
privileges to add or 
delete users or 
groups.



Remote Control System Tray

The remote control system 
tray displays information on:
Encryption Level used
Red: No encryption
Yellow: pcANYWHERE 
Blue: Symmetric 
Activity Indicator: Flashing 
green lights indicating data is 
being sent or received.
Clock: Indicating the duration
of the session.    

You can use the 
online menu to turn off the 
display of this system tray.



Script Editor Commands Listed Alphabetically {button Click to switch to task list.,JI(`',`commands_by_task')}

{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

-A-
Answer

-B-
Beep
Break

-C-
CD Cursor Down
Clear BOL Cursor Home
Clear BOP Cursor Left
Clear EOL Cursor Line
Clear EOP Cursor Off
Clear Screen Cursor Position
Close Cursor Restore
Copy Cursor Right
Create Cursor Save
Cursor block Cursor Up

-D-
Decrypt Dial Host
Del Dial Number
Delete char Dial OnlSvc
Delete line Dir
Description

-E-
Emulate End Menu
Encrypt End Terminal
End Exit

-F-
Find First
Find Next

-G-
Get Environment Get File Time
Get File Attr Get Free Disk
Get File Date GoSub
Get File Size GoTo

-H-
Hang

-I-
If Then Input Key
If Goto Insert Char
Index Insert Line
Input

-K-
Keyboard Flush
Keyboard Hit



-L-
Let Load OnlSvcInfo
Link Load Translation
Load FKeys Lower
Load HostInfo

-M-
MD
Message Box

-O-

On Cancel On Receive
On Disconnect On Timeout
On Error Open

-P-
Print File Print String
Print Line Printer

-R-
RD Receive Line
Read Line Receive String
Read String REN
Receive Char Reset
Receive Clear Return
Receive File Run

-S-
Screen Restore Set Disconnect
Screen Save Set DTR
Script Set Echo
Seek Set File Attr
Send Char Set File Date
Send Clear Set File Size
Send File Set File Time
Send Line Set Flow
Send ScanCode Set IgnoreCase
Send String Set Palette
Session Delay Set Parity
Session Dial Set Port
Session End Set Protocol
Session Exitmode Set Quiet
Session Onerror Set Record
Session Overwrites Set RTS
Session Retry Set Speed
Session Timeout Set Timeout
SessOpr Host Run Set Translation
SessOpr Host Send StrCat
SessOpr Remote Run StrCmp
SessOpr Remote Send StrLen
Set Attribute StrSet
Set Cancel SubStr
Set CharDelay

-T-
Terminal Type Line
Trim Type String



Type File

-U-
Upper

-W-
Wait Carrier Wait Time
Wait Receive Wait Until
Wait Silence Write Line
Wait String Write String
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Answer

Description: This command works for all device types. Use it to wait for an incoming call. The command terminates 
when a connection is made or when the user presses Esc.

The hardware configuration specifies how to detect a successful answer. When creating the hardware 
configuration in Norton pcANYWHERE for DOS, you set the Connection Started By parameter in the 
Configuration form. In    pcANYWHERE for Windows, you select an option from the Started By drop-down 
list box in the Advanced Hardware Options dialog box.

Syntax: Answer

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example loads a hardware configuration and waits for a call.

Load OnlSvcInfo "ACE BBS”

Answer

See Also: Break, Dial Host, Dial Number, Dial OnlSvc, Hang
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Beep

Description: Use this command to sound an audible alarm on the remote PC. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: Beep

Reserved Variables: $Result Set to 0.

Example: The following example beeps twice.

Type String "Attention! An error has occurred."

Beep

Beep

See Also: Message Box, Type Line, Type String
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Break

Description: This command applies to serial devices only. Use it to place a break signal on the communication line. 
The duration of the break signal is specified by the $BrkLen reserved variable, and is measured in tenths 
of a second. By default, $BrkLen is set to 0.

Syntax: Break

Reserved Variables: $Result Set to 0.

Example: The following example causes a .2-second break.

$BrkLen = 2

Break ;breaks the connection

See Also: Answer, Dial Host, Dial Number, Dial OnlSvc, Hang
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CD

Description: This command applies to the remote PC only. Use it to change the current directory on the current drive 
to the specified directory. This command can be used in scripts that perform remote control sessions so 
long as the command is not executed during the remote control session.

Syntax: CD pathname

Parameters: pathname String literal or string variable containing the full pathname of the new current 
directory. You must include a backslash (\) at the beginning of the pathname for 
the root directory on the current drive and between directory names. The drive 
letter is optional.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

$CurDir Set to string containing the name of the current directory on the current drive.

Example: The following example changes the current directory on the current drive so you can access files in that 
directory.

CD "\AW"

The next example prompts the user for the new current directory.

String newpath[66]

;prompt the user for the path

Type Line "Enter a directory: "

;read the pathname into the newpath variable

Input newpath 66

;change the directory using the newpath variable

CD newpath

The last example reads the new current directory from a file.

String newpath[66]

;open a data file, read the path from it,

;and close the file

Open 1 "datafile.txt"

Read String 1 newpath 66

Close 1

;change the directory using the newpath variable

CD newpath

See Also: Dir , MD, RD, SessOpr Host Run, SessOpr Remote Run



Script Editor Commands 
{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

Clear BOL

Description: This command manipulates characters in the remote PC’s display buffer. Use it to clear all characters in 
the current row from the beginning of the row (column 1) up to but not including the current cursor 
position. Each character in the row is replaced by a normal video space. The cursor position does not 
change.

Syntax: Clear BOL

Reserved Variables: $Result Set to 0. 

Example: The following example positions the cursor at row 10, column 15 and uses Clear BOL to clear the 
characters in row 10, columns 1 through 14.

Cursor Position 10 15

Clear BOL

See Also: Clear BOP, Clear EOL, Clear EOP, Clear Screen
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Clear BOP

Description: This command manipulates characters in the remote PC’s display buffer. Use it to clear all characters 
from the upper-left corner of the screen (row 1, column 1) up to but not including the current cursor 
position. Each character is replaced by a normal video space. The cursor position does not change.

Syntax: Clear BOP

Reserved Variables: $Result Set to 0.

Example: The following example positions the cursor at row 10, column 15 and uses Clear BOP to clear the screen 
from row 1, column 1 to row 10, column 14.

Cursor Position 10 15

Clear BOP

See Also: Clear BOL, Clear EOL, Clear EOP, Clear Screen
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Clear EOL

Description: This command manipulates characters in the remote PC’s display buffer. Use it to clear all characters in 
the current row from the current cursor position to the end of the row (inclusive). Each character is 
replaced by a normal video space. The cursor position does not change.

Syntax: Clear EOL

Reserved Variables: $Result Set to 0.

Example: The following example positions the cursor at row 10, column 15 and uses Clear EOL to clear the 
characters in row 10, starting with column 15 and ending with the last character in the row.

Cursor Position 10 15

Clear EOL

See Also: Clear BOL, Clear BOP, Clear EOP, Clear Screen
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Clear EOP

Description: This command manipulates characters in the remote PC’s display buffer. Use it to clear the screen from 
the current cursor position to the lower-right corner of the screen (inclusive). Each character is replaced 
by a normal video space. The cursor position does not change.

Syntax: Clear EOP

Reserved Variables: $Result Set to 0.

Example: The following example positions the cursor at row 10, column 15 and uses Clear EOP to clear the screen 
from row 10, column 15 to last column of the last row.

Cursor Position 10 15

Clear EOP

See Also: Clear BOL, Clear BOP, Clear EOL, Clear Screen
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Clear Screen

Description: This command manipulates characters in the remote PC’s display buffer. Use it to clear the entire screen 
and move the cursor to the upper-left corner (row 1, column 1). Each character is replaced by a normal 
video space.

Syntax: Clear Screen

Reserved Variables: $Result Set to 0.

Example: The following example clears the screen and places the cursor at row 1, column 1.

Clear Screen

See Also: Clear BOL, Clear BOP, Clear EOL, Clear EOP
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Close

Description: This command applies to the remote PC only. Use it to close the file associated with the specified file 
number. Once a file is closed, it cannot be read from or written to. Any file left open when script 
processing terminates is closed automatically. This command can be used in scripts that perform remote 
control sessions so long as the command is not executed during the remote control session.

TIP: Although it is not necessary to close files when you have finished working with them, it is generally a 
good practice to do so. When files are open, they are vulnerable to corruption. If your script should 
terminate unexpectedly, any open files could be damaged.

Syntax: Close file_number

Parameters: file_number Integer literal used by Open or Create command to identify the file. Valid values 
are 1 through 9.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens TESTFILE.DAT, gives it the file number 1, writes one line, then closes the 
file.

Open 1 "testfile.dat"

Write Line 1 "Sample entry."

Close 1

See Also: Copy, Create, Del, Open, Ren
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Copy

Description: This command applies to source and destination files on the remote PC only. Use it to make an exact 
copy of a DOS file with a different name or with the same name in a different directory. This command can
be used in scripts that perform remote control sessions so long as the command is not executed during 
the remote control session.

Syntax: COPY source destination

Parameters: source String literal or string variable containing the pathname (optional) and filename of 
the source file to copy. If only a filename is specified, the file must be in the 
current directory.

destination String literal or string variable containing the pathname (optional) and filename 
for the destination file. If only a filename is specified, the copy is made in the 
current directory.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example makes a backup copy of REFERENC.TXT.
COPY "\docs\referenc.txt" "\olddocs\referenc.txt"

The next example prompts the user for the new filename then creates a copy using that name.

String newname[12]

;prompt the user for filename

Type Line "Enter the name of the new file: "

;read the destination (from screen)

Input newname

COPY "file1.txt" newname

See Also: Close, Create, Del, Open, Ren, SessOpr Host Run, SessOpr Remote Run
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Create

Description: This command applies to the remote PC only. Use it to create and open a new file. This command can be 
used in scripts that perform remote control sessions so long as the command is not executed during the 
remote control session.

TIP: Using the Create command on an existing file with read/write attributes is an easy way to clear the 
file’s contents. The existing file length is truncated to 0. If the truncation is successful, the file is opened.

Syntax: Create file_number filename [attributes]

Parameters: file_number Integer literal used to identify the file. Valid identifiers are 1 through 9.

filename String literal or string variable containing the name of the file.

attributes (Optional) string literal or string variable containing attributes you want the file to 
have. The default is non-sharable read/write.

Use a combination of the following attributes:

R read-only

W read/write

S sharable

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Set to -9 if the file already exists, except in cases where the attributes variable is 
set to read/write.

All other standard errors apply. See Appendix B, “Error Messages.”

Example: The following example creates NEWFILE.TXT, a sharable read/write file named in the current directory.

Create 1 "newfile.txt" "SW"

The next example uses a variable to provide the name of the new file.

String filename[12]

;assign the filename to the string variable

filename = "newfile.txt"

;create and open the new file with the 

;default setting

Create 1 filename

See Also: Close, Copy, Del, Open, Ren, Set File Attr, Set File Date, Set File Size, Set File Time
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Cursor Block

Description: This command applies to the remote PC’s display buffer. Use it to change the shape of the cursor to a 
rectangular block, or to show a cursor hidden using the Cursor Off command.

Syntax: Cursor Block

Reserved Variables: $Result Set to 0.

Example: The following example changes the cursor’s shape to indicate that the user has entered insert mode.

Cursor Block

See Also: Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor Restore, 
Cursor Right, Cursor Save, Cursor Up
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Cursor Down

Description: This command manipulates characters in the remote PC’s display buffer. Use it to move the cursor down 
the specified number of rows, or one row if no number is specified. If the number exceeds the number of 
rows below the current position, the cursor moves to the bottom of the screen. The cursor remains in the 
same column.

Syntax: Cursor Down [count]

Parameters: count (Optional) integer literal or integer variable containing number of rows to move 
cursor. The default is 1.

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor down five rows.

Cursor Down 5

The next example moves the cursor down the number of rows specified in the count variable.

Integer count

count = 5

Cursor Down count

See Also: Cursor Block, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor Restore, 
Cursor Right, Cursor Save, Cursor Up
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Cursor Home

Description: This command manipulates characters in the remote PC’s display buffer. Use it to move the cursor to the 
upper-left corner of the screen (row 1, column 1).

Syntax: Cursor Home

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor to row 1, column 1.

Cursor Home

See Also: Cursor Block, Cursor Down, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor Restore, Cursor
Right, Cursor Save, Cursor Up
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Cursor Left

Description: This command manipulates characters in the remote PC’s display buffer. Use it to move the cursor left 
the specified number of columns, or left one column if no number is specified. If the number exceeds the 
number of columns to the left of the current position, the cursor moves to the leftmost column. The cursor 
remains in the same row.

Syntax: Cursor Left [count]

Parameters: count (Optional) integer literal or integer variable containing the number of columns to 
move the cursor. The default is 1.

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor left 5 columns.

Cursor Left 5

The next example moves the cursor left the number of columns specified in the count variable.

Integer count

count = 5

Cursor Left count

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Line, Cursor Off, Cursor Position, Cursor Restore, 
Cursor Right, Cursor Save, Cursor Up



 Script Editor Commands 
{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

Cursor Line

Description: This command applies to the remote PC’s display buffer. Use it to change the cursor shape to a single 
underscore (underline), or to show a cursor previously hidden by a Cursor Off command.

Syntax: Cursor Line

Reserved Variables: $Result Set to 0.

Example: The following example changes the cursor to indicate that the user has entered overwrite mode.

Cursor Line

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Off, Cursor Position, Cursor Restore, 
Cursor Right, Cursor Save, Cursor Up
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Cursor Off

Description: This command applies to the remote PC’s display buffer. Use it to hide the cursor. The cursor position 
does not change. Show the cursor by using either the Cursor Block or Cursor Line command.

Syntax: Cursor Off

Reserved Variables: $Result Set to 0.

Example: The following example hides the cursor.

Cursor Off

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Position, Cursor Restore, 
Cursor Right, Cursor Save, Cursor Up
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Cursor Position

Description: This command manipulates characters in the remote PC’s display buffer. Use it to move the cursor to a 
specific position on the screen. For example, row 1, column 1 is the upper-left corner of the screen.

Syntax: Cursor Position row column

Parameters: row Integer literal or integer variable specifying the row you want to move the cursor 
to. The top row of the screen is row 1. An asterisk (*) indicates that the row 
position does not change.

column Integer literal or integer variable specifying the column you want to move the 
cursor to. The leftmost column of the screen is column 1. An asterisk (*) indicates
that the column position does not change.

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor to column 20 of the current row.
Cursor Position * 20

The next example moves the cursor to row 15. The column position does not change.
Cursor Position 15 *

The last example uses the variables row and column to position the cursor at row 7, column 10.
Integer row, column

column = 10

row = 7

Cursor Position row column

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Restore, Cursor 
Right, Cursor Save, Cursor Up
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Cursor Restore

Description: This command manipulates characters in the remote PC’s display buffer. Use it to restore the position, 
shape (block or underscore), and video attributes of a cursor. This command is valid only for a cursor you 
saved using the Cursor Save command.

Syntax: Cursor Restore

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor to row 12, column 20; changes it to a block; then saves all the 
information about the cursor. Later, it restores the saved cursor.

Cursor Position 12 20

Cursor Block

;saves the cursor at row 12, column 20 

;with block form

Cursor Save

Clear Screen

;changes the cursor's position and shape

Cursor Position 23 10

Cursor Line

;restores the cursor to row 12, column 20 

;and block form

Cursor Restore

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor 
Right, Cursor Save, Cursor Up
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Cursor Right

Description: This command manipulates characters in the remote PC’s display buffer. Use it to move the cursor right 
the specified number of columns, or right one column if no number is specified. If the number exceeds the
number of columns to the right of the current position, the cursor moves to the rightmost column. The 
cursor remains in the same row.

Syntax: Cursor Right [count]

Parameters: count (Optional) integer literal or integer variable containing the number of columns to 
move right. The default is 1.

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor right five columns.

Cursor Right 5

The next example moves the cursor right the number of columns specified in the count variable.

Integer count

count = 5

Cursor Right count

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor 
Restore, Cursor Save, Cursor Up
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Cursor Save

Description: This command manipulates characters in the remote PC’s display buffer. Use it to save the position, 
shape (block or underscore), and video attributes of the cursor. To restore the cursor’s position and 
attributes, use the Cursor Restore command.

Syntax: Cursor Save

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor to row 12, column 20; changes it to a block; then saves all the 
information about the cursor. Later, it restores the saved cursor.

Cursor Position 12 20

Cursor Block

;saves the cursor at row 12, column 20 

;with block form

Cursor Save

Clear Screen

;changes the cursor's position and shape

Cursor Position 23 10

Cursor Line

;restores the cursor to row 12, column 20 

;and block form

Cursor Restore

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor 
Restore, Cursor Right, Cursor Up
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Cursor Up

Description: This command manipulates characters in the remote PC’s display buffer. Use it to move the cursor up the
specified number of rows, or one row if no number is specified. If the number exceeds the number of rows
above the current position, the cursor moves to the top of the screen. The cursor remains in the same 
column.

Syntax: Cursor Up [count]

Parameters: count (Optional) integer literal or integer variable containing the number of rows to 
move the cursor. The default is 1.

Reserved Variables: $Result Set to 0.

Example: The following example moves the cursor up five rows.

Cursor Up 5

The next example moves the cursor up the number of rows specified in the count variable.

Integer count

count = 5

Cursor Up count

See Also: Cursor Block, Cursor Down, Cursor Home, Cursor Left, Cursor Line, Cursor Off, Cursor Position, Cursor 
Restore, Cursor Right, Cursor Save
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Decrypt

Description: Use this command to decrypt a string which has been encrypted using the Encrypt command. To retrieve 
the original, unencoded string, you must use the exact same key string in both the Encrypt and Decrypt 
commands. Both the source string and key string are case-sensitive. 

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Decrypt source key

Parameters: source String variable to decrypt. The string variable can contain any combination of 
characters and numbers.

key String literal or string variable containing the encryption key. The key can contain 
any combination of characters and numbers.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

WARNING: If the wrong key is used to decrypt the data, no error is generated. The resulting string is 
incorrect and it overwrites the source string.

Example: The following example reads an encrypted password from a file, decrypts the password for later use, and 
dials CompuServe.

String filename[66]

String password[12]

filename = "compusrv.dat"

Find First filename

If ($Result==0) GoTo @end

Open 1 filename

Read Line 1 password

Close 1

Decrypt password "passkey"

Trim password

Dial OnlSvc "CompuServe"

;send password, etc. to CompuServe

...

@end

End

See Also: Encrypt
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Del

Description: This command applies to the remote PC only. Use it to delete a DOS file or group of files. It is extremely 
useful in deleting any temporary files you create during script processing. This command can be used in 
scripts that perform remote control sessions so long as the command is not executed during the remote 
control session.

Syntax: Del filename

Parameters: filename String literal or string variable containing the full path and filename of the file you 
want to delete. Wildcards (? or *) are allowed.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example deletes the file DATA.TMP.
Del "c:\temp\data.tmp"

The next example deletes all files with the extension .TMP.

Del "c:\temp\*.tmp"

The last example deletes the file or files specified by the user.

String filename[66]

;prompt user for a filename

Type Line "Enter the name of the file to delete: "

Input filename

;delete file

Del filename

See Also: Close, Copy, Create, Open, Ren, SessOpr Host Run, SessOpr Remote Run
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Delete Char 

Description: This command manipulates characters in the remote PC’s display buffer. Use it to delete one or more 
characters in the current row, beginning with and including the current cursor position. The characters in 
the current row to the right of the deleted characters are shifted left to fill the gap. If the last character in 
the row is deleted, it is replaced by a normal video space. The cursor position does not change.

NOTE: This command affects only characters in the current row. Deleting characters at the end of a row 
has no effect on the row beneath.

Syntax: Delete Char [count]

Parameters: count (Optional) integer literal or integer variable containing number of characters to 
delete. The default is 1.

Reserved Variables: $Result Set to 0.

Example: The following example deletes five characters to the right of the cursor.

Delete Char 5

See Also: Delete Line, Insert Char, Insert Line
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Delete Line

Description: This command manipulates characters in the remote PC’s display buffer. Use it to delete one or more 
rows on the screen, beginning with and including the current row, in which the cursor appears. Undeleted 
rows below the current row are shifted up the specified number of rows. If the last row on the screen is 
deleted, it is replaced by normal video spaces. The cursor is moved to column 1 of the current row.

Syntax: Delete Line [count]

Parameters: count (Optional) integer literal or integer variable containing the number of rows to 
delete. The default is 1.

Reserved Variables: $Result Set to 0.

Example: The following example deletes the five rows down from the current row.
Delete Line 5

See Also: Delete Char, Insert Char, Insert Line
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Description

Description: Use this command to add a brief description to your script file. You should have at most one Description 
command in each of your scripts.

Normally, you enter a description of your script as one of the first lines in your script file. The description is
for informational purposes only.

In pcANYWHERE for Windows, the description appears in the Scripts dialog box to the right of the script 
name after the script file is compiled.

Syntax: Description string

Reserved Variables: (none)

Parameters: string String literal containing a brief description of the script file.

Example: The following example describes the script’s purpose.

Description "Auto logon to my office PC"
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Dial Host

Description: This command can be used for any connection type. Use it to both load the specified remote control 
session configuration (along with the hardware configuration it includes) and initiate a connection.

Syntax: Dial Host host_name

Parameters: host_name String literal or string variable containing the name of the remote control session 
configuration.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example calls and attempts to connect with “Office PC.”

Dial Host "Office PC"

See Also: Answer, Break, Dial Number, Dial OnlSvc, Hang
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Dial Number

Description: Use this command to dial the specified phone numberand make a connection using the current 
configuration. (You can load a configuration using    Load HostInfo or Load OnlSvcInfo.) Use this 
command when a phone number does not already appear in the configuration or if you want to override 
that number.

Syntax: Dial Number number

Parameters: number String literal or string variable containing telephone number to dial. The maximum
length of the string is 255 characters.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example loads the hardware configuration, then dials that number. 

Load OnlSvcInfo "ACE BBS"

Dial Number "1-500-555-5555"

See Also: Answer, Break, Dial Host, Dial OnlSvc, Hang, Load HostInfo, Load OnlSvcInfo.



Script Editor Commands 
{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

Dial OnlSvc

Description: This command can be used for any connection type. Use it to both load the specified online session 
configuration (along with the hardware configuration it includes) and initiate a connection.

Syntax: Dial OnlSvc online_svc

Parameters: online_svc String literal or string variable containing the name of the online service you are 
calling. The name must be as it appears in your list of online services.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example dials the online service you defined as “CompuServe.”

Dial OnlSvc "CompuServe"

End Terminal

See Also: Answer, Break, Dial Host, Dial Number, Hang
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Dir

Description: This command applies to the remote PC only. Use it to display a list of a directory’s files on the screen. 
This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Dir filespec

Parameters: filespec String literal or string variable containing the full path or filename for the contents 
of the desired directory. Wildcards (? or *) are allowed. If no drive is specified, the
current drive is the default.

Reserved Variables: $Result Set to the number of matching files found and displayed, or 0 if no files are found.
If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example displays all the files in the DATA directory with the extension .DAT. It also displays 
the number of files found.

String total[6]

;get directory information and set total to $Result

Dir "c:\data\*.dat"

total = $Result

Type Line "^MTotal number of files: "

Type String total ;display total number of files

See Also: CD, MD, RD, SessOpr Host Run, SessOpr Remote Run
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Emulate

Description: This command applies to the remote PC only. Use it to emulate a terminal type when in terminal mode or 
when character sequences are output to the screen from a script. Each emulation has its own set of 
screen sequences to control cursor positioning, clearing the screen, screen attributes, and other behavior.

Emulate resets Load Translation to the default translation. If you load an online session configuration after
the Emulate command, the emulation is reset to the one in the configuration.

Syntax: Emulate terminal_name

Parameters: terminal_name The name of the following predefined terminal emulations:

Terminal Emulated Name

Standard ANSI Terminals ANSI

DEC VT-100 VT100

DEC VT-102 VT102

DEC VT-220, 7-bit mode VT220-7

DEC VT-220, 8-bit mode VT220-8

DEC VT-52 VT52

Televideo 912 TVI912

Televideo 920 TVI920

Televideo 925 TVI925

IBM 3101 IBM3101

Data General Dasher 100 DG100

Data General Dasher 200 DG200

Wyse 50 WYSE50

Hazeltine 1500 HAZ1500

LSI ADM-3A ADM3A

ADDS Viewpoint ADDSVPT

X3270 X3270

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.



$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example emulates a VT-100 terminal.

Emulate VT100

See Also: Reset, Terminal
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Encrypt

Description: Use this command to convert the source string into a code based upon the key string. Both the source 
string and key string are case-sensitive. This command prevents unauthorized access to the information 
contained in the source string. 

To retrieve the original, unencoded string, you must use the exact same key string in both the Encrypt and
Decrypt commands. Encryption is commonly used to protect passwords and personal information. You 
can encrypt data and safely write it to a data file for retrieval later.

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Encrypt source key

Parameters: source String variable to encrypt. The string variable can contain any combination of 
characters and numbers.

key String literal or string variable containing the encryption key. The key can contain 
any combination of characters and numbers.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example makes “passkey” the key and prompts the user for a password. After the 
password is encrypted, it is written to a file for later reference.

String password[12]

String key[12]

key = "passkey"

;prompt user for password

Type Line "Enter your password: "

;set password variable

Input password

;encrypt and decrypt password

Encrypt password key

Open 1 "compusrv.dat" "CW"

Write Line 1 password

Close 1

See Also: Decrypt
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End

Description: This command ends current script processing. If the script was executed from a menu, dialog box, or 
window, control is returned to that menu, dialog box, or window. If the script was called by another script, 
control returns to the calling script. For pcANYWHERE for DOS only, if the script was started from a DOS 
command line, pcANYWHERE is terminated.

Syntax: End [return_code]

Parameters: return_code (Optional) integer literal or integer variable to return from called script to calling 
script. Its value is also stored in $Result.

Reserved Variables: $Result Set to the value of return_code so it can be used by the calling script. Set to zero 
when return_code is not used.

$Error Unchanged.

Example: In the following example, the MAIN.SCR script file calls the ANOTHER.SCR script file. ANOTHER.SCR 
uses the global variables declared in MAIN.SCR.

MAIN.SCR

Integer temp

;declare $1 and $2 as global integers

Integer $1, $2

$1 = 5 ;set $1 variable

$2 = 5 ;set $2 variable

Script ANOTHER ;call ANOTHER.SCR

temp = $Result ;store return value in temp

Type String "The value is: "

;print product of $1 and $2 (25) to the screen

Type Line temp

Wait Time 3

End;end script processing

ANOTHER.SCR

value = $1 * $2 ;calculate product of $1 and $2

;end processing of ANOTHER.SCR,

;return control, and pass value to MAIN.SCR

End value

See Also: End Menu, End Terminal, Exit



 Script Editor Commands 
{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

End Menu

Description: This command ends the current script, exits terminal mode, and returns control to the Main menu, 
regardless of how the script was invoked. If a connection was made, it is disconnected.

Syntax: End Menu

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example ends script processing and returns to the main menu.

End Menu

See Also: End, End Terminal, Exit
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End Terminal

Description: Use this command to end all script processing and return control to the terminal mode of pcANYWHERE, 
regardless of how the script was invoked. This allows you to continue to use pcANYWHERE with your 
online session even though the script has ended. 

Unlike the Terminal command, when terminal mode is exited, control does not return to the script 
containing the End Terminal command.

Syntax: End Terminal

Reserved Variables: (none)

Example: The following example ends script processing, but leaves you connected to your online session and 
leaves pcANYWHERE running.

End Terminal

See Also: End, End Menu, Exit
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Exit

Description: Use this command to end all script processing and exit pcANYWHERE. Unless the Online parameter is 
specified, the connection is also terminated. With Online, the user can continue using the online service.

Syntax: Exit [Online]

Parameters: Online (Optional) does not lower the DTR signal on exit. Essentially, if a serial 
connection is in progress (modem or other), this command leaves the connection
alive even after you have exited the application. Used for online service serial 
connections only.

Reserved Variables: (none)

Example: The following example ends the program and exits pcANYWHERE.

Exit

The following example ends the program but keeps the connection to the online service open.

Exit Online

See Also: End, End Menu, End Terminal
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Find First

Description: This command applies to the remote PC only. Use it to search the drive for the first file that matches the 
file specification. This command can be used in scripts that perform remote control sessions so long as 
the command is not executed during the remote control session.

NOTE: You can also use this command to check if a file exists; for example, before performing a Create 
command.

Syntax: Find First search_for [match_found]

Parameters: search_for String literal or string variable containing the name of the file you want to search 
for. The filename can contain wildcards (? or *). If no drive is specified, the 
current drive is the default.

match_found (Optional) string variable used to store the matched filename, if found. When not 
used, the filename is not retrieved.

Reserved Variables: $Result Set to 1 if a match is found; 0 if no match is made. If an error occurs, set to the 
value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example determines if a file with the .DAT extension exists in the current directory on the C: 
drive.

Find First "C:*.DAT"

;if found, go to @found

If ($Result == 1) GoTo @found

Type Line "No matching files found."

GoTo @end ;if not found, go to @end

@found:

Type Line "Matching files found."

@end:

End;end processing

See Also: Dir, Find Next
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Find Next

Description: This command applies to the remote PC only. Use it to search for additional instances of the file or file 
types specified in the Find First command. This command can be used in scripts that perform remote 
control sessions so long as the command is not executed during the remote control session.

Syntax: Find Next [match_found]

Parameters: match_found (Optional) string variable used to store the matched filename, if found. When not 
used, the filename is not retrieved.

Reserved Variables: $Result Set to 1 if a match is found; 0 if no match is made. If an error occurs, set to the 
value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example starts the search for files with .DAT as an extension with the Find First command. 
Every time a match is found, Find Next is repeated to find an additional matching file.

Integer count

String match[10]

;initialize count to 0

count = 0

;search for matching files

Find First "C:*.DAT" match

;if a match is found, continue at @found

If ($Result == 1) GoTo @found

;If no match is found, display message 

;and terminate script

Type Line "No matching files found."

GoTo @end

@found:

Type Line "Matching files found."

count = count + 1 ;increment count by 1

Type String match ;display filename

Type String "^M" ;hard carriage return

;search for next instance until no more are found

Find Next match

If ($Result == 1) GoTo @found

;when no more .DAT files found, display total

Type String "Number of *.DAT files found: "

Type Line count

@end:

End;end processing

See Also: Dir, Find First
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Get Environment

Description: This command applies to the remote PC only. Use it to retrieve the setting for a DOS environment 
variable. The names of environment variables usually appear in Set statements in the AUTOEXEC.BAT 
file and closely resemble the directory names for the applications they represent. For example, 
pcANYWHERE is AW, Norton Utilities is NU, and Norton AntiVirus is NAV. This command can be used in 
scripts that perform remote control sessions so long as the command is not executed during the remote 
control session.

Syntax: Get Environment variable value

Parameters: variable String literal or string variable containing the name of an environment variable.

value String variable that will store the value of the specified environment variable. If 
the variable is not found, this is a null string.

Reserved Variables: $Result Set to 1 if a match is found; otherwise set to 0. If an error occurs, set to the value 
of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following takes the environment variable stating where Windows is installed, and puts it in the string 
variable “winpath”:
Get Environment "WinDir" winpath
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Get File Attr

Description: This command applies to the remote PC only. Use it to retrieve the attributes for the specified file. This 
command can be used in scripts that perform remote control sessions so long as the command is not 
executed during the remote control session.

Syntax: Get File Attr filename [attributes]

Parameters: filename String literal or string variable containing the full path and name of the file whose 
attributes you want. Wildcards are not allowed.

attributes (Optional) integer variable used to store the sum of the values for the file’s 
attributes for filename. Its value is also stored as an integer in $Result.

This values for the attributes are:

Attribute Value

Read-only 1

Hidden 2

System file 4

Volume label 8

Subdirectory 16

Archive 32

For example, suppose the attributes value for the IO.SYS file is 7. Because 7 is 
the sum of 1, 2, and 4, so IO.SYS is read-only, hidden system file. If the sum is 0,
the file is a Normal file.

Reserved Variables: $Result Contains the file attributes integer. A non-negative value indicates that valid 
attribute information has been obtained. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example retrieves the attributes for a file, converts each attribute to a character (such as N 
for normal), then displays the characters.

Integer attr

String description[10]

;set description to null

description = ""

;get file attributes for COMMAND.COM

Get File Attr "COMMAND.COM" attr

;if all bits are 0, write N (normal) to the string

If (attr == 0) Then StrCat description "N"

;if bit 0 is 1, write R (read-only) to the string



If ((attr & 1) == 1) Then StrCat description "R"

;if bit 1 is 1, write H (hidden) to the string

If ((attr & 2) == 2) Then StrCat description "H"

;if bit 2 is 1, write S (system file) to the string

If ((attr & 4) == 4) Then StrCat description "S"

;if bit 3 is 1, 

;write V (volume label) to the string

If ((attr & 8) == 8) Then StrCat description "V"

;if bit 4 is 1, write D (directory) to the string

If ((attr & 16) == 16) Then StrCat description "D"

;if bit 5 is 1, write A (archive) to the string

If ((attr & 32) == 32) Then StrCat description "A"

Type String "The file is a "

Type Line description

See Also: Get File Date, Get File Size, Get File Time, Set File Attr, Set File Date, Set File Size, Set File Time
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Get File Date

Description: This command applies to the remote PC only. Use it to retrieve the date that a file was created or last 
modified. This command can be used in scripts that perform remote control sessions so long as the 
command is not executed during the remote control session.

Syntax: Get File Date filename [date]

Parameters: filename String literal or string variable containing the full path and name of the file whose 
date you want. Wildcards are not allowed.

date (Optional) string variable used to store the date in the appropriate international 
date format (for example, YY/MM/DD for the United States). When not used, the 
date is not retrieved in string form. Its value is also stored as an integer in 
$Result.

Reserved Variables: $Result Stores the date as an integer. The format is YYMMDD. A non-negative value 
indicates that a valid date was retrieved. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example finds the date for the COMMAND.COM file and stores it in $Result.

String filename[12]

filename = "command.com"

;get the file date for COMMAND.COM

Get File Date filename

Type Line $Result ;display date

See Also: Get File Attr, Get File Size, Get File Time, Set File Attr, Set File Date, Set File Size, Set File Time
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Get File Size

Description: This command applies to the remote PC only. Use it to retrieve the size, in bytes, of the file specified in 
filename. This command can be used in scripts that perform remote control sessions so long as the 
command is not executed during the remote control session.

Syntax: Get File Size filename [size]

Parameters: filename String literal or string variable containing the full path and name of the file whose 
size you want. Wildcards are not allowed.

size (Optional) string variable used to store the size of the file. When not used, the 
size is not retrieved in string form. Its value is also stored as an integer in 
$Result.

Reserved Variables: $Result Stores the file size as an integer. Set to a non-negative value indicates a valid file
size was retrieved. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example determines the size of the COMMAND.COM file.

String size[10]

;get the file size and display it

Get File Size "COMMAND.COM" size

Type String "The size of COMMAND.COM is: "

Type Line size

See Also: Get File Attr, Get File Date, Get File Time, Set File Attr, Set File Date, Set File Size, Set File Time
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Get File Time

Description: This command applies to the remote PC only. Use it to retrieve the time that the file specified in filename 
was created or last modified. This command can be used in scripts that perform remote control sessions 
so long as the command is not executed during the remote control session.

Syntax: Get File Time filename [time]

Parameters: filename String literal or string variable containing the full path and name of the file whose 
time you want. Wildcards are not allowed.

time (Optional) string variable used to store the time. The time format is HHMM on a 
24-hour clock. The leading zero is dropped. When not used, the time is not 
retrieved in string form. Its value is also stored as an integer in $Result.

Reserved Variables: $Result Stores the retrieved time as an integer. A non-negative value indicates that a 
valid time was retrieved. The time format is HHMM on a 24-hour clock (no 
leading zero). If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example determines the time for the COMMAND.COM file and stores the time as a string in
the time variable.

String filename[12]

String time[4]

;set filename to COMMAND.COM

filename = "command.com"

;store the time in the time variable

Get File Time filename time

See Also: Get File Attr, Get File Date, Get File Size, Set File Attr, Set File Date, Set File Size, Set File Time
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Get Free Disk

Description: This command applies to the remote PC only. Use it to determine the amount of space remaining on the 
specified disk. This command can be used in scripts that perform remote control sessions so long as the 
command is not executed during the remote control session.

Syntax: Get Free Disk drive [freespace]

Parameters: drive String literal or string variable specifying the drive you are polling. You can 
specify only one drive at a time.

freespace (Optional) string variable containing the amount of space available (in bytes). 
When not used, the amount of space is not retrieved in string form. This value is 
also stored as an integer in $Result.

Reserved Variables: $Result Stores the amount of space available (number of bytes) as an integer. If an error 
occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example determines and displays the amount of free space on drive C.

String size[12]

;and get free space on drive C:

Get Free Disk C size

;display the amount of space available on drive C:

Type String "Free space on drive C: "

Type Line size

See Also: Dir
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GoSub

Description: Use this command to call a subroutine from within the current script file. When the subroutine ends, the 
script resumes processing with the line immediately following the GoSub command.

To correctly return control from the subroutine to the body of the script, each subroutine must end with a 
Return command. An End command should separate any subroutine or series of subroutines from the 
rest of the script so that the lines are executed only when a GoSub command is executed. Subroutines 
can be nested ten levels deep.

Syntax: GoSub label

Parameters: label A label within the current script. The label can contain numbers, letters or 
characters.

Reserved Variables: $Result Unchanged.

$Error Unchanged.

Example: The following example contains a subroutine called getInput that asks the user for a string.

String instring[255]

;call to getInput subroutine

GoSub @getInput

;if no input, end processing

If ($Result == 0) GoTo @end

Send String instring ;send instring

@end:

End;end processing

@getInput: ;getInput subroutine

Input instring ;input string

StrLen instring ;get string length of instring

Return $Result ;return string length of instring

See Also: GoTo, Link, Return, Script
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GoTo

Description: Use this command to branch, or jump, to a label within the current script file.

Syntax: GoTo label

Parameters: label A label within the current script. The label can contain numbers, letters or 
characters.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example uses a GoTo command to end the search for matching files when none or no more
are found. For every file that is found, the script displays the filename and updates the count.

Integer count

String match[10]

count = 0 ;set count to 0

;search for matching files

Find First "C:*.DAT" match

;if match found, go to @found

If ($Result == 1) GoTo @found

Type Line "No matching files found."

GoTo @end ;if not found, go to @end

@found:

Type Line "Matching files found."

@foundmore:

count = count + 1 ;increment count by 1

Type String match ;display filename

Type String "^M" ;hard carriage return

;search for next instance until no more are found

Find Next match

If $Result == 1 GoTo @foundmore

Type String "Number of *.DAT files found: "

Type Line count ;display count

@end:

End;end processing

See Also: GoSub, Link, Return, Script
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Hang

Description: Use this command to terminate any connection.

Syntax: Hang

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example connects to a host PC, then later terminates that connection.

Dial Host "Office PC"

...

Hang ;terminate connection

See Also: Answer, Break, Dial Host, Dial Number, Dial OnlSvc
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If...Then

-or-

If...GoTo

Description: Use this command for conditional processing. If the specified expression is true, the command is 
executed. If the expression is false, the command is ignored and script processing continues with the next
command.

Syntax: If expression Then command

Or,

If expression GoTo label

Parameters: expression Logical expression that results in a true or value. Expressions cannot be used to 
compare values in strings containing both characters and numbers, because the 
string variables are converted to their numeric equivalents. For example, the 
string "123ABX" has the numeric value of 123.

label A label within the current script. The label can contain numbers, letters or 
characters.

command Any valid script command.

Reserved Variables: $Result Unchanged.

$Error Unchanged.

Example: The following example uses If...GoTo commands to control the search for matching files. When a file is 
found, the search continues by going to the found or foundmore label. For every matching file, the script 
displays the filename and updates the count.

Integer count

String match[10]

count = 0 ;set count to 0

;search for matching files

Find First "C:*.DAT" match

;if match found, go to @found

If ($Result == 1) GoTo @found

Type Line "No matching files found."

GoTo @end ;if not found, go to @end

@found:

Type Line "Matching files found."

@foundmore:

count = count + 1 ;increment count by 1

Type String match ;display filename

Type String "^M" ;hard carriage return

;search for next instance until no more are found

Find Next match



If $Result == 1 GoTo @foundmore

Type String "Number of *.DAT files found: "

Type Line count ;display count

@end:

End;end processing

See Also: GoTo
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Index

Description: Use this command to locate the starting position of one string within another. The first character of a string
is at position 1. This command can be used in scripts that perform remote control sessions so long as the 
command is not executed during the remote control session.

Syntax: Index source_str search_str [position]

Parameters: source_str String literal or string variable to be searched.

search_str String literal or string variable you want to search for.

position (Optional) integer variable used to store the starting position of the first instance 
of the search string. Its value is also stored in $Result.

Reserved Variables: $Result Stores the starting position of the first instance of the search string. If no match is
found, set to 0.

$Error Unchanged.

Example: The following example finds the starting position of a substring within a string.

String source[20]

Integer position

position = 2

source = "ABCDEFGHIJ"

;search for FGH in source 

;and store the result in position

Index source "FGH" position

See Also: Lower, Set IgnoreCase, StrCat, StrCmp, StrLen, StrSet, SubStr, Trim, Upper
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Input

Description: Use this command to retrieve data entered by the user from the keyboard. Input retrieves all the 
characters entered before the Enter key, up to the specified maximum length, or up to the length of the 
destination string. The user can use any of the following keys to edit the entry before pressing Enter:

Keystroke Operation

LeftArrow Moves the cursor one column to the left

RightArrow Moves the cursor one column to the right

Backspace Deletes the character before the cursor

Return Terminates data input

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Input data_string [maxlength]

Parameters: data_string String variable where the retrieved data is stored.

maxlength (Optional) integer literal or integer variable containing the maximum number of 
characters accepted into the string. The default value is the declared length of 
the data_string.

Reserved Variables: $Result Contains the total number of characters entered (excluding the terminating 
carriage return). If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example retrieves the user’s response to "Enter your name...".

String username[30]

Type Line "Enter your name (up to 30 characters): "

;retrieve the name typed by the user 

;and store it in the username variable

Input username 30

Send Line username ;send username

See Also: Input Key, Keyboard Flush, Keyboard Hit
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Input Key

Description: Use this command to retrieve a single character typed by the user from the keyboard. The entry is not 
echoed to the screen and the user does not have to press Enter. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: Input Key character

Parameters: character String variable where the retrieved character is stored.

Reserved Variables: $Result Stores the ASCII value of the keystroke entered.

$Error Unchanged.

Example: The following example asks the user for a Y or an N for yes or no until one is received. If the response 
(stored in the yn variable) is a Y, the script continues. If it is an N, the script ends.

String yn[1]

Type Line "Enter Y to continue; N to exit: "

;loop until the user presses y or n

@loop:

Input Key yn

Upper yn ;convert user input to uppercase

;compare user input with "Y" and "N"

StrCmp yn "Y"

If ($Result == 0) GoTo @yes

StrCmp yn "N"

If ($Result == 0) GoTo @no

;beep and keep looping if user presses 

;key other than y or n

Beep

GoTo @loop

@no:

Exit

@yes:

;continue processing the remainder of the script

...

See Also: Input, Keyboard Flush, Keyboard Hit
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Insert Char

Description: Use this command to declare the number of characters to be inserted at the current cursor position, then 
use Type String to insert the desired characters. Insert Char is always used in conjunction with the Type 
String command. The character originally marked by the cursor and the rest of the characters in that row 
are shifted to the right. Characters that are shifted off the screen are lost. The cursor position does not 
change.

Syntax: Insert Char [count]

Parameters: count (Optional) integer literal or integer variable containing number of characters to be 
inserted. The default is 1.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example moves the cursor to an appropriate position and inserts a message in a previously 
typed line.

Type string “This is a test.”

Cursor Left 10

Wait Time 2

;prepare for insertion

Insert Char 21

;insert the characters

Type String "Waiting for signal..."

See Also: Delete Char, Delete Line, Insert Line
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Insert Line

Description: Use this command to insert one or more rows of normal video spaces at the row containing the cursor. 
The row originally containing the cursor and all rows beneath it are shifted down. Rows that are shifted off
of the screen are lost. The row position for the cursor does not change, but it is moved to column 1 (if it 
was not already there).

Syntax: Insert Line [count]

Parameters: count (Optional) integer literal or integer variable containing number of rows to insert. 
The default is 1.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example inserts three rows above the current row.

Integer count

count = 3

Insert Line count ;insert 3 rows at current row

See Also: Delete Char, Delete Line, Insert Char
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Keyboard Flush

Description: Use this command to clear the keyboard buffer containing any characters that the user may have typed 
ahead. Immediately before retrieving keyboard input (using Input or Input Key), use Keyboard Flush to 
clear the keyboard buffers. This ensures that you retrieve only the characters the user types in response 
to a prompt. This command can be used in scripts that perform remote control sessions so long as the 
command is not executed during the remote control session.

Syntax: Keyboard Flush

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example clears the keyboard buffer prior to accepting a filename typed by the user.

String filename[12]

Type Line "Enter the name of the file to delete: "

Keyboard Flush ;clear the keyboard buffer

Input filename;set the filename variable

Del filename ;delete the file

See Also: Input, Input Key, Keyboard Hit
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Keyboard Hit

Description: Use this command to determine if a character has been entered, but not yet read using an Input or Input 
Key command.    This command can be used in scripts that perform remote control sessions so long as 
the command is not executed during the remote control session.

Syntax: Keyboard Hit [flag]

Parameters: flag (Optional) integer variable used as a flag indicating whether or not a key has 
been pressed. Becomes a 1 if a key has been pressed; becomes a 0 otherwise. 
Its value is also stored in $Result.

Reserved Variables: $Result Set to 1 if a key has been pressed; 0 otherwise.

$Error Unchanged.

Example The following example determines if the user has pressed Esc.

@checkesc: ;beginning of subroutine

Keyboard Hit ;check for keystroke

;if not, go back to calling routine

If ($Result == 0) then Return 0

Input Key inkey ;if yes, input keystroke

StrCmp inkey "^[" ;is it the Esc key?

;if yes, Return a value of 1

If ($Result == 0) then Return 1

;repeat loop until all keys are entered and checked

GoTo @checkesc

See Also: Input, Input Key, Keyboard Flush
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Let

Description: Use this command to assign an expression to a variable. You do not need to use the reserved word Let 
unless the variable name you are using is identical to a reserved word, such as a command name.

Syntax: [Let] variable = expression

Parameters: Let (Optional) reserved word; the command may be shortened.

variable Integer variable or string variable.

expression Any expression containing integers, strings, and operators.

Reserved Variables: (none)

Example: The following example assigns a string literal to the echo variable and numeric expressions to the 
variables named base and number.

String echo[10]

Integer base, number

Let echo = "ABC" ;set echo to the string ABC

base = 1

number = base * 10
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Link

Description: Use this command to terminate one script, losing all its local variables and their values, and start another. 
Control is transferred to the script named in the command. A script called using the Link command can be
thought of as a continuation of the original calling script, except that the original script’s local variables are
lost.

This differs from the Script command in that control returns to the calling script after the called script 
terminates.

For example, consider an original calling script named MAIN.SCR. This script is responsible for all 
processing during a session. At one point, an item needs to be printed. Using the Script command, MAIN 
calls a secondary script, CHSPRNT.SCR, which determines which print routine to call (see Figure 4-2). 
CHSPRNT uses a Link command to call the routine for the selected printer. When the item has been sent 
to the printer, the linked script terminates and control is returned to MAIN.SCR (bypassing 
CHSPRNT.SCR entirely).

Figure 4-2 Once the selected print routine has finished executing, control returns to MAIN.SCR.

Syntax: Link script_name

Parameters: script_name String literal or string variable containing the name of the script file to link to. The 
string must not contain the .SCR file extension.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example ends one script and starts another to which the first script has been linked.

Type Line "This script passes control to another."

Link "Script2"

See Also: GoSub, GoTo, Return, Script
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Load FKeys

Description: Use this command to load a function key file containing programmable function key information. Function 
key translations are in effect only in terminal mode (not during script execution).

Syntax: Load FKeys keyboard_file

Parameters: keyboard_file String literal or string variable containing name of function key file. Do not include
a filename extension (.MK6 is assumed).

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example loads the remote control session configuration and function keys information for 
the host PC named MCI Mail, then dials the host.

;load remote control session configuration

Load HostInfo "MCI Mail"

;load function key table for use with MCI

Load FKeys "MCI-MAIL"

;call MCI Mail

Dial Number "9,555-5555"

End Terminal ;go to terminal mode

See Also: Dial Host, Dial Number, Dial OnlSvc, Load HostInfo, Load OnlSvcInfo, Load Translation
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Load HostInfo

Description: Use this command to load a remote control session configuration. The hardware configuration associated 
with the specified remote control session configuration is automatically loaded at the same time. This 
command is used primarily when you need to prompt the user for or override some information in the 
remote control session configuration. If you don’t want to change any settings, you may prefer to use Dial 
Host.

Syntax: Load HostInfo host_name

Parameters: host_name String literal or string variable containing the name of the remote control session 
configuration to load.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example loads the remote control session configuration named Office PC, then dials the 
host.

;load remote control session configuration that has

;no phone number

Load HostInfo "Office PC"

;attempt to connect with office PC

Dial Number "555-5555"

See Also: Dial Host, Dial Number, Dial OnlSvc, Load FKeys, Load OnlSvcInfo, Load Translation
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Load OnlSvcInfo

Description: Use this command to load the specified online session configuration. The hardware configuration 
associated with the specified online session configuration is automatically loaded at the same time. This 
command is used primarily when you need to prompt the user for or override some information in the 
online session configuration. If you don’t want to change any settings, you may prefer to use Dial OnlSvc.

Syntax: Load OnlSvcInfo online_svc_name

Parameters: online_svc_name String literal or string variable containing the name of the online session 
configuration to load. The name must be as it appears in the pcANYWHERE list 
of online services.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example loads the online session configuration, asks the user for the phone number, then 
dials that number. 

String phone_number[12]

;load CompuServe session configuration 

;that has no phone number

Load OnlSvcInfo "CSwoPHONE"

Type Line "Enter CompuServe phone number: "

Input phone_number 12

;attempt to connect with online service

Dial Number phone_number

See Also: Dial Host, Dial Number, Dial OnlSvc, Load FKeys, Load HostInfo, Load Translation
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Load Translation

Description: Use this command to load a translation table file for both incoming and outgoing character streams. A 
translation table is used to translate one character set to another or to filter out unwanted characters. You 
must load the configuration before the Load Translation command is executed. The Set Translation 
command indicates whether or not to use the loaded translation file.

Syntax: Load Translation translation_file

Parameters: translation_file String literal or string variable containing the translation filename to load. Do not 
include the .TRN filename extension.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example loads the strip high bits translation table, loads a remote control session 
configuration, enables the translation, and calls the host. The order of these commands must be as 
shown.

Load OnlSvcInfo "ACE BBS" ;load configuration

Load Translation "STRIPHIG"

Set Translation On

...

Dial Number ACS_BBS ;attempt connection

See Also: Load FKeys, Load HostInfo, Load OnlSvcInfo, Set Translation
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Lower

Description: Use this command to convert all uppercase characters in a string to lowercase. Characters that are 
already lowercase are not affected. This command can be used in scripts that perform remote control 
sessions so long as the command is not executed during the remote control session.

Syntax: Lower string

Parameters: string String variable to convert.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example converts the specified string to all lowercase characters.

String mixed[10]

mixed = "aBC"

Lower mixed

;display string (abc is displayed)

Type String mixed

See Also: Set IgnoreCase, StrCat, StrCmp, StrLen, StrSet, SubStr, Trim, Upper
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MD

Description: This command applies to the remote PC only. Use it to create a new directory. This command can be 
used in scripts that perform remote control sessions so long as the command is not executed during the 
remote control session.

Syntax: MD dirname

Parameters: dirname String literal or string variable containing the full path and name of the directory 
you want to create.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example creates a new subdirectory named AW.

MD "AW"

The next example asks the user for the name of the new subdirectory.

String newdir[66]

Type Line "Enter the directory: "

;read path into the newdir variable

Input newdir 66

;make the directory based upon the newdir variable

MD newdir

The last example creates a new subdirectory using a pathname read from a file.
String newdir[66]

Open 1 "datafile.txt" ;open the data file

Read String 1 newdir 66;read in the path string

Close 1 ;close the data file

;make the directory based upon the newdir variable

MD newdir

See Also: CD, Dir, RD, SessOpr Host Run, SessOpr Remote Run
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Message Box

Description: Use this command to display a message box. The value you use for the options parameter dictates the 
appearance of the message box. This command can be used in scripts that perform remote control 
sessions so long as the command is not executed during the remote control session.

Syntax: MessageBox title text [options]

Parameters: title String literal or string variable containing the title of the message box.

text String literal or string variable containing the text to appear in the message box.

options (Optional) integer literal or integer variable which is the sum of the numbers 
representing the buttons to appear in the message box, the button that is 
selected by default, and (in Windows only) the icon to display to the left of the 
text.

When options is not specified in DOS, the default is 0—an OK button which is 
selected by default; in Windows, the default is 21—the Retry and Cancel buttons 
(with Retry selected by default) and a Stop icon.

Values for the options parameter are:

Value Buttons to Display

0 OK

1 OK and Cancel

2 Abort, Retry, and Ignore

3 Yes, No, and Cancel

4 Yes and No

5 Retry and Cancel

Value Default Button

0 Button 1

256 Button 2

512 Button 3

Value Icon to Display

0 None



16 Stop sign

32 Question mark

48 Exclamation point

64 Information

Reserved Variables: $Result Set to one of the following values depending on which button the user pressed:

$Result Button Pressed

1 OK

2 Cancel

3 Abort

4 Retry

5 Ignore

6 Yes

7 No

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example produces a message box. In    pcANYWHERE for Windows, the message box is as
shown in Figure 4-3.

Session Dial "Office PC"

String message

String filename

message = "Do you want to view the file now?"

filename = "c:\excel\excel.exe 4th_qtr.xls"

Type Line "Launching application on host..."

MessageBox "View File" message 35

If ($Result == 6) Then SessOpr Host Run filename

Figure 4-3 The 35 in the MessageBox command gives this Windows message box its question 
mark as well asthe Yes, No, and Cancel buttons.

See Also: Type Line, Type String
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On Cancel

Description: Use On Cancel to specify a command to be executed if the user presses Esc during the execution of a 
Wait or Receive command. If the previous Set Cancel command was set to on and the user presses Esc, 
the command following On Cancel is executed. If Set Cancel was not executed or set to off, On Cancel is 
ignored.

Syntax: On Cancel [command]

Parameters: command (Optional) command to execute if Esc is pressed. If no command is specified, 
then $Cancel is set to 0 and On Cancel processing is disabled (same effect as 
executing Set Cancel Off).

Reserved Variables: $Result Unchanged.

$Error Unchanged.

NOTE: The command that is executed may set $Result and $Error.

Example: The following example enables the Cancel operation, then specifies what to do when the user cancels (by
pressing Esc).

Set Cancel On ;enable Cancel operation

;specify where to branch when Esc pressed

On Cancel GoTo @cancel

;dial an online service

Dial OnlSvc "CompuServe"

;wait for a specific string

Wait String "Enter password"

...

;control goes here when Esc pressed

@cancel:

Type String "^M^JOperator canceled"

See Also: On Disconnect, On Error, On Receive, On Timeout, Set Cancel
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On Disconnect

Description: Use On Disconnect to specify the command to execute if a connection is lost. If the previous Set 
Disconnect command was set to on and the connection is lost, the command following the On Disconnect
command is executed. If Set Disconnect was not executed or set to off, On Disconnect is ignored.

Syntax: On Disconnect [command]

Parameters: command (Optional) command to execute if the connection is lost. If no command is 
specified, then $Disconnect reserved variable is set to 0 and On Disconnect 
processing is disabled (same effect as executing Set Disconnect Off).

Reserved Variables: $Result Unchanged.

$Error Unchanged.

NOTE: The command that is executed may set $Result and $Error.

Example: The following example enables the Disconnect operation, then specifies what to do when the connection 
is lost.

Set Disconnect On ;enable disconnect operation

;specify where to branch when connection is lost

On Disconnect GoTo @disconnect

;attempt to connect with CompuServe

Dial OnlSvc "CompuServe"

Wait Time 2

;send Ctrl+C to alert online service

Send Char 3

;end script processing and return to terminal mode

End Terminal

;control branches here when connection is lost

@disconnect:

End

See Also: On Cancel, On Error, On Receive, On Timeout, Set Disconnect
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On Error

Description: Use On Error to specify the command to execute when the $Error reserved variable is set to a non-zero 
value by another command. It applies to errors that occur within the same script and as a result of 
commands executed after the On Error command is executed. Each nested script must declare its own 
On Error as appropriate.

The On Error command does not reset $Error to zero before the next command is executed. You should 
do that to avoid reprocessing one error over and over.

Syntax: On Error [command]

Parameters: command (Optional) command to execute if an error occurs. If no command is specified, 
then On Error execution is disabled.

Reserved Variables: $Result Unchanged.

$Error Unchanged.

NOTE: The command that is executed may set $Result and $Error.

Example: In the following example, if an error occurs between the On Error command and the End command, script
control transfers to the label named @error.

$Error = 0 ;set $Error to 0

;specify where to branch when an error occurs

On Error GoTo @error

;attempt to connect with CompuServe

Dial OnlSvc "CompuServe"

;end script processing and return to terminal mode

End Terminal

Wait Carrier

;send carriage return to alert CompuServe

Send Char 13

@end:

End;end script processing

@error: ;prints messages to screen

Type Line "An error has occurred.^M^J"

Type Line "Ending script processing."

GoTo @end

See Also: On Cancel, On Disconnect, On Receive, On Timeout
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On Receive

Description: Use On Receive to specify a command to execute if the specified string is received during the execution 
of a Wait or Receive command. If the string is not received, or an incorrect string is received, the On 
Receive command is disabled. This command is most useful for automatic transmission of passwords 
and other codes.

Syntax: On Receive string [command]

Parameters: string String literal or string variable containing the characters that, if received, cause 
the command to execute.

command (Optional) command to execute if string is received. To disable On Receive 
processing, don’t specify a command.

Reserved Variables: $Result Unchanged.

$Error Unchanged.

$RXString Stores specified string.

NOTE: The command that is executed may set $Result and $Error.

Example: The following example enables On Receive and specifies a GoSub command to execute if "Enter 
password: " is received.

On Receive "Enter password: " GoSub @sendPW

;wait for this string, but if "Enter password:" is received, then branch to subroutine

Wait String "Enter selection: "

End;end script processing

@sendPW:

;send password followed by carriage return

Send String "acx14^M"

Return ;return control to calling point

See Also: On Cancel, On Disconnect, On Error, On Timeout
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On Timeout

Description: Use On Timeout to specify a command to be executed if nothing is entered or received in the time allotted
and a timeout occurs. If the time limit set previously by a Set Timeout command expires, the command 
following the On Timeout command is processed. If Set Disconnect was not executed or set to Off, the On
Timeout command is ignored.

Syntax: On Timeout [command]

Parameters: command (Optional) command to execute if the allotted time expires. If command is not 
specified, then On Timeout processing is disabled and the $Timeout reserved 
variable is set to 0.

Reserved Variables: $Result Unchanged.

$Error Unchanged.

NOTE: The command that is executed may set $Result and $Error.

Example: The following example sets a Timeout value of 60 seconds. The On Timeout command indicates what the
script will do if that time limit is exceeded.

Set Timeout 60 ;set the default timeout value

;specify where to branch if timeout occurs

On Timeout GoTo @timeout

;wait for a specific string

Wait String "Enter password: "

...

;control goes here if timeout occurs

@timeout:

Type Line "Timeout!"

Type Line "Exiting..."

Exit

See Also: On Cancel, On Disconnect, On Error, On Receive
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Open

Description: This command applies to the remote PC only. Use it to open an existing file for reading or writing. No 
more than nine files can be open at the same time. This command can be used in scripts that perform 
remote control sessions so long as the command is not executed during the remote control session.

To prevent “File not found” errors from occurring, specify a “C” attribute in addition to other attributes. 
This flag tells pcANYWHERE to create the file if it doesn’t exist and prevents script processing from 
interruption. This is especially helpful during unattended sessions.

Syntax: Open file_number filename [attributes]

Parameters: file_number Integer literal used to identify the file. Valid identifiers are 1 through 9.

filename String literal or string variable containing the name of the file to open.

attributes (Optional) string literal or string variable used to set the attributes of the file. The 
default is non-sharable read/write.

The following are valid attribute settings:

R Read-only

W Read/write

S Sharable

C Create file if it doesn’t already exist

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens FILE1.TXT as a sharable read/write file in the current directory. The file 
must already exist.

Open 1 "file1.txt" "SW"

Or,

String filename[12]

;assign the filename to the string variable

filename = "file1.txt"

;create the new file with read/write attributes

Open 1 filename "CW"

See Also: Close, Copy, Create, Del, Ren
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Print File

Description: Use this command to print a file to the remote PC’s current printer. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: Print File filename

Parameters: filename String literal or string variable containing the full path and filename of the file to 
print.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example prints TEST.SCR using the current printer.

String filename[80]

filename = "c:\aw\test.scr"

Print File filename ;print the file

See Also: Print Line, Print String, Printer
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Print Line

Description: Use this command to print a string to the remote PC’s current printer. Once the string has been printed, 
the contents of the reserved variable $TLineEnd are also printed. The default value for $TLineEnd is a 
single carriage return and a single linefeed (^M^J). This command can be used in scripts that perform 
remote control sessions so long as the command is not executed during the remote control session.

Syntax: Print Line string

Parameters: string String literal or string variable containing the information to print.

Reserved Variables: $Result Set to number of characters output. The quotation marks surrounding the string 
are not included in the count, but the contents of $TLineEnd are. If an error 
occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example prints "abc" followed by the contents of $TLineEnd.

Print Line "abc"

See Also: Print File, Print String, Printer
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Print String

Description: Use this command to print a string to the remote PC’s current printer. The Print String command differs 
from Print Line in that $TLineEnd is not appended to the end of the string. This command can be used in 
scripts that perform remote control sessions so long as the command is not executed during the remote 
control session.

Syntax: Print String string

Parameters: string String literal or string variable containing the information to print.

Reserved Variables: $Result Set to number of characters output. The quotation marks surrounding the string 
are not included in the count. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example prints "abc" followed by a carriage return and a linefeed.

Print String "abc^M^J"

See Also: Print File, Print Line, Printer
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Printer

Description: Use this command to turn simultaneous printing on and off. When on, data that is sent to the screen is 
also sent to the    remote PC’s current printer. This includes screen sequences used to perform special 
functions, such as repositioning the cursor or setting screen attributes. Simultaneous printing occurs in 
the following situations:

n Data received when after a Set Echo On command

n Output from a File, Type Line, and Type String commands

n Data received in terminal mode after a Printer On command

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Printer On | Off

Parameters: On Toggles simultaneous printing on.

Off Toggles simultaneous printing off.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example turns simultaneous printing on, sends data to the printer, then turns the printing off.

Printer On

Type Line "This is sent to the printer."

Type Line "^M^J"

Printer Off

Type Line "This is not sent to the printer."

See Also: Print File, Print Line, Print String, Set Echo, Type File, Type Line, Type String
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RD

Description: This command applies to the remote PC only. Use it to remove an empty directory. This command can be 
used in scripts that perform remote control sessions so long as the command is not executed during the 
remote control session.

Syntax: RD dirname

Parameters: dirname String literal or string variable containing the full name and path of the directory 
you want to remove.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error If the directory is not empty, $Error is set to -33. See Appendix B, “Error 
Messages.”

Example: The following example removes the TEMP directory.

RD "C:\TEMP"

The next example prompts the user for a directory to remove.
String deldir[66]

Type Line "Enter the directory: "

;read path (input by user) into the deldir variable

Input deldir 66

;remove the directory

RD deldir

The last example removes a directory whose path is read from a file.
string deldir[66]

;open the data file, read a path from it, 

;and close the file

Open 1 "DATAFILE.TXT"

Read String 1 deldir 66

Close 1

;remove the directory

RD deldir

See Also: CD, Dir, MD, SessOpr Host Run, SessOpr Remote Run
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Read Line

Description: This command applies to the remote PC only. Use it to read a line from a file and store it in a variable. By 
default, a line is terminated by an end-of-line character. You can specify the line length to a maximum of 
255 characters. This command can be used in scripts that perform remote control sessions so long as the
command is not executed during the remote control session.

NOTE: A terminating character of 0xFF (255 in decimal) cannot be used.

Syntax: Read Line file_number data_string [length [termchar]]

Parameters: file_number Integer literal used by Open or Create command to identify the file. Valid 
identifiers are 1 through 9.

data_string String variable where the data is stored. The terminating characters are not 
stored.

length (Optional) integer literal or integer variable specifying the maximum number of 
characters to read. The default value is the declared length of data_string. 
Termination characters are not included.

termchar (Optional) A literal or variable (that can be either an integer or string type) 
specifying the line’s terminator. The default terminator is the contents of 
$RLineEnd (whose default value is a carriage return/linefeed). A terminating 
character is expressed as its ASCII decimal equivalent. (For example, a carriage 
return is expressed as ASCII decimal 13.) To specify a terminating character, you 
must also specify the length parameter. To specify more than one terminating 
character, use a string literal or string variable and separate the ASCII values for 
the characters with a space.

Reserved Variables: $Result Set to the number of characters read. If an error occurs, set to the value of 
$Error. When an end-of-file marker is encountered, $Result is set to -12.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens a data file, reads a line containing a path from it, and closes the file. Then 
the script changes the current directory to that path.

string newpath[66]

Open 1 "datafile.txt"

Read Line 1 newpath 66

Close 1

;change directory to the newpath variable

CD newpath

See Also: Read String, Write Line, Write String
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Read String

Description: This command applies to the remote PC only. Use it to read a string of characters from a file and store it 
in a variable. Each read command advances the file pointer. This command can be used in scripts that 
perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: Read String file_number data_string [length]

Parameters: file_number Integer literal used by Open or Create command to identify the file. Valid 
identifiers are 1 through 9.

data_string String variable which stores the data. The terminating characters are not stored.

length (Optional) integer literal or integer variable specifying the maximum number of 
characters to read. The default value is the declared length of data_string.

Reserved Variables: $Result Set to the number of characters read. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens the data file, reads its first 80 characters, its next 52 characters, then closes
the file.

String data1[80]

String data2[80]

Open 1 "datafile.txt"

Read String 1 data1 80

Read String 1 data2 52

Close 1

See Also: Read Line, Write Line, Write String
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Receive Char

Description: Use this command to receive a single character from the communications port and store it in a variable.

Syntax: Receive Char data [timeout]

Parameters: data Integer variable or string variable where the received character is stored. If data 
is a string variable, the character received is stored in the first position in the 
string.

timeout (Optional) integer defining a timeout value (in seconds). If this parameter is 
omitted, the current $Timeout value is used.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example retrieves and displays characters until six seconds goes by without a character 
being typed.

String char[1]

Set Timeout 6 ;6 second time limit set

;where to branch when time expires

On Timeout GoTo @end

@loop:

Receive Char char ;receive a character into char

Type String char ;display char

GoTo @loop

@end:

;on timeout display message

Type Line "Timeout!"

Exit

See Also: Set Cancel, Set Disconnect, Set Timeout, Send commands, other Receive commands
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Receive Clear

Description: Use this command to clear the receive buffer of any data not yet read using Receive commands.

Syntax: Receive Clear

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example clears the receive buffer and receives a string into the data variable.

String data[60]

Receive Clear

Receive String data

See Also: Set Cancel, Set Disconnect, Set Timeout, Send Commands, other Receive commands
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Receive File

Description: Use this command to receive a file using the protocol previously specified by a Set Protocol command. 
During the transfer, a status screen displays the transfer’s progress.

Syntax: Receive File [filename]

Parameters: filename (Optional) string literal or string variable containing the path and filename where 
the incoming file will be stored. Some protocols do not allow you to specify a 
filename, since part of the protocol dictates that the sender informs the receiving 
machine what filename to use.

Reserved Variables: $Result Set to a non-negative integer value. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example performs a file transfer using the XMODEM protocol.

Set Protocol XMODEM

Receive File "c:\data\datafile.txt"

See Also: Set Cancel, Set Disconnect, Set Timeout, Send Commands, other Receive commands
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Receive Line

Description: Use this command to receive a string from the communications port and store it in a variable. The 
Receive Line command is terminated when one of the following occurs:

n The string has been filled

n A line terminating sequence has been specified: either termchar (if it has been specified) or the 
characters equal to $RLineEnd (if termchar has not been specified)

n The elapsed time is equal to the specified timeout value

NOTE: A terminating character of 0xFF (255 decimal) is not allowed.

Syntax: Receive Line data_string [length [termchar [timeout]]]

Parameters: data_string String variable used to store the received data. The terminating characters are 
not stored.

length (Optional) integer literal or integer variable specifying the maximum number of 
characters to read. The default value is the declared length of data_string. 
Termination characters are not included.

termchar (Optional) A literal or variable (that can be either an integer or string type) 
specifying a line terminator. The default terminator is the contents of $RLineEnd 
(whose default value is a carriage return/linefeed). A terminating character is 
expressed as its ASCII decimal equivalent. (For example, a carriage return is 
expressed as ASCII decimal 13.) To specify a terminating character, you must 
also specify the length parameter. To specify more than one terminating 
character, use a string literal or string variable and separate the ASCII values for 
the characters with a space.

timeout (Optional) integer defining a timeout value (in seconds). If this parameter is 
omitted, the current $Timeout value is used. To specify a timeout value, you must
also specify values for both length and termchar.

Reserved Variables: $Result Set to the length of the received string. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example receives the first 80 characters of the line into the data variable.

String data[80]

Receive Line data

The next example receives characters into the data variable until the first of three situations occur: 50 
characters have been received, a carriage return has been encountered, or 20 seconds have elapsed.
String data[80]

Receive Line data 50 13 20

See Also: Set Cancel, Set Disconnect, Set Timeout, Send Commands, other Receive commands
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Receive String

Description: Use this command to receive a string from the communications port and store it in a variable. Input is 
terminated when the string is full, when the specified length has been read or when the timeout value has 
elapsed.

Syntax: Receive String data_string [length [timeout]]

Parameters: data_string String variable used to store the received data. The terminating characters are 
not stored.

length Integer literal or integer variable specifying the maximum number of characters to
read. The default value is the declared length of data_string.

timeout (Optional) integer defining a timeout value (in seconds). If this parameter is 
omitted, the current $Timeout value is used. If you specify a timeout value, you 
must also specify a value for length.

Reserved Variables: $Result Set to the length of the received string. If an error occurs, set to the value of 
$Error. 

$Error The error value for a timeout is -4. See Appendix B, “Error Messages.”

Example: The following example receives the first 30 characters into the data variable.

String data[80]

Receive String data 30

The following example receives 20 characters into the data variable or times out after 10 seconds.

String data[80]

Receive String data 20 10

See Also: Set Cancel, Set Disconnect, Set Timeout, Send Commands, other Receive commands
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Ren

Description: This command applies to the remote PC only. Use it to change the name of a DOS file or directory. The 
Ren command moves a file from one directory to another if you specify a different pathname, but cannot 
be used to move a file from one drive to another. This command can be used in scripts that perform 
remote control sessions so long as the command is not executed during the remote control session.

Syntax: Ren old_name new_name

Parameters: old_name String literal or string variable containing the original path and filename or 
directory.

new_name String literal or string variable containing the new name of the file or directory. 
The new name must not be the name of an existing file or directory.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example renames DRAFT1.TXT to DRAFT2.TXT.

Ren "draft1.txt" "draft2.txt"

The next example prompts the user for the new name of a file.

String newname[12]

Type Line "Enter the name of the new file: "

Input newname

Ren "draft1.txt" newname

See Also: Close, Copy, Create, Del, Open, SessOpr Host Run, SessOpr Remote Run
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Reset

Description: Use this command to reset the terminal emulation screen displayed on the remote PC. The screen is 
cleared of all characters, and the video attribute is cleared and reset to normal. All special modes, such as
simultaneous print and monitor, are set to off. The cursor is moved to row 1, column 1.

Syntax: Reset

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example resets the terminal emulation screen. You may want to use it between calls to 
different online services.

Reset ;reset terminal

See Also: Emulate, Terminal
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Return

Description: Use this command to terminate the processing of a subroutine.    Control is passed back to the line 
immediately following the GoSub command that initiated the subroutine.

Syntax: Return [return_code]

Parameters: return_code (Optional) integer literal or integer variable passed back to the calling script. Its 
value is also stored in $Result.

Reserved Variables: $Result Set to return_code. If return_code is not used, set to 0.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The subroutine in the following example asks the user for a string, then determines and returns the length
of that string. After the subroutine terminates, the string is sent through the communications port (unless 
its length is 0). 

String instring

Integer len

GoSub @getInput ;call getInput subroutine

;if no input, end processing

If (len == 0) GoTo @end

Send String instring ;send instring

@end:

End

@getInput: ;begin getInput subroutine

Input instring ;retrieve user entry string

;get string length of instring

StrLen instring len

;return string length of instring to caller

Return len

See Also: GoTo, GoSub, Link, Script
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Run

Description: This command applies to the remote PC only. Use it to execute a DOS or Windows command line on the 
remote PC.

NOTE: An application may not be able to run if there is not sufficient memory available.

Syntax: Run command_line

Parameters: command_line String literal or string variable containing the full path and application to execute. 
If no path is specified, the current directory and the PATH is searched. In addition
to the executable filename, you can specify parameters.

Reserved Variables: $Result Set to the DOS errorlevel.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example runs EDIT.COM.

Run "c:\dos\edit.com" ;run DOS editor

In the Windows environment, the next example loads AUTOEXEC.BAT into NOTEPAD.EXE, ready for 
editing.

String launch[40]

launch = "c:\windows\notepad.exe c:\autoexec.bat"

;launch Windows Notepad and load autoexec.bat file

Run launch

See Also: End, End Menu, End Terminal, Exit
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Screen Restore

Description: This command applies to the remote PC’s display buffer. Use it to restore a previously saved screen 
image, including cursor position and attributes. The Screen Restore command is ignored if no image has 
been saved.

Syntax: Screen Restore

Reserved Variables: (none)

Example: The following example saves the contents of the screen and later restores those contents.

;move the cursor to row 12, column 20

Cursor Position 12 20

Dir ;display the current directory

Screen Save ;save the screen

Clear Screen ;clear the screen

Screen Restore ;restore the screen

See Also: Clear Screen, Screen Save, Type File, Type Line, Type String
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Screen Save

Description: This command applies to the remote PC’s display buffer. Use it to take a snapshot of the screen.    
Everything on the screen, including the cursor type and position, is stored to a buffer so that it can be 
restored later in the script. To restore the screen, use Screen Restore. For example, when an error occurs
that requires the user’s attention, save the screen, display information that lets the user remedy the error, 
then restore the screen and continue processing.

Syntax: Screen Save

Reserved Variables: (none)

Example: The following example saves the contents of the screen and later restores those contents.

;move the cursor to row 12, column 20

Cursor Position 12 20

Dir ;display the current directory

Screen Save ;save the screen

Clear Screen ;clear the screen

Screen Restore ;restore the screen

See Also: Clear Screen, Screen Restore, Type Line, Type File, Type String
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Script

Description: Use this command to launch a second scriptfrom within the current script. The first script is the calling 
script, and the second script is the called script

Control returns to the first script when the second script terminates (with an End command), and the first 
script’s execution continues at the line immediately following the one containing the Script command. 
Scripts can be nested ten levels deep.

Syntax: Script script_name

Parameters: script_name String literal or string variable containing the name of the script to execute. Do 
not include the .SCR filename extension.

Reserved Variables: $Result Set to the integer value (if any) returned from the second script when it ends.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: In the following example, MAIN.SCR calls ANOTHER.SCR. After ANOTHER.SCR completes, MAIN.SCR 
continues executing.

MAIN.SCR

Integer $1, $2 ;declare $1 and $2 as global integers

$1 = 5

$2 = 5

Type Line "The value is: "

Script ANOTHER ;call ANOTHER.SCR script file

;print product of $1 and $2 (25) to the screen

Type Line $Result

End Terminal ;end script processing

ANOTHER.SCR

value = $1 * $2 ;calculate product of $1 and $2

;end script processing, return control 

;and pass value to MAIN.SCR

End value

See Also: GoSub, GoTo, Link, Return
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Seek

Description: This command applies to the remote PC only. Use it to position the file pointer at a specified location in 
the file. The next Read or Write command starts at that position. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: Seek file_number offset option

Parameters: file_number Integer literal used by the Open or Create command to identify the file. Valid 
identifiers are 1 through 9.

offset Integer literal or integer variable containing the number of spaces to move, or 
offset, from the starting point specified by the option parameter. A positive 
number moves the pointer to the right; a negative number moves the pointer to 
the left.

option Integer literal or integer variable declaring the starting point for the offset 
parameter.

Valid values for option are
:

Value Result

0 Moves the pointer to the beginning of the file and then moves the 
pointer the value of offset. (Offset must be positive.)

1 Moves the pointer from the current position the value of offset.

2 Moves the pointer to the end of the file plus the value of offset. (Offset 
must be negative.)

Reserved Variables: $Result Set to the new position of the pointer within the file. If an error occurs, set to the 
value of $Error. If you move the pointer past either end of the file, the end-of-file 
error (-12) occurs.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens a sharable read/write file (NEWFILE.TXT), moves the read/write pointer to 
the end, appends a string, then closes the file.

Open 1 "newfile.txt" "SW"

Seek 1 0 2

Write String 1 "End of File."

Close 1

See Also: Close, Open, Read Line, Read String, Write Line, Write String
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Send Char

Description: Use this command to send a single character using the currently active communications device. You can 
send characters as strings or their ASCII decimal value.

Syntax: Send Char character

Parameters: character A literal or variable (that can be either an integer or string type) containing the 
character to send. If a string is specified, only the first character of the string is 
sent.

Reserved Variables: $Result Set to a non-negative integer value. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sends a carriage return followed by an A.

Send Char 13 ;send a carriage return

Send Char "A" ;send the character "A"

See Also: Receive Char, Receive Clear, Receive File, Receive Line, Receive String, Send Clear, Send File, Send 
Line, Send String
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Send Clear

Description: Use the command to clear the send buffer of any data not yet transmitted. Data can be in the send buffer 
if the communications rate is slow (such as a low serial data rate) or if the transmission is halted due to a 
flow control error or recovery situation.

Syntax: Send Clear

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example clears the send buffer before it sends a string.

String string1[14]

string1 = "Initializing..."

Wait Silence 5 ;wait for 5 seconds of line silence

Send Clear ;clear the send buffer

Send String string1

See Also: Receive Char, Receive Clear, Receive File, Receive Line, Receive String, Send Char, Send File, Send 
Line, Send String
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Send File

Description: Use this command to send a file using the protocol specified by the Set Protocol command. When the 
transfer begins, a status screen displays the transfer’s progress.

Syntax: Send File filename

Parameters: filename String literal or string variable containing the full name and path of the outgoing 
file. For multi-file protocols, the name may contain wildcards (? or *).

Reserved Variables: $Result Set to a non-negative integer value. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sends a file using the ZMODEM protocol.

Set Protocol zmodem

Send File "c:\data\datafile.txt"

See Also: Receive Char, Receive Clear, Receive File, Receive Line, Receive String, Send Char, Send Clear, Send 
Line, Send String
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Send Line

Description: Use this command to send a string and its terminating character through the communications port. The 
terminating character is the value of the reserved variable $SLineEnd (whose default value is a carriage 
return).

Syntax: Send Line string

Parameters: string String literal or string variable containing the data to send.

Reserved Variables: $Result Set to the number of characters sent. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sends a string followed by the line-terminating character(s) in $SLineEnd.

String string1[14]

string1 = "Processing..."

Send Line string1 ;send string1

See Also: Receive Char, Receive Clear, Receive File, Receive Line, Receive String, Send Char, Send Clear, Send 
File, Send String



 Script Editor Commands 
{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

Send ScanCode

M scan code, then send them through the current communications port. 

Syntax: Send ScanCode string [length]

Parameters: string String literal or string variable containing the data to send.

length (Optional) integer containing the number of characters to send. The default value 
is the size of string.

Reserved Variables: $Result Set to the number of characters sent. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sends the codes for D, I, R, Ctrl, and M. Ctrl+M is a carriage return.

Send ScanCode "Dir^M"

The next example sends codes for W, e, l, c, o, m, e and !.
String string1[14]

string1 = "Welcome!"

Send ScanCode string1

See Also: Dial Host
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Send String

Description: Use this command to send a string through the communications port. The entire string is sent, unless a 
length is specified. No terminating characters are sent.

Syntax: Send String string [length]

Parameters: string String literal or string variable containing the data to send.

length (Optional) integer literal or integer variable containing the number of characters to
send. The default value is the size of string.

Reserved Variables: $Result Set to the number of characters sent. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sends a password.

String password[14]

password = "parley"

Send String password

See Also: Receive Char, Receive Clear, Receive File, Receive Line, Receive String, Send Char, Send Clear, Send 
File, Send Line
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Session Delay

Description: Use this command to specify the number of minutes between retries of the Session Dial command. 

Syntax: Session Delay [minutes]

Parameters: minutes (Optional) integer literal or integer variable containing the number of minutes to 
delay. The default is 0.

Reserved Variables: (none)

Example: The following example calls the Office PC and sends a file remotely. The Session Delay command 
stipulates the number of minutes to wait before redialing.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

See Also: Session Dial, Session End, Session ExitMode, Session Retry, Session Overwrites, Session Timeout, 
SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote Send
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Session Dial

Description: Use this command to initiate a remote control session by dialing a pcANYWHERE host PC.

Syntax: Session Dial host_name [time [date]] [script_name]

Parameters: host_name String literal or string variable containing the name of the remote control session 
configuration.

time (Optional) integer literal or integer variable containing the time of day that you 
want to first attempt the connect. The time format is HHMM. The default is the 
current time.

date (Optional) integer literal or integer variable containing the date to first attempt the 
connect. The date parameter cannot be used unless a value for time is also 
specified. Its format is YYMMDD. The default is the current date.

script_name (Optional) string literal or string variable containing the name of the script file to 
launch after connection is made. Do not include the .SCR file extension.

Reserved Variables: $Result Set to a non-negative integer value. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example calls the Office PC and sends a file remotely.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

See Also: Session Delay, Session End,Session Exit Mode  Session OnError, Session Overwrites , Session Retry, 
Session Timeout, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote 
Send
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Session End

Description: Use this command to terminate a session initiated with a Session Dial command. If the phone is still 
connected when the Session End command is executed, the phone is hung up

Syntax: Session End

Reserved Variables: (none)

Example: The following example calls the Office PC and sends a file remotely. Then it terminates the session.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

...

See Also: Session Delay, Session Dial, Session ExitMode, Session OnError, Session Overwrites, Session Retry, 
Session Timeout , SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote 
Send
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Session ExitMode

Description: Use this command to specify the state in which to leave the host PC when a remote control session 
terminates. This command must be executed before the Session Dial command. If the host PC is 
configured to prevent the remote user from modifying the host state, this command has no effect.

Syntax: Session ExitMode Wait | Idle | Accept | Original | Cancel

Parameters: Wait Disconnects remote user from the host, leaving the pcANYWHERE host as the 
active application. No host activities can be performed until there is a connection.
See note below.

Idle Disconnects remote user from the host, leaving pcANYWHERE running in the 
background. A session cannot begin until a host user presses the host hotkey. 
See note below.

Accept Disconnects remote user from the host, leaving the host to automatically accept 
another call. pcANYWHERE stays in memory and a session starts when a 
remote user calls the host—no action is required from the host user. In fact, the 
host user cannot prevent calls from coming in.

Also use this mode when you want to start a possibly long job on the host, hang 
up, then call back later to check the results. The host PC can continue 
processing even though the remote PC is no longer watching.

Original Disconnects remote user from the host and leaves the host in the same state it 
was in before the remote session occurred.

Cancel Disconnects remote user from the host and removes the host software from 
memory, preventing the host from accepting incoming calls.

NOTE: In pcANYWHERE for Windows, when the host TSR is not running, Idle and Wait have the same 
functionality as Accept.

Reserved Variables: $SesHostExitMode Set to 0 for Wait, 1 for Idle, 2 for Accept, 3 for Original, or 4 for Cancel.

Example: The following example sets the exit mode to accept, calls the Office PC, and sends a file remotely. 

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host



SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session OnError, Session Overwrites, Session Retry, Session
Timeout, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote Send
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Session OnError

Description: Use this command to specify what should occur if one of the following commands fails:    SessOpr Host 
Run, SessOpr Host Send, SessOpr Remote Run, or SessOpr Remote Send. The command can 
terminate the script or allow processing to continue. This command takes precedence over the On Error 
command.

The Session OnError command does not reset $Error to zero before the next command is executed. You 
should do that to avoid reprocessing one error over and over.

Syntax: Session OnError Ignore | Next | End

Parameters: Ignore Ignores the command that caused the error and advances to the next command.

Next Advances to the matching Session End command.

End Ends the script and returns control to pcANYWHERE.

Reserved Variables: $SesOnError Set to 0 for Ignore, 1 for Next, or 2 for End.

Example: The following example specifies that the script should end if an error occurs. Then it calls the Office PC 
and sends a file remotely.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session Overwrites, Session Retry, 
Session Timeout, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote 
Send
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Session OverWrites

Description: Use this command to specify whether or not to overwrite existing files during the execution of a SessOpr 
Host Send or SessOpr Remote Send command. Execute this command before attempting file transfers, 
so script execution is not suspended when a conflict occurs.

Syntax: Session OverWrites Always | Never | Older

Parameters: Always Causes the destination file to be overwritten.

Never Causes the file sent to be ignored.

Older Causes the file at the destination to be overwritten if the file being transferred is 
more recent (compares date/time stamp).

Reserved Variables: $SesOverwrites Set to 0 for Always, 1 for Never, or 2 for Older.

Example: The following example specifies that transferred files can overwrite files that are older. Then it calls the 
Office PC and sends a file remotely.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session OverWrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session OnError, Session Retry, Session 
Timeout, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote Send
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Session Retry

Description: Use this command to specify the number of times to redial the host specified in the Session Dial 
command. 

Syntax: Session Retry [count]

Parameters: count (Optional) integer literal or integer variable containing the number of times to 
attempt initiating a session. The default is 1.

Reserved Variables: (none)

Example: The following example sets the number of retries to three. Then it calls the Office PC and sends a file 
remotely.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "c:\data\wk1030.txt"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session Overwrites, Session Timeout, 
SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote Send
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Session Timeout

Description: Use this command to specify the inactivity timeout value (in seconds) for a remote control session.    Use 
for DOS sessions only.

Syntax: Session Timeout seconds

Parameters: seconds Integer literal or integer variable specifying the number of seconds before a 
timeout occurs.

Reserved Variables: $SesTimeout Set to specified number of seconds.

Example: The following example specifies a timeout after 10 seconds, then calls the Office PC and sends a file 
remotely.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;execute a file on the host

SessOpr Host Run "c:\dos\edit.com"

;edit.com ends when the user exits or when session timeout seconds expires

SessOpr Remote Send “wk1030.txt” “mrd.txt”

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session OnError, Session Overwrites, 
Session Retry, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote Send
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SessOpr Host Run

Description: Use this command to launch an application on the host PC during a session initiated with a Session Dial 
command.    If you do not specify Wait or NoWait, Wait is the default.

When using this command to run DOS commands from COMMAND.COM, such as COPY, you must use 
COMMAND.COM with the /C option as part of the command line:

SessOpr Host Run "command /c copy *.* b:"

Syntax: SessOpr Host Run [Wait | NoWait] command_line

Parameters: Wait (Optional) causes the script to pause until the launched program is completed. 
The launched program ends when the user exits it or it is automatically 
terminated after the number of seconds specified by the Session Timeout 
command.

NoWait (Optional) tries to launch the specified program and continue. Used under 
Windows only.

command_line String literal or string variable containing the command line for the application.

Reserved Variables: $Result Set to the errorlevel returned by the application.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example calls the Office PC and remotely executes a file on the host.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;execute file on the host

SessOpr Host Run "c:\dos\move.bat"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session OnError, Session Overwrites, 
Session Retry, Session Timeout, SessOpr Host Send, SessOpr Remote Run, SessOpr Remote Send
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SessOpr Host Send

Description: Use this command to send a file from the host PC to the remote PC during a session initiated with a 
Session Dial command. It automates file transfers when connected to a pcANYWHERE host. Be sure to 
use the Session Overwrites command to specify what to do if the file you are transferring already exists at
the destination.

Syntax: SessOpr Host Send source_dest

Parameters: source_dest String literal or string variable containing:

a (Required) the complete or partial pathname to the file(s) being sent. 
Wildcards (* or ?) are permitted.

b (Optional) a space followed by the complete or partial destination 
pathname. If one file is sent, this can be a filename. Must be encased in 
separate set of quotes from source file and pathname.

The current directory is always the default path.

Reserved Variables: $Result Set to the number of files actually sent. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example calls the Office PC and copies a file from the host.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

Session Overwrites Older

Session Timeout 10

Session Retry 3

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the host to the remote

SessOpr Host Send "\budget\*.xls” “\updates"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session OnError, Session Overwrites, 
Session Retry, Session Timeout, SessOpr Host Run, SessOpr Remote Run, SessOpr Remote Send
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SessOpr Remote Run

Description: Use this command to launch an application on the remote PC during a session initiated with a Session 
Dial command. If you do not specify Wait or NoWait, Wait is the default.

When using this command to run DOS commands from COMMAND.COM, such as COPY, you must use 
COMMAND.COM with the /C option as part of the command line:

SessOpr Remote Run "command /c copy *.* b:"

Syntax: SessOpr Remote Run [Wait | NoWait] command_line

Parameters: Wait (Optional) causes the script to pause until the launched program is completed. 
The launched program ends when the user exits it or it is automatically 
terminated after the number of seconds specified by the Session Timeout 
command.

NoWait (Optional) tries to launch the specified program and continue. Used under 
Windows only.

command_line String literal or string variable containing the command line for the application.

Reserved Variables: $Result Set to the errorlevel returned by the application. If an error occurs, set to the 
value $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example calls the Office PC then executes a file from the remote.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

Session Overwrites Older

Session Timeout 10

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

SessOpr Remote Run "c:\dos\copy.bat"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session OnError, Session Overwrites, 
Session Retry, Session Timeout, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Send
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SessOpr Remote Send

Description: Use this to send a file from the remote PC to the host PC during a session initiated with a Session Dial 
command. It automates file transfers when connected to a pcANYWHERE host. Be sure to use the 
Session Overwrites command to specify what to do if the file you are transferring already exists at the 
destination.

Syntax: SessOpr Remote Send source_dest

Parameters: source_dest String literal or string variable containing:

a (Required) the complete or partial pathname to the file(s) being sent. 
Wildcards (* or ?) are permitted.

b (Optional) a space followed by the complete or partial destination pathname.
If one file is sent, this can be a filename. 

The current directory is always the default path.

Reserved Variables: $Result Set to the number of files actually sent. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example calls the Office PC and sends a file remotely.

Session ExitMode Accept ;mode to leave host in

Session OnError End ;what to do if error occurs

;what to do if file conflict occurs

Session Overwrites Older

;set the timeout value in seconds

Session Timeout 10

;set the number of retries to attempt

Session Retry 3

;set the amount of time between retries in minutes

Session Delay 30

;dial Office PC at 4 A.M. on May 4, 1993

Session Dial "Office PC" 0400 940504

;send a file from the remote to the host

SessOpr Remote Send "wk1030.txt” “mrd.txt"

Session End ;terminate the session

See Also: Session Delay, Session Dial, Session End, Session ExitMode, Session OnError, Session Overwrites, 
Session Retry, Session Timeout, SessOpr Host Run, SessOpr Host Send, SessOpr Remote Run
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Set Attribute

Description: This command applies to the remote PC’s display buffer. Use it to set colors and other screen 
attributesfor subsequent characters output to the screen. You can set only one attribute at a time, though 
you can have more than one setting active. All changes effect the characters and spaces following the 
current cursor position (not inclusive). Settings 1 through 7 are cumulative. Settings 22 through 27 are 
used to selectively disable settings 1 through 7. Selecting setting 0 disables all settings 1 through 7. 

You can have only one foreground and one background color active at any time. For example, you can 
set the screen attributes to a blinking blue foreground on a black background.

Syntax: Set Attribute attribute

Parameters: attribute Integer literal or integer variable containing the attribute setting.

Valid settings are:

Value Video Attribute

0 Normal (disables settings 1 through 7)

1 Intense

4 Underline

5 Blink

7 Reverse

22 Intense Off

24 Underline Off

25 Blink Off

27 Reverse Off

Value Foreground Colors

30 Black

31 Red

32 Green

33 Brown

34 Blue

35 Magenta



36 Cyan

37 Light Gray

Value Background Colors

40 Black

41 Red

42 Green

43 Brown

44 Blue

45 Magenta

46 Cyan

47 Light Gray

Reserved Variables: (none)

Example: The following examples set and then display a variety of attributes.

Set Attribute 30 ;set black foreground

Set Attribute 41 ;set red background

Type String "This is displayed black on red.^M^J"

Set Attribute 44 ;set blue background

Type String "And this is displayed black on blue.^M^J"

Set Attribute 5;set the text to blink

Type String "And this is displayed blinking black on blue."

Set Attribute 0;turn off the blinking

Type String "Now the blinking is turned off."

See Also: Clear Screen, Set Palette, Set Quiet
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Set Cancel

Description: Use this command to specify what happens when the user presses Esc. When on, Wait and Receive 
commands are terminated and, if an On Cancel command is active, the command specified by On Cancel
is executed.

Syntax: Set Cancel On | Off

Parameters: On Causes Esc to be understood as canceling.

Off Causes Esc to be ignored.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$Cancel Set to 1 for on or 0 for off.

Example: The following example enables canceling and specifies what is to happen if the user presses Esc.

Set Cancel On ;enable canceling

On Cancel GoTo @end

;attempt to connect with CompuServe

Dial OnlSvc "CompuServe"

Wait Time 2

;send carriage return to alert host

Send Char 13

;end script processing and return to terminal mode

End Terminal

@end:

End;end script processing

See Also: On Cancel, Set Disconnect, Set Timeout, Wait and Receive commands 



 Script Editor Commands 
{button A,JI(`',`a')} {button B,JI(`',`b')} {button C,JI(`',`c')} {button D,JI(`',`d')} {button E,JI(`',`e')} {button F,JI(`',`f')} {button G,JI(`',`g')} 
{button H,JI(`',`h')} {button I,JI(`',`i')} {button K,JI(`',`k')} {button L,JI(`',`l')} {button M,JI(`',`m')} {button O,JI(`',`o')} {button P,JI(`',`p')} 
{button R,JI(`',`r')} {button S,JI(`',`s')} {button T,JI(`',`t')} {button U,JI(`',`u')} {button W,JI(`',`w')} 

Set CharDelay

Description: Use this command to set the default value of the between-character send delay. The Send String and 
Send Line commands insert this delay between each character sent. For most applications, delays are 
not necessary, though some mainframes require that data be entered at a “typing” speed. The current 
value of the between-character send delay is stored in the $CDelay reserved variable.

Syntax: Set CharDelay delay

Parameters: delay Integer literal or integer variable specifying the delay value (in tenths of a 
second).

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$CDelay Set to the specified delay.

Example: The following example sets the character delay to 1/10th of a second.

Set CharDelay 1

String string1[14]

string1 = "Processing..."

Send String string1

See Also: Send Line, Send String
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Set Disconnect

Description: Use this command to specify what happens when a connection is lost. When on, Wait and Receive 
commands are terminated, and if an On Disconnect command is active, the command specified by On 
Disconnect is executed.

Syntax: Set Disconnect On | Off

Parameters: On Causes a lost connection to end Wait and Receive commands.

Off Causes no action to be taken when a connection is lost.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$Disconnect Set to 1 for on or 0 for off.

Example: If the connection is lost during the execution of the following example, the script ends.

Set Disconnect On ;enable disconnect action

On Disconnect GoTo @end

;attempt to connect with CompuServe

Dial OnlSvc "CompuServe"

Wait Time 2

Send Char 13

;end script processing and return to terminal mode

End Terminal

@end:

End;end script processing

See Also: On Disconnect, Set Cancel, Set Timeout, Wait and Receive commands
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Set DTR

Description: This command applies only to serial communications. Use it to send the RS-232 Data Terminal Ready 
(DTR) signal to the serial port. When on, the signal is raised or ready. When off, the signal is lowered or 
not ready. If you load a hardware configuration after this command, the state of the signal is reset to that 
in the configuration.

Syntax: Set DTR On | Off

Parameters: On Raises the DTR signal.

Off Lowers the DTR signal.

Reserved Variables: $DTR Set to 1 for on or 0 for off.

Example: The following example lowers and then raises the DTR signal.

Set DTR Off ;lower the DTR signal

Wait 1 ;for one second

Set DTR On ;then raise it again

See Also: Exit Online
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Set Echo

Description: Use this command to enable or disable the echoing received during Wait and Receive commands. Set 
Echo must be on to display characters received while in the terminal mode. By default, Set Echo is set to 
off. Therefore, you usually turn it on during the log-on process to display the log-on prompt on the remote.

Syntax: Set Echo On | Off

Parameters: On Allows the display of received characters.

Off Stops the display of received characters.

Reserved Variables: $Echo Set to 1 for on or 0 for off.

Example: The following example specifies the display of responses, dials the host, and waits for a string.

Set Echo On ;on to display responses

Dial Host "Office PC" ;dial the host

;wait for and display password prompt

Wait String "Enter password:"

See Also: Set Cancel, Set Disconnect
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Set File Attr

Description: This command applies to the remote PC only. Use it to set the attributes of the specified file. The file must
be closed before performing this operation. This command can be used in scripts that perform remote 
control sessions so long as the command is not executed during the remote control session.

Syntax: Set File Attr filename new_attribute

Parameters: filename String literal or string variable containing the name of the file to modify.

new_attribute Integer literal or integer variable containing the sum of the values for the desired 
attributes. The values are as follows:

Attribute Value

Read-only 1

Hidden 2

System file 4

Volume label 8

Subdirectory 16

Archive 32

Using 0 as the attribute, makes the file a Normal file.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example makes DATA.FIL a read-only file.

Set File Attr "C:\DATA.FIL" 1

See Also: Get File Attr, Get File Date, Get File Size, Get File Time, Set File Date, Set File Size, Set File Time
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Set File Date

Description: This command applies to the remote PC only. Use it to revise the date of a file which has otherwise not 
changed. The file must be closed before performing this operation. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

MS-DOS changes the date of a file when a file is closed after being opened. In other words, the date is 
changed when a file is updated, but not when it is renamed, copied, moved, or has changed its file 
attributes.

Syntax: Set File Date filename new_date

Parameters: filename String literal or string variable containing the name of the file.

new_date A literal or variable (that can be either an integer or string type) containing the 
new date in the format YYMMDD.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sets the date of WK1030.DAT to 11/10/94.

Set File Date "wk1030.dat" 941110

See Also: Get File Attr, Get File Date, Get File Size, Get File Time, Set File Attr, Set File Size, Set File Time
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Set File Size

Description: This command applies to the remote PC only. Use it to change the indicated size of the specified file. The 
file must be closed before performing this operation. This command can be used in scripts that perform 
remote control sessions so long as the command is not executed during the remote control session.

WARNING: Use this command cautiously. Changing the way DOS indicates the size of a file may cause 
unintentional errors that are extremely difficult to detect.

Syntax: Set File Size filename new_size

Parameters: filename String literal or string variable containing the name of the file.

new_size A literal or variable (that can be either an integer or string type) containing the 
new file size (in bytes).

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example changes the size of TEMP.DAT to 1024 bytes.

Set File Size "temp.dat" 1024

See Also: Get File Attr, Get File Date, Get File Size, Get File Time, Set File Attr, Set File Date, Set File Time
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Set File Time

Description: This command applies to the remote PC only. Use it to revise the time of a file which has otherwise not 
changed. The file must be closed before performing this operation. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

MS-DOS changes the time of a file when a file is closed after being opened. In other words, the time is 
changed when a file is updated, but not when it is renamed, copied, moved, or has changed its file 
attributes.

Syntax: Set File Time filename new_time

Parameters: filename String literal or string variable containing the name of the file.

new_time A literal or variable (that can be either an integer or string type) containing the 
new time in the format HHMM.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example changes the time of NEWFILE.DAT to 8 A.M.

Set File Time "newfile.dat" 0800

See Also: Get File Attr, Get File Date, Get File Size, Get File Time, Set File Attr, Set File Date, Set File Size
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Set Flow

Description: This command is generally used only for serial connections. Use it to set flow control. You can use this 
command before or after making the connection. However, if you load a hardware configuration after this 
command, the flow is reset to that in the configuration.

XON/XOFF flow control is commonly known as software flow control, and RTS/CTS is known as 
hardware flow control. RTS/CTS flow control is achieved by varying the voltage on the RTS/CTS signal 
lines between the terminal and the modem. XON/XOFF flow control is achieved by embedding control 
characters in the data stream.

RTS/CTS flow control is preferred. Use XON/XOFF flow control when RTS/CTS flow control is not 
supported, or when otherwise required.

Syntax: Set Flow RTSCTS | XONXOFF | Both | None

Parameters: RTSCTS Sets hardware flow control on and software control off.

XONXOFF Sets software flow control on and hardware control off.

Both Sets hardware and software flow control on.

None Sets hardware and software flow control off.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example sets flow control to RTS/CTS.

Set Flow RTSCTS

See Also: Set RTS
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Set IgnoreCase

Description: Use this command to turn case-checking off or on when comparing strings or waiting for strings. Set it to 
off to differentiate between uppercase and lowercase letters. The default for Set IgnoreCase is on, which 
means string comparisons are not case sensitive This command can be used in scripts that perform 
remote control sessions so long as the command is not executed during the remote control session.

Syntax: Set IgnoreCase On | Off

Parameters: On Ignores case.

Off Checks case.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$IgnoreCase Set to 1 for on or 0 for off.

Example: The following example ignores the case when comparing "ABC" and "abc".

;case will be ignored by default

StrCmp "ABC" "abc" ;$Result is set to 0

The next example uses case when comparing "ABC" and "abc".

Set IgnoreCase Off ;case is not ignored

StrCmp "ABC" "abc" ;$Result is set to -1

See Also: Lower, StrCmp, Upper, Wait String
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Set Palette

Description: This command is valid in Norton pcANYWHERE for DOS scripts only. It applies to the remote PC’s 
display buffer. Each displayable object, such as a menu or form, has fields that are predefined as having 
normal, intense, or reverse video attributes. For example, the options listed on a menu are normal; the 
selected option is reverse, and both the menu’s title and border are intense. Use this command to set a 
foreground and background color combination for the specified video attribute on the specified 
displayable object. Values set in a script file remain in effect until the user exits pcANYWHERE.

NOTE: If you are using pcANYWHERE on a monochrome monitor, try to use colors that have high 
contrast. Darker shades are more likely to be distinguishable. 

Syntax: Set Palette attribute color

Parameters: attribute Integer literal or integer variable indicating both the displayable object and the 
video attribute to change.

Normal Video Intense Reverse Video

Menus 3 4 5

Yes/No menus 6 7 8

Errors/Warnings 12 13 14

Help 15 16 17

Status/Info 18 19 20

Terminal Mode 24 25 26

Forms 27 28 29

color Hexadecimal integer starting with 0x and indicating the combination of 
foreground and background colors. Of the last two digits, the background color is 
specified before the foreground color.

black 0

blue 1

brown 6

cyan 3

dark gray* 8

green 2

light blue* 9



light cyan* B

light green* A

light magenta* D

light red* C

light gray 7

magenta 5

red 4

white* F

yellow* E

*Can be used as foreground colors only

Reserved Variables: (none)

Example: The following example sets terminal mode to normal and sets the color to blue on light gray. 

Set Palette 24 0x71

See Also: Screen Restore, Screen Save, Set Attribute, Set Echo, Set Quiet
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Set Parity

Description: This command applies to serial connections only. Use it to change the current parity type. The parity 
determines the settings for data bits and stop bits (see the table below). Both computers must use the 
same parity setting. You can use this command before or after making the connection. However, if you 
load a hardware configuration after this command, the parity is reset to that in the configuration.

Parity Data Bits Parity Bit Stop Bit

None 8 N 1

Even 7 E 1

Odd 7 O 1

Mark 7 M 1

Space 7 S 1

Syntax: Set Parity None | Even | Odd | Mark | Space

Parameters: None Use this setting for direct connections and for modem communications where 
both the host and remote PCs are running pcANYWHERE.

Even, Odd, Use one of these settings when communi-

Mark, Space cating with a non-pcANYWHERE host PC that requires a specific parity setting.

Reserved Variables: (none)

Example: The following example specifies even parity.

Set Parity Even

See Also: Dial Host, Dial OnlSvc, Load HostInfo, Load OnlSvcInfo
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Set Port

Description: Use this command to select the communications portfor subsequent Set Speed, Set Parity, or Set Flow 
commands. It changes the port from the one specified by the current configuration. Use the Set Port 
command prior to making a connection. If you load a hardware configuration after this command, the port 
is reset to that in the configuration.

Syntax: Set Port number

Parameters: number Integer representing communications port to be affected. Valid values are 1 
through 4.

Reserved Variables: $Result Set to 0.

$Error Set if an invalid port value is specified.

Example: This example combines the Set Port command with the Set Parity command for a special situation that 
requires a temporary adjustment of parity.

Set Port 1 ;selects com 1

Set Speed 9600 ;sets bps rate

Dial Number "1-408-973-9834" ;dials service

Set Parity Even ;changes parity to even

See Also: Dial Host, Set Flow, Set Parity, Set Speed
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Set Protocol

Description: Use this command to set the file-transfer protocol to be used for subsequent Send File and Receive File 
commands. You can use this command before or after making the connection. However, if you load a 
session configuration after this command, the protocol is reset to that in the configuration.

ZMODEM is generally regarded to be the fastest file-transfer protocol, although pcANYWHERE’s 
proprietary pcANYWHERE protocol (available only when using AWSEND.EXE) has been tested to be 
faster. The pcANYWHERE protocol uses a CRC algorithm for error-correcting and verifying the integrity of
received files, as does ZMODEM. Both protocols have crash-recovery ability, which enables a partially 
completed file transfer to be resumed from the point of interruption. YMODEM-G is regarded by many to 
be faster than ZMODEM, although it has no inherent error-correcting ability, and should be used only with 
error-correcting modems, such as those employing MNP-5 or v.42bis error correction. YMODEM-G does 
not have crash recovery ability.

Syntax: Set Protocol type

Parameters: type Selected protocol. Valid types are XMODEM, XMODEM-CRC, XMODEM-1K, 
XMODEM-1KG, YMODEM, YMODEM-G, ZMODEM, KERMIT, ASCII.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$Protocol Set to an integer representing the specified protocol.

Example: The following example specifies that the ZMODEM protocol will be used when transferring files. 

Set Protocol ZMODEM

See Also: Emulate, Receive File, Send File, Send String, Set Flow, Set RTS, Set Timeout
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Set Quiet

Description: This command applies to the remote PC’s display buffer. Use it to display or hide progress messages 
about the commands in the script. The default state of Set Quiet is off, which displays the messages.

Syntax: Set Quiet On | Off

Parameters: On Hides progress messages.

Off Displays progress messages.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$Quiet Set to 1 for on or 0 for off.

Example: In the following example, information about the copy command is not displayed, although execution 
occurs.

Set Quiet On

COPY file1 file2

See Also: Set Echo
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Set Record

Description: Use this command to start and stop recording data. When set to on, all data received is written to the 
current recording file. The default recording file is AW.RCD. In the script, you can change the file by 
setting the reserved variable $RecordFile to a string containing another filename.

If you load a session configuration after this command, the value of $Record is reset to that in the 
configuration. So is the value of $RecordFile.

Syntax: Set Record On | Off

Parameters: On Records all received data in the current recording file.

Off Stops recording of the current session.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$Record Set to 1 for on or 0 for off.

Example: The following example turns on recording, dials the host, then turns recording off.

Set Record On

Dial Host "Office PC"

...

Set Record Off

End

The following example turns on recording and dials the host. When the script ends, control passes to the 
remote user.

Set Record On

Dial Host "Office PC"

...

End Terminal
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Set RTS

Description: Use this command to set the state of the RS-232 Request to Send (RTS) signal. When on (or raised), 
pcANYWHERE uses hardware flow control to direct the rate of data flow between your computer and 
modem. This is often used with high-speed and error-correcting modems. You can use this command 
before or after making the connection. However, if you load a hardware configuration after this command, 
the state of the signal is reset to that in the configuration.

Syntax: Set RTS On | Off

Parameters: On Raises the RTS signal.

Off Lowers the RTS signal.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$RTS Set to 1 for on or 0 for off.

Example: The following example lowers the RTS signal for one second, then raises it again.

Set RTS Off

Wait Time 1

Set RTS On

See Also: Set Flow
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Set Speed

Description: This command applies only to serial connections. It sets the bits-per-second (bps) speedof the 
communications port. The Set Speed command may be preceded by a Set Port command, which selects 
the communications port to be set.    Use this command prior to making a connection. If you load a 
hardware configuration after this command, the speed is reset to that in the configuration.

The rate of the communications port affects the speed of data transmission between modems.

Syntax: Set Speed rate

Parameters: rate Integer literal or integer variable containing the bps rate. Permitted values are:    
75, 300, 600, 1200, 2400, 4800, 9600, 14400, 19200, 38400, 57600 or 115200.

Reserved Variables: $Baud Set to the bps rate.

Example: The following example selects com port 1, then sets the speed to 19200 bps.

Set Port 1

Set Speed 19200

See Also: Dial Host, Set Port
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Set Timeout

Description: Use this command to set timeout values for subsequent Wait and Receive commands. This can be used 
to control script execution and prevent script “locking” in the event that an appropriate value is not 
received during the specified timeout period. If an On Timeout command has been specified, then it is 
executed if a timeout occurs during the execution of a Wait or Receive command.

Setting $Timeout to 0 disables the default timeout value for Wait and Receive commands. Set Timeout 
may be combined with an On Timeout command, for error-trapping and controlling script execution. See 
the example below.

Syntax: Set Timeout seconds

Parameters: seconds Integer literal or integer variable specifying the number of seconds before a 
timeout occurs.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

$Timeout Set to the number of seconds.

Example: The following example ends the script when a timeout occurs.

Set Timeout 20 ;set timeout value

;specify where to branch if timeout occurs

On Timeout GoTo @timeout

...

@end:

Beep ;let user know script has ended

End Terminal ;exit to terminal mode

@timeout:

;a timeout occurred, end the script

Type String "^M^J(timeout)^M^J"

GoTo @end

See Also: On Timeout, Set Cancel, Set Disconnect, Wait and Receive commands 
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Set Translation

Description: Use this command to activate/deactivate a previously loaded translation table. When on, all transmitted 
and received data is translated according to the currently loaded translation table. The name of the file 
containing the table is loaded along with the session configuration or with the Load Translation command.
If you load a session configuration after this command, the active/inactive state is reset to that in the 
configuration.

Syntax: Set Translation On | Off

Parameters: On Activates the translation table.

Off Deactivates the translation table. 

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example loads and activates a translation table. Then it sends a translated string.

Load Translation "AW"

Set Translation On ;activate translation

Send String "translate this"

The next example deactivates a translation table and sends a string without translation.

Set Translation Off

Send String "do not translate"

See Also: Load Translation
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StrCat

Description: Use this command to append one string to the end of another. You may want to trim leading and trailing 
blanks (using Trim) before using this command. This command can be used in scripts that perform 
remote control sessions so long as the command is not executed during the remote control session.

Syntax: StrCat string1 string2

Parameters: string1 String variable containing the string to which string2 will be added. After the 
command is executed, it contains the result of concatenating the two strings.

string2 String literal or string variable to be added to the end of string1.

Reserved Variables: $Result Set to the length of the resulting string. The quotation marks surrounding the 
string are not counted. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example concatenates "ABCDE" to string1 and sets $Result to 10.

String string1[15]

string1 = "12345"

;string1 becomes "12345ABCDE"

StrCat string1 "ABCDE"

See Also: Lower, Set IgnoreCase, StrCmp, StrLen, StrSet, SubStr, Trim, Upper
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StrCmp

Description: Use this command to compare, character by character, the contents of two strings for equality. The 
$IgnoreCase reserved variable is used to determine if case sensitivity is enabled. The case of the 
characters is ignored if Set IgnoreCase has been set to on. This command can be used in scripts that 
perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: StrCmp string1 string2 [length]

Parameters: string1 First string literal or string variable to be compared.

string2 Second string literal or string variable to be compared.

length (Optional) integer literal or integer variable containing the number of characters to
be compared. The default is the length of the shorter of the two strings.

Reserved Variables: $Result Set to 0 if the strings are identical. If string1 precedes string2 in ASCII order, 
$Result is set to -1; if string1 follows string2 in ASCII order, $Result is set to 1.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example compares unequal strings. $Result becomes -1 because "ABC" precedes "DEF" in
ASCII order.

StrCmp "ABC" "DEF" ;$Result is set to -1

The next example compares unequal strings. $Result becomes 1 because "123" follows "12" in ASCII 
order.

String S1[3]

String S2[3]

S1 = "123"

S2 = "12"

StrCmp S1 S2 ;$Result is set to 1

The last example compares strings that are equal when the case of the characters is ignored. $Result 
becomes 0 because they are equal.

Set IgnoreCase On

StrCmp "ABC" "abc" ;$Result is set to 0

See Also: Lower, Set IgnoreCase, StrCat, StrLen, StrSet, SubStr, Trim, Upper
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StrLen

Description: Use this command to determine the length of a string; for example, a password or ID specified by the 
user. The quotation marks surrounding the string are not counted. This command can be used in scripts 
that perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: StrLen source [length]

Parameters: source String literal or string variable whose length is to be determined.

length (Optional) integer variable that contains the number of characters in the string. Its
value is also stored in $Result.

Reserved Variables: $Result Set to the length of the string. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example determines that "MICKEY" has six characters.

String s1[25]

Integer length

s1 = "MICKEY"

StrLen s1 length ;length and $Result are set to 6

See Also: Lower, Set IgnoreCase, StrCat, StrCmp, StrSet, SubStr, Trim, Upper
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StrSet

Description: Use this command to fill a string with the specified number of the specified character. This command can 
be used in scripts that perform remote control sessions so long as the command is not executed during 
the remote control session.

Syntax: StrSet result_string length character

Parameters: result_string String variable to be created.

length Integer literal or integer variable containing the number of characters to put in 
result_string. This becomes the length of the string.

character Integer literal or integer variable indicating the ASCII value of the character, or 
string literal or string variable indicating the character itself. If a string literal or 
string variable is specified, only the first character in the string is used.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example creates a string (S1) containing three D's.

StrSet S1 3 "D" ;s1 is set to DDD

The next example creates a string containing one A because 65 is the ASCII character for uppercase A.

StrSet S2 1 65

See Also: Lower, Set IgnoreCase, StrCat, StrCmp, StrLen, SubStr, Trim, Upper
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SubStr

Description: Use this command to extract a portion of a string (called a substring) and store it. You specify the starting 
position within the original string and the number of characters to copy. This command can be used in 
scripts that perform remote control sessions so long as the command is not executed during the remote 
control session.

Syntax: SubStr string start length substring

Parameters: string String literal or string variable from which a portion is to be copied.

start Integer literal or integer variable specifying the starting position within the first 
string. The first character in a string is in position 1.

length Integer literal or integer variable specifying how many characters to copy.

substring String variable that will contain the copied substring.

Reserved Variables: $Result Set to the length of the resulting string. The quotation marks are not counted in 
the length.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: In the following example, string1 becomes "BCD" and $Result becomes 3.

String string1[50]

SubStr "ABCDEF" 2 3 string1

See Also: Lower, Set IgnoreCase, StrCat, StrCmp, StrLen, StrSet, Trim, Upper
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Terminal

Description: Use this command to go into terminal emulation mode. The last terminal emulation, port, speed, parity, 
recording status, and so forth remain in effect. When terminal mode is ended, control returns to the 
current script at the next command.

Syntax: Terminal

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example goes into terminal emulation mode.

Terminal

See Also: End Terminal
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Trim

Description: Use this command to remove, or trim, leading and trailing spaces and control codes from the specified 
string. It trims all ASCII characters with an ASCII value less than 33. This command can be used in scripts
that perform remote control sessions so long as the command is not executed during the remote control 
session.

Syntax: Trim string

Parameters: string String variable to be trimmed.

Reserved Variables: $Result Set to the length of the resulting string. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example trims the spaces from both ends of the S1 string.

String string1[10]

string1 = "        ABC        "

Trim string1 ;string1 is set to "ABC"

See Also: Lower, Set IgnoreCase, StrCat, StrCmp, StrLen, StrSet, SubStr, Upper
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Type File

Description: Use this command to display the contents of a file on the screen. To make the scrolling of the output 
pause, the user can press Ctrl+S. To resume scrolling, the user can press any key. The output stops if the
previous Set Cancel command was set to on and the user presses Esc. This command can be used in 
scripts that perform remote control sessions so long as the command is not executed during the remote 
control session.

Syntax: Type File filename

Parameters: filename String literal or string variable containing path and name of file whose contents 
are to be displayed.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example displays the contents of the AUTOEXEC.BAT file on the screen.

Type File "c:\autoexec.bat"

See Also: Type Line, Type String
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Type Line

Description: Use this command to display a line on the screen. For example, you can display comments about the 
current script operation. Type Line appends a carriage return/linefeed combination ($TLineEnd) to the end
of the string. The $TLineEnd variable can be changed to alter line spacing.    For example, if $TLineEnd is
set to "^M^J^J", lines will be ended with two carriage returns, creating double-spaced lines.

When the string you are displaying exceeds the number of columns available in the current row, the 
remainder of the string automatically wraps to the next line. If the cursor is currently on a row near the 
bottom of the screen, and the string exceeds the number of rows available, then the remainder of the 
string is wrapped beginning at row 1, column 1.

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Type Line string

Parameters: string String literal or string variable to be displayed.

Reserved Variables: $Result Set to the number of characters displayed. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example shows each of three comments on separate double-spaced lines.

$TLineEnd = "^M^J^J"

Type Line "COMMENT ONE"

Type Line "COMMENT TWO"

Type Line "COMMENT THREE"

See Also: Type File, Type String
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Type String

Description: Use this command to display a string on the screen. For example, you can display comments about the 
current script operation. Type String has the same effect as the Type Line command if the string is 
followed by the carriage return/linefeed combination (^M^J).

When the string you are displaying exceeds the number of columns available in the current row, the 
remainder of the string is automatically wrapped to the next line. If the cursor is currently on a row near 
the bottom of the screen, and the string exceeds the number of rows available, then the remainder of the 
string is wrapped beginning at row 1, column 1.

If you want to insert a string rather than type over video space or other characters, use Insert Char first. 
This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Type [String] string

Parameters: String (Optional) reserved word; the command may be shortened.

string String literal or string variable to be displayed. 

Reserved Variables: $Result Set to the number of characters displayed. If an error occurs, set to the value of 
$Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example displays "one, two, three" followed by a carriage return/linefeed. Each Type 
(String) command starts where the previous one left off.

String string1

string1 = "one, "

Type string1

Type "two, "

Type "three^M^J"

The next example moves the cursor to an appropriate position and inserts a message in a previously 
typed line.

Cursor Left 10

Wait Time 2

;prepare for insertion

Insert Char 21

;insert the characters

Type String "Waiting for signal..."

See Also: Type File, Type Line, Insert Char
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Upper

Description: Use this command to convert all lowercase characters in a string to uppercase. Characters that are 
already uppercase are not affected. This command can be used in scripts that perform remote control 
sessions so long as the command is not executed during the remote control session.

Syntax: Upper string

Parameters: string String literal or string variable to be converted.

Reserved Variables: $Result Set to 0.

$Error Unchanged.

Example: The following example converts string1 from "Abc" to "ABC", then displays it.

String string1[3]

string1 = "Abc"

Upper string1

Type string1

See Also: Lower, Set IgnoreCase, StrCat, StrCmp, StrLen, StrSet, SubStr, Trim
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Wait Carrier

Description: This command applies only to serial connections. Use it to wait for the data-carrier-detect signal (CD or 
DCD), signifying that a connection has been established. If an On Timeout command is active, it specifies
timeout handling for this command.

Syntax: Wait Carrier [timeout]

Parameters: timeout (Optional) integer literal or integer variable specifying the maximum number of 
seconds to wait. The default is the number of seconds specified by the Set 
Timeout command.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example dials Office PC and waits two minutes for a connection. It will redial a total of nine 
times if necessary.

;show command processing on the remote

Set Echo On

;declare and initialize a counter

Integer count

count = 0

@retry: ;the retry loop label

count = count + 1 ;increment counter

Dial Host "Office PC" ;dial host

On Timeout GoTo @timeout ;set error handling

;wait two minutes for carrier detection

Wait Carrier 120

;display status on remote PC

Type "Connection established..."

...

@timeout:

Type Line "No carrier..." ;display status

;loop if fewer than ten retries have occurred

If (count < 10) GoTo @retry

Type "Too many retries, try later..."

End;end session

See Also: Set Cancel, Set Disconnect, Set Timeout, other Wait commands
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Wait Receive

Description: Use this command in network connections to replace the Wait Carrier command. It waits for any character
to be received from the communications device. If an On Timeout command is active, it specifies timeout 
handling for this command.

Syntax: Wait Receive [timeout]

Parameters: timeout (Optional) integer literal or integer variable specifying the maximum number of 
seconds to wait. The default is the number of seconds specified by the Set 
Timeout command.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example waits 60 seconds for a character to be received from the host.

;show command processing on the remote

Set Echo On

Set Timeout 60 ;establish a default timeout

;declare and initialize a counter

Integer count

count = 0

@retry: ;the retry loop label

count = count + 1 ;increment counter

Dial Host "Office PC" ;dial host

Wait Receive ;wait 60 seconds for any character

;branch depending on the value for $Error

;these $Error values are for DOS script

If ($Error == -4) GoTo @timeout

If ($Error == -1) GoTo @canceled

If ($Error != 0) GoTo @another_error

...

@end:

End;end session

@timeout:

Type Line "A timeout has occurred..."

;retry or end session

If (count < 10) GoTo @retry

Type "Too many retries, try later..."GoTo @end

@canceled:

;end session

Type Line "Operator abort..."

GoTo @end



@another_error:

;end session

Type Line "Error occurred..."

GoTo @end

See Also: Set Cancel, Set Disconnect, Set Timeout, other Wait commands
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Wait Silence

Description: Use this command to establish a received data timeout for unattended file transfers. It waits until it 
receives a specified number of seconds of communications silence. If an On Timeout command is active, 
it specifies timeout handling for this command.

Syntax: Wait Silence [timeout]

Parameters: timeout (Optional) integer literal or integer variable representing length of silence to wait. 
The default is the number of seconds set by the Set Timeout command.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example The following example transfers the C:\FILE1 file from the host to the remote, waits for a minute of 
inactivity, then transfers C:\FILE2 to the host.

$Error = 0 ;reset $Error

On Error GoTo @error ;handle errors

Send String "AWSEND C:\FILE1 to remote"

Receive File "C:\FILE1"

Wait Silence 60 ;wait for 1 minute of silence

Send String "AWSEND C:\FILE2 to host"

Send File "C:\FILE2"

See Also: Set Cancel, Set Disconnect, Set Timeout, other Wait commands
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Wait String

Description: Use this command to wait for a specified string, for example, a password prompt, to be received. Because
scripts begin execution as soon as the remote calls a host, password prompts on the remote PC can be 
handled by script commands. If an On Timeout command is active, it specifies timeout handling for this 
command.

By default, strings in pcANYWHERE are not case-sensitive. You may want to use the Set IgnoreCase 
command to enable case-sensitivity before prompting the user for a password.

NOTE: Wait String is usually preceded by a Wait Carrier or Wait Receive command to ensure appropriate 
script execution.

Syntax: Wait String string [timeout]

Parameters: string String literal or string variable to wait for.

timeout (Optional) integer literal or integer variable specifying the number of seconds to 
wait. The default is the number of seconds set by the Set Timeout command.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example waits ten seconds for a password, makes sure the case of the password’s 
characters are ignored, and contains error handling in case no password is given.

$Error = 0 ;reset $Error to zero

On Error GoTo @nopassword ;set-up error handling

Set IgnoreCase On ;ignore case

Set Echo On

;wait up to 10 seconds for password

Wait String "Enter password:" 10

...

@nopassword:

;if no password received, hand up the phone and

;try again

Type Line "No password prompt."

Hang

GoTo @retry

See Also: Set Cancel, Set Disconnect, Set Echo, Set Timeout, other Wait commands
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Wait Time

Description: Use this command to wait for the specified number of seconds. For example, use the waiting period to 
display received data (if echo is on), record received data (if recording is on), or check to see if the data 
matches the specified On Receive string (if enabled). 

Syntax: Wait [Time] seconds

Parameters: Time (Optional) reserved word; the command may be shortened.

seconds Integer literal or integer variable specifying the number of seconds to wait.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example prepares for a session, then waits 60 seconds before proceeding with the script.

Set Echo On ;display received data 

Set Record On ;record received data

Wait Time 60 ;wait for 60 seconds

...

See Also: Set Cancel, Set Disconnect, Set Timeout, other Wait commands
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Wait Until

Description: Use this command to wait until a specific time and date occurs. For example, you can delay script 
completion until after normal working hours or until a time when controlling a non-dedicated host will not 
interfere with other operations. Place the command at the beginning of the script, before a Dial Host 
command, and before any loop that redials (see the example for the Wait Carrier command).

Current time is read from the system clock. (The DOS command Time displays the current system time.) 
You can change the system date and time from the Windows Control Panel using the Date/Time option or
from the DOS prompt using the DOS date and time commands.

Syntax: Wait Until time [date]

Parameters: time Integer literal or integer variable specifying time to wait for, in the 24-hour format 
HHMM.

date (Optional) integer literal or integer variable specifying date to wait for, in the 
format YYMMDD.    The default is the current date.

Reserved Variables: $Result Set to 0. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example waits until 10:40 P.M. BEFORE COMPLETING THE SCRIPT. 

Wait Until 2240

See Also: Set Cancel, Set Disconnect, Set Timeout, other Wait commands
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Write Line

Description: This command applies to the remote PC only. Use it to write a string to a file and append a carriage 
return/linefeed combination ($TLineEnd). For example, you can create comments in log files which 
permanently record unattended script operations. The values of string variables may also be stored in a 
file for later review. 

The $TLineEnd variable may changed to alter line-spacing. For example, if $TLineEnd is set to "^M^J^J", 
lines will be ended with two carriage returns, creating double-spaced lines.

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Write Line file_number string

Parameters: file_number Integer literal used by Open or Create command to identify the file. Valid 
identifiers are 1 through 9.

string String literal or string variable to be written to the file.

Reserved Variables: $Result Set to the number of bytes written. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens a log file, positions its file pointer, writes three double-spaced lines, then 
closes the log file.

$TLineEnd = "^M^J^J" ;start double-spacing

Open 1 "logfile" "WC"

Seek 1 0 2

Write Line 1 "First comment"

Write Line 1 "Second comment"

Write Line 1 "Third comment"

Close 1

See Also: Read Line, Read String, Write String
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Write String

Description: This command applies to the remote PC only. Use it to write a string to a file without appending a carriage
return/linefeed. For example, you can create comments in log files which permanently record unattended 
script operations. The values of string variables may also be stored in a file for later review.

This command will have the same effect as the Write Line command if the string is followed by a carriage 
return/linefeed combination, ^M^J.

This command can be used in scripts that perform remote control sessions so long as the command is 
not executed during the remote control session.

Syntax: Write String file_number string [length]

Parameters: file_number Integer literal used by Open or Create command to identify the file. Valid 
identifiers are 1 through 9.

string String literal or string variable to be written to the file.

length (Optional) integer literal or integer variable limiting the number of characters to 
write. The default is the length of the string.

Reserved Variables: $Result Set to the number of bytes written. If an error occurs, set to the value of $Error.

$Error Standard errors. See Appendix B, “Error Messages.”

Example: The following example opens a file, positions its file pointer, writes two strings side-by-side, then closes 
the file.

Open 1 "myfile.dat" "WC"

Seek 1 0 2

Write String 1 "First this; "

Write String 1 "then that"

Close 1

See Also: Read Line, Read String, Write Line





Script Editor Commands Listed by Task {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any task to see related commands you can include in a script:

 Automating Remote Control Sessions
 Loading or Modifying Configuration Information
 Controlling Script Processing

 Interacting with User

 Transmitting and Receiving Data

 Managing Files and Directories

 Reading/Writing to Files

 Performing String Operations

 Printing

 Managing the Display

 Miscellaneous Commands



Automating Remote Control Sessions {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Session Delay

    Session Dial

    Session End

    Session ExitMode

    Session OnError

    Session Overwrites

    Session Retry

    Session Timeout

    SessOpr Host Run

    SessOpr Host Send

    SessOpr Remote Run



    SessOpr Remote Send



Loading or Modifying Configuration Information {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Answer

    Dial Host

    Dial Number

    Dial OnlSvc

    Emulate

    Load FKeys

    Load HostInfo

    Load OnlSvcInfo

    Load Translation

    Set DTR

    Set Echo



    Set Flow

    Set Parity

    Set Port

    Set Protocol

    Set Record

    Set RTS

    Set Speed

    Set Translation



Controlling Script Processing {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    End

    End Menu

    End Terminal

    Exit

    GoSub

    GoTo

    Hang

    If...Then or If...GoTo

    Link

    On Cancel

    On Disconnect



    On Error

    Return

    Script

    Set Cancel

    Set Disconnect

    Terminal



Interacting with User {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Beep

    Input

    Input Key

    Keyboard Flush

    Keyboard Hit

    Message Box

    Type File

    Type Line

    Type String



Transmitting and Receiving Data {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Break

    On Receive

    On Timeout

    Receive Char

    Receive Clear

    Receive File

    Receive Line

    Receive String

    Reset

    Send Char

    Send Clear



    Send File

    Send Line

    Send String

    Set CharDelay

    Set Timeout

    Wait Carrier

    Wait Receive

    Wait Silence

    Wait String

    Wait Time

    Wait Until



Managing Files and Directories {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    CD

    Copy

    Del

    Dir

    Find First

    Find Next

    Get Environment

    Get File Attr

    Get File Date

    Get File Size

    Get File Time



    Get Free Disk

    MD

    RD

    Ren

    Set File Attr

    Set File Date

    Set File Size

    Set File Time



Reading/Writing to Files {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Open

    Close

    Read Line

    Read String

    Seek

    Write Line

    Write String



Performing String Operations {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Decrypt

    Encrypt

    Index

    Lower

    Set IgnoreCase

    StrCat

    StrCmp

    StrLen

    StrSet

    SubStr

    Trim



    Upper



Printing {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Print File

    Print Line

    Print String

    Printer



Managing the Display {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Clear BOL

    Clear BOP

    Clear EOL

    Clear EOP

    Clear Screen

    Cursor Block

    Cursor Down

    Cursor Home

    Cursor Left

    Cursor Line

    Cursor Off



    Cursor Position

    Cursor Restore

    Cursor Right

    Cursor Save

    Cursor Up

    Delete Char

    Delete Line

    Insert Char

    Insert Line

    Screen Restore

    Screen Save

    Set Attribute



    Set Palette

    Set Quiet



Miscellaneous Commands {button Click to switch to alphabetical 
list.,JI(`',`script_editor_commands_alphabet')}

Click any command to view syntax, description, and an example:

    Description

    Let

    Run



Connection Info tab

Check a connection device for remote control sessions using this connection item.    

To find your modem:

Your operating system may detect any modem(s) connected to your PC.    pcANYWHERE then places any such device(s) at the 
top of the Device list:

To find your network device:    

Network devices appear in the middle of the list:

To find your cable device:

You must choose a COM (serial) port or LPT (parallel) port.    You can customize the settings of COM ports.

To find your modem under Windows NT:

If you are using Windows NT, choose the COM port connecting your modem to the PC, then customize it to choose your modem 
from pcANYWHERE’s list:

To customize a device:



Click Details:

For connection items in the Remote Control, File Transfer, and Call Online Service modes: you must customize 
network devices if you want them to use a pcANYWHERE gateway when making connections.



Connection Info                

To choose the devices of a gateway:

You must check two connection devices, one under Incoming devices, and one under Outgoing devices.    Both devices of a 
bidirectional gateway can send and receive calls.

You can make this a bidirectional gateway by checking that option on the Settings tab.
When choosing devices for a unidirectional gateway, however, set the incoming device as the one that connects to remote PCs.   
The outgoing device connects to host PCs.

To find your modem:

Your operating system may detect any modem(s) connected to your PC.    pcANYWHERE then places any such device(s) at the 
top of the Device list:

To find your network device:    

Network devices appear in the middle of the list:

To find your cable device:

You must choose a COM (serial) port or LPT (parallel) port.    You can customize the settings of COM ports.

To find your modem under Windows NT:

If you are using Windows NT, choose the COM port connecting your modem to the PC, then customize it to choose your modem 
from pcANYWHERE’s list:

To customize a device:

Click Details:





Protect Item tab

Password:

Type a password here to protect the use of this connection item.    You must re-type the password in the Confirm Password field.

The password you type here displays as asterisks to protect the security of the connection item.    You may want
to keep a record of what you typed in a restricted place; should you forget the password, it cannot be retrieved in pcANYWHERE.    
Protect item passwords are case-sensitive.

Restriction checkboxes:

Check Required to view properties:

to require a user to enter the password before viewing any of the property sheets of this item.

Check Required to execute: 

to require a user to enter the password before using this connection item to make a connection or wait for a call.    (If this is a 
gateway connection item, users will have to enter the password before activating the gateway.)

The Required to Execute option does not appear on the Protect Item property page for a new caller item 
because these items cannot be executed.

Check Required to modify properties: 

to require a user to enter the password before changing any of the properties of this connection item. 



Settings tab

Type this information:

The host PC’s name (for network connections).
· If your connection device is TCP/IP, type the pcANYWHERE host name,DNS name, IP address , or subnet address of the 

TCP/IP host to which you want to connect.

The phone number to dial (for modem connections).
· Check Use Dialing Properties And Phone Number if you want to use the dialing information in the My Locations property 

page with the number when dialing the host. 
· Click Dialing Properties to view your current location’s dialing properties. You can choose a different location or create a 

new location from this property page. 
· Click Use Manually Entered Prefix, Area Code, Phone Number if you want to type the prefix, area code, and phone number 

to dial and ignore the settings found in the My Locations property page.

You type either the host PC’s name or the phone number of the host PC, depending on what type of connection
device you selected.    To change the type of connection device, choose the Connection Info tab.

Select the following login information:

Check Automatically Login To Host Upon Connection to send your login name and password to the host 
automatically upon connecting.

If you do not enter login information on this property page, you are prompted for it when making the connection. 

If you are calling a Windows NT host, you can include the domain name in addition to the login name. For example, type 
domain\username to automatically locate the user on a specific domain

Select the following connection options:

Type the number of times pcANYWHERE will attempt to dial the host after a failed call.

Type the number of seconds for pcANYWHERE to wait before attempting to redial the host after a failed call.
For connections using gateways:



If you are using a gateway on your network to dial a host, you can type both the name of a host PC and a 
phone number.    The gateway PC dials the number and connects you to the host.

If you are calling a host on an outside network that uses a gateway to make connections, type the phone 
number of the gateway followed by @ and the name of the host PC.    For instance, to dial into a gateway at phone number 555-
5555, and immediately connect to “My Host PC”, you would type:



Automated Tasks    tab

Select options to use whenever making a connection with this connection item.

To run an AutoXfer procedure in all sessions with this connection item:

1 Check Run upon connection and click AutoXfer:

2  Optional: Click Browse to select a different procedure to run

To run a script in all sessions with this connection item:

1 Check Run upon connection and click Script:

2  Click Browse.
3 Choose a script from the Script dialog box.
4 Click Select.

To record all sessions with this connection item:

1 Check Record session in file for later playback:

2 Optional:    Click Browse and select a folder in which to place the file.
3 Type the name of the file in which to record the session.    

If you do not type a filename, you will be prompted for one when making a connection if you have checked the 
option in step 1.

To create activity logs of all sessions with this connection item:

Check Save session statistics in activity log file.

You can run a script or begin recording at any point during a remote control session.



Settings tab

Options set on this tab affect all remote control sessions with this host PC:

    Launch With 
Windows

Causes the host connection item to run and wait for a call
automatically each time you start your PC. 

    Use Windows 
Screen Saver

Causes your Windows 95 screen saver to run whenever 
the host is waiting for a call. 

Add a password to your screen saver to lock the host 
and prevent unauthorized users from canceling the waiting 
host.

    Lock NT 
Workstation (Windows NT only)

Prevents unauthorized users from canceling the waiting 
host by locking the NT Workstation with a password.

    Run Minimized

Causes the host to appear on the desktop as an icon 
when it is waiting for a connection.

    Run as a Service 
(Windows NT only)

Configures the host to run as an NT Service. 

This option is required if you want to launch 
the host with Windows.

    Callback Delay

Causes the host to delay the specified number of 
seconds before attempting to call back the remote caller.

    Keyboard/Mouse 
active during session

Allows you to disable the host or remote keyboard 
functions during a session. The default is to allow both 
host and remote full keyboard/mouse activity.

This option is automatically set to Remote and 
cannot be changed If you check the Blank The PC Screen 
option on the Security Options property page.

    Abnormal Loss of 
Connection and End of Session 
Options:

Allows you to determine the mode the host returns to 
after an unexpected disconnect or an end of session 
command. 

? Wait for Call Causes the host to wait for another call. 
? Cancel Host Cancels the host. Other connections are not possible 



when the host is canceled. 
? Logoff User Causes the host to log the current host user off the 

network, preventing unauthorized access to the user’s 
network privileges. 

? Restart Host Computer Causes the host PC to restart. If you want the host PC to 
wait for another call after restarting, check the Launch 
with Windows option.



Callers tab

Choose one:

To allow full access to all callers:

All callers can connect to this host PC without login names or passwords, and with full remote control privileges. 

To set up unique passwords and privileges for different remote users.    

The Caller items in the window below are like a directory listing of remote users who can call this host.    Use the toolbar to 
create, modify, delete, etc. the caller items.    Right-click any caller item and choose Properties to set that caller’s privileges, 
login name, and password. 

    Each host connection item can be accessed by caller items in only one folder on the host PC.    Change the caller 
folder to access or set up a different group of callers for this host.    

To add remote callers and use Windows NT security privileges:

Select individual users or groups from the Windows NT user list.The users or groups on this list are created and maintained 
by the Windows NT administrator. 

If you have administrator privileges on Windows NT,    click     to add or delete users.



Security Options tab

Check these general security options for this host PC:

    To blank this host PC’s screen during sessions.

    To log failed connection attempts.    This record appears in an activity log on this PC.

    To prompt for confirmation by a user at the host at connection time, and to set a time limit on the time required for 
this confirmation.    (This prompt does not appear if the remote caller is a Superuser.)

    To disconnect if that confirmation does not occur within specified time limit.

    To make passwords entered by remote callers case-sensitive.

    To limit login attempts, or the time available to complete login.

    To encrypt data during a session choose one of three encryption levels.



    To allow any password on reconnection. 

    To disconnect if remote user is inactive for specified period of time.



Settings tab

Choose terminal emulation that online service uses.

Choose the service’s file transfer protocol.    

Type the phone number of online service:

Type the country code of the online service. 

Type the area code of the online service.
Select the following options:

Check Use location information if you want to use the information in the country code and area code fields with 
the number when dialing the online service. Leave unchecked to ignore these fields and dial the number exactly as it appears in the 
phone number field.

Click Change Your Location to view your current location properties. You can choose a different location or 
create a new location from this property page.

    Some options affecting online service sessions are set by choosing either the Terminal Emulation tab or the File 
Transfer tab from the Application Options property sheets.

You can change the protocol or terminal emulation used during an online service using options in the Terminal 



window.



Session tab

Select options to use pcANYWHERE utilities whenever making a connection to the online service.

To record all sessions with this connection item:

1 Check Record session in file for later playback:

2 Optional:    Click Browse and select a folder in which to place the file.
3 Type the name of the file in which to record the session.

If you do not type a filename, you will be prompted for one when making a connection if you have checked the 
option in step 1.

To run a script in all sessions with this connection item:

1 Check Run script file after connect:

2  Click Browse.
The Script dialog box appears.

3 Choose a script.
4 Click Select.

To use a translation table during sessions:

1 Check Use Translation Table file:

2  Click Browse.
3 Choose a translation table.

To use macro keys during sessions:

1 Check Use Macro Key file:

2  Click Browse.
3 Choose a file containing macro keys.

To create activity logs of all sessions with this connection item:

Check Save session statistics in activity log file.

To record sessions for use as scripts:

Check Begin script recording after connection.





Advanced tab

The options you set here customize the terminal emulation you chose on the Settings tab for sessions with the online service.

Set these options:

    Line wrap. Check to display lines that exceed the width of the terminal window on the next line.

    Screen wrap. Check so that when screen is filled, next line overwrites current top line when cursor reaches last 
position on the last line of the terminal display window.

    Destructive backspace key. Check to cause backspace key to act as a destructive, deleting key instead of a left 
cursor key.

    Translate Receive CR to CR/LF. Check to causes cursor to move to the left side of the terminal display window and
to advance one line each time a carriage return character is received.    (Check only if display does not scroll vertically as expected.)

    Break Length. Specifies length of the break signal used to interrupt programs running on a mainframe or 
minicomputer.

Click Defaults to re-set the options on this page as the default options for the chosen terminal emulation.



Gateway Settings tab

The gateway  ’  s   name displays at the top of this tab:

This is the name that users must specify when customizing a connection device to connect using this particular gateway.    To 
change it, you must rename this connection item.

Set these options:

Bidirectional.    Check to allow incoming and outgoing calls on either device selected on the Connection Info tab 
for this gateway.

Inactivity timeout. Check to disconnect any session that remains inactive longer than time limit you specify.

Class.    Type name.    (Places this gateway in a group of other gateways on a network.    Users can specify the 
use of any gateway in a particular class when customizing connection devices.)



Caller Settings tab

You must type a unique login name for each caller.    This protects the host from unauthorized access.

Optional: Type a password for additional security.    You must type it twice, exactly the same, in the Password 
and Confirm password fields.    (Be sure that the remote caller to whom you’ve assigned it knows it!)

To make the entry of passwords case-sensitive, check that option in the Security Options tab in the host 
connection item.    If you do this, a caller who types the password using case differently than you use it here will not be able to 
connect to the host.

Each caller can automatically send the assigned login name and password to the host at connection time.    To 
do this, remote users must enter this information in the Remote Control connection item on the remote PC that they use to connect 
to this host.



Callback tab

Check Call back the remote user: 

to instruct pcANYWHERE to terminate a connection (after the remote user has successfully logged in) and call back the 
remote PC.    

Type the number of the remote PC in: 

or leave blank to prompt caller for number at time of initial connection.    (User will not be prompted until after successful login.) 

Callback can occur only on a host PC that makes connections using a modem, even if you check this option in 
a caller item. accessing that host.

This feature effectively reverses charges for remote control sessions since the host PC’s telephone line is 
generally charged for most of the connection time.    In addition, callback serves as an additional security measure; it allows the host 
PC to verify the location of the remote PC -- as long as you enter the remote telephone number in this tab. 



Caller Advanced tab

Check Superuser - caller has full access rights: 

to allow this caller all privileges on this tab, as well as unlimited time in sessions and full access to all drives on the host PC.

Or, set this caller’s privileges and parameters individually.    
Check to grant any of these privileges: 

Set the following parameters: 

    Limit time per session:

 

    Caller subject to inactivity timeout. (Timeout is set in Security Options tab of host connection item.) 

 

    Click Drive Access to set this caller’s access to drives on the host PC. 
For Superusers and callers whose privileges you have set individually:

    Check to save session statistics of sessions with this caller in activity log:    

 

    Command to execute after connect:

 



Filter dialog box
Use this dialog box to determine the types of files that display.

To filter files that display:

1 Do one:
· Click All Files.
· Click Programs.
· Click Documents.
· Click Custom, and type a filter expression, such as *.bhf.

2 Optional: Uncheck the Show Folders checkbox to exclude subfolders in the window.
3 Click OK.



Button Bars tab

Choose the appearance of the action bar and the toolbar.    

Display these Action Buttons
Check the buttons you want to display on the action bar.

If a user chooses to run a Quick Start Wizard, and that Wizard creates a connection item in a mode not 
currently displaying on the action bar, the button representing that mode then appears on the action bar.

Make the Action Buttons this size
Choose Icon Only so that buttons appear as graphic icons only.    Choose Icon and Text so that buttons appear with text and 
graphics.

Toolbar 
Allow folder browse
Check to display folder browse tool whenever the toolbar displays.

Show folder history
Check to display folder history tool whenever the toolbar displays.

You can drag the action bar and the toolbar to different positions in the main pcANYWHERE window.



Remote Operation tab

Select options here for all remote control sessions in which this PC is the remote PC.

You can change some of these options during a remote control session using the remote online toolbar.

ColorScale
Increases screen refresh performance by reducing the number of colors during a remote control session.    Choose from among 
these options:

The host PC  ’  s   color palette must be set to 256 colors or greater in order for ColorScale

 to take effect during sessions with that host.
pcANYWHERE Cachefile size
Specifies the amount of disk space pcANYWHERE uses when caching information during a remote control session with PCs 
running Windows, thus increasing display speed.    Choose from the available values. If you are connecting to more than one 
host,    you may want to reduce the cachefile size to ensure that cache is available for all sessions. PcANYWHERE32 attempts to
use the cachefile size for all sessions. If disk space is not available, the cachefile may affect the first session only.

Allow connection to multiple hosts
Causes the pcANYWHERE application to remain open, allowing the user to conveniently make another connection. If this option 
is not selected, multiple connections are made by restarting pcANYWHERE. 

You can close the pcANYWHERE application and still quickly make multiple connections by dragging the 
connection items to the desktop. Double-click the desktop icon to start the connection. 

Optimize desktop for local remote control
Affects display of host screen for improved speed.    If checked, disables host’s wallpaper, screensaver, idle power-down features
for the duration of remote control session only.    Also prevents full-screen dragging.

Reduce host desktop area to match remote
Causes the host to lower the screen resolution to match the resolution used by the remote PC.

Screen Scaling
Check to scale the screen image so that it always fits within the terminal window.    Removes scroll bars.



Local full screen display
Check to display the host image full-screen on the remote PC.    

Host active window tracking

Causes the remote’s view to automatically focus on the window that is currently active on the host PC. When the host and 
remote are using different screen resolutions, an active window, such as an error message box, may appear outside the 
remote’s viewing area.

Synchronize mouse buttons
Allows the remote caller to control the host using the same mouse configuration used on the remote computer. For example, if 
the remote caller is using a left-hand mouse configuration, the host mouse adjusts to allow left-hand mouse control during the 
session.

Use Local Fonts for Win 3.x fonts
Improves the performance of the session by having the remote use a local font that closely matches the font used at the host.    
If, after checking this option, text is not displayed correctly on the screen, uncheck it.

This feature disables screensavers only if they appear in the Screensaver tab of Microsoft’s Display Properties 
dialog box after installation.



System Setup tab

Set default options to identify your PC and define its location for remote communications.

Your computer name selection
User-defined 
Choose this option and type in the name that identifies this PC in pcANYWHERE sessions.

Windows computer name
The name of your PC as it was entered during Windows installation.

Dialing properties
Location 
Displays the name of the location you are currently dialing from. This location is configured in the Dialing Properties dialog box.
Area code 
Displays the area code you are currently calling from. This area code is configured in the Dialing Properties dialog box.

Dialing Properties button
Click to view Microsoft’s Dialing Properties dialog box and enter details about your communications device.    Changes text in 
Location above.

Cryptographic certificate store
Type the name of the Cryptographic certificate store to use for encryption. A certificate store is created by the network 
administrator and contains certificate authorities.

Use NT Event Log (Windows NT only)
Check this option if you want to log pcANYWHERE session events to the Windows NT Event Log. Information recorded in this 
log include the date and time the event was recorded, the event category and ID number, the pcANYWHERE user, and the 
name of the PC connecting.



TCP/IP Tab           

Use the TCP/IP host list to add the names or addresses of pcANYWHERE hosts available on your TCP/IP network or the 
Internet. The information on this list is used to generate an Internet SmartList of pcANYWHERE hosts on the Internet. If this list 
is left blank, pcANYWHERE32 lists TCP/IP hosts on the local network only.

TCP/IP hosts to connect to:
Type the pcANYWHERE host name,DNSname, IP address, or subnet address of the TCP/IP host to which you want to connect.

Add button
Click to add the TCP/IP address to the list of hosts.

Remove button
Select a host in the list and click to delete. 



Terminal Emulation Tab    

Choose options affecting display and functions during sessions with online services.

Some of these options can be changed during a session by choosing Display from the Session menu of the 
Terminal window.

Display options:
Automatic Font Sizing checkbox
If checked, pcANYWHERE automatically selects the font size displayed on the remote screen, based upon the size of the 
Terminal window.

Automatic Scroll Bars checkbox
If checked, screen displays horizontal and vertical scroll bars.

Status Line checkbox
If checked, status line displays at bottom of screen.

Macro Keys button
Click to choose a file and specify macro keys during terminal emulation.

Translation Tables button
Click to choose a file and specify codes in a translation table.

Font/Colors button
Click to choose fonts and color of text during terminal emulation.



File Transfer Tab

Choose options affecting file transfer in all remote control sessions and sessions with online services.    

Some of these options can be changed during a remote control session using the remote online toolbar.

Pause Remote Control to Maximize File Transfer Performance
Check this option to optimize file transfer performance. If file transfer speed is not a priority and you want to run simultaneous 
remote control and file transfer, leave this option unchecked. 

Default Download Folder
Choose a folder on your PC where files downloaded from online services are to reside.    Click Browse to find a folder.

Virus Check All Downloaded Files checkbox
Check to virus check all downloaded files automatically. 

Protocols
To Customize Transfer Protocols:

1 Select a protocol.
2 Click Settings.
3 Set options for the selected protocol.

Only ASCII, pcANYWHERE, and ZMODEM can be customized.

Customize the pcANYWHERE protocol to use SpeedSend.



ASCII Protocol Settings dialog box
Pacing

Pacing specifies a delay after each line or character that is sent.
Character: Enter the number of tenths of seconds to pause after a character is sent.
Line: Enter the number of tenths of seconds to pause after a line is sent.
Pace Character: Enter the ASCII value of the character that causes transmission to pause until the character is 
received.

Download: Enter the maximum number of seconds of inactivity before transfer is terminated.

Upload Translations
Upload and Download Translations compensate for differences in how carriage returns and linefeeds are handled on 
different systems. When uploading files (transferring files to the online service), specify how to treat these characters.
CR: Select the way to handle a carriage return.

None: Transmits the character as itself.
Strip: Removes the character from the transmission.
Add LF: Adds a linefeed to the character as it is transmitted.

LF: Select the way to handle a linefeed. Select None, Strip or Add CR.

Download Translations
When downloading files (transferring files from the online service), specify how to treat these characters.
CR: Select the way to handle a carriage return. Select None, Strip or Add LF.
LF: Select the way to handle a linefeed. Select None, Strip or Add CR.



Drive Access dialog box    

Choose one for each drive on the host PC:

Choose this option:

to prevent the remote caller from any access to the drive.

Choose this option:

to allow the remote caller to view and use, but not to delete or change, files on the drive. 

Choose this option:

to allow the remote caller to view, use, delete or change files on the drive. 



COM Port Details tab

To customize this port for connections using a cable:

Set these options:
Speed - This is the data rate for sessions when this port is used to make a connection.

Parity - Set to same parity as that of the system to which you are connecting.    When making a connection with a 
pcANYWHERE host or remote PC, set to None.

Flow control - Transmissions over data rates of 9600 baud usually require that you set flow control to RTS/CTS.

Started by - Do not set for cable connections.

Ended by - Do not set for cable connections.

To customize this port for connections using a modem:

You can do this only if the Use modem checkbox appears on this tab.    If it does not, close this dialog box and 
add your modem to your Windows configuration through Modems in the Control Panel.    Then choose your modem from the device 
list in the Connection Info tab.

1 At the bottom of the Details tab, check Use modem. 
2 Choose your modem from the drop-down list below the Use modem checkbox.    (If your modem is not on the list, check with 

your modem’s manufacturer to find out what modem’s configuration most nearly matches yours, or try Hayes Compatible.)
3 Set these options: 

Speed - This is the data rate for sessions when this port is used to make a connection.    It was selected automatically for you 
when you chose your modem.

Parity - Set to same parity as that of the system to which you are connecting.    When making a connection with a 
pcANYWHERE host or remote PC, set to None.

Flow control - Transmissions over data rates of 9600 baud usually require that you set flow control to RTS/CTS.

Started by - Selected automatically for you when you chose your modem.

Ended by - Selected automatically for you when you chose your modem.

4 Optional:    Click Advanced to set more options for your modem.
The Advanced Modem Settings dialog box displays.



NASI/NCSI Details tab

Server: Check to enter a server name.    Click Browse below to select from a list of currently available servers.    If you leave this 
option as <Any>, pcANYWHERE selects the first available server for you. 

Service: Check to enter the modem group name to use within the ACS. Click Browse below to select from a list of currently 
available services.    If you leave this option as <Any>, pcANYWHERE selects the first available service for you.    

Port: Check to enter a port name. Click Browse below to select from a list of currently available ports.    If you leave this option
as <Any>, pcANYWHERE selects the first available port for you. 

Select when connecting:
Check to allow remote callers to select the server, service, and port at the time of the connection.

<Any> in this dialog box is an appropriate option only if you are a remote user dialing out of an ACS.    If you 
plan to wait for a call as a host, pcANYWHERE requires that you preselect a specific server, service, and port, or a Netware 
Connect Dialin group.



ISDN via CAPI Details tab

Attempt channel bonding    Check if you want pcANYWHERE to attempt to make a 128K connection by using two 64K 
channels. Channel bonding does not occur if the second channel is unavailable at the time of the connection. Leave this option 
unchecked if you want the second channel to remain free for other communications.

Check the transmission rate to determine if channel bonding was successful.
Only receive calls on extensions Type in Multiple Subscriber Number (MSN) extensions, separated with a comma, if you 
want to restrict incoming calls to only those extensions. Leave this field blank to connect on any available extension.



NASI/NCSI User tab

User name: Type the name that you use to login to the NASI/NCSI server.    See your network administrator for this.

Password: Type your password on the NASI/NCSI server. 

Confirm password: Re-type your password. 

Session name: Type a name for this session.    This name is listed as an available workstation session after you log on to 
the server. 

Session name is available to all users:
Check to make this workstation session available to all callers connecting to the NASI server.



Network - Details tab       

Set options on this tab only if the device you are customizing must use a gateway to make connections.

Use gateway checkbox:

Check to specify that the device you are customizing makes connections using a pcANYWHERE gateway.

Gateway
Enter information below to identify which gateway, or group of gateways, this PC should look for when making a connection.

Name
Type the name of the gateway.    This is the name of the gateway connection item located on the gateway PC.

Class 
Type class of gateway this PC must use.    If more than one gateway is active on your network, you can use any of them in 
this class to make a connection.    (Since gateways can only support one connection at a time, specifying a class can help 
you make a connection with whatever gateway is available for use.)    
A gateway’s class (if there is one) is also contained in the gateway connection item located on the gateway PC.

Parity
Specifies what a gateway’s parity must be for this PC to use it when making a connection.



NetBIOS Options dialog box

Use this dialog box to use a LAN Adapter Number (LANA) that is configured in the Windows 95 or Windows NT operating 
system.



Selection dialog box
Choose an available ACS component from those listed here.



pcANYWHERE Protocol Settings dialog box

Use this dialog box to control how aspects of file transfer should be handled.

Destination File: Select the method by which pcANYWHERE decides to overwrite duplicate files in the destination folder. 
Normally you should require verification before overwriting files. If you intend to overwrite a large number of files you may 
want to overwrite automatically or overwrite older files only.
Never Overwrite Duplicate Files: Does not overwrite duplicate files in the destination folder.
Always Overwrite Duplicate Files: Automatically overwrites duplicate files in the destination folder.
Verify Before Overwriting: Asks you for confirmation before overwriting a duplicate file.
Always Ask for Destination: Asks you where to place the file.
Overwrite Older Files Only: Automatically overwrites duplicate files that are older than the file you are transferring.

Use Compression: Check to compress files during transfer. Files are compressed during transfer to improve speed, but are 
automatically uncompressed to their original state before being written to the destination drive.
Allow Crash Recovery: Check to allow reconnection and continued file transfer from the point at which file transfer was 
interrupted.

Use SpeedSend :    Check to use pcANYWHERE’s SpeedSend

 to accelerate transfer to a location where earlier versions of the same files have been sent 
previously.



Remote Drives dialog box           

    Topic under development.



Translation Table dialog box  

Use this dialog box to define a translation table to translate how your PC sends and receives codes during sessions with online 
services.



ZMODEM Protocol Settings dialog box
Settings

Error Checking: Select 32-bit or 16-bit. 32-bit error checking offers the highest level of error correction.
Data Window: Select None, 2K or 4K. Use of a Data Window increases reliability, by pausing for an acknowledgment 
from the receiving computer after a specified amount of data has been sent. Select None to halt transmission only when 
a negative acknowledgment (NAK) is received by the sending computer.
Crash Recovery: Allows interrupted file transfers to be restarted without data loss.
Allow Auto Downloading: Allows the online service to send files selected for transfer without remote user initiation of 
the Receive File command.



Password dialog box           

    Topic under development.



DOS Sessions tab

Select these options for remote control sessions during which you use DOS applications:

· Special keyboard handler

· Synchronize display with host

· Full graphics support.



Macro Keys dialog box    

Use this dialog box to automate sessions with online services by sending text, executing programs, or running a script using 
keystrokes you pre-define here.



Activity Log Processing      

Use the Activity Log Processing dialog box to create a report from a session log and to delete or archive log data.    Using 
pcANYWHERE’s log processing, you can track user access for billing or security purposes. After the report is created, you can 
view it or print it.

To process a session log:

1 Log To Process: Select the type of log from which you want to create a report.
· Remote Session Log: Record of calls made from your remote.
· Host Session Log: Record of calls made to your host. 
· Remote History Log: Archived data from remote session logs.
· Host History Log: Archived data from host session logs.

2 Click either:
· Report: Displays the Select Destination File for Output dialog box which is a standard browse dialog box. Enter .LOG 

filename to create a new report. You then have the option to view and then print the report.
· Archive/Delete: Displays the Archive/Delete Host/Remote Log dialog box when the log to process is the remote session log 

or host session log. Use it to archive or delete data from a remote or host session log.



Archive/Delete Host/Remote
Use this dialog box to move older log information (specified by date) into an archive file. The information is preserved in case you
need to reference it at a later date. You can also delete information instead of archiving it. 

Date Range
Start: Enter the starting date: year, month and day.
End: Enter the ending date: year, month and day.

Delete Log Entries from source: Check to remove the original log entries from the log file and reduces the size of the 
log file. 
Copy Log Entries to archive file: Check to store old log entries in a separate compressed archive file.



Session Log Report

Set options here to format your session log report for sessions either as a host or a remote Pc.

To format your session log report:

1 Choose a report type from the available options: 

2 Set the data range to include sessions from the time period you want:

3 Check options to include the fields you want in either the Remote Options or the Host Options column and click OK.

You are prompted to choose whether to view the report at this time.    If you do, the Script Editor window opens and displays the 
report.



Playback Options                

Set options here for the playback of a session you have recorded:

Check Control Panel to display the Playback Control Panel during the playback.

Choose which session in the record file you want to begin viewing.

Choose whether to play the session over and over, to play all sessions in the record file over and over, or to 
stop after each session.

Choose the speed of the playback.    (You can also change this using the Playback Control Panel during the 
playback.)



 Playback Control Panel      

Topic under development.



AutoXfer contents tab

The contents tab displays the location and filename of the selected AutoXfer procedure and lists the file transfer commands in 
the procedure.

    To add commands to this procedure click:

    To delete commands in this procedure, select the command and click:

    To edit a command in this procedure, select the command and click:

    To position a command in the correct order of execution select the command and click:

    or    

File transfer commands are run in the order they are list, from top to bottom.



AutoXfer options tab

File transfer options can be changed for this AutoXfer procedure only.

    To use the default settings in the Application Options, File Transfer property page:

    To change the default settings for this AutoXfer procedure:

    To change the file overwrite option:

If you want this procedure to run unattended, it is important that you select an automatic file overwrite option. If 
you use the default setting of Verify before overwriting, the AutoXfer procedure will stop and wait for confirmation before continuing..

    To compress the file before sending:

    To enable crash recovery: 

    To enable SpeedSend.  



    To check downloaded files for viruses:

Infected files are deleted.

    To automatically end the session after the AutoXfer procedure ends:

When you choose to automatically end the session, pcANYWHERE ignores all file transfer errors to prevent an 
unattended procedure from pausing when errors are encountered. The command generating the error is skipped and the procedure 
continues with the next command. To verify which commands were transferred, enable the Session Log File option in the Automated
Tasks property page.



Script dialog box 

From the Scripts dialog box, you can create a new script, or select a script you have already created and edit, compile or run it. 
Or, you can select an existing script file to run after connecting with a specific host or online service.

This dialog box contains a list box of all currently defined scripts, with a short description of each. Directly beneath the list box is 
the Script Path text box. If your script files are located in a folder other than the one displayed, you can change folders using the 
Browse button.

To perform an action on a script:

1 Choose a file in the list box.
2 Click either Edit, Compile, Run or Select to perform that function on the selected script.



File Manager window

Perform file transfer functions during remote control sessions from this window.    You can:
· move, copy, or sort files on both the remote PC and the host PC.
· rename files on either PC.
· filter the display of files in this window so that only certain types of files appear.
· transfer entire folders and the folders within them, or selected files.
· make folders on both PCs identical to each other, by synchronizing or cloning their contents.    (Read all information on these 

procedures before performing.)

Files on your PC display on the left side of this window.    Files located on the PC to which you are connected 
display on the right side.

Click 

 to change the direction of file transfer.



Select ASCII Data File dialog box (Standard Browse)
Use this dialog box to save screen data to an ASCII file.

File Name: Type or select the filename you want to open. This box lists files with the extension selected in the List Files 
of Type box.
List Files of Type: Select the type of file you want to open. 

ASCII Data Files (*.TXT): Lists all files in the current folder that were saved with a *.TXT extension.
Drives: Select the drive in which pcANYWHERE stores the file. 
Folders: Select the folder in which pcANYWHERE stores the file. 



Begin File Transfer dialog box

Click OK to confirm the transfer of files to and from the drives indicated here.



Create Folder dialog box
Use this dialog box to create a new folder. 

Folder: Displays the current folder. If a filename is entered without a drive and path, it is assumed to be created in the 
folder listed here.
New Folder: Enter the new folder name. 



Rename dialog box
Use this dialog box to rename a folder or a file. 

Folder: Displays the current folder. If a filename is entered without a drive and path, it is assumed to be in the folder 
listed here.
Rename: Enter the file or folder to rename. 
To: Enter the new filename or folder name. 



Delete dialog box
Use this dialog box to remove one or more folders or files. 

Folder: Displays the current folder. If a filename is entered without a drive and path, it is assumed to be in the folder 
listed here.
Delete: Enter the file or folder to delete. You can use wildcard file specifications in the text box. If you have selected 
more than one file, this line confirms how many files the command affects. 
Include Subfolders: Check only when deleting an entire subtree of folders. If you have a folder name alone or a 
wildcard file specification in the Delete text box, this deletes all matching files in the specified folder and all of its 
subfolders.



Copy dialog box
Use this dialog box to make copies of files on the local drive. To save time when using this dialog box, select the folder or file to 
copy in the pcANYWHERE File Manager window before choosing the File Local Copy command or clicking the Local Copy 
button. 
TIP: To skip this dialog box, select the file or files to copy and drag them to the desired destination. 

Folder: Displays the currently selected folder. 
Copy: Enter the source drive, folder, and filename of the files you want to copy. The source drive is the drive you are 
copying from.
To: Enter the destination drive, folder, and filename. Or, click the prompt box or press Alt+DownArrow to choose from a 
list of previously specified destinations. The destination drive is the drive you are copying to.



Change Folder dialog box
Use this dialog box to change to a different folder.



Clone dialog box
Use this dialog box to make the source and remote folders identical through cloning. This process transfers and deletes files to 
make your current remote folder identical to the host source folder. Files in the source folder that are not in the destination folder 
are transferred.    

Files in the destination folder that are not in the source folder are deleted.
Source: The name of the host or remote computer appears here, depending upon which of the two folder was first 
selected. The folder and file specification appears beneath the computer name for verification purposes.
Destination: The name of the computer whose folder was next selected. The folder and file specification appears 
beneath the computer name for verification purposes.

Include Subfolders Check to clone subfolders of the source folder.

NOTE: You can also make host and remote folders identical using the Synchronize command.



Synchronize Folder dialog box
Use this dialog box to make the host and remote folders identical through synchronization. Files that exist on the host but not on 
the remote are copied to the remote; similarly, files that exist only on the remote are copied to the host.

From: The name of the host or remote computer appears here, depending upon which of the two folders was first 
selected. The folder and file specification appears beneath the computer name for verification purposes.
To: The name of the computer whose folder was next selected. The folder and file specification appears beneath the 
computer name for verification purposes.

Files
All Files Synchronize to include all files on both the remote and host folders.
Selected Files Synchronize to include only selected on both the remote and host folders.

Include Subfolders Check to synchronize all subfolders of the selected host and remote folders.

NOTE: You can also make host and remote folders identical using the Clone command.



Select Some dialog box
Use this dialog box to select files in the active remote or Host file list box using a wildcard file specification.

Folder: Displays the name of the currently selected folder. You must change folders within the file list box.
File: Enter one or more file specifications, separated by spaces or commas. For instance, entering *.WK?, *.XLS filters 
out all files except for Lotus 1-2-3 and Excel spreadsheet files. Or, to select a previously used file specification, click on 
the drop-down list box or press Alt+DownArrow to display a drop-down list box.



File Transfer Options dialog box
Use this dialog box to control how aspects of file transfer should be handled.

Destination File: Select the method by which pcANYWHERE decides to overwrite duplicate files in the destination 
folder. Normally you should require verification before overwriting files. If you intend to overwrite a large number of files 
you may want to overwrite automatically or overwrite older files only.

Never Overwrite Duplicate Files: Does not overwrite duplicate files in the destination folder.
Always Overwrite Duplicate Files: Automatically overwrites duplicate files in the destination folder.
Verify Before Overwriting: Asks you for confirmation before overwriting a duplicate file.
Always Ask for Destination: Asks you where to place the file.
Overwrite Older Files Only: Automatically overwrites duplicate files that are older than the file you are transferring.

Use Compression: Check to compress files during transfer. Files are compressed during transfer to improve speed, but
are automatically uncompressed to their original state before being written to the destination drive.
Allow Crash Recovery: Check to allow reconnection and continued file transfer from the point at which file transfer was
interrupted.

Use SpeedSend :    Check to use pcANYWHERE’s SpeedSend

 to accelerate transfer to a location where earlier versions of the same files have been sent previously.



Terminal window

Conduct sessions with online services from this window.

You can adjust terminal emulation and file transfer protocol settings during your session.    (Click the How do I... 
button above for more information.)



Hardware Settings dialog box
Use the Hardware Settings dialog box to change certain communications parameters while remaining connected to an online 
service.
Settings group box

Data rate drop-down list box: Select the highest speed (in bps) at which your modem and COM port can transmit and 
receive data. If you connect to a slower modem, your modem automatically adjusts its speed. 
Parity: Select the type of error checking performed during the communications session. This setting must match that of 
the computer to which you are trying to communicate. You may need to check with the system administrator of the 
online service to determine the correct setting.

<None>: No parity error correction is used. Use this method for connecting to most bulletin boards (BBSs). This is the 
equivalent to 8 data bits, no parity, and 1 stop bit—also known as 8,n,1.

Odd: A parity bit is added to the bits that make up each character to adjust the number of 1’s in each set of bits to an odd 
number. Use this method when required by an online service. This is also known as 7, O, 1. 

Even: A parity bit is added to the bits that make up each character to adjust the number of 1’s in each set of bits to an even 
number. Use this method when required by on-line services such as CompuServe. This is also known as 7, E, 1. 

Mark: A parity bit is used and is always set to 1. Use this method when required for communications with mainframe or 
minicomputers.

Space: A parity bit is used and is always set to 0. Use this method when required for communications with mainframe or 
minicomputers.

Flow Control: Select how to regulate the flow of data between computers. This prevents data loss when data is sent 
faster than the receiving computer can handle. This is sometimes called handshaking. You may need to check with the 
system administrator of the online service to determine the correct setting.

<None>: No flow control is used. Use this if your modem is operating below 9600 bps.
XONXOFF: Uses software to send control codes between machines to pace the flow of data. Also called software flow control. 

Use this when required by an online service.
RTS/CTS: Uses the RTS and CTS lines of the RS-232 interface to pace the flow of data. Also called hardware flow control. 

This is the method used by most high-speed and error-correcting modems, and is usually the correct choice for connecting 
with online services.

Both: Uses both software and hardware flow control. Use this when required by an online service.



Terminal Settings dialog box
Use the Terminal Settings dialog box to change the terminal emulation type or re-configure the current terminal emulation type 
options while remaining connected to an online service. 

Emulation: Select the type of terminal emulation as required by the online service to which you are connected.
Choose Font: Displays Font dialog box.

Options
Line wrap: Advances the cursor to the first column of the next line, when it reaches the last screen column. If this option
is disabled, the cursor will stay in the last column and each new character will overwrite the previous one.
Destructive BS: Causes the backspace key to delete characters as it moves the cursor to the left. This works like 
sending a destructive backspace code (127). If disabled, the backspace key will move the cursor to the left without 
deleting a character. This works like sending a non-destructive backspace code (08). 
Screen wrap: Advances the cursor to the first column of the first row when it reaches the last column of the last row. 
Subsequent text will overwrite whatever appears on the first row. If disabled the top line of the display scrolls upward, 
out of view when the screen is filled, making room for an additional line of text at the bottom.
CR to CR/LF: Moves the cursor down one line after processing the carriage return code. If disabled, the cursor moves 
to the first position on the current line.

Advanced Options
Macro Keys: Enables the user-defined macro keys. Macro keys can be defined to transmit a string of commands, start 
a script or run a program on the online service.
Translation Tables: Uses the translation table specified in the Advanced Settings for Online Service dialog box. 
Translation tables redefine the hexadecimal codes of incoming or outgoing characters. A translation table allows you to 
make a terminal emulation match specific online service requirements. 



Font dialog box
Use the Font dialog box to change the current terminal emulation font type. 

Font: Select the name of a font to be used to display text in the Terminal window.
Font Style: Select the style to be applied to the selected font, such as bold or italic.
Size: Select the size of the type to be used to display text in the Terminal window.
Sample: Displays a type sample using the selected font, style and size.



Display Settings dialog box
Use the Display Settings dialog box to set certain Terminal window display options while connected to an online service. 

Vertical Scroll Bar: Enables the vertical scroll bar that is used to view text that has scrolled vertically out of view in the 
Terminal window.
Horizontal Scroll Bar: Enables the horizontal scroll bar that is used to view text that has scrolled horizontally out of 
view in the terminal Window.
Status Bar: Enables the Terminal window status bar which indicates the current settings for terminal emulation type, 
COM port, parity and flow control.



Select Files For Transfer dialog box (Standard Browse)

Use this dialog box to send or receive files from an online service.
Sending Files

File Name: Type or select the name of the file or files to send to the online service. If you have selected YMODEM or 
ZMODEM as your file transfer protocol, you may select more than one file and transfer them as a group. This is called a 
batch transfer. 
List Files of Type: Select or enter the type of file you want to display in the list box. 

File Transfer (*.*): Lists all files in the current folder.
Drives: Select the drive on which the files are stored. 
Folders: Select the folder in which the files are stored.

Receiving Files
File Name: The text box displays the name of the file that you have requested from the online service. The list box 
displays the contents of the folder on your computer to which the file will be saved.
List Files of Type: Select or enter the type of file you want to display in the list box. 

File Transfer (*.*): Lists all files in the current folder.
Drives: Select the drive to which you wish to save the file downloaded file.
Folders: Select the folder in which you wish to save the file downloaded file.



File Transfer Protocol dialog box

Protocols
Select a protocol to use for file transfer.

XMODEM: A commonly used file transfer protocol that transfers one file at a time in blocks of 128 bytes. Do not use 
when transferring files with CompuServe or over asynchronous outdial networks like Tymnet.
XMODEM-CRC: A modified version of the original XMODEM with better error correction. Do not use when transferring 
files with CompuServe or over asynchronous outdial networks like Tymnet.
XMODEM-1K: A modified version of the original XMODEM that transfers files in 1024 bytes. Do not use when 
transferring files with CompuServe or over asynchronous outdial networks like Tymnet.
XMODEM-1K-G: A version of XMODEM 1K without error correction. Select only when both you and the Online Service 
are using error-correcting modems which use MNP or V.42 error correction. Do not use when transferring files with 
CompuServe or over asynchronous outdial networks like Tymnet.
YMODEM (batch): Features high reliability, 1024 byte transfer packets and multiple file transfers with a single command
(batch transfers).
YMODEM-G (batch): Features 1024 byte transfer packets and multiple file transfers with a single command (batch 
transfers), without error correction. Select only when both you and the Online Service are using error-correcting 
modems which use MNP or V.42 error correction. 
ZMODEM: A very reliable feature packed file transfer protocol. Its extremely robust error correction make it an excellent 
choice where excessive line noise is a problem. Protocol options may be specified in the Settings Dialog group box.
KERMIT: Originally developed for communication between mainframe computers, this popular public domain protocol 
has been adapter for use on virtually every type of computer.
ASCII: Refers to the transmission of plain text files using minimal error correction. Protocol options may be specified in 
the Settings Dialog group box. It is usually preferable to use a binary file transfer protocol (those listed above) if it is 
available.

Settings (ZMODEM)
Both ZMODEM and ASCII protocol selections have user defined settings.

Error Checking: Select 32-bit or 16-bit. 32-bit error checking offers the highest level of error correction.
Data Window: Select None, 2K or 4K. Use of a Data Window increases reliability, by pausing for an acknowledgment 
from the receiving computer after a specified amount of data has been sent. Select None to halt transmission only when 
a negative acknowledgment (NAK) is received by the sending computer.
Crash Recovery: Allows interrupted file transfers to be restarted without data loss.
Allow Auto Downloading: Allows the online service to send files selected for transfer without remote user initiation of 
the Receive File command.

Settings (ASCII)
Pacing

Pacing specifies a delay after each line or character that is sent.
Character: Enter the number of tenths of seconds to pause after a character is sent.
Line: Enter the number of tenths of seconds to pause after a line is sent.
Pace Character: Enter the ASCII value of the character that causes transmission to pause until the character is 
received.

Download: Enter the maximum number of seconds of inactivity before transfer is terminated.
Upload Translations

Upload and Download Translations compensate for differences in how carriage returns and linefeeds are handled on 
different systems. When uploading files (transferring files to the online service), specify how to treat these characters.
CR: Select the way to handle a carriage return.

None: Transmits the character as itself.
Strip: Removes the character from the transmission.
Add LF: Adds a linefeed to the character as it is transmitted.

LF: Select the way to handle a linefeed. Select None, Strip or Add LF.
Download Translations

When downloading files (transferring files from the online service), specify how to treat these characters.
CR: Select the way to handle a carriage return. Select None, Strip or Add LF.
LF: Select the way to handle a linefeed. Select None, Strip or Add LF.



Search for Text dialog box

Topic under development.



Windows System Key Pressed dialog

Topic under development.



 Save Recorded Script dialog box

Topic under development.



Administrator Password

This dialog box displays the first time you run pcANYWHERE on a workstation where a network installation took place.    You 
must set a password here to access administrative features within the pcANYWHERE program.    

Any user running pcANYWHERE on this machine will be prompted for the password you record now.    This password is case-
sensitive.

To record the administrator password:

1 Type the password you want: 

2 Re-type the same password, remembering that administrator passwords are case-sensitive: 

If you click OK without entering a password, any user running pcANYWHERE can access administrative 
features on this machine.

If you assign a password and another user who does not know it runs pcANYWHERE on this machine, he or 
she can click OK to bypass the password prompt and still use the program -- without administrative features. 



Network Host mode        

Check this option:

to allow pcANYWHERE users on your network to display and use folder tools on their toolbar when in the host mode.

If you check this option, users can choose any folder to store their host connection items, and use items stored 
by other users in folders to which they have access.

Users may choose to display the folder tools in the Button Bars tab, but if you leave this item unchecked, the 
tools will not display in the host mode.

Choose a default folder to store host connection items for all pcANYWHERE users on your network.



Network Remote mode 

Check this option:

to allow pcANYWHERE users on your network to display and use folder tools on their toolbar when in the remote control mode.

If you check this option, users can choose any folder to store their remote control connection items, and use 
items stored by other users in folders to which they have access.

Users may choose to display the folder tools in the Button Bars tab, but if you leave this item unchecked, the 
tools will not display in the remote control mode.

Choose a default folder to store remote control connection items for all pcANYWHERE users on your network.

The options you choose on this tab also affect the use of file transfer connection items for all users.



Network Gateway mode 

Check this option:

to allow pcANYWHERE users on your network to display and use folder tools on their toolbar when in the gateway mode.

If you check this option, users can choose any folder to store their gateway connection items, and use items 
stored by other users in folders to which they have access.

Users may choose to display the folder tools in the Button Bars tab, but if you leave this item unchecked, the 
tools will not display in the gateway mode.

Choose a default folder to store gateway connection items for all pcANYWHERE users on your network.



Network Online mode 

Check this option:

to allow pcANYWHERE users on your network to display and use folder tools on their toolbar when in the online service mode.

If you check this option, users can choose any folder to store their online service connection items, and use 
items stored by other users in folders to which they have access.

Users may choose to display the folder tools in the Button Bars tab, but if you leave this item unchecked, the 
tools will not display in the online service mode.

Choose a default folder to store online service connection items for all pcANYWHERE users on your network.



Computer Name Selection    

Choose this option:

to allow any network user of pcANYWHERE to change the name identifying his or her PC in remote control sessions.    (The user
sets this name in the System Setup tab of the Application Options dialog box.)



List of network hosts

You are using a network connection device to establish a remote control session.

Click an available host or gateway, then click OK.
A host or gateway displaying with this symbol is not available at this time, although it is active on the network.

A host that is in conference with one or more remote callers.

A host or gateway displaying with this symbol may be available to you.



Host online menu

Choose one of the following options from the host online menu:

End session - To disconnect from the remote PC.

File Transfer - To open the File manager window on either the host or remote in order to send files from one 
PC to the other.

Chat - To open a Chat window to type a conversation with a user at the remote PC.



Chat window

To chat with a user at the other PC:
1 Type your comments to the user at the PC to which you are connected. 
2 Press Enter to send your comments to that user. 
3 When you are finished chatting, close the Chat window.    

Closing the window on the remote PC automatically closes it on the host PC.    



Dial-Up Networking dialog box

Uncheck Do remote Control over remote networking if you want to initiate a remote networking session only.

If you do want to initiate a remote control session on top of the remote networking connection, click Remote 
Control Settings to set the properties of the remote control connection item.



Comment dialog box

under development.



Advanced Modem Options dialog box

under development.
This is a test, this is a test.



Host Operations Tab

Use the Host Operations tab to set the number of rings before the host answers a call and to change the selected video mode. 

Ring number to answer on

Type the number of rings after which the host answers an incoming call. Type a value between 1 and 99.

Video mode selection

Default (Accelerator enabled): Maximizes the performance of a pcANYWHERE32 remote control connection. This is the 
preferred video mode and should be selected unless you experience video problems on the host.
Accelerator disabled:    Select this option if the host is using a 3D accelerator video card.    NOTE: This option is only available 
for Windows 95 hosts.
Compatibility:    Select this option if you experience incomplete or distorted video display when connected to the host..



NASI Port list box

You are using NASI to establish a remote control session.

This dialog box displays a list of available NASI ports.

Click an available NASI port,    then click OK.

A host or gateway displaying with this symbol is not available at this time, although it is active on the network.

A host that is in conference with one or more remote callers.

A host or gateway displaying with this symbol may be available to you.



The pcANYWHERE Script Editor: Help Contents

Script Editor Commands 
Script Commands: Listed Alphabetically
Script Commands: Listed by Function

Text Editor Functions
Reference
Editor Functions:    Functional Groups
List of Editor Procedures
The pcANYWHERE Editor Keys

Procedures
Using the pcANYWHERE Editor
Customizing the pcANYWHERE Editor
Customizing Editor Keystrokes
Comparing Two Files
Finding Which Key Performs an Editor Function
Printing All of or Part of a Document
Searching for Files That Contain Specific Text
Searching for Specified Text in an Open Document
Searching with Regular Expressions
Using Editor Macros
Using Multiple Edit Windows

Menu Commands
File
Edit
Search
Options
Window



The pcANYWHERE Editor Menu Commands

File menu
New
Open
Close
Save
Save As
Save All
Insert
Revert
Write Block
Page Setup
Print
Compare
Exit
(list of files)

Edit menu
Undo
Cut
Copy
Paste
Delete
Select All
Time/Date
Wrap Paragraph
Word Wrap
Record Macro
Playback Macro

Search menu
Find
Find Again
Replace
Find Files Containing
List Found Files
Goto Line

Options menu
Document Preferences
Editor Preferences
Key Assignments

Tool menu
Reference

Window menu
New Window
Cascade
Tile
Arrange Icons
(list of windows)



See Also

Using the pcANYWHERE Editor
Text Editor Functions



The File menu
Commands in this menu let you create, edit, and print script files as well as providing access to other file-related 
functions.
New Create a new script file.
Open Open an existing script file.
Close Close the active editing window.
Save Save file in the active editing window.
Save As Save file in active editing window using different name.
Save All Save all open files.
Insert Insert contents of a file at cursor position.
Revert Undo all changes since last save.
Write Block Write selected block to a file.
Page Setup Set headers, footers, margins, etc.
Print Print current script file.
Compare Compare contents of two files.
Exit Close the pcANYWHERE Editor windows and exit.
(list of files) Open or activate a recently used file.



New command (File menu)

Function name: new_file
Default keys: Alt+F,N

This command opens a new untitled editing window. Use the Save or Save As… command to assign a name to 
the file.



Open command (File menu)

Function name: open_file
Default keys: F3

This command displays an Open File dialog box. Use it to select a file to edit.



Open File dialog box (Standard Browse)
Use this dialog box to open an existing script file for editing.
File Name:    Type or select the filename you want to open. This box lists files with the extension selected in the 
List Files of Type box.
List Files of Type:    Select the type of file you want to open
Script Files (*.SCR):    Lists all files in the current folder that were saved with an *.SCR extension.

Drives:    Select the drive on which the file you want to open is stored.
Folders:    Select the folder in which the file you want to open is stored.



Close command (File menu)

Function name: close_window
Default keys: Alt+F,C

This command closes the active editing window.
If you have modified the file and not yet saved your changes, (and it is not open in any other editing window), 
then the pcANYWHERE Editor prompts you to save your changes before it closes the file.



Save command (File menu)

Function name: save_file
Default keys: F2

This command immediately saves the file in the active window.
If the file does not yet have a name, a Save As... dialog box appears and prompts you for a path and filename.



Save As dialog box (Standard Browse)
Use this dialog box to specify a path and filename under which to save your script file.
File Name:    Type or select the filename under which you want to save your script. This box lists files with the 
extension selected in the List Files of Type box.
List Files of Type:    Select the type of file to save. If you are saving a script file, be sure to specify an extension 
of .SCR.
Script Files (*.SCR):    Lists all files in the current folder that were saved with an *.SCR extension.

Drives:    Select the drive on which you want to store your script file.
Folders:    Select the folder in which you want to store your script file.



Save As command (File menu)

Function name: (none)
Default keys: Alt+F,A

This command displays a Save As... dialog box. Use it to select a new path and filename for the file displayed in 
the active editing window.
You can use this command to save the file with a new name; for example, make a backup of your file by saving it
under a different name.



Save All command (File menu)

Function name: save_all
Default keys: Alt+F,L

This command saves all open files.
If any windows are untitled, a Save As... dialog box appears. Use this to specify a path and filename for any 
open, untitled files.



Insert command (File menu)

Function name: (none)
Default keys: Alt+F,I

Use this command to insert the contents of one file into another. The file is inserted at the current cursor 
location.
An Insert File dialog box appears and prompts you for the name of the file to insert.



Insert File dialog box (Standard Browse)
Use this dialog box to specify the file to be inserted at the current cursor position.
File Name:    Type or select the name of the file you want to insert into the active editing window.
List Files of Type:    Select the type of files to display. Script source files have an extension of .SCR.
Script Files (*.SCR):    Lists all script files in the current folder.

Drives:    Select the drive on which the desired file is stored.
Folders:    Select the folder in which the desired file is stored.



Revert command (File menu)

Function name: revert
Default keys: Alt+F,V

This command undoes all editing changes since the file was last saved. Before reading the file from disk, the 
pcANYWHERE Editor displays a confirmation box, allowing you to cancel the operation.



Write Block command (File menu)

Function name: (none)
Default keys: Alt+F,W

This command copies the currently selected text to a file. It is enabled only when text is selected.
When the Write Block... dialog box appears, specify a path and filename under which to save the text.



Write Block dialog box (Standard Browse)
Use this dialog box to specify the path and filename under which to store the selected text.
File Name:    Type or select the name of the file under which you want to save the selected text.
List Files of Type:    Select the type of files to display. Script source files have an extension of .SCR.
Script Files (*.SCR):    Lists all script files in the current folder.

Drives:    Select the drive on which to store the new file.
Folders:    Select the folder in which to store the new file.



Page Setup command (File menu)

Function name: (none)
Default keys: Alt+F,G

This command displays a Page Setup dialog box which lets you select a paper size, font, margins, and header 
and footer text to be used when files are printed.    You can also select a printer.
Use the File Print command to print the document.



Page Setup dialog box

Use this dialog box to set page formatting options, preview a print job, and select a printer. These settings take 
effect the next time you use the Print command.

Preview area
Displays thumbnail view of print job with options (below) as currently selected.

Paper Size and Source
Choose paper size and source (tray, manual feed, and so on).

Header and Footer:
Enter one line of text to be centered at the top (a header) and/or bottom (a footer) of each page. Or, click the prompt button (or 
press Alt+ ) to choose from a list of previously-used settings.
You can embed the following special-purpose codes in the text:

%f Full path and filename of active document
%d Current date and time
%p Current page number

To omit a header or footer, leave its text box empty.
In addition, choose a previous header or footer code from the list of options available from the drop-down list.

Margins:
Set the print margins. The units of measure are the standard units used in your country (inches or centimeters), as set in the 
Windows Control Panel.

Font:
Click this to display a Printer Font dialog box which lets you choose a typeface and size for the printed output. The entire 
document, including headers and footers, uses the selected font. The specified settings are used for the current session and all 
subsequent sessions, until changed.

See Also

Printing a Document
Printing a Block of Text
The File Print command
Printer Font dialog box



Printer Font dialog box

Use this dialog box to choose a typeface and size for your printed output. The Printer Font dialog box appears 
when you click the Font... button from the Page Setup dialog box.

Font:
Choose from the list of available fonts. Only fonts available for the current printer are shown (use the Printer Setup command on 
the File menu to choose a different printer and the Windows Control Panel to install additional fonts).

Size:
Select from the list of available sizes for the currently-selected font.

See Also

Printing a Document
The Page Setup command
The File Print command



Print command (File menu)

Function name: print
Default keys: Alt+P or Alt+F,P

If text is selected in the active window, this command sends the selected text to the default printer.
If no text is selected, the entire file is printed.
Use the Page Setup… command to select a printer and specify print options before using this command.



Compare command (File menu)

Function name: compare
Default keys: Alt+F,E

This command displays a Compare dialog box which lets you select two files to compare.
If either file is currently open, the pcANYWHERE Editor uses the version which is in memory, rather than reading 
the file from the disk. If you want to pinpoint recent changes, first save the open file under a different name (use 
the Save As... command), then compare it to the file on disk.
The pcANYWHERE Editor performs the comparison on a line-by-line basis. Both files are displayed and the first 
mismatch is highlighted.



Compare dialog box

Use this dialog box to choose two files to compare, their starting line numbers, and how to display the ouput. The
Compare dialog box appears when you choose Compare from the File menu. 

File 1 and File 2:
Enter the names of the files to compare.

Or, click the prompt button (or press Alt+ ) to choose from a list of previously-used files.
Or, click Browse... to locate the desired files.

Line:
To compare all lines in both files, use the default setting of 1. Otherwise, specify a starting line number for each file.

Display:
Select an option button:
* Horizontal: The files are displayed one above the other.
* Vertical: The files are displayed side-by-side.

Browse:
Click this button to display a Compare dialog box which helps you locate a desired file. The selected file is displayed in the File 
text box which is active.

See Also

Comparing Two Files
The File Compare command



Exit command (File menu)

Function name: exit
Default keys: Alt+F4 or Alt+F,X

This command closes all pcANYWHERE Editor windows and exits.
The pcANYWHERE Editor prompts you to save changes you have made to any open file.



List of files (1 to 4) (File menu)

Function name: (none)
Default keys: Alt+F,1...4

This command lets you quickly open a recently edited file. The last four files edited appear at the bottom of the 
File menu. To open one of these files, press Alt+F then 1, 2, 3, or 4.
If the selected file is currently in memory, its window is brought to the front. You can also activate any open or 
minimized window by selecting it from the Window menu.



The Edit menu
Commands in this menu provide text editing tools,access to the clipboard, and keyboard macro control.

Undo Undo the most recent text-editing change.
Cut Copy the current selection to the clipboard and then delete that text.
Copy Copy selected text to the clipboard.
Paste Paste clipboard contents to the cursor position.
Delete Delete current selection.
Select All Select all text in the active file.
Time/Date Insert the current date and time at the cursor.
Wrap Paragraph Reformat the paragraph at the cursor, wrapping at the current margin settings.
Word Wrap Toggle automatic paragraph wrapping on or off.
Record Macro (toggles to Stop Recording Macro) Record subsequent keystrokes for automatic recall.
Playback Macro Replay the keystrokes saved during the most recent Record Macro command.

By default, the pcANYWHERE Editor uses standard keystrokes for text selection and clipboard operations. 
However, you can assign different (perhaps more convenient) keystrokes to these functions. See Customizing 
Editor Keystrokes for details.



Undo command (Edit menu)

Function name: undo
Default keys: Alt+BkSp or Gray *

Reverses the effects of a previous editing operation. Each Undo reverses the effects of one editor function or 
keystroke. The number of operations that can be undone is specified in the Editor Preferences dialog box (from 
the Options Menu).
Only changes made since a file was last saved can be undone.



Cut command (Edit menu)

Function name: cut
Default keys: Shift+Del or Gray -

Deletes the selected text from the active window and moves it to the clipboard.
If no text is selected, and if the Cut/Copy Current Line if No Text is Selected check box in the Editor Preferences 
dialog box is checked, the current line is cut.
Use the Copy command (on the Edit menu) if you want to copy the selection to the clipboard without deleting it. 
Use Delete if you want to discard the line without changing the contents of the clipboard.



Copy command (Edit menu)

Function name: copy
Default keys: Ctrl+Insert or Gray +

Copies the selected text from the active window into the clipboard.
If no text is selected, and if the Cut/Copy Current Line if No Text is Selected check box in the Editor Preferences 
dialog box is checked, the current line is copied.



Paste command (Edit menu)

Function name: paste
Default key: Shift+Insert

Inserts the contents of the clipboard at the current cursor position.



Delete command (Edit menu)

Function name: delete
Default key: Del

Deletes the currently selected text. If no text is selected, deletes the character to the right of the cursor.
Use the Cut command (on the Edit menu) if you want to copy the selection to the clipboard and simultaneously 
delete it from your file.



Select All command (Edit menu)

Function name: select_all
Default key: Alt+E,A

Selects all text in the active window. The cursor is moved to the end of the file.
This is the same as pressing Ctrl+Home and then Shift+Ctrl+End.



Time/Date command (Edit menu)

Function name: stamp
Default key: Shift+F2

Inserts the date and time at the cursor location.



Word Wrap command (Edit menu)

Function name: toggle_wordwrap
Default key: Ctrl+W

Enables or disables word wrap in the active window. Word wrap is used when writing narrative paragraphs; turn 
this feature off when writing program source code or creating formatted tables.
When word wrap is enabled, typing beyond the right margin causes the current word to be moved down to the 
next line. The word WRAP appears on the status line.
The right margin setting can be changed from the Document Preferences dialog box dialog box on the Options 
menu.
Use the Wrap Paragraph command on the Edit menu to reformat a paragraph and wrap all lines at the margin.

The pcANYWHERE Editor displays text using a monospaced 
font, so word wrapping is based on a uniform character width. 
If you use a proportional-spaced font when you print the 
document, the right edge appears more ragged in the printout
than it does on the screen.

Wrap Paragraph command (Edit menu)

Function name: wrap_para
Default key: F12

Reformats the current paragraph (or the previous paragraph, if the cursor is between paragraphs) so that all the 
words fit within the margins. The cursor moves to the end of the paragraph.
This command does nothing if word wrap is turned off. Use the Word Wrap command (on the Edit menu) to 
enable this feature.
Word wrap is used when writing narrative paragraphs. Don't use this feature when writing program source code 
or creating formatted tables.
Change the margin settings from the Document Preferences dialog box. To display this dialog box, choose 
Document Preferences from the Options menu.



Record Macro command (Edit menu)

Function name: record_macro
Default key: F7

Begins or ends a keyboard macro definition. While recording a macro, REC appears on the status line, and the 
menu command toggles to Stop Recording Macro. All keystrokes and functions are recorded until you choose 
Stop Recording Macro from the Edit menu.
You can use the Playback Macro command to replay the recorded sequence.
See Using Keyboard Macros for related details.



Play Back Macro command (Edit menu)

Function name: play_macro
Default key: F8

Replays the sequence of keystrokes and functions saved by the Record Macro command.
See Using Keyboard Macros for related details.



The Search Menu

Commands in this menu let you search for text in the current file or in a set of files on disk. They also provide a 
quick way to move to a line given its line number.

Find Search for text or a regular expression.
Find Again Continue search started with the Find command.
Replace Search for and replace text or regular expression.
Find Files Containing Generate a list of files which contain the specified text or regular expression.
List Found Files See a list of files found; choose one to edit.
Goto Line Move the cursor to a line specified by its line number.



Find command (Search menu)

Function name: find
Default key: Ctrl+S

This command searches the active document for specified text or a regular expression. It displays the Find dialog
box which lets you specify search criteria such as what text to find and in which direction to perform the search. 

If you select text before choosing this command, the 
selected text appears as the default search string in the 
dialog box.

The search commences at the current cursor location of the active document. If the search is successful, the 
matcing text is highlighted. If it fails, the status line displays the message Pattern not found.

The pcANYWHERE Editor cannot find text that spans
two lines.



Find dialog box

This dialog box appears when you choose the Search Find command. Use it to specify the text you want to find 
and in which direction to perform the search.

Pattern:

Enter the text you want to find, or click the prompt button (or press Alt+ ) to choose from a list of previously-used 
search strings.
If you want to use regular expression wildcards in your search string, check the Regular Expression check box.

By default, the pcANYWHERE Editor uses any currently selected text as the search 
string.
The pcANYWHERE Editor cannot find text that spans two lines.

Match Upper/Lowercase:
When this check box is checked, the pcANYWHERE Editor checks the case of the text in the Pattern combination box and 
returns only exact matches.
When cleared, the editor considers text a match even when the case is not the same. For example, goto matches GOTO and 
Goto.

Regular Expression:
Check this if you want to enable the powerful and flexible regular expression pattern matching. Leave this unchecked (for speed) 
if you simply want to locate a string.

Next:
Click this or press Enter to confirm your settings and begin searching forward from the cursor location. If a match is found, the 
found text is highlighted.

Previous:
Click this to confirm your settings and begin searching backward from the cursor location.

See Also

Searching with Regular Expressions
Finding Files that Contain Specified Text
Search Functions



Find Again command (Search menu)

Function name: find_again
Default key: Ctrl+A

This command continues the search begun by the Search Find command. The search resumes from the current 
cursor position in the active document and proceeds in the direction previously specified.
If the search is successful, the matching text is highlighted. If it fails, the status line displays the message 
Pattern not found.



Replace command (Search menu)

Function name: replace
Default key: Ctrl+R

This command displays a Replace dialog box which lets you find and replace occurrences of text with different 
text. You can also perform a search and replace on a regular expression.

If you select some text before using this command,
that text appears as the default search string in 
the dialog box.

The search commences at the current cursor location of the active document. If the search succeeds (and if you 
checked the Confirm Changes check box), the matching text is highlighted and you can choose to replace or skip
each occurrence. The status line reports how many changes were made.
If the search fails, the status line displays the message Pattern not found. 

The pcANYWHERE Editor cannot find text that spans two 
lines.

Replace dialog box

Use this dialog box to specify the text to find and the text which replaces it. The search and replace operation 
always proceeds forward from the current cursor location in the active window.

Search For:

Enter the text you want to find or click the prompt button (or press Alt+ ) to choose from a list of previously-used 
search strings. 
If you want to use regular expression wildcards in your search string, check the Regular Expression check box.

By default, the pcANYWHERE Editor uses any 
currently selected text as the search string.

The pcANYWHERE Editor cannot find text that spans two 
lines.

Replace With:

Enter the text you want to use as the replacement string or click the prompt button (or press Alt+ ) to choose from a 
list of previously-used replacement strings. You cannot use a text wildcard in this text box.
If you leave this field blank, each occurrence of the search string is deleted (that is, replaced with nothing).

Match Upper/Lowercase:
When this check box is checked, the pcANYWHERE Editor checks the case of the text in the Pattern combination box and 
returns only exact matches.
When cleared, the editor considers text a match even when the case is not the same. For example, goto matches GOTO and 
Goto.

Regular Expression:
Check this if you want to enable the powerful and flexible regular expression pattern matching. Leave this unchecked (for speed) 
if you simply want to locate a string.

Confirm Changes:



Check this if you want to be prompted before a change is performed. When unchecked, the editor replaces all occurrences of the 
Search For text, starting at the current cursor location and proceeding to the end of the file, without prompting you.

It is a good idea to leave this checked and confirm the first one or two 
changes. When you're satisfied that an appropriate string has been 
specified in the Search For text box, you can uncheck this checkbox let 
the editor quickly finish the job.
Repeated use of the Undo command on the Edit menu can repair the 
effects of undesired changes.

If Confirm Changes is checked, you are prompted to accept or skip each occurrence of the found text. Otherwise,
the editor automatically replaces all occurrences from the cursor location onward.
The number of changes made appears on the status line.

See Also

Searching with Regular Expressions
Finding Files that Contain Specific Text
Search Functions



Find Files Containing command (Search menu)

Function name: find_files_containing
Default key: Ctrl+F

This command displays the Find Files Containing dialog box, which lets you search the disk for files which contain
specified text or a regular expression. Specify the text to search for, the types of files to search and a folder.
If one or more files are found to contain the search string, the List Found Files dialog box appears. You can open 
any of the files from here and edit it.

After opening a found file, the first occurrence of the 
search text is displayed and highlighted. Use Ctrl+A to
find other occurrences.

Find Files Containing dialog box

Use this dialog box to choose what type(s) of files to scan and specify the text you want to find. The Find Files 
Containing dialog box appears when you choose Find Files Containing… from the Search menu.

Pattern:

Enter the text you want to find or click the prompt button (or press Alt+ ) to choose from a list of previously-used 
search strings.
If you want to use regular expression wildcards in your search string, check the Regular Expression check box.

The pcANYWHERE Editor cannot find text that spans two lines.

Files:

Enter one or more wildcards separated by spaces. Or, click the prompt button (or press Alt+ ) to choose from a list 
of previously-used file specifications.
You can include a drive ID and path in any file specification. If omitted, only files in the current default folder are searched.
Examples:

*.c *.h *.asm find a variable or function name in several types of program source code files
c:\wp\ltrs\*.doc c:\wp\old\*.* look at files in two directories

Match Upper/Lowercase:
When this check box is checked, the pcANYWHERE Editor checks the case of the text in the Pattern combination box and 
returns only exact matches.
When unchecked, the editor considers text a match even when the case is not the same. For example, goto matches GOTO and 
Goto.

Regular Expression:
Check this if you want to enable the powerful and flexible regular expression pattern matching. Leave this unchecked (for speed) 
if you simply want to locate a string.

See Also

Finding Files that Contain Specified Text
Searching with Regular Expressions
The List Found Files command
Search Functions



List Found Files command (Search menu)

Function name: list_files_containing
Default key: Ctrl+L

This command displays a List Found Files dialog box containing the the files located using the Search Find Files 
Containing command. Use it to examine each file.
As you open each file from this dialog box, it is removed from the list. This makes it easy to process the files one-
by-one, examining and/or making changes to each file.

After opening a found file, the first occurrence of the 
search text is displayed and highlighted. Use Ctrl+A to find
other occurrences.

List Found Files dialog box

This dialog box appears when a search started by the Search Find Files Containing command locates one or more
files. Thereafter, you can use the List Found Files command to view the list and choose files to open.

Pattern and Filter:
These are displayed to remind you of the search criteria used to obtain the files in this list.

Files:
This lists the files found by the most recent use of the Find Files Containing command (on the Search menu), less any files that 
have already been opened for editing.
Scroll through the list to select a file. Click Open to open the file and remove it from the list.

Open:
This opens the selected file for editing. On future uses of the List Found Files command, the opened file does not appear in the 
list.

See Also

Finding Files that Contain Specified Text
Searching with Regular Expressions
The List Found Files command
Search Functions



Goto Line command (Search menu)

Function name: goto_line
Default key: Ctrl+G

This command displays a Goto Line dialog box which lets you specify the number of a line to jump to.
The active document is scrolled to the requested line. If any text is currently selected, the selection is extended 
to include that line.

This command is particularly useful for programmers. When a 
compiler reports an error, you can quickly move to the line 
containing the error.

Goto Line dialog box

Use this dialog box to specify the line number at which to position the cursor.
Line Number:

Enter a number between 0 and 32,365.
The file in the active window is scrolled to the requested line. If any text is currently selected, the selection is 
extended to include that line.

See Also

The Goto Line command
Cursor Motion Functions
Search Functions



The Options menu
Commands in this menu set editor and document preferences.

Document Preferences Set margin, tabs, indent, etc. for current file only or defaults for all files.
Editor Preferences Set screen font, cursor, backup, autosave.
Key Assignments Customize keystrokes for fast access to editor functions.



Document Preferences command (Options menu)

Function name: document_preferences
Default key: F4

This command displays a Document Preferences dialog box which lets you select options for the currently active 
document.

Document preference settings are used for the current document for 
the current editing session. They are not saved when you save your 
script file. However, you can specify default settings, to be used in all 
editing sessions, from the Editor Preferences dialog box.

See Also

Customizing the pcANYWHERE Editor
Document Preferences dialog box
The Editor Preferences command
The Key Assignments command



Document Preferences dialog box

Use this dialog box to customize settings for the current active document. This dialog box appears when you 
choose Document Preferences from the Options menu.

These settings are used for the current document during the 
current editing session. They are not saved with the document. 
However, you can set default preferences by choosing Editor 
Preferences from the Options menu.

Tab Spacing:
Sets your desired tab-stops for the current document. When you press the Tab key, the cursor advances this many character-
widths.

Right Margin:
Sets the wrapping-point to be used when word wrap is in effect. Enter a number of columns. The right margin is ignored unless 
the Word Wrap checkbox is checked (see below).

To set the margins for printing, choose Page Setup from the 
File menu.

Word Wrap:
Check this to enable word-wrap in the current document for the current editing session. You can toggle this setting by using the 
Word Wrap command on the Edit menu.
* When checked, typing beyond the right margin causes the current word to be moved down to the next lower line. Also, this 

enables the Wrap Paragraph command of the Edit menu.
* When cleared, the right margin setting is ignored. 

Auto Indent:
When checked, pressing Enter positions the cursor directly below the first non-blank character in the previous line. This is handy 
for programmers.

Expand Tabs with Spaces:
When checked, the editor replaces TAB characters (0x09) with a series of spaces (0x20) as it reads a file. It uses the tab settings 
set above. When it saves the file, all TAB characters are gone.

Save as Default Settings:
When checked, the above settings are used as the defaults for files opened in the future. Otherwise, the settings are used only 
for the current file during the current session.

See Also

Customizing the pcANYWHERE Editor
The Editor Preferences command
The Document Preferences command
The Key Assignments command



Editor Preferences command (Options menu)

Function name: (none)
Default key: Alt+O,E

This command displays an Editor Preferences dialog box which lets you select options to be used by the editor 
for all documents. These include the display font, cursor style, backup, autosave, and undo level preferences.

Editor preference settings are saved and used in the current
editing session and remembered for use in future sessions.

See Also

Customizing the pcANYWHERE Editor
Editor Preferences dialog box
The Page Setup command
The Editor Preferences command
The Key Assignments command



Editor Preferences dialog box

Use this dialog box to customize some of the pcANYWHERE Editor features. This dialog box appears when you 
choose Editor Preferences from the Options menu.
Changes made here are saved automatically and used each time the editor starts.

Font:
Select one of the option buttons. The font and size that is displayed depends on settings in your SYSTEM.INI file in the [boot] 
section:
* System Fixed Font depends on fixedfon.fon=
* ANSI Fixed Font depends on fonts.fon=
* OEM Fixed Font depends on oemfonts.fon=
The OEM font contains the IBM text-mode box-and-line drawing characters.

Cursor:
Select the option button corresponding to how you want the text cursor to be displayed. Check the Blinking check box to enable a
blinking cursor.
* Block Covers the current character.
* Underline Underlines the current character.
* Vertical Bar Standard "insertion point" caret, displayed between characters.
* Blinking The cursor blinks when this is checked. You can set the blink rate from the Windows Control Panel.

Autosave:
If you want the editor to automatically save open files, put non-zero values in either or both of the text boxes.

Undo Levels:
Sets how many edit changes are remembered for the undo function. A large number tends to use up memory. Setting this to 0 
disables the undo function.

Restore Session:
When checked, each file that was open last time you exited the editor is opened automatically next time you start the editor.

Typing Replaces Selection:
When checked, the editor follows the Windows standard convention of replacing any selected text with the first character typed or
pasted. When unchecked, typing or pasting inserts the text to the left of the current selection.

Make Backup Files:
When checked, each time you save a file, the editor makes a copy of the original, giving it the same name, but with an extension 
of .BAK.

File Locking:
When checked, the editor locks each file when you open it and unlocks it only when you close its window. When a file is locked, 
no other program can delete or modify it. It only has an effect if a network is active and/or the program SHARE.EXE has been 
executed.

Cut/Copy Current Line if No Text is Selected:
When checked, you can quickly cut or copy the current line using the standard cut or copy keystrokes (without having to first 
select the line). When unchecked, you can cut or copy a line by using the keys assigned to the cut_line or copy_line functions.

Remove Trailing Spaces:
When checked, the editor discards spaces and tabs characters that are at the end of each line.

See Also

Customizing the pcANYWHERE Editor
The Editor Preferences command
The Document Preferences command
The Key Assignments command



Key Assignments command (Options menu)

Function name: (none)
Default key: Alt+O,K

This command displays a Key Assignments dialog box which lets you customize the way the editor interprets and
acts on keystrokes. You can assign your own favorite shortcut keys to any editor function.
You can also use this command to see what keystrokes are currently mapped to the editor functions. See also:
Editor Functions: Functional Groups

Be sure to use the Save button in the dialog box if you want your key 
assignments to be remembered for future editing sessions.

See Also

Customizing the pcANYWHERE Editor
Key Assignments dialog box
The Document Preferences command
The Editor Preferences command



Key Assignments dialog box

Use this dialog box to associate custom keystrokes with editor functions. You can also use it to look up the 
currently-assigned keystroke for an editor function. This dialog box appears when you choose Key Assignments 
from the Options menu. 

In order to make a keystroke assignment permanent, you must 
select a function and a key, click Assign, then click Save.

Function:
Select a function from this list box. As you move the cursor through the items in the list box, the current keystroke for that function
is displayed in the Current Keys box below.    See also:

Editor Functions: Functional Groups
Key:

Select a keystroke from the list box. Only the listed keystrokes can be used.
Assign and Unassign:

When a name is in both the Function and Key text boxes, you can click these buttons to associate a keystroke with a function or 
dissolve the association.

You can assign more than one keystroke to a 
function. For instance, you can add Alt+C to the 
keys for the copy function while retaining the 
standard Ctrl+Insert for compatibility.

Enable Menu Accelerators:
When this is checked, the standard menu accelerator keys such as Alt+F (to drop-down the File menu) take precedence over 
individual keystroke assignments. In general, this is the normal situation in Windows applications.
If you prefer to be able to use the normally preempted keystrokes for editing functions (for instance, if you want Alt+F to 
immediately save a file), you can clear this checkbox. You can still access the menus with the mouse, or by pressing and 
releasing Alt.

Keyboard Configuration File:
Load and Save:

When the pcANYWHERE Editor starts, it reads a file named DEFAULT.KEY from its home folder to map keystrokes to 
functions. If you want to maintain more than one set of keystroke assignments, you can enter a new name in the Keyboard 
Configuration File text box and click Save. Then, to load that file at a later date, enter its name in this text box and click Load.

Changes you make are in effect only for the current session unless 
you use the Save button to save the assignments.

See Also

Customizing the pcANYWHERE Editor
The Key Assignments command
The Editor Preferences command
The Document Preferences command



Key Assignments dialog box (Standard Browse)
Use this dialog box to locate an existing keyboard configuration file.
File Name:    Type or select the desired filename. This box lists files with the extension selected in the List Files 
of Type box.
List Files of Type:    Select the type of files to display in the File Name list box.
Keyboard Configuration Files (*.KEY):    Lists all files in the current folder that were saved with a .KEY 
extension.

Drives:    Select the drive on which the desired file is stored.
Folders:    Select the folder in which the desired file is stored.



The Tool menu

This menu lets you access the script language quick reference dialog box. You can also access the Session Dial 
dialog box, used in writing scripts for unattended sessions.

Reference Displays the Reference dialog box.



Reference command (Tool menu)
Function name: batch_help

Default key: Alt+R
This command displays the pcANYWHERE Editor Reference dialog box, which provides an alphabetically ordered 
list of script language commands and a description, syntax summary, and example of each command.
You can keep the Reference dialog box open as you create or edit your script file. Use Alt+F6 to toggle back and 
forth between the Reference dialog box and the editing window.



Reference Dialog Box
Use this dialog box as a quick reference for the 150 commands in the pcANYWHERE script language. This dialog 
box appears when you choose Reference from the Tools menu.

Commands

* Use  and 
 to scroll though this list.

* Or, press the first letter of any command to scroll quickly to that part of the list.
Description

As you scroll through the Commands list box, the Description box displays a short description of the command, its syntax and 
example of its use.

Close
Click this button to close the Reference dialog box.

Add
This inserts the currently highlighted statement from the Commands list into the text-editing screen at the current cursor position. 
This handy feature will help you avoid misspelling command names.

Assist
This button is enabled only when the Session Dial command is selected. Use the Assist button for help when you want to write a 
script to be used in an unattended session. The pcANYWHERE Editor helps you create this file by taking the information you 
enter in the Assist dialog box and generating the basic commands required for the script. Use this dialog box to ensure that the 
proper parameters are set.



 Dial Commands Dialog Box
Use when you want to write a script for commands to be used in an unattended session. The pcANYWHERE Editor helps you 
create this file by taking the information you enter in the Assist dialog box and generating the basic commands required for the 
script. Use this dialog box to ensure that the proper parameters are set.

For specific information about this and other Script Language commands, see Chapter 4 of the Creating    pcANYWHERE Scripts 
manual.



Load Commands Dialog Box
Use when you want to write a script for commands to be used in an unattended session. The pcANYWHERE Editor helps you 
create this file by taking the information you enter in the Assist dialog box and generating the basic commands required for the 
script. Use this dialog box to ensure that the proper parameters are set.

For specific information about this and other Script Language commands, see Chapter 4 of the Creating pcANYWHERE Scripts 
manual.



 Receive Commands Dialog Box
Use when you want to write a script for commands to be used in an unattended session. The pcANYWHERE Editor helps you 
create this file by taking the information you enter in the Assist dialog box and generating the basic commands required for the 
script. Use this dialog box to ensure that the proper parameters are set.

For specific information about this and other Script Language commands, see Chapter 4 of the Creating pcANYWHERE Scripts 
manual.



 Send Commands Dialog Box
Use when you want to write a script for commands to be used in an unattended session. The pcANYWHERE Editor helps you 
create this file by taking the information you enter in the Assist dialog box and generating the basic commands required for the 
script. Use this dialog box to ensure that the proper parameters are set.

For specific information about this and other Script Language commands, see Chapter 4 of the Creating    pcANYWHERE Scripts 
manual.



Wait Commands Dialog Box
Use when you want to write a script for commands to be used in an unattended session. The pcANYWHERE Editor helps you 
create this file by taking the information you enter in the Assist dialog box and generating the basic commands required for the 
script. Use this dialog box to ensure that the proper parameters are set.

For specific information about this and other Script Language commands, see Chapter 4 of the Creating    pcANYWHERE Scripts 
manual.



Session Dial dialog box
Use this dialog box to write a script to be used in an unattended session. The pcANYWHERE uses the information 
you enter here to generate correctly formatted Session commands. These commands contain the parameters 
used during the unattended session.
Once you have the session outlined, complete the script by specifying the action to occur after the connection 
has been made. These commands should be inserted into your script at the line COMMENT: ** insert SESSOPR 
here **. If you are using your script to launch an application on the host computer, be sure to use the correct 
SessOpr commands. The corresponding "regular" commands (such as Send File) in the script language are 
unavailable for unattended sessions and return an error when used.
Host to Call:    Click the prompt button to select the name of the host you want to connect to during the session.
The drop-down list box contains the same set of names as those in the Host PC Folder list box in the Call Host PC 
main window. For example, choosing Carol's Office PC from the list box generates the command:

SESSION DIAL "Carol's Office PC"

Cancel Host After Session:    Check this check box to disable the host TSR when your session is complete. If 
this box is checked, the following command is generated:

SESSION HOST EXITMODE CANCEL

Call Immediately:    Check this check box if you want the call to be made as soon as the script is executed. You 
can also specify a date and time at which the call is to be made. If this box is unchecked, then the Time to Call 
and Date to Call text boxes are enabled.
Time to Call:    Enter the time you want pcANYWHERE to dial the host. The format is military time (24-hour 
clock). If you specify a time, you must also specify a date in the Date to Call text box. For example, specifying a 
time of 10:00 P.M. on June 30, 1993 generates the command:

SESSION DIAL "Carol's Office PC" 22:00 93/06/30

Date to Call:    Enter the date you want pcANYWHERE to dial the host. The format is YY/MM/DD. If you specify a 
date, you must also specify a time in the Time to Call text box.
Retries:    Enter the number of times you want pcANYWHERE to redial the host. An entry of 3 generates the 
command:

SESSION RETRY 3

Time Between Retries:    Enter the number of minutes that elapse between retries to dial the host. An entry of 
10 generates the command:

SESSION DELAY 10

If Error Occurs:    Click the prompt button to select the action to perform if an error should occur during the 
unattended session. You can select from:
END SCRIPT--ends the script and returns control to pcANYWHERE.
CONTINUE SESSION--ignores the command which caused the error and advances to the next command.
END CURRENT SESSION--advances to the matching Session End command and continues processing from that 
point on in the script.

For example, selecting End Script generates the following command:

SESSION ONERROR END

File Transfer Overwrites:    Click the prompt button to select the action to perform when the filename 
parameter in a SessOpr Host Send or SessOpr Remote Send command is the same as a filename at the 
destination. You can select from:
ALWAYS--causes the destination file to be overwritten.
NEVER--causes the file sent to be ignored.
OLDER--causes the file at the destination to be overwritten if the file being transferred is more recent (compares
date/time stamp).

For example, selecting Older generates the command:

SESSION OVERWRITES OLDER

Error Time Out:    Enter the time (in minutes) of the remote's inactivity timeout for unattended sessions. For 
example, entering 30 generates the command:

SESSION TIMEOUT 30



The Window menu

This menu lets you select, create, and manipulate the pcANYWHERE Editor's editing windows.
New Window Creates an additional window containing a copy of the file in the active window.
Cascade Rearranges windows in a cascading pattern.
Tile Rearranges windows in a non-overlapping pattern.
Arrange Icons Aligns any minimized editing windows.
1 to n Activates one of the editing windows, restoring it to its standard size if it is minimized.
See Also

Managing Multiple Windows
Window Control Functions



New Window command (Window menu)

Function name: new_window
Default key: Alt+W,C

Creates a new editing window and activates the new window.
If the same file is open in two or more editing windows, editing the file in any of the windows affects the contents
of the file. Also, any file-related commands, such as changing the name using the Save As... command, affect all 
windows. However, the current cursor position, selection, and similar attributes are tracked separately for each 
window.

See Also

Managing Multiple Windows
Window Control Functions



Cascade command (Window menu)

Function name: cascade
Default key: Alt+W,C

Reorganizes all open editing windows in a cascading pattern. This usually makes it possible to see the titles of all
the open windows, while making one entire window visible.
Any minimized windows remain icons.

See Also

Managing Multiple Windows
Window Control Functions



Tile command (Window menu)

Function name: tile
Default key: Alt+W,T

Reorganizes all open editing windows in a tiled (non-overlapping) pattern. This makes it possible to see at least a
small part of all of the open windows.
Any minimized windows remain icons.

See Also

Managing Multiple Windows
Window Control Functions



Arrange Icons command (Window menu)

Function name: (none)
Default key: Alt+W,A

Aligns all minimized editing windows along the bottom of the pcANYWHERE Editor application window.
See Also

Managing Multiple Windows
Window Control Functions



pcANYWHERE Editor Keys

The pcANYWHERE Editor lets you assign your own favorite keystrokes to any of its over 100 editing functions. 
See Customizing Editor Keystrokes for details.
For information on default keystroke assignments, review the topics below:
Cursor Movement
Selecting Text
Function Keys
Other Keys

See Also

The Key Assignments command
Using Editor Macros



Scripts dialog box

From the Scripts dialog box, you can create a new script, or select a script you have already created and edit, 
compile or run it.
The Scripts list box contains a list of all the currently defined scripts and a short description of each. Directly 
beneath the list box is the Script Path text box. If your script files are located in a folder other than the one 
displayed, you can change directories using the Select… button.
After highlighting a file in the list box, simply click the Edit, Compile or Run button to perform that function on 
the selected script.



Select Folder dialog box

Use this dialog box to specify the drive and folder where your script files are located.
Folders:    Scroll through the list box to locate the folder in which your script files are located.
Drives:    Click the prompt button to display a list box containing all available drives.



All script files in the current script path appear here. Select a script and click Run, Compile or Edit.



Displays the currently selected path. If your script files are in a different folder, click Select and select a new 
drive and folder.



Click here to display the Select folder dialog box and change your Script Path.



Select a script from the Scripts list box and click here to execute the selected script.



Select a script from the Scripts list box and click here to compile the selected script.



Select a script from the Scripts list box and click here to edit the selected script.



Click here to launch the pcANYWHERE Editor and create a new script.



Click here to close the dialog box and return to the pcANYWHERE main window.



 New command (File menu)
Use the New command to create a new document file.



Open command (File menu)
Use the Open command to open an existing document file.



Close command (File menu)
Use the Close command to close active document window.



Save command (File menu)
Use the Save command to save the file in the active window.



Save As command (File menu)
Use the Save As command to save the file in active window under a different name.



Save All command (File menu)
Use the Save All command to save all currently open files.



Insert command (File menu)
Use the Insert command to insert the contents of a file at the cursor position.



Revert command (File menu)
Use the Revert command to undo all changes made since the last save.



Write Block command (File menu)
Use the Write Block command to write the selected text to a file you specify.



Page Setup command (File menu)
Use the Page Setup command to set headers, footers, margins, etc.



Print command (File menu)
Use the Print command to send the contents of the file in the active document window to the printer.



Compare command (File menu)
Use the Compare command to compare the contents of two documents.



Exit command (File menu)
Use the Exit command to close the pcANYWHERE Editor windows and exit.



(list of files) command (File menu)
Select any number from 1 to 4 to open or activate the recently used file asociated with that number.



Undo command (Edit menu)
Use the Undo command to undo the most recent text-editing change.



Cut command (Edit menu)
Use the Cut command to copy the selected text to the clipboard and then delete the text from the document.



Copy command (Edit menu)
Use the Copy command to copy the selected text to the clipboard.



Paste command (Edit menu)
Use the Paste command to paste the contents of the clipboard to the current cursor position.



Delete command (Edit menu)
Use the Delect command to delete the current selection.



Select All command (Edit menu)
Use the Select All command to select all text in the active file.



Time/Date command (Edit menu)
Use the Time/Date command to insert the current date and time at the current cursor position.



Wrap Paragraph command (Edit menu)
Use the Wrap Paragraph command to reformat the paragraph at the cursor, wrapping at the current margin 
settings.



Word Wrap command (Edit menu)
Use the Word Wrap command to toggle automatic paragraph wrapping on or off.



Record Macro command (Edit menu)
(toggles to Stop Recording Macro) Use the Record Macro command to record subsequent keystrokes for 
automatic recall.



Playback Macro command (Edit menu)
Use the Playback Macro command to replay the keystrokes saved during the most recent Record Macro 
command.



Find command (Search menu)
Use the Find command to search for text or a regular expression.



Find Again command (Search menu)
Use the Find Again command to continue the search started with the Find command.



Replace command (Search menu)
Use the Replace command to search for and replace text or regular expression.



Find Files Containing command (Search menu)
Use the Find Files Containing command to generate a list of files which contain specified text or regular 
expression.



List Found Files command (Search menu)
Use the List Found Files command to see a list of files found; choose one to edit.



Goto Line command (Search menu)
Use the Goto Line command to move the cursor to a line specified by its line number.



Document Preferences command (Options menu)
Use the Document Preferences command to set the margins, tabs, indent, etc. for current document only or the 
default for all documents.



Editor Preferences command (Options menu)
Use the Editor Preferences command to set the screen font, cursor, backup, and autosave options.



Key Assignments command (Options menu)
Use the Key Assignments command to customize keystrokes for fast access to editor functions.



Reference command (Tool menu)
Use the Reference command to display the script language Reference dialog box. The Reference dialog box 
contains the name of each of the script langauge commands, a description, syntax and an example of its use.



New Window command (Window menu)
Use the New Window command to create an additional window on the document in the active window.



Cascade command (Window menu)
Use the Cascase command to rearrange the document windows in a cascading pattern.



Tile command (Window menu)
Use the Tile command to rearrange the document windows in a non-overlapping pattern.



Arrange Icons command (Window menu)
Use the Arrange Icons command to align any minimized document windows.



1 to n command (Window menu)
Select a number from 1 to n to activates one of the document windows, restoring it to its standard size if it is an 
icon.
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ASCII
assignment operator

-B-

baud rate
binary operator
bitwise And
bitwise Or
bps
break length
bug

-C-

case sensitivity
clipboard
command
comment
communications protocol
compile
compile time
constant
control-menu box
control menu

-D-

data rate
directive

-E-

equality operator
exclusive Or

-F-

file transfer
flow control

-G-

global variable

-H-

hardware configuration
host

-I-

identifier
integer
integer constant

-K-

key word

-L-

label



LAN
loop

-M-

macro
macro keys
minimize and maximize

-N-

nest

-O-

online service
operator

-P-

parameter
parity
password
port
protocol

-R-

relational operator
reserved variable
return value
RS-232 standard
run time

-S-

script
scope
statement
string
string constant
string variable
syntax
syntax error

-T-

terminal emulation
timeout
translation table

-U-

unary operator
user variable

-V-

variable

-W-

wildcard
wrap





    ASCII
Standardized codes used to represent characters, commands and other data, thereby enabling different 
programs, computer systems and hardware devices to exchange information; stands for American Standard 
Code for Information Interchange.



    assignment operator
An operator that assigns the value on the right side of the equal sign to the variable on the left side of the equal 
sign. The    pcANYWHERE assignment operator is the equal sign (=). The assignment operator can be used with 
integers or strings. Unless otherwise noted, you can also assign values to the script language's reserved 
variables.



    binary operator
An operator having two terms.    pcANYWHERE can use binary arithmetic operators, relational operators and 
logical operators. Compare to unary operator.



    bitwise And
Usually used in masking, a bit by bit Anding of two binary values.



    bitwise Or
Usually used in masking, a bit by bit Oring of two binary values.



    bug
Any problem that exists within a program.



 case sensitivity
Differentiation between uppercase letters and lowercase letters. Case sensitivity means that a string such as 
"Password" does not match "PASSWORD." On the other hand, case insensitivity means that "Dial Number" 
matches "DIAL NUMBER," "dial number" or any other combination of upper and lowercase letters.



  clipboard
A temporary storage area for cut or copied text or graphics. The clipboard can be used as a holding pen for 
information you want to pass between Windows programs.
You can place data in the clipboard by using the Cut or Copy command of the Edit menu. Insert data from the 
clipboard into a document by using the Edit Paste command.



    command
Commands are instructions to    pcANYWHERE. Each command has a name consisting of one or more reserved 
words, followed by zero or more parameters. Parameters provide additional information about how the 
instruction is to be executed. Depending on the instruction, a parameter may be an integer or string variable or 
constant, or an arithmetic expression.



    comment
A string which is ignored by the    pcANYWHERE compiler and is not executed. Use comments in your script files 
to provide documentation and to serve as reminders during subsequent modifications to the script. A comment 
is designated by a semicolon (;) that is not within delimiting quote marks.    pcANYWHERE considers all text to 
the right of the semicolon as a comment. Comments can be entered on a line by themselves, or added to the 
end of any other command line.



    compile
The process of converting a high-level script into a low-level set of commands which can be executed, or run. 
Syntax errors are discovered when a script is being compiled.



    compile time
Refers to the events which occur during the compilation process.



 constant
A symbol for a fixed numeric or character value.    pcANYWHERE supports integer and string constants.



 control-menu box

Click this button to open a menu which provides general control for the active window.
Double-click it to close the window.
Click it once to drop-down the application control-menu which lets you close, resize or move the window.
Keyboard users can press Alt+spacebar to access the control-menu.
For programs which support multiple documents (such as the pcANYWHERE Editor), press Alt+hyphen to drop-
down the document control-menu for the active editing window.



 control menu

Click  the control-menu box (Alt+spacebar) to drop-down the control menu. This menu provides a way for 
keyboard users to move and resize the window.



    directive
A directive is a script file statement which helps    pcANYWHERE interpret your intentions. Directives in the script 
language are the integer and string declarations.



    equality operator
The symbol testing whether the values on each side of it are equal.    pcANYWHERE's equality operator is a 
double-equal sign (==). See also relational operator.



    exclusive Or
A logical comparison in which only one of the two conditions being compared is true.



    global variable
Global variables are variables whose values are remembered and remain accessible while you are running linked
or nested scripts. These variables retain their values for the duration of the script execution.    pcANYWHERE 
contains 127 global variables, named $1 through $127.



    identifier
Identifiers are the names supplied for variables, parameters, labels, and commands in scripts. An identifier is a 
single letter, or else a sequence of letters and/or digits that begins with a letter.
Only the first eight characters of an identifier determine its uniqueness within the script.



    integer
Any whole (non-fractional) number, such as 0, 1 or 9275.



    integer constant
Any value built from the digits 0 through 9. Unlike string constants, integer constants are not delimited by quote 
marks. Integer constants in    pcANYWHERE can have a value from -2,147,483,648 to 2,147,483,647 and cannot 
contain any commas or decimal points.



    key word
Key words are identifiers that have special meaning to    pcANYWHERE and cannot be used as user-defined 
variable names.    pcANYWHERE key words include the titles of all commands, reserved variables and global 
variables.



    label
An identifier that serves as a destination address or marker. In the script language, a label is used with the Goto 
and Gosub commands. The destination to which the Goto or Gosub command is to transfer control is indicated 
by a colon following the label name.



    loop
A portion of a program that gets repeated. The script language uses Goto statements, in conjunction with 
If...Then statements, to set up loops.



    minimize and maximize

When you click  the Minimize button (Alt+Spacebar,N) located near the top-right corner of a window, that 
window shrinks into an icon and appears on your taskbar.
You can click the icon to restore it to its previous size.

When you click  the Maximize button (Alt+Spacebar,X) located at the top-right corner of a window, that 
window instantly expands to fill the screen.

You can click  the Restore button to restore the window to its previous size.

    You can also maximize or restore a window by double-clicking its title bar.



    nest
A nested expression is an expression whose result is used as an operand in another expression. The expressions 
in the innermost parentheses are evaluated first.
For example, the command

IF ((a == b) && (c != d)) THEN GOTO @continue
contains two nested expressions:    (a==b) and (c!= d). These expressions are evaluated first, and their results 
are used as the operands for the logical And (&&) expression.



    operator
A symbol within a statement that denotes a type of operation. For example, the equal sign (=) is the assignment 
operator, and the double-equal sign (==) is the equality relational operator.



    parameter
Information that is supplied to a command. Parameters follow the command name and are separated by spaces. 
Some parameters must be specified; others are optional.



    relational operator
A binary operator for comparing the values on either side of the symbol. For example, in the script language > is
the relational operator for "greater than" and == is the equality operator (the relational operator for "equal to"). 
The script language can use relational operators with either integers or strings.



    reserved variable
Reserved variables are variables that have special meaning to    pcANYWHERE. They may contain, for example, 
current parameter settings, results of operations, or the current date and time. You can use reserved variables 
anywhere that variables of the appropriate type (integer or string) are allowed.



    return value
The information returned by a command. Many commands store the return value in the $RESULT reserved 
variable; others, such as Find First, allow you to specify a user variable to store it.



    run time
Refers to the events which occur while the program is actually executing.



    script
A standard ASCII test file containing statements of the script language for    pcANYWHERE. A script usually 
consists of instructions expressed using the script language's rules and syntax, combined with simple control 
structures.
 pcANYWHERE source scripts have an extension of .SCR.
Compiled, executable    pcANYWHERE scripts have extensions of .SCX.
You can create a    pcANYWHERE script using the    pcANYWHERE Editor or any other standard ASCII text editor.



    scope
The set of rules governing when and how a variable may be accessed. These rules determine when the variable 
name is valid; that is, when it can be used in a script. Since script files can call other script files to be run, the 
variables named in the first script may not be accessible to the called script.



    statement
A program unit consisting of a command, an assignment operator or a combination of both. A statement is 
equivalent to a script file line.



    string
Any series of characters surrounded by a pair of single or double quotation mark delimiters.



    string constant
A value that is delimited by quotation marks.



    string variable
A placeholder for text. For example, in the statement prompt = "Please click Yes, No or Cancel" the variable 
named prompt is a string variable.



    syntax
The set of rules governing the way a command can be used.



    syntax error
Syntax errors are detected during compilation and occur when you make a mistake entering a command, such 
as not enclosing a string in quotes, or specifying the wrong number of parameters. The syntax errors are written 
to a file with the same source filename and the extension .ERR. You can use the    pcANYWHERE Editor to view 
the .ERR file, make corrections to the script and attempt compilation again.



    unary operator
An arithmetic operator having only one term. The script language's unary operator is the minus sign (-). 
Compare to binary operator.



    user variable
User variables are those variables that you define for your own use during the running of a single script. At the 
end of script execution, the values stored in these variables are forgotten.



    variable
Variables identify data which may change during the running of a script or each time a script is run. See also 
global variable, reserved variable and user variable.



    wildcard
A symbol that enables multiple matching values to be returned based on a shared feature. The script language 
has two wildcards:    the question mark (?) and the asterisk (*). The question mark stands for any single 
character, and the asterisk stands for any character string of any length. For example, the file specification *.* 
would return all files, regardless of their filenames; the file specification *.SC? would return all filenames having a
three-character extension beginning with SC (COMPUSRV.SCR, COMPUSRV.SCX, etc.).



Frequently Asked Questions    
{button ,JI(`winaw32.hlp>faqsub',`faq_11')}    Do the host and remote PCs both need to run pcANYWHERE in 

order to make a remote connection?
{button ,JI(`winaw32.hlp>faqsub',`faq_5')}    Can I make remote control connections over a network as well as 

through telephone lines?
{button ,JI(`winaw32.hlp>faqsub',`faq_10')}    Do PCs need to use the same type of connection device in order to

connect in a remote control session?
{button ,JI(`winaw32.hlp>faqsub',`faq_7')}    How does call waiting affect a remote computing session?
{button ,JI(`winaw32.HLP>faqsub',`faq_15')}    What is a Voice First connection? 
{button ,JI(`winaw32.hlp>faqsub',`tip_3')}    What is a Superuser and why would I create one?
{button ,JI(`winaw32.hlp>faqsub',`faq_4')}    Can I send files both ways in file transfer?
{button ,JI(`winaw32.hlp>faqsub',`faq_9')}    During a remote control session, can I print files located on both 

PCs at either location?
{button ,JI(`winaw32.hlp>faqsub',`faq_3')}    What is the difference between remote networking and remote 

control?
{button ,JI(`winaw32.hlp>faqsub',`faq_8')}    If I can use remote networking, why should I use pcANYWHERE  ’  s   

remote control?
{button ,JI(`winaw32.hlp>faqsub',`faq_12')}    Can I hide action bar buttons that I  ’  m not using -- like the Be A   

Gateway button?



What is the difference between remote control and remote networking?

 In a remote control session, a remote PC controls the operations of the host PC. 

 In a remote networking session, a PC dials into a network and becomes a remote node on that LAN.



Can I send files both ways in file transfer?

Yes. 

In a remote control session, you can send files from the host PC to the remote PC, and vice versa. 

In an online service session, you can upload and download files. 

{button ,AL(`move those files;receive from online;send to online')}    Related topics



Can I make remote control connections over a network as well as through telephone lines?

Yes.    Choose a network connection device when creating a connection item.    Connections made using that item establish a 
communications link using the network protocol you choose.

    If you use a network connection device, you must connect to a PC that is also using that network device, unless you
connect through a pcANYWHERE gateway.

{button ,AL(`one device;gateway setup')}    Related topics



How does call waiting affect a remote computing session?

If a call comes through a line carrying a remote computing session with call waiting enabled, this can terminate the session in 
progress.    

Contact your telephone company to learn how to temporarily disable call waiting.
Then, you can take these steps in pcANYWHERE to disable it for all sessions:

1 Choose Application Options from the File menu. 
2 On the System Setup Tab, click Change Location. 
3 On the My Locations tab, check This location has call waiting. 
4 Type the code to disable call waiting: 



 If I can use remote networking, why should I use remote control? 

Remote control minimizes information transfer across the telephone line by limiting communications to keyboard, mouse, and 
screen information. In other words, CPU activity still takes place on the other end of the phone line during a remote control 
session; you just see the results on the screen of your remote PC. 

This is important because telephone lines are significantly slower than direct LAN connections.      An application that needs to 
exchange large amounts of data with a database server on the LAN should probably be used in a remote control session, not in 
a dial-up session.

    Remote control with pcANYWHERE can also run over the remote node connection created with remote networking. 
This offers you the best of both worlds; it provides you access to network files while giving you fast screen updates and file 
transfers.

{button ,AL(`addrem')}    Related topics



During a remote control session, can I print files located on both PCs at either location?

As the remote PC user, you can instruct pcANYWHERE to print files at either the host PC, the remote, or at both locations.

If the host PC is not locked during remote control sessions, a host user can issue print commands.    Only the remote user, 
however, can change the print destination.

The host user can also initiate file transfer and download files from the remote, which can later be printed locally.

{button ,AL(`printing during')}    Related topics



Do PCs need to use the same type of connection device in order to connect in a remote control session?

If a PC that is on a network but has no modem needs to connect with a PC that is not on that network, a pcANYWHERE gateway
can be set up to allow the two PCs to connect to each other.    

Likewise, two PCs on different network types (for example, NetBios and IPX) can connect through a gateway that has been set 
up on these networks.

If a direct connection is made, the host and remote PCs must both use the same type of port, either serial or parallel.    

{button ,AL(`gateway task;one device')}    Related topics



Do the host and remote PCs both need to run pcANYWHERE in order to make a remote connection?

Yes.    You must be sure that both the remote PC and the host PC are running pcANYWHERE before making a connection.



Can I hide action bar buttons that I’m not using -- like the Be A Gateway button?

Yes.    

By default, all buttons display on pcANYWHERE’s action bar.

To tell pcANYWHERE which action bar buttons to hide:

1 Choose Application Options from the File menu. 
2 Click the Button Bars tab. 
3 Uncheck any buttons that you do not want to display on the action bar: 



What is a Superuser and why would I create one?

On the host PC, you can create a caller item for a remote user who has full access to the host PC’s drives and full privileges in 
pcANYWHERE.    No time limits are placed on a Superuser’s remote control sessions, and he or she can reboot the host PC or 
disable its hardware.

The Superuser is an important feature because you can still assign a login name and password to this caller, protecting the host 
PC from unauthorized access, while allowing this user to have full remote control capabilities.

{button ,AL(`superuser')}    Related Topics.



Notes on running pcANYWHERE under Windows NT

The following pcANYWHERE features are not supported at this time when running under Windows NT 3.51:

Feature Workaround
Drive security. Use NT’s built-in security subsystem 

instead (for NTFS volumes only).
IPX connections. Use SPX on Novell networks.
NASI connections.    Establish a connection using Remote 

Access Service (RAS).    Then add a remote
control connection.

Parallel port connections. Use serial port for cable connections.
Full-screen DOS.    Use DOS window, where possible.

 In Windows NT, 3.51, the list of network hosts (when using a connection item without the specific host name or 
address) is only supported while using Novell's netware client.



What is a voice first connection?
If you are using one phone line for both voice and data connections, pcANYWHERE’s voice first option allows you 
to make a call and speak with the other user before switching the call to data mode. 



pcANYWHERE Dictionary
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ACS (asynchronous communications server)
A communications server that manages a pool of modems. It directs outgoing messages to the next available modem and directs
incoming messages to the appropriate workstation. See also asynchronous transmission.



ANSI (American National Standards Institute)
An organization of industry and business groups that develops voluntary U.S. standards for trade and communications. In 
pcANYWHERE, this refers to terminal emulation that enables the use of ANSI commands (escape sequences) to control the 
screen and keyboard. These escape sequences have been standardized by ANSI.



asynchronous transmission
A way of transmitting data at irregular time intervals in which information is sent one character at a time. Each character contains
a start bit, followed by a number of data bits and ending with a stop bit. This is the common method of communicating using a 
modem. Contrast synchronous transmission. 



AutoXfer

A file that contains commands to automatically transfer files to the host PC, receive files from the host PC, or synchronize files on
both host and remote PCs. An AutoXfer procedure can execute immediately upon connecting to the host PC.



baud rate
The number of times per second a signal changes in a communications channel. The term baud is often erroneously used to 
describe the speed at which the modem can transfer data. The correct measure for data rate is bits per second (bps).
A baud can vary in the number of bits it can represent. For example, a 300-baud modem that transmits one bit per baud (300 x 
1) is also a 300-bps modem. However, what is often called a 1200-baud modem is really a 300-baud modem that transmits four 
bits per baud (300 x 4) or 1200-bps. See also bps and data rate.



BBS
Acronym for bulletin board system.    A computer system that serves as an information and messaging center for a group of users
who can dial in and connect using a modem and communications software. Online services often offer access to a BBS.



blank
Refers to a computer screen. A verb meaning to clear or not show an image on the screen. You can configure a pcANYWHERE 
host to blank the host screen once a connection has been made. This enhances the security of an unattended pcANYWHERE 
host.



blink
Refers to a computer screen.    The flashing on and off of a displayed character, such as a cursor. You can configure 
pcANYWHERE to disable blinking characters if you do not want to support the blinking text attribute, or if it causes unstable 
display performance.



bps
Abbreviation for bits per second, a measure of the speed at which a device such as a modem can transfer data. Also known as 
data rate. Compare baud rate.



break length
In terminal emulation, this is the length of a break signal used to interrupt a program running on a mainframe or minicomputer. 
This is different from the CTRL-C or CTRL-BRK used by PCs. In pcANYWHERE, you can specify the length of the break signal 
individually for each terminal emulation you are using.



break signal
A special signal used to interrupt whatever program is currently running and returns the user to the operating system, or some 
earlier level of a menu hierarchy. 



cable
A group of wires enclosed in a protective tube, usually an organized set of wires that correspond to specific pins on 9- or 25-pin 
connectors located at each end. A cable is used to connect peripheral devices to each other or to another computer. In remote 
computing this can refer to a cable used to connect a computer to a modem, or a cable that connects two computers directly, 
sometimes called a null modem cable.



cache file
In pcANYWHERE, a file used to improve the performance of Windows. The cache is established on the remote computer and is 
used to hold Windows’ bitmap data. If the bitmap data is in the cache when a Windows screen is redrawn, the data does not 
have to be resent, which results in better performance.



callback
In pcANYWHERE, when a host disconnects a remote caller after a successful connection and then calls back the remote PC, 
either for security verification or financial reasons.



carriage return (CR)
A control character that tells a computer to return to the beginning of the current line. A separate character, the linefeed character
(LF), advances the cursor to the next line. Because carriage return is often combined with linefeed, the combination is often 
referred to as carriage-return/linefeed, CR/LF or hard carriage return. In pcANYWHERE, you can specify how the carriage return
works for each terminal emulation.



carrier
The signal generated by a modem that is used to transmit data. The high-pitched sound (or “squeal”) you hear when you initially 
connect with another modem is the carrier signal.



case-sensitivity
The discrimination between lowercase and uppercase characters.



certificate
A file used by cryptographic systems as proof of identity. It contains your name and your public key.



certificate authority
An office or bureau that issues security certificates.



certificate store
A database containing security certificates.



channel
In communications, a medium for transferring information, also known as a line or a circuit. Depending on its type, a 
communications channel can carry information in analog or digital form. A communications channel can be a physical link, such 
as the cable connecting two stations in a network, or it can consist of some electromagnetic transmission 



channel bonding
For ISDN, channel bonding allows the two B channels to be combined into a 128 Kbps transmission. If    second    channel is 
available at the time PcANYWHERE32 attempts to bond, the ISDN session will transmit at the 128K rate. 



class
In pcANYWHERE, a group of gateway hardware setups that have similar characteristics. The gateway hardware setup is 
assigned to a class when you create or edit the hardware setup. If a piece of hardware in a gateway cannot be accessed, 
pcANYWHERE will use another piece of hardware with a hardware setup in the same class.    For example: You can create 
hardware setups for five 9600-bps modems attached to the network. If all 9600-bps modems are assigned to the same class, 
pcANYWHERE will use one of the other modems if the specified modem is busy. 



clone
In pcANYWHERE, to make a specified folder on the host or remote PC identical to a specified folder on the other PC.    Any files 
that are in the source folder, but not the destination, are copied to the destination folder.    Files in the destination folder that are 
not in the source folder are deleted from the disk.    Compare synchronize.



communications
The transfer of data between computers by means of a device such as a modem or a cable.



communications device or connection device
A modem, network interface card, or other hardware component enabling remote communications and data transfer between 
PCs.



communications link
A connection between computers (and/or peripherals) that enables data transfer. A communications link can be a network, 
modem or cable.



communications port (COM port)
A location for sending and receiving serial data transmissions. Also known as a serial port.    These ports are referred to by the 
names COM1, COM2, COM3 and COM4.



communications protocol
A set of rules designed to allow computers to exchange data with one another with as little error as possible. Some protocols, 
such as RS-232-C, refer to hardware standards; others, such as XMODEM, refer to file transfer protocols. See also flow control.



communications system
The combination of hardware, software and data-transfer links that makes communications possible.



communications session
In communications, the time during which two computers (or a computer and a terminal) maintain a connection and, usually, are 
engaged in transferring information.



compile
The process of converting a high-level script into a low-level set of commands that can be executed, or run. Syntax errors are 
discovered when a script is being compiled.



conference host
A conference host allows multiple remote users to simultaneously connect and view the activities on the host PC. Only the first 
caller to connect can remotely control the host. 



connection
The successful establishment of a communications link.



connection item
A host or remote connection item represents a pcANYWHERE file containing connection device information and security settings
to use during a session.    To begin a session, double-click the connection item from a pcANYWHERE window, from your 
Windows desktop, or from the Explorer.    



Context Menu
The menu that appears when you right-click any connection item.



CR
See carriage return.



crash recovery
A file transfer option that directs pcANYWHERE to continue transferring files where it left off when PCs are re-connected after a 
broken connection, instead of beginning the transfer all over again.



Cryptographic Service Provider (CSP)
An operating system software that provides cryptographic services compliant with the Microsoft CryptoAPI. Base-level CSPs are 
shipped with Windows NT 4.0 and Microsoft Internet Explorer 3.0 and higher.



CTS
Stands for Clear to Send. A signal sent from a modem to the computer to which it is connected, indicating that it is ready for 
transmission. CTS is sent over line five in standard RS-232-C connections.



data bits
In asynchronous transmission, this is the group of binary digits (bits) used to represent a single character of data. The number of 
data bits (usually 7 or 8 for modems) used in a transmission must be agreed upon by the sending and receiving computers. Each
group of data bits in a transmission is preceded by a start bit and followed by an optional parity bit as well as one or more stop 
bits.
pcANYWHERE uses 7 when parity is set to anything other than NONE.
See also asynchronous transmission, parity, start bits, stop bits.



Data conversion
In pcANYWHERE, this feature allows you to convert configuration files (to connect to a host PC, for example) from an earlier 
version of pcANYWHERE so that they can be used in the current version.    You can also use this feature to import or export 
configuration files to text files for record-keeping purposes.



data rate
The speed at which information is moved from one location to another; measured in bits per second, or bps. Compare baud 
rate.



data transfer
The movement of information from one location to another. The speed of transfer is called the data rate, or data transfer rate, 
and is usually measured in bits per second (bps).



data transmission
The electronic transfer of information from a sending device to a receiving device.



destructive <Backspace> key
When the Backspace key is pressed, characters are erased as the cursor moves to the left. A non-destructive Backspace key is 
identical in function to the PC’s left arrow key.
pcANYWHERE allows you to configure the Backspace key to function either as a delete key or as an arrow key, depending upon
the type of terminal emulation you are using.



dial
In pcANYWHERE, to initiate a connection via LAN, modem or direct connection, whether or not actual "dialing" is involved.



direct connection
A form of data communication where one computer or terminal is directly connected to another, usually via a 
null modem cable. 



Domain

In Windows NT, a collection of computers defined by the administrator of a Windows NT server network that 
share a common directory database. A domain provides access to centralized user and group accounts 
maintained by the administrator.



Domain Naming System (DNS)

A hierarchical system of host naming that groups TCP/IP hosts into categories. For example, in the Internet naming scheme, 
names with extensions of "COM", identify hosts in commercial businesses. 



DOS
DOS is the software that organized PC operations before the arrival of operating systems like Windows 95 and Windows NT.    
Programs that were created to run under DOS can run under Windows 95 and Windows NT, but they do not display the same 
interface elements as later programs do, such as windows, minimizing and maximizing buttons, and so on.



DOS Host TSR
In pcANYWHERE, the DOS Host TSR is a terminate-and-stay-resident program which enables remote users to run on the Host, 
DOS applications full-screen within Windows or to exit Windows and run a program from the DOS command line. If this feature is
enabled, the Host computer’s AUTOEXEC.BAT file is modified to start the TSR at the time the computer is started.



download
In communications, the process of transferring a copy of a file from a distant or host computer to the local computer by means of 
a modem or network. In pcANYWHERE, the process generally requires the remote PC to instruct the host PC to begin the 
transfer to the remote, which then stores the incoming file on disk. Compare upload.



download folder
The folder in which files received during file transfer are stored.



driver
Software instructions for interpreting commands for transfer to and from peripheral devices and the CPU.



DSR
Stands for Data Set Ready. A signal sent from a modem to the computer to which it is attached, indicating that it is ready to 
operate.



DTR
Stands for Data Terminal Ready. A signal used in serial communications that a modem sends to the PC to which it is attached, 
indicating that is available to accept incoming transmissions.



edit
To make changes to the content of a document or file.



encryption
A method or algorithm used to scramble data being transferred to protect the data from being intercepted by unauthorized 
persons.



error correction
Noisy lines or faulty connections can sometimes cause errors that translate into erroneous characters on the screen and in 
transferred files. Error correction causes data to be re-transmitted before it is displayed or transferred. pcANYWHERE performs 
software-based error correction.



file transfer
The process of using communications to send a file from one computer to another. In communications, a protocol must be 
agreed upon by sending and receiving PCs before file transfer can take place. 



flow control
A signal that acknowledges that communication or the transfer of information can take place. When a modem or computer 
receives data at a faster rate than it can process, data is stored in a special area of memory called a data buffer. Flow control, 
also called handshaking, prevents data loss by temporarily halting data transmission when the buffer approaches its capacity.
Handshakes can be controlled by either hardware or software. A hardware handshake, as between a computer and a modem, is 
an exchange of signals, over specific wires, in which each device signals its readiness to send or receive data (see RTS/CTS). A
software handshake, usually exchanged during modem-to-modem types of communication, consists of actual information 
transmitted    between the sending and receiving devices. A software handshake establishes agreement between devices on the 
protocols that both will use in communicating. See also protocol, XON/XOFF.



gateway
In pcANYWHERE, a computer allowing users on a network to share a modem or other communications device when making 
connections.    The gateway PC must have two devices. It takes the information from one communications device, converts it, 
and sends it out through the other.
A bidirectional gateway routes both incoming and outgoing calls.



group
In Windows NT User Manager, an account containing other accounts called members. Permissions and rights granted to a group
are also provided to its members, making groups a convenient way to grant common capabilities to collections of user accounts.



handshake
A signal indicating that the communications devices involved are ready to communicate. Handshakes can be controlled by either 
hardware or software. A hardware handshake occurs when the two devices send signals over specific wires, indicating they are 
ready to send/receive data. A software handshake occurs when actual information is sent between the two devices. See flow 
control.



hardware setup
In pcANYWHERE, a set of hardware parameters--such as modem type, port/device, data rate--that is used as a singular named 
resource in launching a host or remote session.



hexadecimal
The base-16 numbering system that consists of the digits 0 through 9 and the upper or lowercase letters A through F. Also called 
hex, hexadecimal is used in programming as a compact means of representing binary numbers used internally by the computer.



host
In pcANYWHERE, this term refers to the PC that is controlled by the remote PC.



initialize
To prepare for use. In communications, to set a modem and software parameters at the start of a session.



IP address
Used to identify a workstation on a network and to specify routing information. Each workstation on the network must be 
assigned a unique IP address, which is made up of the network ID, plus a unique host ID assigned by the network administrator. 
This address is usually represented in dot-decimal notation, with the decimal value of each separated by a period (for example 
123.45.6.24)..



IRQ
Interrupt ReQuests, also called hardware interrupts.    They are the means that a connection device uses to signal other 
hardware components that it needs attention.    When you start filling your PC with new devices (like serial ports, modems, and 
mice), you may find that previous devices no longer work.



Integrated Services Digital Network (ISDN)
A type of phone line used to enhance WAN speeds, ISDN lines can transmit at speeds of 64 or 128 kilobits per second, as 
opposed to standard phone lines, which transmit at only 9600 bits per second (bps). An ISDN line must be installed by the phone
company at both the server and remote site.



keyboard handler
Keyboard handlers help you to send special key sequences to the remote computer. Some applications, such as terminal 
emulation programs, require a keyboard handler to communicate directly with the host keyboard. Without this support, some or 
all of the keys in this type of program may be disabled in the remote session.
In pcANYWHERE, the Level 1 keyboard handler works well with most applications.



LAN
Acronym for local area network; a group of computers and other devices in a relatively limited area (such as a single building) 
and connected by a communications link that enables any device to interact with any other device on the network.



launch
To start a program or application.    In pcANYWHERE, the host PC is launched so that a remote PC can call it and begin a 
remote control session.



leased line
A telephone channel leased from a common carrier for private use.    A leased line is faster and quieter than a switched line, but 
generally more expensive.



linefeed (LF)
A control character that tells a computer to advance one line below the current line. Because linefeed is often combined with 
carriage return, the combination is often referred to as carriage-return/linefeed or CR/LF.



log
In pcANYWHERE, a record of activities and events that take place on a computer system during a remote control session. This 
record is stored in a data file.



login procedures
The process of identifying oneself to a computer after connecting to it over a communications line. During the login procedure, 
the computer usually requests the user’s name and a password. On a computer normally used by many people, the login 
procedure provides a means of identifying authorized users, keeping track of their usage time, and maintaining security by 
controlling their access to sensitive files or actions.
pcANYWHERE can be configured to require a password during login.



macro
A set of keystrokes and instructions recorded, saved and assigned to a short key code. When the key code is typed, the 
recorded keystrokes and instructions are executed (played back). Macros can simplify day-to-day operations that otherwise 
become tedious. For example, a single "macro" keystroke can set up a connection using pcANYWHERE.



macro keys
Key codes assigned to sets of specific instructions. See also macro.



modem
A device that enables a computer to transmit information over a standard telephone line.    Modems can transmit at different 
speeds or data transfer rates. See also baud rate, bps.



NACS
Stands for Novell’s NetWare Asynchronous Communications Services. NACS allows any network PC to share dial-up phone 
lines or directly connected lines to a host or other asynchronous devices. In addition, remote users can access the network and 
transmit data over asynchronous protocols.



NASI
Stands for NetWare Asynchronous Services Interface. Network software used with Novell’s NetWare Asynchronous 
Communications Services (NACS).



network
A group of PCs and associated devices that are connected by communications facilities (both hardware and software) for the 
purpose of sharing information and peripheral devices such as printers and modems. See also LAN.



network station
A computer connected to a LAN through a network adapter card and appropriate software.



null modem cable
A cable that enables two computers to communicate without the use of modems. A null modem cable accomplishes this by 
crossing the sending and receiving wires so that the wire used for transmitting by one device is used for receiving by the other 
and vice versa.



offhook
A telephone or modem that is in use.



onhook
A telephone or modem that is not in use.



online service
A computer communications system or service that allows users to dial in for information, messages and files. CompuServe is an
example of a commercial online service. See also Bulletin Board Service (BBS). 



parallel port
Transmits synchronous, high-speed flow of data along parallel lines.    Usually used for printers.



parameters
A value assigned to a variable; in communications, a means of customizing program (software) and hardware operation.



parity
In communications, parity refers to an error-checking procedure in which the number of 1’s must always be the same--either 
even or odd--for each group of bits transmitted without error.

In typical modem-to-modem communications, parity is one of the parameters that must be agreed upon by sending and receiving
computers before transmission can take place.
Parity can be computed in any of the following ways:
Even:    Adding the data bits and the parity bit yields an even number. If a character with an even number of bits arrives with the 
parity bit set (to 1), an error must have occurred during transmission.
Odd:    Adding the data bits and the parity bit yields an odd number. If a character with an odd number of bits arrives with the 
parity bit set (to 1), an error must have occurred during transmission.
None:    There is no parity bit.
Space:    Sometimes a parity bit is used, but it is always set to 0. If a character is received with a parity bit set to 1, an error may 
have occurred during transmission. Space can also be used to transmit seven-bit characters to a device that is expecting eight-
bit characters. Also referred to as “bit trimming”.
Mark:    Works the same way as Space, except that the parity bit is always set to 1. Also referred to as “bit forcing”.



parity bit
An extra bit used in checking for errors in groups of data bits transferred within or between computer systems. In modem-to-
modem communications, the sending computer adds a parity bit to each group of data bits, each of which represents a single 
character. The setting of the parity bit depends on the type of parity used. With even parity, for example, the parity bit is set to 1 
whenever it is needed to make the total number of 1s (data bits plus parity bit) an even number. The receiving device counts the 
number of 1s in each arriving group of data and parity bits; if the number is odd when it should be even, the device can assume 
that one of the bits was transmitted incorrectly and that an error occurred.



password
A security measure used to restrict access to computer systems and sensitive files. A password is a unique string of characters 
that a user types as an identification code. The system compares the code against a stored list of authorized passwords and 
users. If the code is legitimate, the system allows access, at whatever security level has been approved for the owner of the 
password.



peripheral device
Piece of equipment that allows user to send and receive data to and from a PC, generally attaching to one of the PC’s ports.    
Printers, modems, mice, and keyboards are all examples of peripheral devices.



port
A hardware location for passing data in and out of a computing device. Computers have ports for connecting peripheral devices, 
such as the COM (or RS-232-C) ports used to connect modems and printers. See also communications port.



prefix
In pcANYWHERE, a code required before a telephone number (can be any number of digits). For example, the number 9 is 
often required to call out from many office PBX systems.



protocol
A set of rules designed to allow computers to exchange data with one another with as little error as possible. See also 
communications protocol.



pulse dialing
Rotary-style dialing (clicks can be heard when dialing) as opposed to touch tone.



record
To capture a chronological series of actions and events that occurred during a pcANYWHERE session and store this information 
in a file. In a macro, keystrokes and program instructions are recorded for later.



remote
In pcANYWHERE, a PC that connects with a host PC and takes control of it in a remote control session.



remote control session
Process in which a remote PC calls and connects with a host PC.    The remote PC then operates the host while the host’s video 
display is transmitted to the remote PC’s monitor.    CPU activity takes place on the host.    Compare Remote Networking.



remote communications
Interaction with a host by a remote computer through a telephone connection or another communications line, such as a network
or a direct serial cable connection.



Remote Networking (RAS) or Dial-Up Networking
Connection in which a PC calls a network device and then operates as a node on that network.      Compare remote control 
session.    
Remote Networking is also referred to as Dial-Up Networking, Remote Access Service, or RAS.



remote terminal
A screen (monitor, video adapter and keyboard) that is located at a site removed from the computer to which it is attached. 
Remote terminals rely on modems and telephone lines to communicate with the host PC, or another communications link, such 
as a network or a direct serial cable connection.



resolution
A measure of the quality of an image, measured in pixels used to display alphanumeric characters of graphic images on the 
screen.    High resolutions are composed of more dots per inch and appear smoother than low-resolution images.    

In Windows 95, resolution is the Desktop Area in the Settings tab of the Display Properties dialog box for your 
desktop.



router
A device that helps Local Area Networks (LANs) and Wide Area Networks (WANs) achieve interoperability and connectivity.



RS-232-C standard
An industry standard for serial communication connections. Specific lines and signal characteristics are used to control the 
transmission of serial data between devices.



RTS
Request to send. An RS-232-C signal used in hardware flow control to pace information sent from one device to another. RTS is 
also used in most modems that equal or exceed 9600 baud, as well as direct connections.
See also CTS.



run
To execute a program or a script.



script
A type of program that consists of a set of instructions to an application. A script usually consists of instructions expressed using 
the application’s rules and syntax, combined with simple control structures.
 pcANYWHERE source scripts have an extension of .SCR; compiled, executable    pcANYWHERE scripts have extensions 
of .SCX.
You can create a    pcANYWHERE script using the    pcANYWHERE Editor or any other standard ASCII text editor.



serial communication
The transmission of information between computers or between computers and peripheral devices one bit at a time over a single
line (or data path 1 bit wide). Serial communications can be either synchronous or asynchronous. Both the sender and receiver 
must use the same baud rate, parity and flow control information. Most modems automatically synchronize to the highest baud 
rate both modems can support. pcANYWHERE uses the asynchronous communications standard for personal computer serial 
communications.



serial interface
A data-transmission scheme that sends data and control bits in a 1 bit wide data path sequentially over a single transmission 
line. See also RS-232-C.



serial port
A location for sending and receiving serial data transmissions. Also known as a communications port or COM port. DOS 
references these ports by the names COM1, COM2, COM3 and COM4.



serial transmission
The transmission of discrete signals one after the other. In communications and data transfer, serial transmission involves 
sending information over a single wire one bit at a time; this is the method used in PCmodem-to-modem communications over 
telephone lines.



session
In communications, the time during which two PCs (or a computer and a terminal) maintain a connection and, usually, are 
engaged in transferring information.



signal
A general term for any electrical quantity that can be used to transmit or represent information.



signal state
A high or low voltage state. +3 volts or higher equals a binary 0, -3 volts or less equals a binary 1.



smart terminal
A PC running terminal emulation software that mimics a terminal, but is also capable of running a PC operating system, such as 
Windows ‘95. A pcANYWHERE terminal is an example of a smart terminal.



SpeedSend
In pcANYWHERE, an option that enhances file transfer performance when sending files with duplicate filenames by comparing 
the two files and transferring only the data that is different in the source file.



start bit
In asynchronous transmission, the bit that signals the beginning of a character. Start and stop bits are required in asynchronous 
transmissions because the irregular time gaps between transmitted characters makes it impossible for a receiving device to 
determine when the next character should arrive. These start and stop bits add considerable overhead to transmissions, 
increasing the transmission time as much as 20% over the synchronous equivalent. Usually, a transmitted character is made up 
of 1 start bit, 8 data bits and 1 stop bit.



stop bit
In asynchronous transmission, the bit that signals the end of a character. Start and stop bits are required in asynchronous 
transmissions because the irregular time gaps between transmitted characters makes it impossible for a receiving device to 
determine when the next character should arrive. pcANYWHERE always uses 1 start bit and 1 stop bit.



suffix

In pcANYWHERE, a code appended to the end of a telephone number, such as a calling card number for billing purposes. 



subnet address

An address used to poll all 254 nodes on the designated network for pcANYWHERE hosts. For example, an entry of 127.2.3.255
would display all pcANYWHERE hosts with an IP address beginning with 127.2.3.



switched line
A standard dial-up telephone connection; the type of line established when a call is routed through a switching station. Compare 
leased line.



synchronize
In pcANYWHERE, to copy files in both directions between two folders on host and remote PCs to make the folders identical to 
one another, each containing the same files.    If two files with the same name are located, the file with the most current date and 
time is copied.    Must be performed from the File Manager window. Compare clone.



synchronous transmission
A form of data transmission in which information is sent in blocks of bits separated by equal time intervals. The sending and 
receiving devices must first be set to interact with one another at precise intervals, then data is sent in a steady stream. See also
asynchronous transmission (pcANYWHERE uses asynchronous transmission).



syntax error
Syntax errors are detected during the compilation of a script and occur when you make a mistake entering a command, such as 
not enclosing a string in quotes, or specifying the wrong number of parameters. The syntax errors are written to a file with the 
same source filename and the extension .ERR. You can use the    pcANYWHERE Editor to view the .ERR file, make corrections 
to the script and attempt compilation again.



TAPI
An acronym for the Telephony Application Programming Interface available in Microsoft’s Windows 95 and Windows NT, 4.0 
operating systems. This feature automatically detects and configures communication hardware, including modems, installed on 
the PC. 



TCP/IP
A common set of protocols used to link dissimilar computers across many kinds of networks.    Used on the Internet.



terminal
A device consisting of a monitor, video adapter, and keyboard. A terminal does little or no processing on its own (also known as a
dumb terminal); instead, it is connected to a computer with a communications link over a cable. Terminals are used mainly with 
multi-user systems, where they are used to monitor and receive but not store information (i.e., with a mainframe). See also 
terminal emulation, smart terminal.



terminal emulation
The technique of imitating a terminal by using software that conforms to a standard such as the ANSI standard. pcANYWHERE 
can make your computer act as if it were a particular type of terminal in order to communicate with another computer, such as a 
mainframe or minicomputer.



timeout
A predetermined period of time during which a given task must be completed. If the timeout value is reached before or during the
execution of the task, the task is canceled. You can configure a pcANYWHERE host to disconnect from a remote PC after a 
certain amount time has passed without activity.



translation table
A code that allows data to be converted from one format to another.



voice first
Allows the host and remote user to have a voice conversation before beginning the data session. Use voice first when you have 
only one phone line and want to speak with the other user before starting the session. 



upload
In communications, the process of sending a file from a one computer to a another by means of a modem, network or serial 
cable. With a modem-based communications link, the process generally involves the requesting computer instructing the distant 
computer to prepare to receive the file on its disk and then wait for the transmission to begin. Compare download.



WAN or Wide Area Network
Contrast with LAN.    This network uses links provided by local telephone companies and usually connects disperse sites.    
Typically, it extends a local area network outside the building to link to other LANS in remote buildings, possibly in remote cities.



wildcard
A symbol that enables multiple matching values to be returned based on a shared feature. The script language has two 
wildcards:    the question mark (?) and the asterisk (*). The question mark stands for any single character, and the asterisk stands
for any character string of any length. For example, the file specification *.* would return all files, regardless of their filenames; 
the file specification *.SC? would return all filenames having a three-character extension beginning with SC (COMPUSRV.SCR, 
COMPUSRV.SCX, etc.).



wrap
The ability of the program to continue displaying information on a new line or page when the end of that line or page is reached.



workstation
Any networked computer using server resources.



XON/XOFF
The most common of protocols established to govern software handshaking. Under this protocol, the receiving device sends a 
specific character when it wants the transmitting device to stop sending characters. It sends a different character when it wants 
the transmission to resume.



pcANYWHERE Dictionary



user account
A Windows NT file containing information that defines a user to windows NT. This includes user name and password, the groups 
in which the user account has membership, and the rights and permissions the user has for using the system and accessing its 
resources.



User Manager
A Windows NT utility that allows a user with administrative privileges to edit and define individual user accounts and privileges for
the local workstation.



user privileges
One of three privilege levels you can assign to a Windows NT user account. pcANYWHERE uses the same privileges to 
configure a remote caller in the pcANYWHERE Callers property page when the Use NT User Privileges option is selected.





 Being a host PC                

Many options that affect a remote control connection are set at the host PC, which is then operated by the remote PC during a 
remote control session.    Usually, a host PC is set to wait for a call from the remote PC, although sometimes the host initiates the
connection.

To set a host PC to wait for a remote control session

1 Click Be A Host PC on the action bar.
2 Create a host connection item, or select one that is already there.
3 Set your PC to wait for a call by double-clicking this connection item.

Connection items
Store options for a remote control session in a host connection item, including the type of modem or other hardware used to 
make a connection, general security options, and whether to set security options for individual callers who connect to this host.    

Other options and privileges in a host connection item include: 

· To set time before calling back a remote PC (if callback option activated in caller item).
· To determine control of keyboard and mouse activity during remote control session (host, remote control, or host and remote 

control).
· To run pcANYWHERE whenever Windows starts.
· To restart after a remote control session.
· To minimize pcANYWHERE when waiting for a call.
· To specify gateway used, if any.
· To blank host’s screen during session.
· To lock host from use during session.
· To make passwords case-sensitive.
· To limit login attempts, or the time available to complete login.
· To protect this item with a password, if you want to restrict it from being viewed, modified or used.    This password can also 

prevent users who don’t know it from unlocking or canceling the host when it is waiting for a call.
· To make passwords case-sensitive.
· To use data encryption.
· To disconnect if the remote PC remains inactive for a specified period of time.

 Options for individual callers are stored in caller items, including passwords and privileges.    A host PC may be 
accessed by all callers whose items are stored in a specified folder on that PC.    

Create and modify caller items in the Callers tab of the host connection item. 

The host PC’s role in making a connection
Prepare for a remote control session at the host PC by either:
· Double-clicking the connection item to wait for a call from a remote PC. 
· Clicking the item once and clicking the Launch tool on a Toolbar. 
· Right-clicking the connection item and choosing either Launch Host or Call Remote from the context menu. 

During the remote control session
At the host PC, you can affect the remote control session in progress by right-clicking the pcANYWHERE In-Session button to 
access the host online menu, as long as the host PC is not locked during a session.
Options on the online menu include:

    End Session



    File Transfer

    Chat Window

Ending the remote control session
You can end a session by choosing End Session from the host online menu.



Remote control                 

When you are a remote PC user, you operate the host PC as if you were sitting in front of it.

To begin a remote control session from a remote PC:

1 Click Remote Control on the action bar.
2 Create a remote control connection item, or select one that is already there.
3 Verify that the host PC is configured and waiting for your call.
4 Call the host by double-clicking your connection item.
5 Enter login ID and password (if necessary) to gain access to the host.

Remote control connection items
All options for a particular remote control connection, including the phone number of the host PC (if any) and the type of modem 
or other connection device used, are stored in a remote control connection item.    

Other options stored in the item include: 

· Name of the host PC, for network connections.
· Login ID and password, if required by the host PC.    (If you include this information in the connection item, you do not need to 

enter the ID and password each time you connect.) 
· Type of gateway used, if any. 
· Whether to record sessions for playback, or store session statistics in a text log file. 

· Whether to run a script or AutoXfer  procedure after connection. 
· Password to protect this item, if you want to protect it from being viewed or used. 

    Some options affecting the performance of remote PCs are set by choosing the Remote Operation tab from the 
Application Options.

    Remote control connection items automatically appear in pcANYWHERE’s File Transfer window as file transfer 
connection items also, and vice versa.    Their configuration is identical; when you modify the properties of an item in one window, 
the corresponding item in the other window is also modified.    

The host PC during remote control sessions
Many options that affect remote control sessions are configured at the host PC.    In addition, pcANYWHERE must be running on
the host, and the host must be set to wait for a call.    (Although, in some circumstances, the host PC initiates the connection by 
calling the remote PC.)

Calling the host
Normally, the remote PC must intitiate the connection that begins a remote control session.    To do so, you can either:

· Double-click your connection item.
· Click the item once and click the Connect tool on a Toolbar. 
· Right-click the item and select the Connect option on the context menu. 

Password and login ID
If the host PC requires a login ID and/or password before a remote control session can begin, you must enter these items, 
unless you have already included them in your connection item.



During the remote control session
At the remote PC, you can change some settings of the session while it is in progress by using the remote online toolbar.    This 
toolbar allows you to type a conversation in the Chat window or begin File Transfer.

Other options accessible from this toolbar include:
· File Transfer
· Chat
· Recording
· Save Screen
· Restart Host    (This option can be prohibited at the host PC.) 
· Scripts
· Transfer Clipboard    (You can choose whether to transfer the contents of your Windows clipboard to the host’s, or vice versa.) 
· Color and Screen Scaling
· DOS Settings

Ending the remote control session

You can end a session by clicking  from the remote online toolbar.    



File Transfer                 

You can begin a file transfer session with a host PC immediately.

To transfer files to or from an online service, you must connect to that service first by choosing the Online 
Service mode and using an online service connection item.    (See Tell me about... Online Services for more information.)

To begin a file transfer session with a host PC:

1 Click File Transfer on the action bar.
2 Create a file transfer connection item, or select one that is already there.
3 Verify that the host PC is configured and waiting for your call.
4 Call the host by double-clicking your connection item.
5 Enter login ID and password (if necessary) to gain access to the host.

File Transfer Connection items
The file transfer connection item stores all options for a particular file transfer connection, including the type of modem or other 
connection used by the remote PC and the phone number of the host PC (if any).

Other options you set in the connection item include: 

· Login ID and password, if required by the host PC.    (If you include this information in the item, you do not have to enter the ID 
and password each time you connect.) 

· Type of gateway used, if any. 
· An application on the host PC to run at connection time.
· Whether to record a session for playback, or store session statistics in a text log file. 

· Whether to run a script or AutoXfer  procedure after connection.
· Password to protect this item, if you want to restrict it from being viewed or used. 

    File transfer connection items automatically appear in pcANYWHERE’s Remote Control window as remote control 
connection items also, and vice versa.    Their configuration is identical; when you change the properties of an item in one window, 
the corresponding item in the other window is changed, too.    

The host PC in file transfer sessions
Many options that affect file transfer sessions are configured at the host PC; in particular, the host can be set up to restrict 
remote access to certain drives.    In addition, pcANYWHERE must be running on the host, and the host must be set to wait for a 
call.    (Although, in some circumstances, the host PC initiates the connection by calling the remote PC.)

You can initiate and conduct file transfer at the host PC.

Calling the host
Normally, the remote PC must intitiate the connection that begins a file transfer session.    To do so, you can either:



    Double-click your connection item.

    Click the item once and click the Connect tool on a Toolbar. 

    Right-click the item and choose Start file transfer on the context menu. 

Password and login ID
If the host PC requires a login ID and/or password before a file transfer session can begin, you must enter these items, unless 
you have already included them in your connection item.

During the file transfer session
The pcANYWHERE File Manager window lists files on the host PC side by side with files on the remote PC.    

File management
Remote users can rename, copy, or delete individual files on the host PC.

Folder management
Remote users can also make folders on the host PC, or sort their contents.

Folder-to-folder management
Compare
Remote users can compare the contents of a folder on the host PC to those in a folder on a remote PC.
Synchronize
Ensures that all files in each folder are then contained in the other folder, as well.
Clone
Matches one folder (the source) with another (the destination) so that the destination folder contains only the files 
originally located in the source.

Files may be deleted from the destination folder in a cloning procedure; these cannot be retrieved.    Use this 
feature with care.

File transfer
Selection and tagging
Before sending files and folders through file transfer, select them using standard mouse techniques or using the Tag 
menu.

File Transfer Options
Use the option File Transfer Options on the Configure menu to set the following:
Destination File 
Options include:
- Never Overwrite Duplicate Files
- Always Overwrite Duplicate Files
- Verify Before Overwriting
- Always Ask for Destination
- Overwrite Older Files Only
Use Compression 



Compresses files during transfer only.    If files have already been compressed using a utility such as PKZIP, there will be
no noticeable improvement in the speed of the file transfer.
Allow Crash Recovery 
If a file transfer is interrupted, the user can reconnect and continue transferring from the point at which the file transfer 
was interrupted.    Consider using this feature when transferring large files.

SpeedSend
Check to send only portions of files that are different, instead of re-sending entire files.

You can close the File Manager window to perform remote control with the host at any time during a file transfer
session.

Ending the file transfer session

1 Choose Exit from the File menu of the File Manager window.

2 Click  from the remote online toolbar.



Gateways           

Setting up and activating a pcANYWHERE gateway allows other users on your network to use the gateway’s connection devices
to connect to PCs that are not on your network.    It does not prevent you from using the gateway PC for other tasks.    

To set up and activate a PC as a pcANYWHERE gateway:

1 Click Be A Gateway on the action bar.
2 Create a gateway connection item, or select one that is already there.
3 Double-click the connection item to activate the gateway.

You must customize IPX, SPX, TCP/IP, Banyan VINES and NetBIOS connection devices of PCs using a 
gateway, if those PCs are performing remote control, file transfer, or connecting to online services.    

Connection items
All information configuring a PC to act as a pcANYWHERE gateway is included in a gateway connection item.    Gateway options
include:

· Bidirectional.    If selected, other PCs on the network can both send and receive calls through the gateway.
· Inactivity Timeout.    If no activity takes place during a specified time in a remote control session, the connection is terminated.    (A

gateway supports only one remote control session at a time.)
· Class.    Places the gateway PC in a family of gateways.    Other users can then select a family of gateways that share 

characteristics.
· Hardware connection information, including modem ports and network protocols used in making connections.
· Password to protect this item, if you want to restrict it from being viewed, modified, or used.    This password would also prevent 

users who do not know it from de-activating the gateway.



Remote Networking (RAS)                

Use pcANYWHERE’s Remote Networking feature to:
· Dial in to a network and act as another node on the LAN. 
· Act as a node on a LAN and make a remote control connection.

You must install either Windows 95 Dial-up Networking or Windows NT 3.51 Remote Access Service before 
dialing in to a network.    

To use pcANYWHERE to dial in to a network:

1 Click Remote Networking on the action bar.
2 Create a connection item for Remote Networking, or select one that is already there. 
3 Double-click the connection item to connect to the network.
4 Specify whether to initiate a remote control session after logging in to the network.
5 Type your login name and password to attach to the network.

Connection items
Configuration information on Remote Networking is stored in remote networking connection items created through your operating
system. These items appear in pcANYWHERE’s main window when you have chosen the Remote Networking mode.    

You can create new remote networking connection items once you’ve chosen Remote Networking mode in 
pcANYWHERE.

To add a remote control connection to a remote networking connection:

1 In pcANYWHERE’s main window, click Remote Control on the action bar.
2 Double-click a remote control connection item to call the host PC. 

You must use a remote control connection item using a network connection device supported by the current 
Remote Networking connection.    

You cannot use Banyan Vines, TCP/IP, or NASI/NCSI to add a remote control connection to a remote 
networking connection.



Online Services                

Connect to an online service using pcANYWHERE and gather information, transfer files, etc.

To connect to an online service:

1 Click Call Online Service on the action bar.
2 Create an online connection item, or select one that is already there.
3 Double-click the item.

Connection items
All options affecting an online service connection are stored in connection items, including the phone number of the online 
service and any file transfer protocols that that service uses.    
Other options include:

· Type of terminal emulation to be used, if any, and emulations settings such as line wrap and screen wrap.
· Whether to record session activities in a file that can be played back, or as a script that can be used in a later session.
· Whether to run a script.
· Whether to use a translation table.
· Whether to use predefined macro keys.
· Hardware configuration options for your communications device.
· Type of gateway used, if any.
· Password to protect this item, if you want to restrict it from being viewed, modified, or used. 

During an online session
During an online session, a terminal window (different from the main pcANYWHERE window) displays the terminal screen of the 
online service.    This window also includes a menu bar containing options affecting the online session.    For example, you can:

· change the type of terminal emulation or set a file transfer protocol during a session.
· print from the Terminal window.
· edit Terminal window text.
· copy text to the Terminal window.
· paste text to an online service.
· adjust online service session hardware parameters.
· adjust online service session Terminal window display.
· run scripts during an online service session.
· end an online service session
· send files to the service.
· receive files from the service.

Settings for the current session appear on the status bar.    

Ending an online session
To end an online session, just close the Terminal window, or use the online service’s option to end a session. 



Utilities: Maintaining Logs          

Create log files of remote control sessions and connections made to online services in order to:
· View information about a connection, including time and date, duration, nature of file transfer, name of connecting PC, and so on 
· Create and print reports using specific criteria
· Archive logged data in history files

OPTIONS TO SET
Log File Options on the Host PC

· Log Failed Connection Attempts checkbox.    Check this option on the Security Options tab of a host connection item. 
· Save Session Statistics in Activity Log File checkbox.    Check this option on the Advanced tab of a caller connection item. 

Log File Options on the Remote PC
· Save Session Statistics in Activity Log File checkbox.    Check this option on the Automated Tasks tab of a remote control 

connection item. 
Log File Options for PC Connecting to an Online Service

· Save Session Statistics in Activity Log File checkbox.    Check this option on the Automated Tasks tab of an online service 
connection item. 

    Create a log file for sessions with a particular remote user by checking the option in the Advanced Tab of the caller 
item for that remote user.

CREATING ACTIVITY LOG REPORTS

1 Choose Activity Log Processing from the Utilities menu to access the Activity Log Processing dialog box. 
2 Select the log file to process. 
3 Click Report. 
4 Type a filename for the report and click Open.
5 Select options for the report in the Host & Remote Session Log Report dialog box and click OK.

ARCHIVING AND DELETING LOG FILES
 pcANYWHERE can store multiple log files (with the extension .LOG) on a PC; from time to time, you may want to delete and/or 
archive some of the older data stored in these files.

To archive and delete a log file:

1 Choose Activity Log Processing from the Utilities menu to access the Activity Log Processing dialog box. 
2 Choose the log file you want to process. 
3 Click Archive/Delete.
The Archive/Delete Host/Remote Log dialog box appears.
4 Select dates of the entries you want to delete and archive and click OK.

 To obtain a report of log information you have archived, choose a History Log from the Activity Log Processing dialog 
box.



Utilities: Using Scripts            

 pcANYWHERE includes a script language that allows you to:
· Perform operations automatically when calling online services.    
· Automate some procedures during remote control sessions.

Use scripts to automate:
· Running programs.
· Transferring files.
· Performing arithmetic operations.
· Other procedures.

To create a script:
· Use the Script Editor. For more information on the Editor, refer to the pcANYWHERE Editor Help Contents.
· Record the activities of a session with an online service to a script file, so that the procedures in that session can be repeated by 

executing the script in a later session.    To do this, check the Begin Script Recording After Connection in the Session tab of an 
online Service connection item. 

To execute a script upon connection:
· Check Run Upon Connection and select the script file in the Automated Tasks tab of a Remote Control connection item. 
· Check Run Upon Connection and select the script file in the Session tab of an Online Service connection item. 

To run a script during a session:

    In a remote control session, choose Scripts from the pcANYWHERE remote menu, then select the script you want 
to execute.

    In a session with an online service, choose Scripts from the File menu of the Terminal window, select the script you 
want to execute, and click Run.



Utilities: Using Data Conversion                  

To use data conversion:

1 Choose Data Conversion from the Utilities menu. 
2 Select the data conversion feature you want to run.
3 Follow the Data Conversion Wizard’s instructions. 

Use data conversion to:

    Convert configuration files from a previous version of pcANYWHERE so that they can be used as connection items 
in pcANYWHERE for Windows 95 and Windows NT.

    Export pcANYWHERE configuration files to a pcANYWHERE text data file.

    Import data from a pcANYWHERE text data file into connection items for the current version of pcANYWHERE.    

If you choose to convert pcANYWHERE files, you are prompted to enter the folder containing source files, the version 
of pcANYWHERE in which they were created, and (if applicable) the User ID identifying those files.    If you used User IDs in earlier 
versions of pcANYWHERE, you can convert only one user’s files at a time.    



Utilities: Session Playback                

Use Session Playback to record and then review remote control sessions and sessions with online services.

You can record sessions in the following ways:
· Automatically, by setting an option before a session to record the entire session.
· Manually, by turning record on and off during a session to record portions of it.

To record sessions automatically:

1 Check the Record Session in File checkbox in the Session tab of either a remote control connection item or an online service 
connection item.

2 Choose the file in which to record the session.

Sessions made using this connection item are recorded.

To record part of a remote control session:

1 On the remote online toolbar, click .
2 Type a filename for the recorded session.

3 When you have recorded as much of the session as you want, click  again.

To record online service sessions manually:

1 Begin a session with an online service.
2 Choose Recording from the File menu of the Terminal window.
3 Designate a filename for the recorded session.
4 To stop recording, choose Recording from the File menu again.

To play back a recorded session:

1 Choose Playback Sessions/Screens from the Utilities menu.
2 Select the file you want to play back.
3 Select options in the Playback Options dialog box and click OK.
4 Control the session using the Playback Control Panel.

Click Save Screen in the Playback Control Panel to save a screen during a playback.    



Application Options                        

To customize pcANYWHERE:
1 Choose Applicaton Options from the File menu.
2 Set the options outlined below:

System Setup tab
Click to configure identifying properties of your computer in pcANYWHERE sessions and to set dialing properties, such as 
your area code.

Remote Operation tab 
Click to configure options for all remote control sessions during which your PC acts as the remote.

Some of these options you set here can be changed during a remote control session using the remote online 
toolbar.

TCP/IP tab
Click to maintain a list of TCP/IP hosts to which you can connect.

File Transfer tab 
Click to configure options for file transfer in sessions with online services.    Some options you set here also affect remote 
control sessions.

Terminal Emulation tab
Click to configure terminal emulation options for use during sessions with online services.    

Button bars tab 
Click in order to configure the action bar and the toolbar.    



Network installation: Administrator options               

To install pcANYWHERE as an administrator, you need full access privileges to the network. The pcANYWHERE32 program files
and options set during the administrator installation affect every network user who runs pcANYWHERE. After the administrator 
has installed pcANYWHERE on the network and has configured the shared data files, users on the network can install 
pcANYWHERE on their local workstations.

To install pcANYWHERE on a network: 

1 Run the pcANYWHERE installation file with the /a switch: setup.exe /a.
2 Follow the instructions on your screen being sure to perform the installation on a network drive.

When the installation is complete, a Setup folder is created on the network within the folder where you chose to install 
pcANYWHERE.    It contains the setup.exe file necessary to perform individual workstation installations.

To perform a workstation installation:

1 On a workstation PC, run the setup.exe file located in the Setup folder on the network. (This folder and file are located on the 
network drive where the administrator performed the original, network installation.)

2 Follow the instructions on your screen.

The installation procedure for an individual workstation includes an option to place files on that workstation 
enabling it to wait for a call as a host PC before it is logged in to the network.    Follow the installation instructions closely to either 
allow or disallow this feature.
To access Administrator options:
1 Run the pcANYWHERE program, using the command winaw32.exe /a
2 Type a password to protect Administrator options from other users who might try to run pcANYWHERE in this way.
3 Re-type this password to confirm it.    This password is case-sensitive.

Administrator options include:
· Allowing all network users to create computer names identifying their PCs in pcANYWHERE sessions.
· Allowing all network users to use the folder browse and folder history tools to change and to create folders containing 

connection items.    You can choose whether to allow or prohibit the display of these tools in each of pcANYWHERE’s modes.
· Setting a default folder for each mode where all users access and create connection items.    If you have prohibited the display 

of folder tools in a mode, this becomes the only folder in which users can access items.
· Changing the password required to access Administrator options on your PC.

The Administrator options that you choose affect all pcANYWHERE users on the network, including yourself.    If
you change an option for your own use, even temporarily, remember that other users on the network also experience this change.

If you prohibit access to the folder tools, a user may check the folder tool options in the Button Bars tab, but the 
tools cannot display in the pcANYWHERE modes in which you have restricted their use.

The network administrator password is case-sensitive, and any user trying to run pcANYWHERE using the /a 
option, is prompted for it.    If the user doesn’t know the administrator password and clicks Cancel at the password prompt, 
pcANYWHERE runs without without Administrator options.



Using pcANYWHERE

    Topic under development.

To find out more about one of pcANYWHERE six modes, click one of the buttons on the picture of the action bar below, then click on
any item for more information:

    If you want to choose the Gateway mode and it does not appear on the action bar, customize the action bar to add the 
Gateway button to it.

An AutoXfer procedure is a file containing commands to automatically transfer files to the host PC, receive files from the host PC,
or synchronize files on both host and remote PCs. 



AutoXfer  procedures 

AutoXfer  procedures allow you to automatically transfer folders or files to and from the host PC. Files with 
duplicate filenames can be automatically synchronized with the newer file overwriting the older one.

The End Session When Finished option allows you to run a large AutoXfer procedures unattended. When the procedure is done, the
connection to the host is terminated automatically. 

To automatically run an AutoXfer procedure upon connection:
1 Click Remote Control on the action bar.
2 Create a remote control connection item or select an existing item.
3 Choose Properties from the context menu    
4 Click the Automated Tasks tab.
5 Check Run Upon Connection.
6 Click AutoXfer.
7 Choose a procedure to run and click OK

You can add or modify an AutoXfer procedure using any of the following:

· Automated Tasks property page - allows you to create or modify a procedure to run automatically each time the remote 
connection item is launched.

· Remote online menu or online toolbar - allows you to create, modify, and run a procedure during a session with the host PC.
· File Manager - allows you to view the folders and files on both the remote and host PC. In addition to the advantage of displaying

the host files, modifying procedures using the File Manager allows you to add more than one file transfer command at a time to    
the procedure. 

    Remote control connection items automatically appear in pcANYWHERE’s File Transfer window as file transfer 
connection items also, and vice versa.    Their configuration is identical; when you modify the properties of an item in one window, 
the corresponding item in the other window is also modified.    



Data encryption

pcANYWHERE32 8.0 can encrypt data using any of the following encryption methods:

Public-key : Provides the highest level of session security by using pre-defined keys distributed by a certificate authority.
Symmetric :    Uses similar session security options as public key, however, it does not use certificate authority issued certificates
for authenticating callers.
PcANYWHERE : Provides minimum data security by using a simple transformation of data to prevent data interception by third 
parties.
Modern encryption methods rely on a cryptographic key – typically a long string of alphanumeric characters – to determine how 
an encryption algorithm scrambles and unscrambles the data. A cryptographic system that uses key pairs, that is, a public key 
and a matching private key, is known as public key cryptography. A system that uses a single key to encrypt and decrypt data is 
known as symmetric cryptography.
PcANYWHERE32 uses a combination of public key and symmetric encryption methods. By combining both techniques, 
pcANYWHERE32 takes advantage of the strengths of each method:
? Symmetric encryption is fast but requires sharing the key if the encrypted data is given to others.
? Public key encryption is slower but the private key (the key used to decrypt data) is not shared.

{button ,AL(`encryption;security',0,`',`')}    Related Topics 



Public-key encryption

Public-key encryption uses key pairs – a public key that encrypts data and a corresponding private key that decrypts data. A 
unique public key and private key are generated for each user. These key pairs, along with the user’s name, is stored in a 
certificate issued by a certificate authority .
? When one person needs to send encrypted data to another, the sender encrypts the data using the public key of the recipient. 

Since only the private key can decrypt data, the public key can be shared with anyone.
? To decrypt the data, the recipient uses his or her own private key.
Some pre-configuration is required to ensure that both the host and remote have access to the appropriate key pairs.
When public-key encryption is selected, pcANYWHERE32 uses public key encryption to authenticate the caller and establish a 
connection, then uses the faster symmetric encryption to secure the session.

Public-key encryption requires CryptoAPI 2.0, available in Windows NT 4.0 Service Pack 3, or Microsoft Internet
Explorer 4.0



Public-key components

The following components comprise the total public key encryption method:
Microsoft-compatible certificates : You may obtain personal certificates (or key pairs) from a commercial certificate authority or
through an internal certificate server.
After the certificate has been installed, it appears in the private-key list box on the host and remote security options property 
page.
Certificate store: A certificate is a data document containing a person’s name, public key, and the signature of the certificate 
authority that issued the certificate. A certificate store is a secure database containing one or more certificates. To locate the 
public key for a session, pcANYWHERE32 searches a certificate store for the certificate belonging to the current caller.

PcANYWHERE32 uses certificate stores in any of the following formats:

A Microsoft-compatible certificate store.

A standard PKCS#7 cryptographic message.

A single encoded certificate.
The host needs access to a certificate store containing the remote’s certificate, and the remote needs access to a certificate 
store containing the host’s certificate. You must specify the filename of the certificate store in the Application Options|System 
Setup property page.
Certificate common name: Every host and remote caller should be configured with the common name from its own certificate. 
This name is provided on the Security Options property page of the host and remote connection item. When a connection is 
attempted, the common name for the host and the remote are verified for authenticity.



Symmetric encryption

When symmetric encryption is selected, pcANYWHERE32 generates a unique public key and uses this key to encrypt and safely
pass the symmetric key used to encrypt the session. Because the public key is not obtained from a certificate authority it does 
not provide the level of caller authentication that total public-key encryption does.

To enhance caller authentication when using symmetric encryption, use pcANYWHERE’s individual caller privileges 
option.

The symmetric encryption level is available on any operating system that supports the CryptoAPI , such as Windows NT 4.0. For 
the Windows 95 operating system, CryptoAPI 1.0 is available with OSR2 or with Microsoft Internet Explorer 3.0 and higher.



pcANYWHERE encryption

pcANYWHERE encryption applies a simple transformation to data so that the datastream cannot be easily interpreted by a third 
party. This is the only encryption level compatible with earlier versions of pcANYWHERE.



encryption technical information

With CryptoAPI, cryptographic functions are actually performed by a Cryptographic Service Provider (CSP), or low-level 
cryptography driver, which functions as part of the operating system. Microsoft provides a basic CSP as part of Windows NT and 
Internet Explorer. This basic CSP can be replaced by third-party products.
PcANYWHERE32 uses the default Prov_RSA_FULL CSP and the RC4 symmetric algorithm. Any CSP classed as 
PROV_RSA_FULL that provides RC4 can support pcANYWHERE32.
Many important parameters are determined by the CSP in use. For example, the basic Microsoft CSP uses 512-bit public keys 
and 40-bit session keys. Other CSPs use different key lengths.
Please visit the Microsoft Website for more details on CryptoAPI and available CSPs.



Conferencing the host  

A conference host allows multiple remote users to simultaneously connect and view the host activities. For example, the host 
user can conduct a software training demonstration that can be viewed by any remote caller connected to the host PC.

A conference host is remotely controlled by the first remote caller to connect. All other callers can only view the activity taking 
place on the host PC and can use some utility functions such as saving screens and recording sessions.

The first remote caller can connect using any connection device . Other callers connecting to view the host 
session must make a TCP/IP network connection.



Windows NT user privileges

Windows NT user accounts contain information defining a user to Windows NT. This includes the user name and password, the 
groups in which the user has membership, and the rights and permissions the user has for using the system and accessing its 
resources. Windows NT user accounts are managed with User Manager . To configure host caller information in Windows NT, 
you can use the Windows NT user account information in addition to pcANYWHERE’s caller privileges.



Symantec’s LiveUpdate  

LiveUpdate lets you update pcANYWHERE32 when new versions are made available on Symantec’s Internet site. Using 
LiveUpdate, you can ensure that you always have the most current version of pcANYWHERE32.



Host scheduling  

You can schedule a pcANYWHERE32 host to wait for a call at a particular time of day. The method used to schedule a host 
varies depending on the host PC’s operating system.

For the Windows 95 environment you can use Norton Program Scheduler of Microsoft’s System Agent.
For the Windows NT environment you can use the Schedule Service (AT command) feature.



      Text Editor Functions

about

Displays the editor's version number, copyright notice and miscellaneous system information.

Keyboard shortcut: Alt+V.



    Text Editor Functions

backspace

If text is selected, deletes it; otherwise, deletes the character to the left of the cursor.

If the cursor is at the beginning of the line, appends the current line to the previous line.

Keyboard shortcut: Backspace 



Text Editor Functions

batch_help

Displays help text on each script language command and lets you select commands to enter into your current file.

Keyboard shortcut: Alt+R



Text Editor Functions

beginning_of_buffer

Moves the cursor to the beginning of the document in the active window.

Keyboard shortcut: Ctrl+Home



Text Editor Functions

beginning_of_line

Moves the cursor to the beginning of the current line.

Keyboard shortcut: Home



Text Editor Functions

bottom_of_window

Moves the cursor to the bottom line of the window.

Keyboard shortcut: Ctrl+PageDown



Text Editor Functions

cascade

Resizes and rearranges all open windows in an overlapping pattern. Same as the Cascade command on the Window menu.

Keyboard shortcut: Alt+W, then C



Text Editor Functions

change_case

Within the selected block, changes the case of all letters, making uppercase letters into lowercase, and lowercase letters into 
uppercase.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

close_window

Closes the active window. If you have made changes to the file, the pcANYWHERE Editor prompts you to save them if you have 
not already done so.

Same as the Close command on the File menu. You can also close a window by double-clicking its document control-menu 
button.

Keyboard shortcut: Ctrl + F4



Text Editor Functions

compare

Prompts for two filenames, then compares them line-by-line.

Same as the Compare command on the File menu.

Keyboard shortcut: Alt+F, then E



Text Editor Functions

copy

Copies the selected text to the clipboard.

If no text is selected, but the Editor Preferences dialog option Cut/Copy line if no text is selected is checked, then this copies the 
entire line to the clipboard.

Same as the Copy command on the Edit menu.

Keyboard shortcut: Ctrl + Insert



Text Editor Functions

copy_block

Copies the selected text to the clipboard.

This variation of the copy command has no effect if no text is selected.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

copy_line

Copies the current line to the clipboard.



Text Editor Functions

cursor_down

Moves the cursor down one line.

Keyboard shortcut: DownArrow



Text Editor Functions

cursor_left

Moves the cursor one character to the left or, if in the leftmost column, to the end of the line above.

Keyboard shortcut: LeftArrow



Text Editor Functions

cursor_right

Moves the cursor one character to the right or, if at the end of the line, to the beginning of the line below.

Keyboard shortcut:    RightArrow



Text Editor Functions

cursor_up

Moves the cursor up one line.

Keyboard shortcut: UpArrow



Text Editor Functions

cut

Removes the selected text, placing it in the clipboard.

If no text is selected, but the editor's Preferences dialog option Cut/Copy Line if No Text is Selected is checked, then this cuts the
entire line from the document and copies it to the clipboard.

Same as the Cut command on the Edit menu.

Keyboard shortcut:    Shift + Del



Text Editor Functions

cut_block

Removes the selected text, placing it in the clipboard.

This variation of the cut command has no effect if no text is selected.



Text Editor Functions

cut_line

Removes the current line, placing it in the clipboard.



Text Editor Functions

delete

Deletes the selected text. If no text is selected, deletes the character at the cursor.

The text can be recovered using the undo function.

Keyboard shortcut: Del



Text Editor Functions

delete_line

Deletes the current line.

The line is not copied to the clipboard, but can be recovered using the undo function.

Keyboard shortcut: Alt + D



Text Editor Functions

delete_to_eol

Deletes all text from the cursor to the end of the current line.

The text can be recovered using the undo function.

Keyboard shortcut: Alt + K



Text Editor Functions

delete_word_left

If the cursor is in a word, deletes the text from the cursor to the beginning of the word.

If the character to the left of the cursor is a space or tab, deletes the text from the cursor to the previous non-blank character.

If the character to the left of the cursor is a delimiter other than space or tab, deletes that delimiter.

Keyboard shortcut: Ctrl + BackSpace



Text Editor Functions

delete_word_right

If the cursor is in a word, deletes the text from the cursor to the end of the word.

If the character to the right of the cursor is a space or tab, deletes the text from the cursor to the next non-blank character.

If the character to the right of the cursor is a delimiter other than space or tab, deletes that delimiter.

Keyboard shortcut: Ctrl + Del



Text Editor Functions

document_preferences

Displays the Document Preferences dialog box, which lets you select options for the file in the active window.

Same as the Document Preferences command on the Options menu.

Keyboard shortcut: F4



Text Editor Functions

editor_help

Accesses the editor's help system.

Keyboard shortcut: F1



Text Editor Functions

end_of_buffer

Moves the cursor to the end of the document in the active window.

Keyboard shortcut: Ctrl + End



Text Editor Functions

end_of_line

Moves the cursor to the end of the current line.

Keyboard shortcut: End



Text Editor Functions

enter

In insert mode, inserts a carriage return and line feed, then moves the cursor to the beginning of the next line (or positions the 
cursor below the first non-blank character in the previous line if Auto Indent is checked in the Document Preferences dialog box).

In overwrite mode, simply moves the cursor to the beginning of the next line.

Keyboard shortcut: Enter



Text Editor Functions

exit

Prompts you to save any modified files, then closes all windows and exits from the editor.

Same as the Exit command on the File menu.

Keyboard shortcut: Alt + F4



Text Editor Functions

exit_windows

Prompts you to save any modified files, then issues an ExitWindows call to end the current Windows session.    The session is 
not terminated unless all applications agree to terminate.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

find

Displays the Find dialog box, which lets you set search criteria for the active document and begins searching.

Same as the Find command on the Search menu.

Keyboard shortcut: Ctrl + S



Text Editor Functions

find_again

Continues a search you initiated using the find function.

Same as to the Find Again command on the Search menu.

Keyboard shortcut: Ctrl + A



Text Editor Functions

find_files_containing

Displays the Find Files Containing dialog box. Use this to set search criteria and begin searching for files. Use the 
list_files_containing function to see and open the found files.

Same as the Find Files Containing command on the Search menu.

Keyboard shortcut: Ctrl + F



Text Editor Functions

goto_line

Prompts for a line number, then moves the cursor to the specified line in the active document.

If any text is selected, the selection is extended to include the requested line.

Same as the Goto Line command on the Search menu.

Keyboard shortcut: Ctrl + G



Text Editor Functions

list_files_containing

Use after using the find_files_containing function to display a list of found files. You can then double click a file to open it and 
remove it from the list.

Same as the List Found Files command on the Search menu.

Keyboard shortcut: Ctrl + L



Text Editor Functions

lowercase

Converts all uppercase characters in the marked block to lowercase.

If no block is marked, acts on the character at the cursor.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

new_file

Opens a blank untitled document window. Use Save or Save As... on the File menu to give it a name and save the contents to 
disk.

Same as the New command on the File menu.

Keyboard shortcut: Alt + F, then N



Text Editor Functions

new_window

Opens an additional window on the current active document.

Changes made to either window affect the same document. If you want two different versions, first, use the Save As... command 
of the File menu to make a duplicate, then open both files.

Same as the New Window command on the Window menu.

Keyboard shortcut: Alt + W, then N



Text Editor Functions

 next_window

Activates the next window in the editor's circular list.

Same as the Next Window command on the document control-menu.

Keyboard shortcut: Ctrl + F6



Text Editor Functions

open_file

Prompts for a directory and filename and opens a window on that file.

Same as the Open command on the File menu.

Keyboard shortcut: F3



Text Editor Functions

page_down

Moves the cursor down one page; that is, the number of lines visible in the window.

Keyboard shortcut: PageDown



Text Editor Functions

 page_up

Moves the cursor up one page; that is, the number of lines visible in the window.

Keyboard shortcut: PageUp



Text Editor Functions

paste

Inserts the contents of the clipboard at the cursor location.

Same as the Paste command on the Edit menu.

Keyboard shortcut: Shift + Insert



Text Editor Functions

play_macro

Replays the keystrokes and functions recorded by the most recent use of the record_macro function.

If no macro has been recorded, that is indicated on the status line.

Same as the Play Back Macro command on the Edit menu.

Keyboard shortcut: F8



Text Editor Functions

prev_window

Activates the previous window on the editor's circular list.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

print

Prints the active document, using settings set from the Page Setup and Printer Setup commands under the File menu.

Same as the Print command on the File menu.

Keyboard shortcut: Alt + P



Text Editor Functions

record_macro

Starts recording keystrokes and editor functions.    Recording continues until the next use of this function.

Same as the Record Macro/Stop Recording Macro commands on the Edit menu.

Keyboard shortcut: F7



Text Editor Functions

replace

Prompts for search and replace criteria and then replaces specified text in the active document, starting at the cursor location.

Same as the Replace command on the Search menu.

Keyboard shortcut: Ctrl + R



Text Editor Functions

restore_window

Resizes the active window to its user-configurable "intermediate" size.

Same as the Restore command on the document control-menu.

Keyboard shortcut: Ctrl + F5



Text Editor Functions

revert

Prompts for verification, then undoes all changes to the contents of the active document since the file was last saved.

Same as the Revert command on the File menu.

Keyboard shortcut: Alt + F, then V



Text Editor Functions

save_all

Saves the contents of all modified document to disk. For untitled windows, prompts for filenames.

Same as the Save All command on the File menu.

Keyboard shortcut: Alt + F, then L



Text Editor Functions

save_all_exit

Saves the contents of all modified document to disk, then ends the editor session.

Keyboard shortcut: Alt + X



Text Editor Functions

save_all_exit_windows

Saves the current contents of all modified documents to disk, then ends the current Windows session. The Windows session is 
not terminated unless all applications agree to terminate.



Text Editor Functions

save_file

Saves the document in the current active window to disk. If the window is untitled, you are prompted for a filename.

Same as the Save command on the File menu.

Keyboard shortcut: F2



Text Editor Functions

save_file_close_window

Saves the contents of the current active document to disk, then closes the active window. If the window is untitled, the 
pcANYWHERE Editor prompts you for a filename.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

select_all

Selects (highlights) the entire contents of the active document.

Same as the Select All command on the Edit menu.

Keyboard shortcut:    Alt + E, then A



Text Editor Functions

select_char_left

Selects the character to the left of the cursor, or cancels the selection if that character is already selected.

If the cursor is at the beginning of a line, it moves to the end of the previous line.

Keyboard shortcut: Shift + LeftArrow



Text Editor Functions

select_char_right

Selects the character to the right of the cursor, or cancels the selection if that character is already selected.

If the cursor is at the end of a line, it moves to the beginning of the next line.

Keyboard shortcut: Shift + RightArrow



Text Editor Functions

select_line

Selects the current line.



Text Editor Functions

select_line_down

Extends the current selection down one line, or cancels the selection if that line is already selected.

Keyboard shortcut: Shift + DownArrow



Text Editor Functions

select_line_up

Extends the current selection up one line, or cancels the selection if that line is already selected.

Keyboard shortcut: Shift + UpArrow



Text Editor Functions

select_page_down

Extends the current selection down one page and scrolls the window.

Keyboard shortcut: Shift + PageDown



Text Editor Functions

select_page_up

Extends the current selection up one page and scrolls the window.

Keyboard shortcut: Shift + PageUp



Text Editor Functions

select_to_bol

Selects the text from the cursor to the beginning of the current line, or cancels the selection if the text is already selected.

Keyboard shortcut: Shift + Home



Text Editor Functions

select_to_end

Selects the text from the cursor to the end of the document in the active window.

Keyboard shortcut: Ctrl + Shift + End



Text Editor Functions

select_to_eol

Selects the text from the cursor to the end of the current line, or cancels the selection if the text is already selected.

Keyboard shortcut: Shift + End



Text Editor Functions

select_to_top

Selects the text from the cursor to the beginning of the document in the active window.

Keyboard shortcut: Ctrl + Shift + Home



Text Editor Functions

select_word

Selects the word containing the cursor. (You can also select a word by positioning the cursor on the word and double-clicking the
primary mouse button.)



Text Editor Functions

select_word_left

Extends the current selection to the beginning of the word to the left of the cursor, or cancels the selection if the text is already 
selected.

Keyboard shortcut: Ctrl + Shift + LeftArrow



Text Editor Functions

select_word_right

Extends the current selection to the beginning of the word to the right of the cursor, or cancels the selection if the text is already 
selected.

Keyboard shortcut: Ctrl + Shift + RightArrow



Text Editor Functions

split_line

Inserts a line break at the cursor without advancing the cursor.

Keyboard shortcut: Ctrl + N



Text Editor Functions

stamp

Inserts the current date and time at the cursor location.

Same as the Time/Date command on the Edit menu.



Text Editor Functions

tab_right

In insert mode, inserts a tab character at the cursor (or inserts spaces, if Expand Tabs with Spaces in the Document Preferences
dialog box is checked).

In overwrite mode, moves the cursor to the next tab position, as set in that same dialog.

Keyboard shortcut: Tab



Text Editor Functions

test_batch

Executes the script commands in the active editing window.



Text Editor Functions

tile

Resizes and rearranges all open windows to fit within the editor main window with no overlap.

Same as the Tile command on the Window menu.

Keyboard shortcut: Alt + W, then T



Text Editor Functions

to_bottom

Scrolls the active window to place the current line at the bottom of the window.

Keyboard shortcut: Ctrl + B



Text Editor Functions

to_center

Scrolls the active window to place the current line to the center of the window.

Keyboard shortcut: Ctrl + C



Text Editor Functions

to_top

Scrolls the active window to place the current line to the top of the window.

Keyboard shortcut: Ctrl + T



Text Editor Functions

toggle_backup

Toggles the Make Backup Files option in the Editor Preferences dialog box.

When the backup option is on and you save a file, the original file is retained, but with an extension of .BAK.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

toggle_insert

Toggles between insert mode and overwrite mode.    The current mode is displayed on the status line.

Keyboard shortcut: Insert



Text Editor Functions

toggle_wordwrap

Toggles into and out of word wrap mode.    The current mode is displayed on the status line.

When word wrap is on, typing past the right margin causes the current word to be moved to the next lower line.

Same as the Word Wrap option on the Edit menu.

Keyboard shortcut: Ctrl + W



Text Editor Functions

top_of_window

Moves the cursor to the top visible line of the window.

Keyboard shortcut: Ctrl + PageUp



Text Editor Functions

undo

Reverses the effects of the a previous editing operation. Repeated use undoes up to 300 edit operations.

Same as the Undo command on the Edit menu.

Keyboard shortcut: Alt + BackSpace



Text Editor Functions

unmark_block

Deselects the selected text and returns the cursor to its location before the text was selected.

Keyboard shortcut: Esc



Text Editor Functions

uppercase

Converts all lowercase characters in the marked block to uppercase. If no block is marked, converts the character at the cursor.

    To assign a keyboard shortcut to this Text Editor function, use the Key Assignments option on the Options menu.



Text Editor Functions

window_down

Moves the cursor up one line and at the same time moves the text in the window down one line.

Keyboard shortcut: Ctrl + UpArrow



Text Editor Functions

window_up

Moves the cursor down one line and at the same time moves the text in the window up one line.

Keyboard shortcut: Ctrl + DownArrow



Text Editor Functions

word_left

Moves the cursor to the beginning of the previous word or to the end of the previous line, whichever comes first.

Keyboard shortcut: Ctrl + LeftArrow



Text Editor Functions

word_right

Moves the cursor to the beginning of the next word or to the end of the line, whichever comes first.

Keyboard shortcut: Ctrl + RightArrow



Text Editor Functions

wrap_para

Reformats the current paragraph within the margins of the active document. Margins are set using the Document Preferences 
command on the Options menu.

Same as the Wrap Paragraph command on the Edit menu.

Keyboard shortcut: F12



Text Editor Functions

zoom_window

Resizes the active document window to its maximum possible size within the editor's window.

Same as the Maximize command on the document control-menu. You can also maximize and restore a window by double-
clicking its title bar.

Keyboard shortcut: Ctrl + F1



Text Editor Functions:    Functional Groups 
Use Text Editor functions as you are creating scripts.    Text Editor functions are not Editor commands and should not be 
included in scripts.

Click one of the following groups to see a listing of Text Editor functions:

 Cursor Motion

 Cut, Copy, and Paste

 Deleting Text

 File Control

 Lines

 Paragraphs and Word Wrap

 Searching and Replacing

 Selecting Text

 Window Control

 Miscellaneous



 Cursor Motion Text Editor Functions

Click an item below for more information.
beginning_of_buffer page_up
beginning_of_line split_line
bottom_of_window tab_right
cursor_down to_bottom
cursor_left to_center
cursor_right to_top
cursor_up top_of_window
end_of_buffer window_down
end_of_line window_up
enter word_left
goto_line word_right
page_down

Cut, Copy, and Paste Text Editor Functions

Click an item below for more information.
copy
copy_block
copy_line
cut
cut_block
cut_line
paste
undo



Delete Text Editor Functions

Click an item below for more information.
backspace delete_to_eol
cut delete_word_left
cut_line delete_word_right
delete replace
delete_line undo



File Text Editor Functions

Click an item below for more information.
close_window save_file
compare save_file_close_window
find_files_containing save_all
list_files_containing save_all_exit
new_file save_all_exit_windows
open_file toggle_backup
revert



Line Text Editor Functions

Click an item below for more information.
beginning_of_line select_line
copy select_line_down
copy_line select_line_up
cursor_down select_to_bol
cursor_up select_to_eol
cut split_line
cut_line to_bottom
delete_line to_center
delete_to_eol to_top
end_of_line window_down
enter window_up
goto_line



Miscellaneous Text Editor Functions

Click an item below for more information.
about record_macro
batch_help save_all_exit_windows
change_case split_line
document_preferences stamp
editor_help tab_right
enter test_batch
exit toggle_backup
exit_windows toggle_insert
lowercase toggle_wordwrap
play_macro undo
print uppercase



Paragraph Text Editor Functions

Click an item below for more information.
document_preferences
enter
split_line
toggle_wordwrap
wrap_para



Text Selecting Text Editor Functions

Click an item below for more information.
select_all select_to_bol
select_char_left select_to_end
select_char_right select_to_eol
select_line select_to_top
select_line_down select_word
select_line_up select_word_left
select_page_down select_word_right
select_page_up unmark_block

The default keys are assigned so that pressing Shift along 
with a navigation key selects text as the cursor moves.



Search and Replace Text Editor Functions

Click an item below for more information.
find
find_again
find_files_containing
list_files_containing
replace



Window Text Editor Functions

Click an item below for more information.
cascade
close_window
new_window
new_file
next_window
prev_window
restore_window
tile
to_bottom
to_center
to_top
window_down
window_up
zoom_window



Navigation Key Defaults

Key Default Editor Function
cursor_left

Ctrl+ word_left
cursor_right

Ctrl+ word_right

cursor_up

Ctrl+ window_down

cursor_down

Ctrl+ window_up
PgUp page_up
Ctrl+PgUp top_of_window
PgDn page_down
Ctrl+PgDn bottom_of_window
Home beginning_of_line
Ctrl+Home beginning_of_buffer
End end_of_line
Ctrl+End end_of_buffer
Tab tab_right
Enter enter
Ctrl+G goto_line



Text Selection Key Defaults

Key Default Editor Function

Shift+ select_line_up

Shift+ select_line_down

Shift+ select_char_left

Shift+Ctrl+ select_word_left
Shift+ select_char_right

Shift+Ctrl+ select_word_right
Shift+PgUp select_page_up
Shift+PgDn select_page_down
Shift+Home select_to_bol
Shift+Ctrl+Home select_to_top
Shift+End select_to_eol
Shift+Ctrl+End select_to_end
Esc unmark_block

The default keys are assigned so that 
pressing Shift along with a navigation 
key selects text as the cursor moves.

F1...F12 Function Key Defaults

Key Default Editor Function
F1 editor_help
F2 save_file
F3 open_file
F4 document_preferences
Ctrl+F4 close_window
F5 (none)
Ctrl+F5 restore_window
F6 (none)
Ctrl+F6 next_window
F7 record_macro
F8 play_macro
F9 (none)
F10 (none)
Ctrl+F10 zoom_window



F12 wrap_para



Other Key Defaults

Key Default Editor Function
BkSp backspace
Alt+BkSp undo
Ctrl+BkSp delete_word_left
Del delete
Ctrl+Del delete_word_right
Shift+Del cut
Ins toggle_insert
Ctrl+Ins copy
Shift+Ins paste
Enter enter
numpad * undo
numpad + copy
numpad - cut
Tab tab_right
Alt+ - close_window
Alt+D delete_line
Alt+K delete_to_eol
Alt+N next_window
Alt+P print
Alt+R batch_help
Alt+V about
Alt+X save_all_exit



pcANYWHERE Text Editor Procedures

Using the pcANYWHERE Editor
Customizing the pcANYWHERE Editor
Customizing Editor Keystrokes
Comparing Two Files
Finding Which Key Performs an Editor Function
Printing All of or Part of a Document
Searching for Files that Contain Specific Text
Searching for Specified Text in an Open Document
Searching with Regular Expressions
Using Editor Macros
Using Multiple Edit Windows



Using the pcANYWHERE Text Editor

The pcANYWHERE Editor is the text editor supplied with pcANYWHERE for Windows. It is the default editor used when creating
and editing scripts.

Features of the pcANYWHERE Editor include:
* A customizable keyboard--you can assign keystrokes to over 100 editing functions.
* MDI windows--you can open many edit windows, then tile, cascade, and minimize them. You can also open the same script 

file in more than one window.
* Uses as much memory as it needs for fast editing of large files.
* Flexible find and replace capabilities, including the use of regular expression text wildcards. The editor also remembers 

recently-used search strings.
* Ability to search for files containing a specific word or phrase and easily open them for inspection or editing.
* Customizable auto-save and automatic backup options.
* Ability to compare two files on a line-by-line basis.
* Auto-indent (handy for programmers).
* Supports word wrapping and paragraph reformatting for simple word processing tasks.
* Remembers recently-edited files--you can reopen the exact same set of files you used in your last editing session.

Opening files when the pcANYWHERE Editor is running:
* Choose the editor's File Open command.
* Or, to open a file that you recently edited, choose it from the list at the bottom of the editor's File menu.
* Or, after using the editor's Find Files Containing command, use the List Found Files command to open any of the found files.

To automatically reload a set of files next time you start:
1 Use the Options Editor Preferences command and check the Restore Session check box.
2 Open the files you want to load the next time you start the editor.
3 Use the File Exit command to quit the editor (Note: don't close the files individually).
4 Next time you start the editor, it automatically opens the same files, arranging the windows in a cascading pattern.



Using Text Editor Macros

The pcANYWHERE Editor allows you to record and play back a single keyboard macro. You can use this to automate simple, 
repetitive tasks.

To record an editor macro:
1 Press F7 (Alt+E,R) to start recording. The status line displays the word REC to indicate it is recording.
2 Type text and use menu commands and keystroke functions to accomplish the desired task.
3 Press F7 again (Alt+E,S) to stop recording. The status line displays the message Keyboard macro defined.

To play back the editor macro:
1 Make sure the desired window is active and the cursor is positioned correctly.
2 Press F8 (Alt+E,P) to begin replaying the macro.

Events that take place in dialog boxes are NOT 
recorded. 

Up to 256 editing events can be recorded. 

The current macro is not saved between editing 
sessions.

Using Multiple Edit Windows

The pcANYWHERE Editor lets you see more than one document at a time and provides standard    ways to access the 
documents.

To activate a window (bring it to the front):
Click any part of it, select it from the window list under the Window menu, or press Ctrl+F6 until it moves to the front.

To enlarge a window to see more text:
First maximize the application window (click the maximize button or press Alt+spacebar,X), then maximize the individual 
document window (click the maximize button or press Alt+hyphen, X).

To see two parts of a document simultaneously:
Activate the desired window. Use the Open Window command of the Window menu. You can scroll the windows 
independently.

To see as much as possible of two documents:
First maximize the application window, then choose the Window Tile command (Alt+W,T).

To see the title bars of all windows:
Choose the Window Cascade command (Alt+W,C).

To iconize a window:
Minimize the window into an icon (click the minimize button or press Alt+hyphen,N). It is now displayed at the bottom of the 
application window.

To restore an icon to a normal-size window:
Double-click the icon, or press Ctrl+F6 until it is highlighted, then press Alt+Hyphen,X to maximize it. You can also select it 
from the Window menu.

To tidy up window icons:
Use the Window Arrange Icons command (Alt+W,A).



Searching with Regular Expressions

The Find, Replace, and Find Files Containing commands of the Search menu provide a powerful text wildcard search capability 
called regular expression searching.

Although not the full-blown "grep" utility known to UNIX programmers, this feature can be useful in many situations. For instance,
it can be used for locating:

* Text in formatted layouts, such as phone numbers, zip codes, text in parentheses, quoted strings, etc.
* Programming elements and idioms; for instance, locating the start of any procedure.
* Proper names or the start of a sentence (i.e., first letter capitalized).
* Blank lines.
* A sequence of digits.
* Lines beginning or ending with some specified text.
* Alternate spellings of a word or name (e.g., Kathy or Cathy).
* Leading or trailing blanks in a line.

One of the powers of this feature over simple text-matching is that you can use it to select entire words or lines that contain a 
match. For instance,

goto selects just that single word when found
<*goto*> selects the entire line that contains the word

You can use this feature in editor macros to automate some operations. For instance, you can easily copy the matching line or 
word to the clipboard and paste it to a second file.

Examples
[KC]athy Kathy or Cathy

[KC]athy [A-Z][~ ]@ Kathy or Cathy and her last name

[A-Z][a-z]@ [A-Z][~ ]@ any two-word proper name

[2-9]??-[0-9]??? any phone number

<*[2-9]??-[0-9]???*> a line that contains any phone number

<* [A-Za-z]@(*){> a line that defines a C function; e.g., int DoIt(x,y){

<{ finds "{" when at the start of a line

<[ \t][ \t]> any line containing only blanks or tabs

\\[nrt] finds "\n" or "\r" or "\t"



Printing

The Desktop Editor provides printing capabilities that will more than satisfy your needs when you are working with text files, 
including font selection, and generation of page headers and footers. For more complex formatting, you may need to open the 
file using a full-featured word processor.

To print an entire document:
1 Activate the document you want to print by clicking its window title.
2 Deselect any selected text by pressing Esc.
3 Choose the File Printer Setup command to specify a printer.
4 Choose the File Page Setup command to select printing options. You can type text to be displayed at the bottom and/or top 

of each page, as well as select a font for the printout.
5 Choose the File Print command to send the file to the printer.

To print a partial document
1 Select the portion of the document you want to print.
2 Follow the steps above. You can modify the header or footer to indicate that this is a partial printout. All lines having any text 

selected are printed.



Comparing Two Files

The pcANYWHERE Editor provides a handy file-comparison feature. This is especially useful for programmers who want to 
check for differences between versions of program source code.

To compare two files:
* (optional) Maximize the editor window and minimize all open documents. This provides screen space to show larger 

document windows when displayed.
1 Choose Compare from the File menu to display the Compare dialog box.
2 Select the two files you want to compare.
3 Leave the Line text box set at 1 for both files.
4 Choose the Horizontal option if you want the files to be displayed one above the other, or choose Vertical for a side-by-side 

display.
5 Click OK. The editor displays both files, highlighting the first difference it finds. If no differences are found, it displays a 

message on the status line.
6 The editor displays a small dialog box. Click Find Next... to advance through the files, or click Cancel when satisfied.



Finding Text in an Open File

The pcANYWHERE Editor can search for simple text strings or for special text wildcards. See Searching with Regular 
Expressions for a description of the latter capability. See Searching for Files for a way to locate all files which contain a specified 
text string.

To search an entire file:
1 Open and activate the file you want to search.
2 Press Ctrl+Home to get to the top of the document (the search always starts at the current cursor location).
3 Press Ctrl+S or use the Find command of the Search menu to bring up the Find dialog box.
4 Enter the text you want to find into the Pattern text box.

Or, press Alt+{bmp symDnAro.Bmp} to choose from a list of recently-used search strings.
Or, you can select text before opening the dialog and the selected text is placed into the text box automatically.

5 Uncheck the Match Upper/Lowercase check box to provide the best chance of finding a similar match. Leave the Regular 
Expressions check box unchecked to speed up the search.

6 Click Next to start searching. If any match is found, it is displayed and highlighted. Otherwise, the message Pattern not found
is displayed in the status line.

To continue a search:
* Press Ctrl+A or use the Find Again command on the Search menu. If another match is found, it is displayed and highlighted. 

Otherwise, the message Pattern not found is displayed in the status line.

To search backward through a document:
1 Position the cursor where you want the search to start.
2 Press Ctrl+S, and follow the steps described above, except use the Previous button in the dialog box to begin the search.
3 Pressing Ctrl+A continues the search backward through the document until it hits the top of the file.



Finding Files that Contain Specified Text

The pcANYWHERE Editor can search the disk for files containing a specified string of text. This is particularly useful for 
programmers wishing to inspect or modify all source code files that use a particular function or variable.

To find files containing a search string:
1 Use the Find Files Containing command on the Search menu to bring up the Find Files Containing dialog box.
2 In the Pattern text box, enter the search string (it can contain regular expression wildcard characters). 

Or, select from the list of previously-used search strings.
3 In the Files text box, enter one or more wildcard file specifications separated by spaces.

Or, select from the list of previously-used filespecs.
Or, click Directory... and select the directory from the tree display.

4 Clear the Match Upper/Lowercase check box, unless you want the search to be case-sensitive. 
5 Check the Regular Expression check box only if you have used text wildcards in the Pattern text box.
6 Click OK to start the search.
7 If any files containing the specified string are found, a list of filenames appears. Just double-click a filename to open it. The 

first occurrence of the found text is displayed.

To inspect or edit other files that contain the found string:
1 Use the List Found Files command on the Search menu to display the List Found Files dialog box.
2 Select a file from the scrolling list and click Open.
3 As you open files from this dialog, they are removed from the list.



Customizing Text Editor Keystrokes

The pcANYWHERE Editor lets you customize the keyboard; you can assign any keystroke to any of over 100 editor functions.

Most users are satisfied with the default key assignments. However, when you are accustomed to another editor, you may find it 
convenient to change some of the pcANYWHERE Editor keystrokes to match your old habits (so your fingers can do the 
thinking...).

To add a keystroke to a function:
1 Browse the Editor Functions:    Functional Groups help topic to familiarize yourself with the available functions.
2 Use the Key Assignments command on the Options menu to display the Key Assignments dialog box.

3 Press  and scroll through the Functions list box until you highlight the function you want to access; its name 
appears in the box on top.

The Current Keys box at the bottom displays what key or keys are currently assigned to the function. You are about to add
another keystroke to those assigned to the function.
4 Press Tab and scroll through the Keys list box until you find the keystroke you want to use to access that function.

The Current Function box at the bottom of the dialog box displays what function (if any) is currently assigned to that 
keystroke. If you proceed, you lose that assignment, since a key can be assigned to only one function.

5 Click Assign.
6 Click Save to save the changes to the file, DEFAULT.KEY.
7 Click OK.

To change a keystroke assignment:
1 Use the Key Assignments command on the Options menu to display the Key Assignments dialog box.

2 Press Tab and  and scroll through the Keys list box until you find the keystroke you want to change.
The Current Function box at the bottom displays what function (if any) is currently assigned to that keystroke. If you 

proceed, you lose that assignment, since a key can be assigned to only one function.

3 Press Shift+Tab and  and scroll through the Functions list box until you find the editor function you want to 
map to the selected keystroke.

4 Click Assign.
5 Click Save to make the assignment permanent.
6 Click OK.



Finding Which Key Performs a Text Editor Function

The pcANYWHERE Text Editor features over one hundred editing functions. Click below to see more on these functions:

 Editor Functions:    Functional Groups

Since some keystrokes may have been reassigned (or if you want avoid this help system), you can find the current key 
assignments as follows:

To see what key performs a function:
1 Use the Key Assignments command on the Options menu to bring up the Key Assignments dialog box.

2 Press  and scroll through the Functions list box until you highlight the function you want to access; its name 
appears in the box on top.

The Current Keys box at the bottom displays what key or keys are currently assigned to the function.
3 Click Cancel to avoid changing any settings.



Customizing the pcANYWHERE Text Editor

The pcANYWHERE Editor lets you customize many of its features. If you are already familiar with another text editor, you can 
modify the pcANYWHERE Editor to conform to your editing habits. And, as you become comfortable with the pcANYWHERE 
Editor, you can make minor adjustments to speed up common operations.

Some customization is automatic. For example, the pcANYWHERE Editor automatically remembers:
* Files that you have recently edited (they are placed on the File menu).
* Search strings you have previously used.
* File types recently used when finding files.
* Files that you have recently compared.
* Page printing settings, including margins, font face and size, headers, and footers.

Here are some other features and the menu commands that let you customize them:

Feature Menu command
Automatic file backups Options Editor Preferences
Automatic file saving Options Editor Preferences
Automatic line indenting Options Document Preferences
Automatic file loading Options Editor Preferences
Convert tabs to spaces Options Document Preferences
Cursor shape Options Editor Preferences
Features not on menus Options Key Assignments
File locking Options Editor Preferences
Header/Footer text Options Document Preferences
Keyboard macro Edit Record Macro (see Using Macros)
Keystroke assignments Options Key Assignments
Line indenting Options Document Preferences
Printer Font Options Document Preferences
Printer Margins Options Document Preferences
Programmer's indenting Options Document Preferences
Reload recent files Options Editor Preferences
Remove trailing spaces Options Editor Preferences
Screen Font Options Editor Preferences
Screen margin settings Options Document Preferences
Tab settings Options Document Preferences
Typing replaces selected text Options Editor Preferences
Undo levels Options Editor Preferences
Word wrapping Options Document Preferences



word
For the purposes of word-wrap:

An unbroken sequence of non-blank characters.

As defined for cursor motion, selection, and deletion:
A sequence of characters unbroken by space, tab, or any common programing text delimiters such as ; , { } ( ), etc.



paragraph
A sequence of lines of text, containing no blank lines.

When determining how to wrap a paragraph, the editor looks backward from the cursor location until it finds a blank line, then 
assumes that the paragraph includes all lines after that, down to, but not including, the first blank line.



status line

The pcANYWHERE Editor status line, at the bottom of its application window, displays information about the currently active edit 
window.

Information, including error messages and search-and-replace status is displayed momentarily on the left side of the status line, 
until the next keystroke or mouse click.



delimiter
When using editor functions to advance or select by "words," the following characters are considered as word-ending delimiters:

tab (0x09)
space (0x20)
end-of-line

_ ( ) " ' , # $ @ ! % ^ & * { } [ ] \ ? / | < > ; . + - = ~ :



regular expression "wildcard" codes
? any single character or space
* zero or more characters or spaces

[chars] any one of the characters between [ and ]
[~chars] any one character except those after the ~
[c1-c2] any one of the range of characters c1 to c2
@ zero or more of the previous character

% or < the beginning of a line
$ or > the end of a line

\t a tab character (0x08)
\f a formfeed character (0x0c)
\c the literal character c; e.g. \\ means \



wildcard file specification
You can use wildcard characters to specify a set of files which share similar names. The wildcard characters are:
* any 1-to-8 character filename (or 0-to-3 character file extension)
? any single character

Examples:

*.* any filename and any extension
*.bak any filename with an extension of .BAK
*.? any file that has a 1-character extension
*. any file that has no extension
*.WK? any filename that has an extension that starts with .WK and then any other single character
rpt??jul.* any filename starting with RPT, then any two characters, then JUL, and having any extension



To call a host PC
On the remote PC:

1 Click Remote Control on the action bar.
2 Double-click the remote PC connection item to call the host PC you want.
3 You may be prompted for the following:

· If your connection item does not include the phone number of the host for a modem connection, you are prompted to type a 
number.

· If your connection item does not include the name of the host PC for a network connection, a list of     network hosts   displays, 
allowing you to choose a host.

A remote can simultaneously connect to as many as ten hosts.

{button ,AL(`remote control connecting')}    Related topics



To create a connection item

1 Click Quick Start on the action bar.
2 Choose a Wizard.
3 Follow the instructions on your screen.

When you click Finish, pcANYWHERE places a new connection item in the window. 

4 Double-click the new connection item to make a connection.

After using a Quick Start Wizard to make a connection item, just double-click the item whenever you want to 
make a connection.    You do not need to use the Wizard to make multiple, identical connection items for the same kind of 
connection.

To create a connection item without using a Quick Start Wizard, choose New from the File menu or choose the 
New item tool from the toolbar.    Property sheets for the new item open automatically so that you can choose settings and enter 
information.

{button ,AL(`modify one')}    Related topics

{button ,PI(`',`TAPI')}    Modem tip



To end a session

On the remote PC:

1 Click  on the remote online toolbar. 
The Ending remote session dialog box displays. 

2 Optional:    Uncheck Host accepts another call to prevent the waiting host from being accessed by another remote PC. 
3 Click Yes. 
4 If you are creating a log of this session, the Log Comment dialog box displays.    Type a comment.

You must have the right to cancel the host in order to uncheck the option in step 2 above.

{button ,AL(`display remote toolbar;ending a remote control session')}    Related topics



To change the properties of a connection item

1 Right-click the connection item you want to modify. 
2 Choose Properties from the context menu. 
3 Change any options in the item’s property sheets and click OK when you have finished.

{button ,KL(`connection item')}    Related topics

{button ,PI(`',`item_reminder')}    Additional tip



To automatically log in to the host PC

On the remote PC:

1 Right-click the remote PC connection item.
2 Choose Properties from the context menu.
3 Click the Settings tab.
4 Type your assigned login.
5 Type your assigned password in the Password and Confirm Password fields.

The next time you make a connection using this connection item, your login and password will be entered automatically at the 
host PC.

{button ,AL(`set caller login')}    Related topics



To choose a connection device

1 Right-click the connection item for which you want to choose a connection device.
2 Choose Properties from the context menu.
3 In the Connection Info tab, check one:
· A TAPI modem definition that Windows 95 or Windows NT 4.0 placed on the pcANYWHERE device list.
· A COM port for a modem or serial cable connection. 
· A network protocol for a network connection.
· A parallel port for a parallel cable connection. 
4 Optional: To customize the device, click Details and choose any options.

Both PCs must be running Windows 95 to make parallel port connections. To communicate in either direction, 
use a bi-directional parallel cable and configure the parallel port in the BIOS for bi-directional communication. 

{button ,AL(`customize device;gateway communications device')}    Related topics

{button ,PI(`',`TAPI')}    Modem tip

{button ,PI(`',`or_wizard')}    Additional tip



To customize a connection device

1 Right-click the connection item for which you want to choose a connection device.
2 Choose Properties from the context menu.
3 In the Connection Info tab, check the connection device you want to customize:

4 Click Details.
A dialog box displays for the connection type you are customizing.

5 Select options to customize the device.

{button ,AL(`gateway communications device;customize device')}    Related topics

{button ,PI(`',`network device customize')}    About network devices



To customize a COM port for a cable connection

1 Right-click the connection item for which you want to choose a connection device.
2 Choose Properties from the context menu.
3 In the Connection Info tab, check the port you want to customize (COM1, COM2, COM3, or COM4).
4 Click Details.

The COM Port dialog box displays.

5 Select options to customize the device.

{button ,AL(`one device;customize device')}    Related topics



To customize a COM port for a modem connection

You must be running pcANYWHERE under Windows NT 3.51 in order to do this.
1 Right-click the connection item for which you want to choose a connection device.
2 Choose Properties from the context menu.
3 In the Connection Info tab, check the COM port you want to customize.
4 Click Details.

The COM Port dialog box displays.

5 Select options to customize the device.
6 Optional:    Click Advanced.

The Advanced Modem Settings dialog box displays.

7 Optional:    Choose settings for your modem.

Important:    If the COM Port dialog box that displays on your system doesn’t include the Use Modem checkbox,
you cannot customize the COM port in the way described here.    Instead, you must add your modem to your Windows configuration 
through Modems in the Control Panel.    Then choose your modem from the device list in the Connection Info tab.    

{button ,AL(`one device;customize device')}    Related topics

{button ,PI(`',`TAPI')}    Modem tip



To customize a network device so that it uses a gateway

1 Click either Remote Control, File Transfer, or Call Online Service on the action bar.
2 Right-click the connection item that you want to set to use a gateway.    
3 Choose Properties from the context menu.
4 In the Connection Info tab, check either IPX, SPX, NetBIOS, Banyan VINES, or TCP/IP:
5 Click Details.

The Details tab for the network device displays.

6 Check Use gateway.
7 Optional:    Type the name of the pcANYWHERE gateway you want to use.
8 Optional:    Type the name of the gateway’s class.

{button ,AL(`one device;customize device;gateway task')}    Related topics

{button ,PI(`',`network device customize')}    About network devices



 To customize a NASI/NCSI connection device

1 Right-click the connection item for which you want to choose a connection device.
2 Choose Properties from the context menu.
3 In the Connection Info tab, check the connection device you want to customize.
4 Click the name of the device.
5 Click Details.

The User tab of the NASI/NCSI dialog box displays.

6 Select options to customize the device.
7 Choose the Details tab.

The Details tab of the NASI/NCSI dialog box displays.

8 Select options to customize the device.

If you receive an error message when attempting a NASI/NCSI connection, you must check the properties of the 
IPX/SPX protocol in the Windows 95 Network property page. 
1 Choose Network from the Windows 95 Control Panel. 
2 Select the IPX/SPX protocol and click Properties. 
3 Click the Advanced tab and choose Maximum Connections from the Property list box.
4 Click Value and type 50 in the text box. Click OK to save.

{button ,AL(`one device;customize device')}    Related topics



To configure pcANYWHERE utilities in an online service connection item

1 Click the Call Online Service on the action bar.
2 Right-click the connection item for which you want to configure utilities.
3 Choose Properties from the context menu.
4 Choose the Session tab.
5 Choose options and files for session playback, running scripts, and creating session logs.

Whenever you make a connection using this connection item, the utility options you have chosen are in effect.

{button ,KL(`utilities')}    Related topics



To configure pcANYWHERE utilities for a remote control connection item

1 Click either Remote Control, or File Transfer on the action bar.
2 Right-click the connection item for which you want to configure utilities.
3 Choose Properties from the context menu.
4 Choose the Automated Tasks tab.
5 Choose options and files for running scriptsor AutoXfer procedures, session playback,and creating session logs.

Whenever you make a connection using this connection item, the utility options you have chosen are in effect.

{button ,KL(`utilities')}    Related topics

{button ,PI(`',`item_reminder')}    Additional tip



To protect a connection item

1 Right-click the connection item you want to protect.
2 Choose Properties from the context menu.
3 Choose the Protect Item tab.
4 Type a password in the Password field.
5 Re-type the password in the Confirm Password field.
6 Check the activities (viewing, modifying, executing) that you want to restrict.

Protect item passwords are case-sensitive.

{button ,KL(`security')}    Related topics

{button ,PI(`',`or_wizard')}    Additional tip



To set the remote PC to wait for a call from the host

On the remote PC:

1 Right-click the remote PC connection item.
2 Choose Wait for Connection from the context menu.

{button ,AL(`remote control connecting')}    Related topics

{button ,PI(`',`or_wizard')}    Additional tip



To use callback 

On the host PC:

1 Right-click the host PC connection item for the host that is going to call back a remote PC.
2 Choose Properties from the context menu.
3 Click the Callers tab.

Specify individual caller privileges must be selected in order to use callback. 
4 Right-click the caller item for the remote PC you want to call back.
5 Choose Properties from the context menu.
6 Click the Callback tab.
7 Check Call back the remote user.
8 Type the remote PC’s phone number.    

{button ,AL(`remote control connecting;host connecting')}    Related topics

{button ,PI(`',`additional_callback')}    About callback

{button ,PI(`',`or_wizard')}    Additional tip



To start file transfer during a remote control session

On the remote PC:

    Click 

 on the remote online toolbar.

The File Manager window displays.

{button ,AL(`display remote toolbar;move those files;host transfer')}    Related topics



To turn on screen scaling during a remote control session

On the remote PC:

    Click 

 on the remote online toolbar.
The host’s screen fits your exactly, and the scroll bars disappear.

{button ,AL(`display remote toolbar')}    Related topics



To send Control+Alt+Delete to the host PC

On the remote PC:

    Click 

 on the remote online toolbar.

This option applies only if you are running pcANYWHERE under Windows NT.

{button ,AL(`display remote toolbar')}    Related topics



To view the host’s screen in a full window

On the remote PC:

    Click 

 on the remote online toolbar.

This option is only functional when both hostand remote are running the same resolution.
To return to viewing the host’s screen in a sizable window:

1 Press Alt+Enter.
The Windows System Key Pressed dialog box displays.

2 Choose Execute locally:

3 Click OK.

{button ,AL(`display remote toolbar')}    Related topics



To open a Chat window

On the remote PC:

    Click 

 on the remote online toolbar.
The Chat window displays.

{button ,AL(`display remote toolbar;host chat')}    Related topics



To record part of a session

On the remote PC:

1 On the remote online toolbar, click .
The Select Recording File dialog box displays.

2 Select or type the name of a file in which to record the session.

3 When you want to stop recording, click  on the remote online toolbar again.

{button ,AL(`record first;play it back;display remote toolbar')}    Related topics



To save a screen during a session

On the remote PC:

1 On the remote online toolbar, click .
2 Choose or type the name of a file in which to save the screen.

{button ,AL(`display remote toolbar')}    Related topics



To restart the host PC

On the remote PC:

On the remote online toolbar, click 

.

You can restart the host PC only if you have been granted this privilege in the host connection item located on 
the host.

{button ,AL(`caller sec;display remote toolbar')}    Related topics

{button ,PI(`',`additional_reboot')}    About restarting the host



To run a script during a session

On the remote PC:

1 Click the System Menu .
2 Choose Scripts from the pcANYWHERE remote menu.
3 Select the script and click Run.

{button ,AL(`script create;script modify')}    Related topics



To transfer the clipboard

On the remote PC:

1 On the remote online toolbar, click .
The Transfer Clipboard dialog box displays. 

2 Choose one:
· Transfer the host’s clipboard to your clipboard.
· Transfer your clipboard to the host’s clipboard.
3 Check Text, Graphics, or both.
4 Click OK.

{button ,AL(`display remote toolbar')}    Related topics



To print files during a remote control session at the remote PC:

Use this procedure on the host PC to install printer definitions for printers that will be used by remote callers 
when they want to print host files during a session. You can install as many remote printers as you wish by repeating the following 
steps for each printer that will be used by the remote callers.

On the host PC:
1. Choose Application Options from the File menu. 
2. Click the Remote Printing tab. 
3. Click Add Printer to add a remote printer definition to the list.
4. Do one of the following:

· Select the remote printer driver from the list of Currently Installed Drivers and click Next.
· Select the manufacturer and model of the remote printer from the Manufacturers and Printers list boxes and click Next. 

5.Type a name that identifies the owner or location of the remote printer and click Finish. The remote caller 
selects this name to print to the local printer during a remote control session.

If the remote printer driver is not listed in the Manufacturers list box, install it following the printer 
manufacturers instructions. After installation, you can select it as a remote printer from the Currently Installed 
Driver list.

{button ,KL(`printing')}    Related topics



To change online settings

On the remote PC:

1 On the remote online toolbar, click .
2 Click the General or DOS Settings tab.
3 Set the options on any tab.

{button ,AL(`default remote options;display remote toolbar')}    Related topics



To set ColorScale  during a session
On the remote PC:

1 On the remote online toolbar, click .

2 Choose the ColorScale  option you want.
3 Click OK.

The host window refreshes using the setting you chose.

In order to use this option effectively, the color palette on the host PC must be set to 256 colors or greater.

{button ,AL(`display remote toolbar;optimize desktop;optimize color before')}    Related topics

{button ,PI(`',`color_scaling')}    About ColorScale



To blank a host screen during a session

On the remote PC:

1 On the remote online toolbar, click .
2 Check Host screen blanked and click OK.

The screen of the host PC cannot be seen at the host site.

You can blank the host PC’s screen only if you have been granted this privilege in the host connection item 
located on the host.

{button ,AL(`display remote toolbar;blank for all')}    Related topics



To transfer files

1 In the File Manager window, choose the folder on the destination PC (where you want to send files/folders).
2 Choose the folder on the source PC (where files/folders are currently located that you want to send).
3 On the source PC, select the files and/or folders that you want to transfer. 
4 Be sure that the large red arrow in the top center of the window points toward the destination PC (where you want to send 
files).    If it doesn’t, click the arrow once to change the direction of the file transfer.
5 Click Send. 

You can also drag the files from one side of the File manager window to the other to transfer them.

{button ,AL(`start transfer;clone;synchronize')}    Related topics



To compare folders

1 In the File Manager window, select the host and remote folders you want to compare.
2 Choose Compare Folders from the File menu.

If the folders’ contents are different, files that are in one folder but not the other are highlighted. 

{button ,AL(`clone;synchronize;move those files')}    Related topics



To synchronize folders and files

1 In the File Manager window, choose the host and remote folders you want to synchronize.
2 Optional: Choose files you want to synchronize.
3 Click Sync.

The Synchronize Folder dialog box displays.

4 Choose either All files or Selected files.
5 Optional:    If you have selected All files, and you want to synchronize all folders within the ones you have selected, check 
Include folders in this folder.
6 Click OK to begin synchronization.

{button ,AL(`clone;move those files')}    Related topics



To synchronize files using filters

1 Do one:
· In the File Manager window, select the host and remote files you want to synchronize.
· Choose Filter from the View menu, select a type of file to synchronize, and click OK.
2 Click Sync.

{button ,AL(`synchronize')}    Related topics



To clone folders

 Cloning could result in data loss. If you are unsure of the files that will be deleted, compare the two folders first. 
1 In the File Manager window, choose first the source folder that you want to duplicate.
2 Choose the destination folder.    (Note: This folder becomes an exact match of the source folder.)
3 Choose Clone from the File menu.

The Clone Folder dialog box displays. 

4 Verify that the source and destination folders are correct.
5 Optional:    Check Include folders in these folders if you want the cloning process to include them.
6 Click OK to begin the cloning process.

{button ,AL(`synchronize;move those files')}    Related topics



To set file transfer options

Do this in the File Manager window before you have started the transfer.
1 Choose File Transfer options from the Configure menu.
The File Transfer Options dialog box displays.
2 Choose the Destination file overwrite method, Compression, and Crash recovery options you want for this file transfer.

{button ,AL(`move those files;start transfer')}    Related topics



To call an online service

1 Click Call an Online Service on the action bar.
2 Double-click the online service connection item for the service you want to call.

{button ,AL(`online options')}    Related topics



To set online service options

1 Right-click the online service connection item for the online service you want to call.
2 Choose Properties from the context menu.
3 Click the Settings tab.
4 Select the terminal emulation required by the service.
5 Optional:    Choose the file transfer protocol of the online service.
6 Type the phone number of the online service.
7 Optional:    Click the Advanced tab.
8 Optional:    Select options to customize the terminal emulation.

{button ,AL(`customize protocol;customize termem;change term during;change protocol during')}    Related topics



To print only the current screen from the terminal window

    Select Print Screen from the File menu to print only the current terminal display.

{button ,AL(`print term cont')}    Related topics



To print continuously from the terminal window

    Choose Print Online from the Sessions menu. 
Terminal window output is sent to your printer until you stop terminal window printing. 

To stop terminal window printing 

Choose Print Online from the Sessions menu. 

 Printing a session is like using a camcorder or VCR in that you need to start and stop the recording. 

{button ,AL(`print term screen')}    Related topics

{button ,PI(`',`term_print2')}    About terminal window printing



To paste text to the terminal window

1 In another Windows application, select the text that you want to paste.
2 Choose Copy (or Cut) from the Edit menu of the other Windows application to copy the text to the clipboard. 
3 Switch to the pcANYWHERE terminal window. 
4 Choose Paste from the Edit menu. 

{button ,AL(`paste to service')}    Related topics



To paste text to an online service

1 In another Windows application, select the text that you want to paste.
2 Choose Copy (or Cut) from the Edit Menu of the other Windows application to copy the text to the clipboard. 
3 Switch to the pcANYWHERE terminal window. 
4 Choose Paste To Host from the Edit menu.

{button ,AL(`paste to term')}    Related topics



To adjust hardware parameters during an online service session

1 In the terminal window, choose Hardware from the Session menu. 
The Hardware Settings dialog box displays.

2 Choose the hardware parameters you want for Data Rate, Parity and Flow Control. 

{button ,AL(`customize device')}    Related topics



To adjust terminal emulation options during an online service session

1 In the terminal window, choose Terminal from the Session menu. 
The Terminal Settings dialog box appears.

2 Select the terminal emulation options that you want. 

{button ,AL(`customize termem')}    Related topics

{button ,PI(`',`term_adjem')}    Additional tips



To adjust terminal window display during an online service session

1 In the terminal window, choose Display from the Session menu. 
The Display dialog box appears.

2 Select the display options that you want. 

{button ,AL(`online options')}    Related topics



To run a script during an online service session

1 In the terminal window, choose Scripts from the File menu. 
The Scripts dialog box appears.

2 Choose the script.
3 Click Run. 

{button ,AL(`script create;script modify')}    Related topics



To end an online service session

 In the terminal window, choose Exit from the File menu. 

If you are creating a log file of this session, the Log Comment dialog box displays.    Type a comment.



To change file transfer protocol during an online service session

1 In the terminal window, choose Protocol from the Transfers menu.
The File Transfer Protocol dialog box appears.

2 Select the protocol for the transfer.
3 Click OK.

{button ,AL(`customize protocol')}    Related topics



To receive files from an online service

1 In the terminal window, choose a file for transfer and initiate download by following online service instructions. 
2 Choose Receive File from the Transfer menu. 

The Select Files For Transfer dialog box appears.    The selected filename and download folder display in the dialog box.

3 Optional:    Change the target (download) folder or edit the filename and click OK. 

{button ,AL(`send to online')}    Related topics



To send files to an online service

1 In the terminal window, initiate upload according to the online service’s instructions. 
2 Choose Send File from the Transfer menu. 

The Select Files For Transfer dialog box displays.

3 Select a file for uploading. 
4 Optional:    Change the target folder or edit the filename and click OK.

{button ,AL(`receive from online')}    Related topics



To set file transfer options during an online service session

1 In the terminal window, choose Protocol from the Transfers menu.
The File Transfer Protocol dialog box appears.

2 Select the protocol and settings for the transfer.
3 Click OK.

{button ,AL(`customize protocol')}    Related topics



To wait for a call

On the host PC:

1 Click Be A Host PC on the action bar.
2 Double-click the host connection item for the host you want to launch.

A host can wait for a call on more than one device. When the host answers a call one one device,    the other 
device is not available until the first session ends. 

{button ,AL(`host connecting')}    Related topics



To call a remote PC

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item.
3 Choose Call Remote from the context menu.

{button ,AL(`host connecting')}    Related topics



To end a session from the host PC

1 Right-click pcANYWHERE in Session on the taskbar.
2 Choose End Session from the pcANYWHERE Host menu.

    You cannot access the host menu on a host PC that has been locked during a remote control session.

{button ,AL(`ending a remote control session;cancel host')}    Related topics



To set host security options

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item.
3 Choose Properties from the context menu.
4 Click the Security Options tab.
5 Select options to protect the security of the PC when it is a host using this connection item.

{button ,KL(`security')}    Related topics



To select data encryption

Data encryption can be selected on both the host PC and the remote PC.

1 Right-click the host or remote connection item for which you want to select data encryption.
2 Choose Properties from the context menu.
3 Click the Security Options tab.
4 Select the level of encryption to use during a session.
5 Check Deny Lower Encryption Level if you want to prevent connections with PCs that use a lower encryption level. 

Earlier versions of pcANYWHERE support pcANYWHERE encryption only. Checking the Deny Lower Encryption 
Level will prevent connections with PCs using pcANYWHERE versions 2.0, 5.0, and 7.x.

{button ,KL(`security')}    Related topics



To blank the host PC’s screen for all sessions

On the host PC:

1 Right-click the host connection item for which you want to select data encryption.
2 Choose Properties from the context menu.
3 Click the Security Options tab.
4 Check Blank this PC screen after connection made.

{button ,AL(`blank during')}    Related topics



To create a caller item

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item for the host to which the caller will connect.
3 Choose Properties from the context menu.
4 Choose the Callers tab.
5 Choose Specify individual caller privileges if it is not selected:

6 Double-click the Add Caller item.
7 Follow the instructions on your screen.

When you click Finish, pcANYWHERE adds a caller item to the window for this host.

{button ,KL(`security')}    Related topics



To select a caller folder

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item whose caller folder you want to select.
3 Choose Properties from the context menu.
4 Click the Callers tab.
5 If it is not selected, choose Specify individual caller privileges.
6 Click the folder browse tool.
7 Select the folder containing all caller items for this host.
8 Click OK.

If you do not see the folder browse tool in the Callers tab, customize pcANYWHERE’s toolbars to include folder 
tools.

{button ,AL(`host callers;customize toolbar')}    Related topics

{button ,PI(`',`additional_folder')}    About caller folders



To set general host options

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item whose caller folder you want to select.
3 Choose Properties from the context menu.
4 Click the Settings tab.
5 Select the options for remote control sessions using this host connection item.

{button ,AL(`host configuration')}    Related topics



To set a caller’s login name and password

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item.
3 Choose Properties from the context menu.
4 Click the Callers tab.

Specify individual caller privileges must be selected.
5 Right-click the caller item representing the remote caller whose password you want to set.
6 Choose properties from the context menu.
7 Type a login name.
8 Type a password in the password field.    
9 Re-type the password in the Confirm password field.    

{button ,KL(`security')}    Related topics

{button ,PI(`',`additional_password')}    About login names



To set caller security privileges

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item.
3 Choose Properties from the context menu.
4 Click the Callers tab.
5 Choose Specify individual caller privileges if it is not selected:

6 Right-click the caller item representing the remote caller whose privileges you want to set.
7 Choose Properties from the context menu.
8 Click the Advanced tab.
9 Do one:
· Check Superuser to grant this caller all rights appearing on this property sheet.
· Select the rights and session parameters you want to grant to this caller.

{button ,KL(`security')}    Related topics



To create a Superuser

On the host PC:

1 Click Be A Host PC on the action bar.
2 Right-click the host connection item.
3 Choose Properties from the context menu.
4 Click the Callers tab.
5 Select Specify individual caller privileges if it is not selected:

6 Right-click the caller item representing the remote caller you want to make a Superuser.
7 Choose Properties from the context menu.
8 Click the Advanced tab.
9 Check Superuser - caller has full access rights.

{button ,AL(`host callers')}    Related topics



To access the pcANYWHERE host menu

Right-click pcANYWHERE in Session on the taskbar.
The host online menu appears.

    You cannot access the host menu on a host PC that has been locked during a remote control session.

{button ,AL(`host during session')}    Related topics



To transfer files on the host PC

On the host PC:

1 Right-click pcANYWHERE in Session on the taskbar.
2 Choose File Transfer from the pcANYWHERE Host menu.
3 Choose either:
· Controlled by Host, in order to view the File Manager window and transfer files at the host.
· Controlled by Remote, in order to open the File Manager window on the remote PC.

    You cannot access the host menu on a host PC that has been locked during a remote control session.

{button ,AL(`start transfer;host during session')}    Related topics



To open a Chat window on the host PC

1 Right-click pcANYWHERE in Session on the taskbar.
2 Choose Chat from the pcANYWHERE Host menu.
The Chat window opens.

    You cannot access the host menu on a host PC that has been locked during a remote control session.

{button ,AL(`remote chat')}    Related topics



To set up a PC to be a gateway

On the gateway PC:

1 Click QuickStart on the action bar.
2 Choose the Gateway Wizard.
3 Follow the instructions on your screen.

When you click Finish, pcANYWHERE places a gateway connection item in the main window.    

    If the callback option is used in making a connection with a gateway, the gateway must be bidirectional. 

{button ,AL(`gateway communications device;bidirectional create')}    Related topics



To activate a gateway

On the gateway PC:

1 Click Be a Gateway on the action bar.
2 Double-click the gateway connection item for this PC.

{button ,AL(`gateway configuration')}    Related topics



To set up the connection devices of a gateway

On the gateway PC:

1 Click Be a Gateway on the action bar.
2 Right-click the gateway connection item whose connection devices you want to set up.
3 Choose Properties from the context menu.
4 Check the incoming device for this gateway.    (The remote PC "calls" this device.)
5 Check the outgoing device for this gateway.    (The host PC is "called" on this device.)
6 Optional:    To customize each device, click the name of that device and click Settings.    Then select options for that device.

{button ,AL(`one device;bidirectional create')}    Related topics

{button ,PI(`',`or_wizard')}    Additional tips



To create a bidirectional gateway

On the gateway PC:

1 Click Be a Gateway on the action bar.
2 Right-click the gateway connection item whose connection devices you want to set up.
3 Choose Properties from the context menu.
4 Choose the Settings tab.
5 Check Bidirectional.
6 Choose the Connection Info tab.
7 Check a device in each column.    (Remote PCs can "call in" to either device and reach a host PC through the other device.)
8 Optional: To customize each device, select the name of that device and click Details.    Then select options for that device.

{button ,AL(`gateway configuration')}    Related topics

{button ,PI(`',`or_wizard')}    Additional tips



To dial in to a network

1 Click Remote Networking on the action bar.
2 Double-click a remote networking connection item.

The Dial-Up Networking dialog box displays.

3 Optional:    Check Do remote control over dial-up networking to establish a remote control connection on top of the network 
connection.
4 Optional:    Click Remote Control Settings.

A pcANYWHERE remote control connection item  ’  s   property pages open.

5 Optional: Choose options for the remote control connection.

In the Connection Info tab, you must choose one of these connection devices: NetBIOS, SPX, or IPX.
6 Click OK.
7 Type in your login name and password required to attach to the network.

{button ,AL(`remnet')}    Related topics

{button ,PI(`',`more_remnet')}    More about remote networking



To end a remote networking session

In the Connected to dialog box, click Disconnect.

If you are also connected to another PC in a remote control session through the network, that session also 
ends.

{button ,AL(`remnet')}    Related topics



To add remote control to a remote networking session

Once you have established a remote networking connection, you can connect to any waiting host PC attached 
to that network, in a remote control session.
1 Click Remote Control on the action bar.
2 Double-click a remote control connection item. 

{button ,AL(`remnet')}    Related topics

{button ,PI(`',`more_remnet')}    More about remote networking



To create a log file of a session

1 Right click a connection item in one of these pcANYWHERE modes: Remote Control, Call Online Service, or File Transfer.
2 Choose Properties from the context menu.
3 Click the Automated Tasks Session tab.
4 Check Save session statistics in activity log file.

Statistics of sessions initiated with this connection item are stored in a log file.

{button ,KL(`logs')}    Related topics



To create a report from logged data

1 Choose Activity Log Processing from the Utilities menu.
2 Select the type of logged data to process. 
3 Click Report. 
4 Type a filename for the report and click Open. 
5 Select options for the report in the Host & Remote Session Log Report dialog box and click OK.

If you choose to view the report now, it opens in the Script Editor window.

{button ,KL(`logs')}    Related topics



To archive/delete a log file

1 Choose Activity Log Processing from the Utilities menu to access the Activity Log Processing dialog box. 
2 Select the log file you want to process. 
3 Click Archive/Delete. 

The Archive/Delete Host/Remote Log dialog box appears.

4 Select entries you want to delete and archive and click OK. 

{button ,KL(`logs')}    Related topics



To create a script

1 Choose Scripts from the Utilities menu.
2 Click New.

The pcANYWHERE Text Editor window displays.

3 Enter the script commands you want to include.
4 Choose Save from the File menu.
5 Type a filename and click OK.

The Text Editor window closes.

    A script must compile with no errors before it runs.    Scripts automatically compile when you run them.

{button ,KL(`scripts')}    Related topics



To run a script

1 Choose Scripts from the Utilities menu.
2 Select the name of the script you want to run.
3 Click Run.

{button ,KL(`scripts')}    Related topics



To edit a script

1 Choose Scripts from the Utilities menu.
2 Select the name of the script you want to edit.
3 Click Edit.

The pcANYWHERE Text Editor window displays.

4 Make any changes to the script.

{button ,KL(`scripts')}    Related topics



To compile a script

1 Choose Scripts from the Utilities menu.
2 Select the name of the script you want to compile.
3 Click Compile.

{button ,KL(`scripts')}    Related topics



To delete a script

1 Choose Scripts from the Utilities menu.
2 Select the name of the script you want to delete.
3 Click Delete.

{button ,KL(`scripts')}    Related topics



To convert configuration files

1 Choose Data Conversion from the Utilities menu. 
The Data Conversion Wizard appears. 

2 Follow the instructions on your screen.

{button ,AL(`data conversion overview')}    Related topics



To record a remote control session

1 Right-click a connection item in one of these pcANYWHERE windows: Remote Control, Call Online Service, or File Transfer.
2 Choose Properties from the context menu.
3 Click the Automated Tasks tab.
4 Check Record session in file for later playback.
5 Optional:    Click Browse and select a folder in which to place the file.
6 Type the name of the file in which to record the session.

{button ,AL(`play it back;record during remote control session')}    Related topics



To record an online service session

1 Right-click a connection item in the Call Online Service window.
2 Choose Properties from the context menu.
3 Click the Session    tab.
4 Check Record session in file for later playback.
5 Optional:    Click Browse and select a folder in which to place the file.
6 Type the name of the file in which to record the session.

{button ,AL(`play it back;record during online service session')}    Related topics



To play back a session

1 Choose Playback Sessions/Screens from the Utilities menu.
The Select Playback File dialog box appears.

2 Select the file you want to play back.
3 Select options in the Playback Options dialog box and click OK. 
4 Control the session using the Playback Control Panel.

{button ,AL(`save a screen;record first;record during')}    Related topics



To save a screen from a session playback

1 Choose Playback Sessions/Screens from the Utilities menu.
The Select Playback File dialog box displays.

2 Choose the file you want to play back.
3 When you see the screen from the playback that you want to save, click Pause to temporarily stop the playback, then click 
Save screen to save the    screen.
4 Type a filename for the file in which the screen will be saved.
5 Click OK.

{button ,AL(`play it back;record first')}    Related topics



To name your PC in pcANYWHERE

1 Choose Application Options from the File menu.
2 Select User defined.
3 Type the name that you want pcANYWHERE to use to identify your PC in a remote control session.

The User defined option may not be available to you if you are using a network version of pcANYWHERE.



To set default remote control options

On the remote PC:

1 Choose Application Options from the File menu.
2 Click the Remote Operation tab.
3 Select default options for remote control sessions.

    The options you select here affect sessions in which this PC is the remote PC.

{button ,AL(`online remote options')}    Related topics

{button ,PI(`',`remcon_default')}    About remote control options



To optimize the host’s desktop

On the remote PC:

1 Choose Application Options from the File menu.
2 Click the Remote Operation tab.
3 Check Optimize desktop for remote control.

{button ,AL(`optimize color;optimize color before')}    Related topics

{button ,PI(`',`optimize_desktop')}    About Optimize desktop



To select ColorScale
On the remote PC:
1 Choose Application Options from the File menu.
2 Click the Remote Operation tab.

3 Select the ColorScale  option you want to use to display colors on the host PC during a remote session.

In order to use this option effectively, the color palette on the host PC must be set to 256 colors or greater.

{button ,AL(`optimize desktop;optimize color')}    Related topics

{button ,PI(`',`color_scaling')}    About ColorScale



To add a TCP/IP host

1 Choose Application Options from the File menu.
2 Click the TCP/IP tab.
3 Type any of the following identifiers for the TCP/IP hosts you want to connect to:

n pcANYWHERE host name - Use if the host is located on the local subnet. The host name appears in the Network Hosts 
dialog box.

n DNSname - Use if the network administrator has assigned DNS names and IP addresses to the host PCs.
n IP address - Use to connect to a host regardless of the subnet it is located on. The host IP address appears in the Network 

Hosts dialog box.
n Specific group IP address - Substitute 255 for the last portion of an IP address to display all hosts having an IP address 

containing the first three portions of the group address. For example, an address of 120.45.62.255 causes pcANYWHERE to 
list all hosts with an IP address beginning with 120.45.62. 

Use the group IP address to connect to a host that is connected to the Internet through an Internet service 
provider.
4 Click Add.

{button ,AL(`TCP/IP app')}    Related topics



To remove a TCP/IP host

1 Choose Application Options from the File menu.
2 Click the TCP/IP tab.
3 In the list of current hosts, select the host you want to remove.
4 Click Remove.

{button ,AL(`TCP/IP app')}    Related topics



To customize a file transfer protocol

1 Choose Application Options from the File menu.
2 Click the File Transfer tab.
3 Select the protocol you want to customize.
4 Click Settings.

The dialog box for the selected protocol displays.

5 Select the options you want for this protocol.
6 Click OK.

{button ,AL(`online options;change protocol during')}    Related topics

{button ,PI(`',`more_protocol')}    About the pcANYWHERE protocol



To customize terminal emulation

1 Choose Application Options from the File menu.
2 Click the Terminal Emulation tab.
3 Check the Display options you want for terminal emulation in online service    sessions.
4 Optional:    Click to customize macro keys, translation tables, and the font and colors for terminal emulation.

{button ,AL(`online options;change term during')}    Related topics



To customize toolbars

1 Choose Application Options from the File menu.
2 Click the Button bars tab.
3 In the Toolbar options group box, check:
· the folder history tool to place it on all toolbars
· the folder browse tool to place it on all toolbars

{button ,AL(`action bar app;display toolbar')}    Related topics



To customize the action bar

1 Choose Application Options from the File menu.
2 Click the Button bars tab.
3 In the Action buttons to show group box, check the buttons to appear on the action bar.
4 In the Action button size group box, select the appearance of buttons on the action bar.

You can drag the action bar and the toolbar to different positions in the main pcANYWHERE window.

{button ,AL(`toolbar app')}    Related topics



To delete a connection item

1 Right-click the connection item you want to delete.
2 Choose Delete from the context menu.

You cannot perform this procedure in pcANYWHERE’s Remote Networking mode.

{button ,KL(`connection item')}    Related topics

{button ,PI(`',`item_reminder')}    Additional tip



To rename a connection item

1 Right-click the connection item you want to rename.
2 Choose Rename from the context menu.
3 Type the new name for the item.
4 Press Enter.

You cannot perform this procedure in pcANYWHERE’s Remote Networking mode.

{button ,KL(`connection item')}    Related topics



To use a Quick Start Wizard to make a connection

1 Click Quick Start on the action bar.
2 Choose a Wizard.
3 Follow the instructions on your screen.
4 Double-click the new connection item to make a connection.

After using a Quick Start Wizard to make a connection item, just double-click the item whenever you want to 
make a connection.    You do not need to use the Wizard to make multiple, identical connection items for the same kind of 
connection.

{button ,AL(`modify one')}    Related topics

{button ,PI(`',`TAPI')}    Modem tip



To specify a download folder

1 Choose Application Options from the File menu.
2 Click the File Transfer tab.
3 Do one:
· Type the name and path of the folder where downloaded files will reside.
· Click Browse and select the folder in the Select Folder dialog box.

The folder you specify receives files transferred during online service sessions only.

{button ,AL(`online file transfer')}    Related topics



To define macro keys

1 Choose Application Options from the File menu.
2 Choose the Terminal Emulation tab.
3 Click Macro Keys.
4 Type a filename for the file that will contain your macro key definitions and click OK.

The Macro Keys dialog box displays. 

5 Choose the first macro key you want to define from the Macro key list box.
6 Choose the type of macro to run from the Macro Type group box.
7 Type the text, script, or program to run with the macro key you are defining.
8 Repeat steps 5 through 7 above for all keys you want to define.

{button ,KL(`terminal emulation')}    Related topics



To define a translation table

1 Choose Application Options from the File menu.
2 Click    the Terminal Emulation tab.
3 Click Translation Table.
4 Type a filename for the file that will contain your translation table and click OK.

The Translation Table dialog box displays. 

5 Choose the code for which you want to set translation parameters.
6 In the Receive translation box, type in the code as you want your PC to translate it before receiving it.
7 In the Transmit translation box, type in the code as you want your PC to translate it before sending it to another PC or system.
8 Repeat steps 5 through 7 above until you have entered all codes you want your PC to translate and click OK.

{button ,KL(`terminal emulation')}    Related topics



To cancel a waiting host 

On the host PC:

1 Optional:    If the pcANYWHERE host is minimized, click the minimized host button on the taskbar.
The Host waiting dialog box appears.

2 Click Cancel. 
The main pcANYWHERE window displays.

{button ,AL(`ending a remote control session')}    Related topics



To disable the host PC’s hardware

On the remote PC:

1 On the remote online toolbar, click .
2 Check Host keyboard locked and click OK.

{button ,AL(`default remote options')}    Related topics



To close the File Manager window

    Choose Exit from the File menu. 
You are still connected to another PC in a remote control session.

{button ,KL(`ending a session')}    Related topics



To sort files in the File manager window

In the File Manager window, choose one of the following from the View menu:
· By Name.
· By Ext.
· By Date.
· By Size.

{button ,AL(`remote control file transfer')}    Related topics



To filter the files displayed in the File Manager window

1 In the File Manager window, click to select the folder (remote or host) you want to filter.
2 Choose Filter from the View menu.

The Filter dialog box appears.

3 Do one:
· Click All Files.
· Click Programs.
· Click Documents.
· Click Custom, and type a filter expression, such as *.bhf.

4 Optional: Uncheck the Show Folders checkbox to display only files in the window.
5 Click OK.

{button ,AL(`remote control file transfer')}    Related topics



To copy a connection item

1 Right-click the connection item you want to copy.
2 Choose Copy from the context menu.
3 Optional:    Click the folder browse tool and select a different folder.
4 Choose Paste from the Edit menu.

A second connection item, with the same properties as the original, appears in the pcANYWHERE window.

{button ,KL(`connection item')}    Related topics



To place a connection item on the Desktop

    Drag the connection item outside of the pcANYWHERE window and release it anywhere on your Windows Desktop.

Just double-click the connection item from the Desktop to make connections.    The security options you 
included in the item continue to protect it outside pcANYWHERE.    You cannot, however, drag-and-drop a connection item from the 
Windows Desktop into a pcANYWHERE window.

To initiate a file transfer connection, right-click a file transfer connection item from the Desktop and choose Start
file transfer from pcANYWHERE host from the context menu.

{button ,KL(`connection item')}    Related topics



To make a connection from the Explorer

Double-click a pcANYWHERE connection item as it appears in the Explorer.

Only the mode of the program for the item you have chosen runs; the main pcANYWHERE window does not display, even 
though you are making a connection.

pcANYWHERE connection items are files with the following extensions:
Be a Host PC .BHF
Remote Control .CHF
Gateway .GWF
Online Service .OSF

You cannot make a remote networking connection from the Explorer.

To initiate a file transfer connection, right-click a Remote Control file in the Explorer and choose Start file 
transfer from pcANYWHERE host from its context menu.

{button ,KL(`connection item')}    Related topics



To scan all downloaded files for viruses

1 Choose Application Options from the File menu in pcANYWHERE’s main window.
2 Click the File Transfer tab.
3 Check Virus Check all Downloaded Files.

Whenever you begin to transfer files to your PC, Norton AntiVirus scans those files on the host PC or online service before they 
are sent.    If a virus is detected, the transfer does not occur.    

{button ,AL(`move those files;receive from online')}    Related topics

{button ,PI(`',`virus')}    More about AntiVirus



To make a file transfer connection
1 Click File Transfer on the action bar.
2 Double-click the file transfer connection item to call the host PC with which you want to transfer files.
3 You may be prompted for the following:

n If your connection item does not include the phone number of the host for a modem connection, you are prompted to type a 
number.

n If your connection item does not include the name of the host PC for a network connection, a list of     network hosts   displays, 
allowing you to choose a host.

{button ,AL(`file transfer configuration')}    Related topics

{button ,PI(`',`or_wizard')}    Additional tip

{button ,PI(`',`file_trans_rem_con')}    Connection item reminder



To display the toolbar

Choose Toolbar from the View menu.

You can drag the action bar and the toolbar to different positions in the main pcANYWHERE window.

{button ,AL(`toolbar app;display remote toolbar')}    Related topics



To change how connection items display

    Do one:
· Choose Large Icons from the View menu. 
· Choose Small Icons from the View menu. 
· Choose List from the View menu. 
· Choose Details from the View menu. 

{button ,KL(`connection item')}    Related topics



To arrange connection items

1 Right-click in the blank area around the connection items you want to arrange.
2 Point at the Arrange Icons option.

The Arrange Icons menu displays.

3 Choose an option on the menu to arrange the connection items in the current window.

{button ,KL(`connection item')}    Related topics



To use SpeedSend  in pcANYWHERE file transfer sessions

On the remote PC:

1 Choose Application Options from the File menu.
2 Choose the File Transfer tab.
3 Select pcANYWHERE from the list of protocols.
4 Click Settings.

The pcANYWHERE Protocol Settings dialog box appears.

5 Check Use SpeedSend.

{button ,AL(`file transfer configuration')}    Related topics

{button ,PI(`',`more_smart')}    About SpeedSend



To protect drives on the host PC from access

On the host PC:

1 Right-click the host PC connection item for the host whose drives you want to protect.
2 Choose Properties from the context menu.
3 Click Callers.

You must choose Specify individual caller privileges if it is not selected. 

4 Right-click the caller item for the remote user for whom you want to set access to drives on the host PC.
5 Choose Properties from the context menu.
6 Click the Advanced tab.
7 Click Drive Access.
8 Select the options to restrict and grant access to drives on the host PC.

{button ,KL(`security')}    Related topics



To display the remote online toolbar

The remote online toolbar displays by default during remote control sessions.    If it has been turned off, take the following steps 
on the remote PC:

1 Click .
2 Choose Online Options from the pcANYWHERE remote menu.

The General tab displays. 

3 Check Remote online toolbar.

{button ,KL(`during a remote control session')}    Related topics



To run pcANYWHERE with Administrator options

1 Run the pcANYWHERE program using the command winaw32.exe /a.
2 Do one:
· If this is the first time you are running the program in this way, type a password for Administrator options, and re-type it to 
confirm it.    (This password is case-sensitive.)
· If this is not the first time you are running this program on this machine, you must type the password previously recorded for 
Administrator options.

The main pcANYWHERE window displays, with an additional Administrator menu:

{button ,AL(`network admin;network overview')}    Related topics



To allow network users to assign names to their PCs

1 Run pcANYWHERE with Administrator options.
2 Choose Shared Data from the Administrator menu.
3 Click the Computer Name Selection tab.
4 Select Allow User Defined name.

All network users of pcANYWHERE can now assign names to their PCs for identification during pcANYWHERE sessions.

{button ,AL(`network admin;name your PC')}    Related topics



To assign a default folder for network users

1 Run pcANYWHERE with Administrator options.
2 Choose Shared Data from the Administrator menu.
3 Click the tab for the pcANYWHERE mode for which you want to assign a default folder.
4 In the Use Folder field, type the name of the network folder where users will store and access connection items for that mode.

Click Browse to find the folder you want to use. 

{button ,AL(`network admin;display toolbar;customize toolbar;protect item')}    Related topics



To restrict network users from changing folders in pcANYWHERE

1 Run pcANYWHERE with Administrator options.
2 Choose Shared Data from the Administrator menu.
3 Click the tab for the pcANYWHERE mode you want to restrict.
4 Uncheck the Allow Folder Change checkbox.

Users cannot access the folder browse tool or the folder history tool in the mode you chose in step 2 above, even if their toolbars
display the folder tools in other modes.

{button ,AL(`network admin;protect item')}    Related topics



To change the Administrator password

1 Run pcANYWHERE with Administrator options.
2 Choose Change Administrator Password from the Administrator menu.

The Administrator Password dialog box appears.

3 Type the new password you want to use.
4 Re-type the password to confirm it.

Administrator passwords are case-sensitive.

{button ,AL(`network admin')}    Related topics



To make a connection using parallel ports

1 Connect the two PCs using a parallel cable.
2 On the host PC, create a host connection item and select the LPT connection device to which the parallel cable connects:

3 Set the host PC to wait for a call.
4 On the remote PC, create a remote control connection item and select the correct LPT connection device.
5 Double-click the remote control connection item so that the call to the host is made.

Both PCs must be running Windows 95 to make parallel port connections. To communicate in either direction, 
use a bi-directional parallel cable and configure the parallel port in the BIOS for bi-directional communication. 

{button ,AL(`create item;one device;host wait;call the host')}    Related topics

{button ,PI(`',`optimize_parallel')}    About optimizing parallel port connections



 Modem Tip    
Both Windows 95 and Windows NT, 4.0 use Microsoft’s Telephony Application Programming Interface (TAPI) to detect and 
configure modems. If your operating system supports TAPI devices and has added your modem to the top of the device list on 
the Connection Info tab, you should choose it for modem connections.    It is not necessary to customize the device. 
Please refer to your operating system’s documentation for information on how to detect and configure TAPI modem devices.



About Callback 

· Use Callback only for connections made using modems as connection devices.    Network or direct connections cannot 
implement this feature. 

· If you do not type in a remote PC’s phone number, the remote PC user will be prompted to enter a phone number when the 
intitial connection is made, before the host calls back. 

· To change the time the host delays before callback, click the Settings tab in the host connection icon’s property sheets and 
enter the delay you want.      

· If you use callback when making a connection involving a gateway, that gateway must be bidirectional. 



About Restarting the Host 
If Specify individual caller privileges is selected in host PC’s connection item, Allow caller to restart host must be checked in the 
Advanced tab of the caller item for this remote PC.    If it is not, the remote user cannot restart the host.



About Caller Folders 
Each host connection item uses only one caller folder, in which caller items for remote users of that host are stored.
Several host connection items can share the same caller folder.



About the Gateway mode 
If no Gateway button displays on the action bar, you can customize the action bar so that it appears.



About Optimizing the host’s desktop    
Set this option on the remote PC to optimize the desktop of any host PC that to which it connects.    
This feature:

· disables the host PC’s wallpaper and screen saver. 
· disables idle power-down optionson the host. 
· prevents full-window dragging.

These changes are temporary.    After the remote control session, all options on the host PC are unchanged.

This feature disables screensavers only if they appear in the Screensaver tab of Microsoft’s Display Properties 
dialog box after installation.



About ColorScale     

Selecting fewer colors in this option results in improved performance.

Click  on the remote online toolbar to select ColorScale

 options during a remote control session.



About remote control and file transfer  connection items

When you create a connection item in the remote control window, an identical version of that item automatically appears in the 
file transfer window, and vice versa.    

The items function differently in the following ways:

• The remote control connection item begins each session in remote control, allowing you to view the host PC’s screen.    You can
then initiate file transfer at any time.

• The file transfer connection item begins each session in file transfer, displaying the File Manager window.    You can choose to 
operate the host PC using remote control options at any time.



About Remote Operation options 

Many of the options contained in the Remote Operation tab can be changed during a session.    Click  on the 
remote online toolbar.



About Terminal Window printing

A checkmark appears next to the Print Online command when session printing is on.



About Adjusting Terminal Emulation settings

If you want to make changes to your terminal emulation settings permanent for all online service sessions, you must also choose
Application Options from the File menu (in the main pcANYWHERE window), choose the Terminal Emulation tab and make 
changes there. 



About Wizards    

If no connection item exists yet for the procedure above, use the Add...item to create one.    A pcANYWHERE Wizard guides you 
in setting up the connection item.



About Norton AntiVirus    
Norton AntiVirus provides the most complete Windows 95 virus protection -- one simple, easy to use package that 
detects, destroys and prevents virus infections.    
Norton’s true 32-bit virus protection installs easily on your system, then works automatically in the background, watching for 
suspicious disk activity that could indicate a virus.    Our revolutionary technology detects viruses before they can damage your 
files, instantly removing viruses from infected files, and keeping your system virus-free. 
Norton AntiVirus detects and eliminates every common virus, every class of virus, every type of viral activity -- even the most 
destructive polymorphic viruses.    Norton AntiVirus is certified by the National Computer Security Association (NCSA) for 
effective virus detection.    
Norton’s exclusive, patent-pending technology uses rule-based integrity checking to monitor for virus-like activity and to disinfect 
and repair any infected files, providing the best safeguard available against new and unknown viruses.    
Norton AntiVirus is also available in a network-pack version, which includes features for centralized installation, updating and 
customization and for forced log-off of infected or unprotected workstations.    Norton AntiVirus also integrates with Norton 
Administrator for Networks and Norton AntiVirus for NetWare to provide comprehensive protection at every level of your 
computing environment. 

If you’re interested in the full-featured automatic virus detection, elimination and prevention afforded by the 
Norton AntiVirus, contact Symantec Customer Service at 1 (800) 441-7234. 



About File Transfer Protocols    

pcANYWHERE automatically uses the pcANYWHERE protocol for file transfer between a host PC and a remote PC.



About SpeedSend     

SpeedSend  speeds up your file transfers when you are updating files already located on the destination PC.    
pcANYWHERE sends only the portions of files that have changed, instead of sending the entire files.    

You can use SpeedSend  only when using the pcANYWHERE file transfer protocol.



About Login names    
In previous versions of pcANYWHERE, login names were optional when setting up caller security.
Now, you must enter a login name for each caller to a host PC.    Entering a password is optional.



About customizing network devices 
You cannot customize the network devices TCP/IP, IPX, SPX, and Banyan VINES if you are selecting options in a host connection 
item or a gateway connection item.    
The only option you set when customizing these devices is the use of a gateway; gateways on a network access host PCs on that 
network automatically.



About Using Remote Control with  Remote Networking sessions    
When you are connected to a network as a node, you can establish a remote control session with a PC on that network using an 
IPX, SPX, or NetBIOS network connection device.    



About optimizing parallel port  connections
For the fastest possible transfer and screen refresh speeds during parallel port connections, configure the parallel port on each PC 
so that it is bidirectional. You can do this by altering the PC’s CMOS or BIOS settings.    See your computer’s manual for specific 
instructions.





To customize an ISDN connection device
1 Check ISDN via CAPI 2.0 in the Connection Info property page of the connection item. 
2 Click Details
3 Check Attempt Channel Bonding if you want pcANYWHERE32 to use two B channels for the connection. The connection is 

made using one B channel if the second channel is not available at the time of the connection.
4 In the Seconds to Wait After Dial box, type the maximum time pcANYWHERE32 allows for a successful connection after a 

number has been dialed. 



To configure simultaneous remote control and file transfer sessions

On the remote PC:

1 Choose Application Options from the File menu.
2 Choose the File Transfer tab.
3 Uncheck Pause remote control to maximize file transfer performance.

 You can choose to pause remote control at the time of the file transfer by clicking the Pause Remote Control button 
on the File Manager window.

{button ,AL(`pausing remote control',0,`',`')}    Related Topics



To pause remote control during file transfer

To set the pause remote control option on the remote PC before connecting

1 Choose Application Options from the File menu.
2 Choose the File Transfer tab.
3 Check Pause remote control to maximize file transfer performance

To pause remote control during a file transfer session

1 Make a connection and choose File Transfer from the File menu.
2 Select the folders or files for transfer and click Send on the file manager button bar.
3 Click Pause Remote Control. 

 If the Pause remote control option was checked in the Application Options properties sheet before making the 
connection, the button on the File Manager window is labeled Resume Remote Control.



To add commands to an AutoXfer procedure:

1 Create a remote control connection item or select an existing item.
2 Choose Properties from the context menu 
3 Click the Automated Tasks tab.
4 Check Run Upon Connection.
5 Click AutoXfer
6 Click Properties.

The Add AutoXfer Command dialog box lists any file transfer commands currently in the procedure.

7 Click Add.
8 Select the type of transfer:

n Send to host Sends the folder or file from the remote to the host PC.
n Receive from host Sends the folder or file from the host to the remote PC.
n Sync Checks duplicate filenames and transfers the file with the latest date and time.

When sending folders in an AutoXfer procedure, subfolders are not automatically included in the transfer. Add a 
separate command for each subfolder you want transferred. 
9 Type the folder and file name in the Local and Host folder/file text box and Click OK.
10 Repeat for each command you want to add to the procedure.

To view the hosts folder and files and add several commands at a time to the AutoXfer procedure, add or modify
commands to the procedure from the File Manager window. 

{button ,AL(`autoxfer',0,`',`')}    Related Topics



To add AutoXfer commands from the remote online menu

1 Make a remote control connection.
2 Choose AutoXfer from the online menu or click the AutoXfer icon on the remote online toolbar 

The Run AutoXfer dialog box appears listing any commands currently in the procedure.

3 Do one:
n Click Properties to add commands to the AutoXfer procedure listed in the text box.
n Type a new name for the procedure and click Properties.
n Click Browse to select a different procedure and click Properties.

4 Click Add.
5 Select the type of transfer:

n Send to host Sends the folder or file from the remote to the host PC.
n Receive from host    Sends the folder or file from the host to the remote PC.
n Sync Checks duplicate filenames and transfers the file with the latest date and time.

6 Type the folder and file name in the Local and Host folder/file text box and Click OK.
Repeat for each command you want to add to the procedure.

When sending folders in an AutoXfer procedure, subfolders are not automatically included in the transfer. Add a 
separate command for each subfolder you want transferred. 

To add AutoXfer commands from the File Manager

1 Make a file transfer connection.
2 Select a folder, a file or a group of files from the host or remote file list box that you want to add to the AutoXfer procedure.

When sending folders in an AutoXfer procedure, subfolders are not automatically included in the transfer. Add a 
separate command for each subfolder you want transferred. 
3 Do one:

n Click Add AutoXfer in the File Manager Button Bar.
n Choose Add to AutoXfer from the File menu.

4 Optional: Click Browse to add commands to a different procedure.
5 Click OK to add displayed files to the selected AutoXfer procedure.

To view or modify the commands in an AutoXfer procedure, switch to remote control and choose Modify 
AutoXfer from the File menu.
{button ,AL(`autoxfer',0,`',`')}    Related Topics



To add AutoXfer commands from file manager

1 Make a file transfer connection.
2 Select a folder, a file or a group of files from the host or remote file list box that you want to add to the AutoXfer procedure.

Note: When sending folders in an AutoXfer procedure, subfolders are not automatically included in the transfer. Add a separate 
command for each subfolder you want transferred. 

3 Do one:
n Click Add AutoXfer in the File Manager Button Bar.
n Choose Add to AutoXfer from the File menu.

If you click AutoXfer without selecting a folder or files, the host and remote folders currently displayed are 
automatically synchronized. Files on the remote that are not found on the host are copied and files on the host that are not found on 
the remote are copied. 
4 Optional: Click Browse to add commands to a different procedure.
5 Click OK to add displayed files to the selected AutoXfer procedure.

To view or modify the commands in an AutoXfer procedure, choose Modify AutoXfer from the File menu.
{button ,AL(`autoxfer',0,`',`')}    Related Topics



To run an AutoXfer procedure from the online menu

1 Make a remote control connection.
2 Choose AutoXfer from the online menu or click the AutoXfer icon on the remote online toolbar 

The Run AutoXfer dialog box appears listing any commands currently in the procedure.

3 Click Run to run the procedure displayed in the AutoXfer procedure text box.
4 Optional: Click Browse to select a different procedure to run.



To select files and folders

To select a different drive
· Click the prompt button in the drive drop-down list box and choose a drive letter from the list.
To select a single file or folder
· Click the name of the file or folder.
To select two or more files in sequence
· Click the first filename, the press Shift and click the last filename in the group.
To select multiple files not in sequence
· Click the first filename, then press Ctrl while clicking each of the other filenames.



To tag files and folders

The Tag menu lets you select all or some of the files or folders in the active file list box.
The tag options available are:
TAG ALL - Selects all files and folders in the active list box.
TAG FILES - Selects all files in the active list box, omitting folders.
TAG FOLDERS - Selects all folders in the active list box and the files contained within the folders.
CLEAR TAGS - Clears all file and folder selections.
REVERSE TAGS - Deselects the tagged files and folders while selecting the unselected files and folders.
TAG BY - Selects files and folders based on a filter you specify.



To call multiple hosts

On the remote PC:

1 Check the Allow Connection To Multiple Hosts option in the Application Options, Remote Operation property page.
2 Click Remote Control on the action bar.
3 Double-click the remote PC connection item for the host PC you want to call.
4 You may be prompted for the following:

· If your connection item does not include the phone number of the host for a modem connection, you are prompted to type a 
number.

· If your connection item does not include the name of the host PC for a network connection, a list of     network hosts   displays, 
allowing you to choose a host.

5 Click the pcANYWHERE32 remote control icon in the taskbar to switch to the pcANYWHERE application.

6 Double-click the remote PC connection item for the next host you want to call.
7 Repeat for each host you want to call.

If the Allow Connection to Multilple Hosts option is not checked, minimize the first host connection and run 
pcANYWHERE32 again to call additional hosts..

{button ,AL(`multiple hosts',0,`',`')}    Related Topics



To allow connections to multiple hosts

On the remote PC:

1 Choose Application Options from the File menu.
2 Click the Remote Operation tab.
3 Check the Allow Connection to Multiple Hosts option.

You can leave this option unchecked and still call multiple hosts by minimizing the first connection and running 
the pcANYWHERE32 program again.    

{button ,AL(`multiple hosts',0,`',`')}    Related Topics



To configure a conference host

On the host PC :

1 Click the host connection item you want to configure.
2 Do one of the following:

· Right-click the selected item and choose Properties from the context menuhost_menu 
· Choose Properties from the File menu

3 Click the Conference tab .
4 Check Enable conferencing to allow multiple callers to connect and view the activities on the host PC.
5 Do one of the following:

· Click Obtain IP Address Automatically to automatically select an IP address from any valid Class D addresses.
· Click Specify IP address to type an IP address within the range of 225.1.1.1 through 239.254.254.254.

6 Type the number of routers to include in the conference broadcast area.



To make a voice first connection

On the host PC and the remote PC :

1 Right-click a connection item that uses a modem connection device .
2 Choose Voice First from the context menu .
3 When finished with the voice conversation, click OK and hang up the receiver to begin the remote control session.

Both the host PC and the remote PC must select the voice first option.



To configure Windows NT caller privileges

On the host PC :

1 Click the host connection item you want to configure.
2 Right-click the selected item and choose Properties from the context menu 
3 Click the Callers tab in the Host Properties sheet.
4 Click Use NT User Privileges to enable Windows NT caller security.
5 Double-click the Add User wizard to add a new pcANYWHERE caller.
6 Click the User button to add a Windows NT user or the Group button to add a Windows NT group to the pcANYWHERE caller 

list.
7 Click Next.
8 Select the workstation or domain to use to add users or groups to the pcANYWHERE caller list.

You must be signed on to a domain for the domain name to appear.
9 Choose a user account or a group account from the drop-down list and click Next.
10 Click Finish to add the user or group to the pcANYWHERE caller list.
11 Click User Manager if you have Windows NT administrator privileges and want to add or delete users to the workstation or 

domain.



To download pcANYWHERE32 updates

1. Choose LiveUpdate from the Utilities menu.
2. Select the device to use to connect to the LiveUpdate server and click OK.
3. Select the update you want to download from the Select Updates dialog box and click Next.

LiveUpdate downloads the selected upgrade and automtically updates your version of pcANYWHERE32.



To schedule a host using Norton Program Scheduler

1.    Start the Norton Scheduler.
2.    Click Add on the toolbar or choose Add from the Event menu.
3.    Set Type Of Event to Run Program.
4.    Type a description of the scheduled event.
5.    Type the name of your host connection item in the Command Line to Run box. pcANYWHERE host connection items are 

stored in the pcANYWHERE Data folder and have a BHF extension.
6.    Select the schedule you want from the Frequency list box.
7.    Type the time of day you want the host to run and click OK.

To change any of the settings, double-click the Norton Scheduler icon in the system tray.



To schedule a host with Microsoft System Agent

1. Open System Agent.
2. Choose Schedule A New Program from the Program menu.
3. Click Browse to locate the pcANYWHERE host connection item. pcANYWHERE connection items are stored in the 

pcANYWHERE Data folder and have a BHF extension.
4. Change the File Type to All Files.
5. Choose the host connection item you want to schedule.
6. Type a description for the scheduled event and click When To Run.
7. Choose the schedule you want to the host to run on.
8. Type the type of day you want the host to begin waiting for a call and click OK.



To schedule a host with Windows NT Schedule Service (AT command)

1. Use any text editor to create a batch file with the following commands:
  C:
  Cd “\Program Files\pcANYWHERE”
  Awhost32.exe “C:\Program files\pcANYWHERE\DATA\itemname.bhf

    Where Itemname is the name of the host connection item you want to run.

2. At the DOS prompt, type the AT command using the following syntax:
  AT time [ /every:date[,…] /next:date[,…]] “command”

time: is the time you want the host to start waiting for a call, specified in 24-hour format.
/every: runs the host on each specified day(s) of the week or month. Days of the week are typed as M,T,W,Th,F,S,Su 

and the date is any number between 1 and 31.
/next: runs the host on the next occurrence of the day (for example, next Thursday)
“command” is the batch file containing the instructions to run the host connection item.

For example, to run the host every day at 2:00 pm, type the following command:

AT 14:00 /every:M,T,W,Th,F,S,Su c:\filename.bat

Please refer to your Windows NT documentation for new or updated information on the Schedule Service (AT 
command) feature if necessary.



pcANYWHERE Tips and Tricks      
{button ,JI(`winaw32.hlp>tipwin',`tip_1')}    For speeding up the display of graphics in a remote control session
{button ,JI(`winaw32.hlp>tipwin',`tip_4')}    For switching between host applications from the remote PC
{button ,JI(`winaw32.hlp>tipwin',`tip_2')}    For speeding up file transfer
{button ,JI(`winaw32.hlp>tipwin',`faq_2')}    For securing my data when using pcANYWHERE
{button ,JI(`winaw32.hlp>tipwin',`faq_6')}    For scanning downloaded files for viruses
{button ,JI(`winaw32.hlp>tipwin',`faq_1')}    For transferring files without performing remote control
{button ,JI(`winaw32.hlp>tipwin',`tip_5')}    For increasing the speed of pcANYWHERE when using parallel port 

connections



To speed up the display of graphics in a remote control session 

1 Use the Optimize desktop for remote control option.    When you check this option on the Remote Operation tab, pcANYWHERE
temporarily: 
· disables the host PC’s wallpaper.
· disables the host PC’s screen saver.
· disables idle power-down options on the host PC.
· prevents full-window dragging.

Again, these changes are only temporary, for the duration of the remote control session.    Optimize desktop does not 
permanently change options on the host PC.

2 Select the ColorScale  option.    Choosing to display the host PC's screen in as few as two colors accelerates 
screen refreshes.    Choose this option, and the number of colors to display, on the Remote Operation tab. 

{button ,KL(`improving performance')}    How do I . . .



To switch between host applications from the remote PC    

Press Control-Alt-Tab on the remote PC to send the Windows keystrokes Alt-Tab to the host PC.    These 
keystrokes instruct the Windows program on the host to switch between open applications.

-or-

You can use the remote PC's mouse to switch between open applications on the host PC.

Both of these techniques are effective only if keyboard and mouse activity have not been restricted to the host 
only during remote control sessions.



To speed up file transfer 

1 Use pcANYWHERE's SpeedSend .    When you customize the pcANYWHERE file transfer protocol in the File 
Transfer tab of the Application Options dialog box to use SpeedSend 

, pcANYWHERE sends only the portions of files that have changed, instead of sending entire files.    

2 For direct communication links between PCs in the same location, use pcANYWHERE's new parallel port connections.    You 
can transmit data at rates up to 500 KB per second.

{button ,AL(`SpeedSend;one device')}    How do I . . .



To ensure that your data is safe when using pcANYWHERE, take any or all of the following precautions:

- Set a password on the host PC that a remote caller must enter before connecting. 
- Password-protect any pcANYWHERE connection item so that users who do not know the password cannot initiate a 

connection or even view its properties. 
- Use the data encryption options configured on the host PC. 
- Blank the screen of a host PC whenever a connection is made. 
- Protect certain drives on the host PC from partial or full access by remote callers. 
- Set the host PC to call back any connecting remote caller to verify the caller's identity. 
- Set file transfer rights on the host PC to limit uploads or downloads by the remote caller.
- Monitor sessions by recording connection attempts, files transferred, etc. on both PCs.    Details are stored in activity log files.

{button ,KL(`security')}    How do I . . .



Can I scan downloaded files for viruses? 

Yes.
pcANYWHERE uses Norton’s AntiVirus to scan files that you are transferring to your PC.    If a virus is detected, transfer breaks 
off.

To scan files for viruses

1 Choose Application Options from the File menu in pcANYWHERE’s main window.
2 Choose the File Transfer tab.
3 Check Virus Check all Downloaded Files.



To transfer files without performing remote control 

Click File Transfer on the action bar, and double-click a file transfer connection item to connect to a host PC to 
transfer files immediately.

{button ,AL(`trancon')}    Related topics



For increasing pcANYWHERE’s speed with parallel port connections 
The Direct Parallel Universal Cable can significantly increase the performance of the pcANYWHERE product when using parallel 
port connections and high-speed parallel ports.

Direct Cable Connection cables are available directly from Parallel Technologies:
Via Telephone

· Phone (800) 789-4784 from inside the U.S.
· Phone (206) 813-8728 from outside the U.S.

Via FAX
· Phone (206) 813-8730

Via E-Mail
· SALES@LPT.COM (Internet) 
· 71612,3466 (CompuServe) 



Failed connection to host with modem troubleshooter
Just click to answer the questions, and then try the suggested steps to fix the problem.

Did you see an error message?
{button ,JI(`',`yes_message')}    Yes.
{button ,JI(`',`no_message')}    No.



What did the error message say?

{button ,JI(`',`no_response_from_modem')}    "No Response From Modem." 
{button ,JI(`',`no_dialtone')}    "No dialtone."



What happened?

{button ,JI(`',`No_dialtone')}    I never heard my modem pick up the line and dial.
{button ,JI(`',`other_modem_no_dial')}    I never heard the other modem pick up.
{button ,JI(`',`other_modem_hang_up')}    The other modem picked up the line and started "squealing", then hung up.
{button ,JI(`',`connection_then_hang_up')}    The modems connected, then hung up.



Have you configured the correct COM port attaching your modem to the PC?

{button ,JI(`',`try_Hayes_2400')}    Yes.
{button ,JI(`',`configure_correct_COM')}    No.

I don't know?



Is the telephone line plugged into the plug marked "LINE" on the modem?

{button ,JI(`',`telephone_in_wall_jack')}    Yes.
{button ,JI(`',`switch_the_plug')}    No.



Is the telephone line also plugged into the wall jack?

{button ,JI(`',`modem_on_PBX')}    Yes.

{button ,JI(`',`plug_it_in')}    No.



Are you using the modem on a PBX or multi-line telephone system?

{button ,JI(`',`pbx_adaptor')}    Yes.
{button ,JI(`',`same_line')}    No.



Are there other telephone devices, such as fax machines, answering machines, or cordless telephones, on the same 
line?

{button ,JI(`',`remove_them')}    Yes.
{button ,JI(`',`Other_dial_out')}    No.



Other modem does not pick up

If the host PC's modem does not respond, the trouble must be investigated at the host location.    Someone must make sure that 
pcANYWHERE is running and waiting for a call.    

If the communications device is an external modem, give it a AT&D to disable dtr?



If the host PC's modem "squeals" and then hangs up before a connection is made, you may need to check both modems’ 
configuration.    

Someone at the host PC must check the configuration of its modem.

Click here  to check your modem's configuration.

also check: IRQ conflict. hyper?
The telephone lines. what, how?



Is either the host PC's modem or the remote PC's modem an external modem?

{button ,JI(`',`always_connected')}    Yes.
{button ,JI(`',`marie')}    No.

I don’t know.



Can other remote callers connect successfully to the host?

{button ,JI(`',`checkmany')}    Yes.
{button ,JI(`',`marie')}    No.



The following must be checked on both the host and remote PCs.

IRQ conflict

proper modem configurations

TSR conflicts, boot both sides cleanly?

calling a PCA host?



The following must be checked on both the host and remote PCs.

IRQ conflict

proper modem configurations

TSR conflicts, boot both sides cleanly?

calling a PCA host?

in addition phone lines -

other telephone ines and bad telephone lines, if using multi line, try a dif.. line



Can other remote callers connect successfully to the host?

{button ,JI(`',`checkmany2')}    Yes.
{button ,JI(`',`marie')}    No.



Configure your modem in pcANYWHERE as a Hayes Compatible modem operating at a data rate of 2400. 

Can you make a connection now?

{button ,CW(`task')}    Yes.
{button ,JI(`',`modem_internal_external')}    No.



Is your modem internal or external?

{button ,JI(`',`irq_conflict')}    Internal.

{button ,JI(`',`bad_serial')}    External.

I don’t know.



Check the following:    how who when where

Bad serial port.

Cable.

Modem. 

IRQ conflict.



Configure the correct COM port correctly.

Click here {shortcut.bmp}    to open Microsoft's modems applet...



Switch the line so that it is plugged into the LINE plug on the modem.    Try to make the connection again.

Do you hear a dialtone now?
{button ,CW(`task')}    Yes.
{button ,JI(`',`telephone_in_wall_jack')}    No.



Plug the telephone line into a wall jack.    Try to make the connection again.

Do you hear a dialtone now?
{button ,CW(`task')}    Yes.
{button ,JI(`',`modem_on_pbx')}    No.



You may need to have add a PBX modem adaptor to your system, or try a separate telephone line. 

Try to make a connection using a separate telephone line.

Can you make the connection?    
{button ,JI(`',`marie')}    Yes.
{button ,JI(`',`same_line')}    No.



Other devices on the same line may be dropping the line voltage.    Remove any other devices on the same line.

Can you make a connection now?

{button ,CW(`task')}    Yes.
{button ,JI(`',`irq_conflict')}    No.



Try to dial out using another software such as Hyperterminal (in Windows' Accessories).

Can other communications software dial out?

{button ,JI(`',`disable_dial_tone')}    Yes.
{button ,JI(`',`irq_conflict')}    No.



Disable the dial tone with additional modem command of atx3 huh?



You may have an IRQ conflict.    You can fix this by:

Turn off the external port.

Set modem to an unused IRQ.

other haardware device w/ IRQ?



CD_line

Have no ideas what this means    "CD line hardware problem."



Change the option Connection Ended By located? to Always Connected on the PC with the external modem.

Can you make a connection now? 
 
{button ,JI(`',`cd_line')}    Yes.
{button ,JI(`',`marie')}    No.



    Topic under development.



After connecting, I can't see the host PC's screen clearly.

How does it appear?

{button ,JI(`',`connection_then_blank_screen')}    After the modems stopped squealing and connected, I saw just a blank screen.
{button ,JI(`',`connection_then_garbage')}    After the modems stopped squealing and connected, I saw just "garbage" text on the 

screen.



My modem doesn't appear on pcANYWHERE's device list:

What is your operating system?

{button ,JI(`',`os_95')}    Windows 95.
{button ,JI(`',`os_nt')}    Windows NT.



OK, your operating system is Windows 95.

pcANYWHERE can identify your modem as soon as Windows 95 does:

1 Click here  to open the Modems Control Panel program.
2 Click Add to start the Install New Modem wizard.
3 Follow the instructions on your screen.
4 Close the pcANYWHERE program.

When you re-open the property sheets of any connection item in pcANYWHERE, your modem should appear at the top of the 
device list.

If your modem does not appear on the device list after you take the steps above, contact your modem 
manufacturer.    They may have a driver for your modem.    Or, they may be able to tell you to use an alternative modem.



OK, your operating system is Windows NT.

Customize the serial port connecting your modem to your PC so that pcANYWHERE can identify your modem.

How?



What is an IRQ/COM port conflict and what problems can it cause?

An IRQ conflict can produce several symptoms, including an Error Initializing Modem error message, or a black screen upon 
connection to the host PC.

Every COM port in your system uses an IRQ.    Other devices, such as sound cards, network cards, internal modems and 
emulation boards, also use IRQs.    No two devices in your system should use the same IRQ.    

COM1 and COM3 use IRQ4, while COM2 and COM4 both use IRQ3, as defaults.    Problems arise, therefore, if two separate 
devices attach to the COM1 and COM3 ports in your system, because both devices use IRQ4.    You will also run into conflicts if 
you install your internal modem as COM2, but another device already uses the COM2 port in your system. Having a COM1 port 
only in your system, and installing an internal modem set for COM3 is cause of another potential conflict.    

Windows 95 usually warns you if you have an IRQ or COM port conflict.    Windows NT does not provide a 
warning.

If you are experiencing one of the symptoms above, go through your system manually (even if Windows 95 
does not indicate a problem).    Make a note of each device in your system, and the IRQ it uses.    To avoid potential conflicts, keep 
your COM ports numbered sequentially.



I am a NETBEUI user.  What special settings shall I configure?

If you have the NetBIOS for IPX/SPX protocol, we recommend using the IPX or SPX option in pcANYWHERE.   
If not, take the steps below to use pcANYWHERE across the NETBEUI protocol:

In pcANYWHERE, choose a NetBIOS connection device:    

Then, customize your operating system to use NETBEUI.

To set NETBEUI options in Windows 95:
1 From the Start menu, choose Settings and Control Panel:

2 Double-click the Network icon: 

3 Choose NETBEUI from the list of network components and click Properties. 
4 Click the Advanced tab. 
5 Click on Maximum Sessions and raise it to 60. 

6 Click on NCBS and raise it to 40. 

You cannot communicate across a WAN using the NETBEUI protocol.



How do I know whether to select IPX or SPX as my network connection device?

pcANYWHERE supports both protocols.    

Use the IPX protocol when:
· communicating with earlier versions of pcANYWHERE
· speed is one of your chief concerns

Use the SPX protocol when:
· you are communicating across a WAN
· reliability is one of your chief concerns
· Windows NT is your operating system

Always use the same protocol on host and remote PCs making a connection.    



What kind of font should I choose for full-screen DOS programs in remote control sessions?

When running a full-screen DOS program in a remote control session, it is recommended that    before making your connection, 
you set the font to a true type font.    

To choose the font in pcANYWHERE:
On the remote PC:

1 Choose Application Options from the File menu. 
2 Click the Remote Operation tab. 
3 Click Fonts/Colors. 
4 Choose one of the fonts with the True Type font symbol. 

You may need to experiment with the font size.    

You will not be able to see any extended characters that your DOS program requires or uses.



What does the TCP/IP protocol allow me to do and how do I use it in pcANYWHERE?

Using the TCP/IP connection device in pcANYWHERE, you can communicate across TCP/IP networks.    This does not give you 
Intenet access, however,    you can use it to connect to any pcANYWHERE32 host waiting on the Internet,    or to other TCP/IP 
networks.    

Before using the TCP/IP protocol in pcANYWHERE, you must customize Windows NT or Windows 95 for 
TCP/IP.    

To create a TCP/IP host list hosts:
On the remote PC:

1 Choose Application Options from the File menu. 
2 Click the TCP/IP tab. 
3 Add any of the following to the list for TCP/IP connections:

· pcANYWHERE host name
· DNS name
· Host IP address
· Specific subnet IP address
· IP address 

You can also include the name or IP address of a specific TCP/IP host in a remote control connection item.    If 
you do not include a name or address, the hosts you add to the TCP/IP tab in the steps above appear in a list whenever you start a 
remote control connection.    You can then choose the host to which you want to connect.



our modem selection lists?



What does the full window option do?

The full window option adjusts a remote display so that you can see the host  ’  s   monitor completely.    

To choose the full window option during a remote control session:

On the remote PC:

Click 

 on the remote online toolbar.

This option takes effect only if the resolution of the remote PC is greater than that on the host PC.    

This option does not affect DOS applications.





Click one of the buttons below:

{button ,JI(`',`vfirst_time')}
           Click here if this is the   
first time you have used 
pcANYWHERE.

{button ,JI(`',`vnot_first_time')}
           Click here if you have   
used pcANYWHERE before.

i



If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vRemote')}
           What is remote   
computing?

{button ,JI(`',`vcontrol')}
           What can I do in   
a remote control 
session at the remote 
PC?

{button ,JI(`',`vhost')}
           What can I do in   
a remote control 
session at the host 
PC?

{button ,JI(`',`vtran')}
           How can I   
transfer files?

{button ,JI(`',`vget_started')
}           How can I get   
started?

Next.

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

             What is remote   
computing?

{button ,JI(`',`vcontrol')}
           What can I do in   
a remote control 
session at the remote 
PC?

{button ,JI(`',`vhost')}
           What can I do in   
a remote control 
session at the host 
PC?

{button ,JI(`',`vtran')}
           How can I   
transfer files?

{button ,JI(`',`vget_started')
}           How can I get   
started?

Remote computing
Using pcANYWHERE, you can connect a PC to other PCs in one (or 
both) of the following ways:

1 In a remote control session, in which a remote PC controls the host 
PC.    You can also transfer files during this kind of session.

2 By remote networking, so that a PC dials into a network and becomes
a remote node.



Next.

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vRemote')}
           What is remote   
computing?

{button ,JI(`',`vcontrol')}
           What can I do in a  
remote control session 
at the remote PC?

What can I do in a 
remote control session at 
the host PC?

{button ,JI(`',`vtran')}
           How can I transfer  
files?

{button ,JI(`',`vget_started')}
           How can I get   
started?

Next.

At the host, the remote PC operates your computer as if the remote user 
were actually there.    

You can:
· Receive long-distance technical training. 
· Let others use your PC’s files, programs, and speed capabilities. 
· Allow files to be transferred to or from your PC. 

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vRemote')}
           What is remote   
computing?

{button ,JI(`',`vcontrol')}
           What can I do in   
a remote control 
session at the remote 
PC?

{button ,JI(`',`vhost')}
           What can I do in   
a remote control 
session at the host 
PC?

There are three ways to transfer files in pcANYWHERE:

1 Use File Transfer mode to send or receive files from other PCs 
running pcANYWHERE.    

2 Start File Transfer from the remote online toolbar during a remote 
control session.    

3 Add file transfer commands to an AutoXfer  
procedure to automatically send, receive, or synchronize files.    



How 
can I transfer files?

{button ,JI(`',`vget_started')
}           How can I get   
started?

Next.



If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vRemote')}
           What is remote   
computing?

            What   
can I do in a remote 
control session at the 
remote PC?

{button ,JI(`',`vhost')}
           What can I do in   
a remote control 
session at the host 
PC?

{button ,JI(`',`vtran')}
           How can I   
transfer files?

{button ,JI(`',`vget_started')
}           How can I get   
started?

Next.

At the remote PC, you can operate the host PC as if you were actually 
there.

You can:
· Use programs and files on the host PC.
· Troubleshoot a technical problem. 
· Transfer files quickly between the two PCs. 
· Access programs and files on a network. 

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vRemote')}
           What is remote   
computing?

{button ,JI(`',`vcontrol')}
           What can I do in   
a remote control 
session at the remote 
PC?

{button ,JI(`',`vhost')}
           What can I do in   
a remote control 
session at the host 
PC?

{button ,JI(`',`vtran')}
           How can I   
transfer files?

Use pcANYWHERE’s new Quick Start Wizards!

1 Click Quick Start on the action bar.

2 Choose a pcANYWHERE Quick Start Wizard and use it to create 
a connection item.

3 Then just double-click the connection item whenever you want to 
connect in a remote control session. 



            How   
can I get started?

Next.

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vmodem')}
           How do PCs in a  
remote control session
connect to each other?

{button ,JI(`',`vhelp')}
           What is remote   
networking? 

{button ,JI(`',`vinternet')}
           How can I use   
the Internet with 
pcANYWHERE?

{button ,JI(`',`vgateway')}
           What is a   
gateway?

{button ,JI(`',`vonline')}
           What is an online  
service?

Previous 
questions. 

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vmodem')}
           How do PCs in a  
remote control session
connect to each other?

{button ,JI(`',`vhelp')}
           What is remote   
networking? 

{button ,JI(`',`vinternet')}
           How can I use   
the Internet with 
pcANYWHERE?

Online services offer information on all subjects, either in stored 
databases or on electronic bulletin boards where users post and 
answer questions to each other.    

pcANYWHERE provides access to BBSs and services such as 
CompuServe, Dow Jones, MCI Mail, and so on.



{button ,JI(`',`vgateway')}
           What is a   
gateway?

            What is   
an online service?

Previous 
questions. 

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vmodem')}
           How do PCs in a  
remote control session
connect to each other?

{button ,JI(`',`vhelp')}
           What is remote   
networking? 

How 
can I use the Internet with 
pcANYWHERE?

{button ,JI(`',`vgateway')}
           What is a   
gateway?

{button ,JI(`',`vonline')}
           What is an online  
service?

Previous 
questions. 

Use remote control on the Internet in one of two ways:

1 To cut costs, you may want to have remote control sessions with 
another PC through an Internet connection, rather than over a 
telephone line. 

Note: The Internet is essentially a worldwide TCP/IP network.    
You can have remote control sessions using it only if both 
PCs already connect to the Internet and are running 
pcANYWHERE using its TCP/IP protocol.

2 You can use your home PC to remotely control your office 
PC and gain access to the Internet.    This can save on the 
cost of a separate Internet service for your home PC, and 
it may provide quicker response times. 

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vmodem')}
           How do PCs in a  
remote control session
connect to each other?

{button ,JI(`',`vhelp')}
           What is remote   
networking? 

{button ,JI(`',`vinternet')}

A pcANYWHERE gateway allows users on a network to share a 
communications device, usually a modem, so that each user does 
not need a separate device. 

A bidirectional gateway supports both incoming and outgoing calls 
for users of the network.



           How can I use   
the Internet with 
pcANYWHERE?

            What is   
a gateway?

{button ,JI(`',`vonline')}
           What is an online  
service?

Previous
questions. 

If this is the first time you have used pcANYWHERE, click on one of the buttons below.

How do 
PCs in a remote control 
session connect to each 
other?

{button ,JI(`',`vhelp')}
           What is remote   
networking? 

{button ,JI(`',`vinternet')}
           How can I use   
the Internet with 
pcANYWHERE?

{button ,JI(`',`vgateway')}
           What is a   
gateway?

{button ,JI(`',`vonline')}
           What is an online  
service?

Previous
questions. 

You can connect using pcANYWHERE through the following 
devices:

· Your modem, if the other PC also has one.
· A null modem cable attached to the serial ports of both PCs. 
· A null modem cable attached to the parallel printer ports of both 

PCs. 
· A network, if both PCs are attached to it. 

Reminder:
Both the host PC and the remote PC must have pcANYWHERE 
configured and running before making a remote control connection.



If this is the first time you have used pcANYWHERE, click on one of the buttons below.

{button ,JI(`',`vmodem')}
           How do PCs in a  
remote control session
connect to each other?

         What is remote   
networking? 

{button ,JI(`',`vinternet')}
           How can I use   
the Internet with 
pcANYWHERE?

{button ,JI(`',`vgateway')}
           What is a   
gateway?

{button ,JI(`',`vonline')}
           What is an online  
service?

Previous
questions. 

Remote networking means using a laptop or another PC to dial in to a 
network.    

You can then :
· Access a file stored on a network drive.
· Run a program locally on your laptop with data stored on the network. 

You can even initiate a remote control session while a remote networking 
session is in progress.

{ }

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vwhyrem')}
           How does   
pcANYWHERE make 
remote computing 
sessions faster?

{button ,JI(`',`vhow')}
           How does   
configuring work now?

{button ,JI(`',`vyesconf')}
           Can I use my   
configuration files from
earlier versions of 
pcANYWHERE?

{button ,JI(`',`vadvtran')}
           How can I   
transfer files?

{button ,JI(`',`vdial')}  What   
is remote networking?



Next. 

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vwhyrem')}
           How does   
pcANYWHERE make 
remote computing 
sessions faster?

{button ,JI(`',`vhow')}
           How does   
configuring work now?

            Can I   
use my configuration files 
from earlier versions of 
pcANYWHERE?

{button ,JI(`',`vadvtran')}
           How can I   
transfer files?

{button ,JI(`',`vdial')}  What   
is remote networking?

Next. 

Yes!    Choose Data Conversion from the Utilities menu.

The Data Conversion Wizard reads older pcANYWHERE files on 
your PC and upgrades them so that they can be used in 
pcANYWHERE for Windows 95 and Windows NT.

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vwhyrem')}
           How does   
pcANYWHERE make 
remote computing 
sessions faster?

{button ,JI(`',`vhow')}
           How does   
configuring work now?

{button ,JI(`',`vyesconf')} 
           Can I use my   
configuration files from
earlier versions of 

Remote networking means using a laptop or another PC to dial in 
to a network and use its resources as just another node on the 
LAN.

You can then :
· Access a file stored on a network drive.
· Run a program locally on your laptop with data stored on the 

network. 

You can even initiate a remote control session while a remote 
networking session is in progress. 



pcANYWHERE?

{button ,JI(`',`vadvtran')}
           How can I   
transfer files?

What is 
remote networking?

Next. 

If you have used pcANYWHERE before, click on one of the buttons below.

            How   
does pcANYWHERE make 
remote computing 
sessions faster?

{button ,JI(`',`vhow')}
           How does   
configuring work now?

{button ,JI(`',`vyesconf')}
           Can I use my   
configuration files from
earlier versions of 
pcANYWHERE?

{button ,JI(`',`vadvtran')}
           How can I   
transfer files?

{button ,JI(`',`vdial')}  What   
is remote networking?

Next. 

Four new features provide faster remote control and file transfer 
sessions:

1 Optimize desktop for remote control.    To speed up graphic 
display at the remote PC, this option temporarily disables:
· the host PC’s wallpaper.
· the host PC’s screen saver.
· idle power-down options on the host.
· capabilities for full-window dragging.

2 ColorScale  Choose to display the host’s screen in 
as few as two colors for the fastest refresh time ever.

3 SpeedSend  - When transferring updates, 
select this option to transfer only changes in files -- not entire files.

4 Parallel cable connections    Transmit data between parallel 
ports at speeds up to 500 KB/second.

If you have used pcANYWHERE before, click on one of the buttons below.



{button ,JI(`',`vwhyrem')}
           How does   
pcANYWHERE make 
remote computing 
sessions faster?

            How   
does configuring work 
now?

{button ,JI(`',`vyesconf')}
           Can I use my   
configuration files from
earlier versions of 
pcANYWHERE?

{button ,JI(`',`vadvtran')}
           How can I   
transfer files?

{button ,JI(`',`vdial')}  What   
is remote networking?

Next. 

Remote control options, passwords, and hardware connection 
information are stored in connection items.    

You can now create connection items for different hosts, gateways, 
callers, etc.

Example - Multiple remote control connection items:

Tip:    Use Quick Start Wizards to create connection items.

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vwhyrem')}
           How does   
pcANYWHERE make 
remote computing 
sessions faster?

{button ,JI(`',`vhow')}
           How does   
configuring work now?

{button ,JI(`',`vyesconf')}
           Can I use my   
configuration files from
earlier versions of 
pcANYWHERE?

            How   
can I transfer files?

{button ,JI(`',`vdial')}  What   
is remote networking?

There are now two ways to transfer files in pcANYWHERE:

1 Use File Transfer mode to send or receive files from other PCs 
running pcANYWHERE.    

2 Or, start File Transfer from the remote online toolbar during a 
remote control session.    



Next. 

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vmultconf')}
           What makes   
remote control 
sessions easier 
now? 

{button ,JI(`',`secimp')}
           How has   
security improved?

{button ,JI(`',`vpass')}
           How have   
passwords 
changed?

{button ,JI(`',`v95')}      Can   
I use new Windows 
95 features like Long
File Names?

{button ,JI(`',`vGet_Starte
d_A')} How 
can I get started?

Previous 
questions. 

If you have used pcANYWHERE before, click on one of the buttons below.

            What   
makes remote control 
sessions easier now?

{button ,JI(`',`secimp')}
           How has   
security improved?

{button ,JI(`',`vpass')}

The new remote online toolbar puts remote control features just one mouse-click 
away, yet it’s small enough that you can keep it onscreen all the time:

Place your mouse pointer over any tool for a moment to see a Tool 
Tip identifying that tool:



           How have   
passwords 
changed?

{button ,JI(`',`v95')}      Can   
I use new Windows 
95 features like Long
File Names?

{button ,JI(`',`vGet_Starte
d_A')} How 
can I get started?

Previous 
questions. 

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vmultconf')}
           What makes   
remote control 
sessions easier 
now? 

            How   
has security improved?

{button ,JI(`',`vpass')}
           How have   
passwords 
changed?

{button ,JI(`',`v95')}      Can   
I use new Windows 
95 features like Long
File Names?

{button ,JI(`',`vGet_Starte
d_A')} How 
can I get started?

Previous 
questions. 

No more master password!    This gives you better security with 
more flexibility.

You can protect each of your connection items with an individual 
password, so that unauthorized users cannot modify or use them.   



If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vmultconf')}
           What makes   
remote control 
sessions easier 
now? 

{button ,JI(`',`secimp')}
           How has   
security improved?

            How   
have passwords 
changed?

{button ,JI(`',`v95')}      Can   
I use new Windows 
95 features like Long
File Names?

{button ,JI(`',`vGet_Starte
d_A')} How 
can I get started?

Previous 
questions. 

When you set up individual callers to a host PC, you must now 
assign each caller a separate login name. Passwords need not be 
unique, and are optional.    It is the login name that identifies each 
caller to the host and establishes the rights granted to that remote 
PC user:



If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vmultconf')}
           What makes   
remote control 
sessions easier 
now?

{button ,JI(`',`secimp')}
           How has   
security improved?

{button ,JI(`',`vpass')}
           How have   
passwords 
changed?

Can I 
use new Windows 95 
features like Long File 
Names?

{button ,JI(`',`vGet_Starte
d_A')} How 
can I get started?

Previous 
questions. 

As long as these features are supported by your operating system, you 
can:

· Use Long File Names: 

· Right-click on options and buttons to access a context-menu, including 
What’s This: 

· Drag-and-drop your connection items to the desktop of your PC and 
make connections without even starting the pcANYWHERE program. 

If you have used pcANYWHERE before, click on one of the buttons below.

{button ,JI(`',`vmultconf')}
           What makes   
remote control 
sessions easier 
now?

{button ,JI(`',`secimp')}
           How has   
security improved?

{button ,JI(`',`vpass')}
           How have   
passwords 
changed?

{button ,JI(`',`v95')}      Can   
I use new Windows 
95 features like Long

Use pcANYWHERE’s new Quick Start Wizards!

1 Click Quick Start on the action bar.

2 Choose a pcANYWHERE Quick Start Wizard and use it to create 
a connection item.

3 Then just double-click the connection item whenever you want to 
connect in a remote control session. 



File Names?

How 
can I get started?

Previous 
questions. 



General buttons -- probably not needed...



Closes property sheets and saves any changes you have made.



Closes property sheets without saving any changes you have made.



(Shared) Connection Info page



Check to choose a connection device for pcANYWHERE sessions.



Click to set options for the device you have selected.



Click one to choose an outgoing connection device for this gateway PC. 



Click to set options for the device whose name you have selected.



(Shared) Protect Item tab



Type password to protect this connection item.



Re-type password to protect this connection item.



Makes password above necessary to view the properties of this connection item.



Makes password above necessary to make a connection using this connection item.



Makes password above necessary to change any of this connection item’s properties.



Starts your Windows screen saver when a host is waiting for a call. Assign a password to the screen saver to lock the host when 
waiting for a call. You enable screen savers in the Windows 95 Display Properties and in the Desktop dialog box in the Windows 
NT Control Panel. 



Prevents unauthorized users from canceling the waiting host by locking the keyboard on the NT Workstation



Remote Control item - Settings tab



Displays name of this remote control connection item.



Identifies host computer for network connections.    (To enable this option, click the Connection Info tab and select a network 
connection device.) 



Telephone number of host’s modem, needed for modem connections only.    (To enable this option, click the Connection Info tab 
and select a modem connection device.) 



Country code prefix for the location you are calling. 



Area code for the location you are dialing. 



Use this field when you do not want to use the dialing properties configured for your present location. Enter the phone number of 
the host, including area code and any required dialing prefix. 



Check to enter your assigned login name and password.    pcANYWHERE then automatically sends this information to the host 
upon connection.



Type assigned login name for access to host. 

If you are calling a Windows NT host, you can include the domain name in addition to the login name. For example, 
type domain\username to automatically locate the user on a specific domain.



Type assigned login name for access to host.

If you are dialing into a Windows NT host, you must include the domain name in addition to the login name.



Type assigned password for access to host. 



Type assigned password for access to host.



Re-type assigned password for access to host.    (Same as Password above.) 



Check to run a software program on the host PC automatically on connection.



Dials the area code or country code, and phone number using    the dialing properties configured for your current location. 



Remote control connection item: Automated Tasks tab



Enables you to record remote session for later playback in file you select. (If you check this option and do not enter a filename in 
the area below, you will be prompted for one when making a connection.)



Type name of file in which to record of remote session for later playback.    (If you do not enter a filename here, you will be 
prompted for one when making a connection if you have checked the option above.)



Click to view and select existing files containing records of remote sessions.



Runs selected script or AutoXfer procedure after connection.



Click to run a script file after connecting. 



Click to run an AutoXfer procedure after connecting. 



Name of script file to run. 



Click to view and select existing AutoXfer procedure. 



Click to view and select existing script file. 



Enables you to save session statistics in a log file for later reports of pcANYWHERE activity.



 Caller item, Settings tab:



Displays name of caller item.



Type to assign login name of remote user.    (This is required.)



Type to assign password of remote user.



Re-type password of remote user. (Same as Password above.)



Caller item, Callback tab:



If checked, host disconnects at connection time and calls back remote user.



Type number to dial when calling back remote user.



Caller item, Advanced tab:



Click to give the caller unrestricted access to the host. 



Click to select specific access rights for this caller. 



Enables remote user to blank screen of host PC during session.



Enables remote user to determine at termination of session whether host PC remains accessible or not.



Enables remote user to restart host PC during session.



Enables remote user to send files to the host.



Enables remote user to get files from the host.



Enables remote user to terminate processes with the keystrokes CTRL+Break.



If checked, limits time remote user can maintain connection to the host.



Sets time limit of session, if you have checked Limit time allowed per session.



Type a command to be executed upon connection.



If checked, causes termination of session if remote user is inactive for time exceeding that set in host connection item’s Security 
Options tab.



Saves statistics of sessions with remote user in file on host PC.



Opens dialog box with Drive Access options to set access rights for remote user.



Caller Drive Access dialog box (accessed from Caller item’s Advanced tab)



Allows remote user full access to host’s floppy drive.



Allows remote user read-only access to host’s floppy drive.



Prohibits remote user from accessing host’s floppy drive.



 Allows remote user full access to host’s fixed drive.



Allows remote user read-only access to host’s fixed drive.



Prohibits remote user from accessing host’s fixed drive.



Allows remote user full access to host’s network drive.



Allows remote user read-only access to host’s network drive.



Prohibits remote user from accessing host’s network drive.



Allows remote user full access to host’s CD-ROM drive.



Allows remote user read-only access to host’s CD-ROM drive.



Prohibits remote user from accessing host’s CD-ROM drive.



Remote Networking (Dial-Up Networking dialog box): 



Check to establish remote control connection after remote networking session begins.



Click to specify options in remote control connection item.



Online connection item: Settings tab



Displays name of this online service connection item.



Sets type of terminal emulation to use during connection with online service.



Sets protocol to use during file transfer with online service.



Type phone number of online service.



Type phone number of online service.



Online Connection item: Session tab



Check to record online session in file you select.    (If you check this option and do not enter a filename in the area below, you will
be prompted for one when making a connection.)



Type name of file in which to record online session.    (If you do not type a filename, you will be prompted for one when making a 
connection if you have checked the option above.)



Allows you to view and select existing files containing records of online sessions.



Enables you to run a script after connecting to online service.



Type name of script to run.



Allows you to view and select files containing existing scripts.



Enables use of translation table during online connection.



Type name of file containing translation table to use during online connection.



Allows you to view and select files containing translation tables.



Enables use of macro keys during online connection.



Type name of file containing configuration of macro keys.



Allows you to view and select files containing configurations of macro keys.



Saves statistics of online session in log file on this PC.



Records connection with online service as a script that can be re-used to repeat procedures.



Online connection items: Advanced tab:



Check to display lines that exceed the width of the terminal window on the next line.



Check so that when screen is filled, next line overwrites current top line when cursor reaches last position on the last line of the 
terminal display window.



Check to cause backspace key to act as a destructive, deleting key instead of a left cursor key.



Check to causes cursor to move to the left side of the terminal display window and to advance one line each time a carriage 
return character is received.    (Check only if display does not scroll vertically as expected.)



Specifies length of the break signal used to interrupt programs running on a mainframe or minicomputer. 



Click to restore original settings for the options in this dialog box.



Host Settings tab:



Displays name of this host connection item.



Sets time for delay before host calls back a remote caller, when callback is selected in that caller’s connection item.    (Disabled, 
if connection device other than modem has been selected.)



Determines who has use of keyboard and mouse during session. 

This option is automatically set to Remote and cannot be changed if the Blank The PC Screen option is checked on 
the Security Options property page. 



Causes the host to restart after every remote control session.



If checked, pcANYWHERE displays minimized button on the task bar when host is waiting for remote PC to call.



Sets host PC to start pcANYWHERE and begin waiting for a call as soon as Windows starts after boot-up.    (If this host requires 
a network gateway to make connections, do not check this option.)



A connection that is unexpectedly ended.



A connection that is ended by the remote or host PC.



The number of minutes the host waits after an unexpected disconnect before returning    to the selected end of session option.    



The host is canceled and does not accept other connections.



The host returns to wait for another connection.



Logs the host user off the network preventing unauthorized access to the user's network privileges.



The host PC restarts.

To have the host PC automatically wait for another call after restarting, check the Launch with Windows option.



Prevents unauthorized users from canceling the waiting host by locking the keyboard on the NT Workstation.



Prevents unauthorized users from canceling the waiting host by locking the keyboard on the NT Workstation.





The host is canceled and does not accept other connections.



The host returns to wait for another connection.



Logs the host user off the network preventing unauthorized access to the user's network privileges.



The host PC restarts.

To have the host PC automatically wait for another call after restarting, check the Launch with Windows option.



Causes your windows 95 screen saver to launch whenever the host is waiting for a call. Add a password to your 
screen saver to lock the host and prevent unauthorized users from canceling the witing host.



Causes your windows 95 screen saver to launch whenever the host is waiting for a call. Add a password to your 
screen saver to lock the host and prevent unauthorized users from canceling the witing host.



Check to run the workstation as a Windows NT Service.



Host connection item Caller Tab:



Allows any caller to access this host with full privileges, no login names or passwords necessary.



Allows you to define individual callers, each with different privileges, login names, and passwords.



Contains caller items with access to this host PC.



Host connection item NT Caller



Click to add a Windows NT user to the pcANYWHERE caller list.



Click to add a Windows NT group to the pcANYWHERE caller list.



If you have Windows NT administrator privileges you can use the Windows NT User Manager to add or delete users to the 
workstation or domain.



Host connection item, Security options tab:



Check to prevent use of host other than by remote control.



Check to prevent viewing of remote session at the host.



When a session unexpectedly ends, information could be left on the host screen. To prevent unauthorized callers from 
connecting and viewing this information, leave this option unchecked. Unchecked, the host accepts only the password of the 
remote caller that was connected at the time of the disconnect. 



If left unchecked, passwords may be typed using any combination of uppercase and lowercase letters.



Check to log all connection attempts that do not succeed.    Use as a security measure to track unauthorized connection 
attempts.    (Applies only to connections with remote users for whom you create a caller item.)



Check to display, on connection, a prompt at the host that must be acknowledged before remote session continues. (Does not 
apply to callers who are Superusers.)



Set number of seconds that pcANYWHERE waits for response by a host user when prompt on connection is enabled.



Protects data being transferred by using one of three levels of data encryption available in the drop-down list box.



A list box containing three levels of encryption methods to use during remote control connections.



This options prevents a connection if the host and remote are not using the same level of encryption.



Provides the highest level of data security and is used when a certificate authority makes public keys available to the 
Cryptographic Service Provider on both host and remote sides of the session.



Select a private key from the list of currently installed private keys.



Type the name provided to the certificate authority at the time the certification was requested.

This option is case sensitive; type the name exactly as you provided it to the certificate authority.



Check to accept only calls from remote PCs using pcANYWHERE for Windows, 2.0 and above, or pcANYWHERE for DOS, 
version, 5.0, eliminating risk of data being transmitted without encryption.



Check to disconnect if login not successful within specified number of attempts.



Set maximum number of attempts at login before caller is disconnected.



Check to disconnect if login not successful within specified period of time.



Set time limit for login attempts before remote user is disconnected.



Check to disconnect if remote user is inactive for a specified period of time.



Set time limit for inactivity before remote user is disconnected.



HIDD Caller Folder textbox
Type folder to contain security settings for individual remote users calling this host.
HIDD Caller Folder Browse button
Allows you to view and select existing folders.    
HIDD Settings button
Accesses dialog box with options to set for individual remote users.



Host connection item, Conference tab



Check if you want this host to allow multiple callers to connect and view activities on the host PC.

The first caller to connect remotely controls the host PC, while other callers connecting can only view the 
actions performed on the host PC.



Select to have the IP address automatically selected from any valid Class D addresses.



To increase the range of this host's broadcast, type in the number of routers to include.



To increase the range of this host's broadcast, type in the number of routers to include.



Select to manually provide an IP address for the conference. Use any IP address within the range of 225.1.1.1 through 
239.254.254.254.



Settings page for modems under nt



Speed of transmission of modem.



Sets error-checking procedure.    Must be same for remote and host PCs.



Sets handshaking protocol.



Sets pcANYWHERE to make connections through modem.



Selects type of modem to use.



Check to use modem connected to this port (instead of cable).



Choose modem connected to this port.



Click to set options for the modem connected to this port.



Advanced Modem Options page for modems under nt



Check for older rotary telephone systems that don't support tone dialing.



Check to instruct modem to use a leased telephone line rather than standard telephone service.



Check to match the serial port speed to the connect speed of the modem. Check this option if you selected Hayes Compatible 
and your modem supports speed adjustment.



Type the number of seconds pcANYWHERE allows for a successful connection after a number has been dialed. 



Type the number of seconds pcANYWHERE allows for a successful connection after a number has been dialed. 



Type the number of consecutive redial attempts that the pcANYWHERE remote makes when a successful connection is not 
achieved. Type 0 to disable the redial feature. 



Type the number of consecutive redial attempts that the pcANYWHERE remote makes when a successful connection is not 
achieved. Type 0 to disable the redial feature.



Type the number of seconds a pcANYWHERE remote pauses between redial attempts. Enter 0 to allow unlimited time for 
connection after host dial. 



Type the number of seconds a pcANYWHERE host pauses between redial attempts. Enter 0 to allow unlimited time for 
connection after host dial. 



Type the number of rings after which the modem answers an incoming call. Type a value between 1 and 10. 



Type optional AT modem commands to be added to the standard initialization string for your modem. 



Type optional AT modem commands to be added to the standard initialization string for your modem. 



Network device detail dialog box



Check to use a gateway PC to make remote connections outside of network.



Enter the name of a gateway you want to use when making a connection. 



Enter the class of the gateway to view a list of all gateways with that class.    Enter * to allow pcANYWHERE to select any class. 



Leave as “None” to use gateway’s parity setting. 



Check to enter name of server in the textbox to the right.



Type name of asynchronous communications server.      Leave as <Any> to allow pcANYWHERE to select the first available 
server.    Click the Browse button below to view a list of currently available servers.



Select to enter name of multiport serial card to use with the asynchronous communications server.    



Enter name of multiport serial card to use with the ACS.    Leave as <Any> to allow pcANYWHERE to select the first available 
service.    Click the Browse button below to view a list of currently available servers.



Select to enter name of port in text box to the right.



Enter name of port.    Leave as <Any> to allow pcANYWHERE to select the first available service.    Click the Browse button 
below to view a list of currently available ports.



Select to allow remote caller to select the ACS server, service, and port at the time of connection.



Click to view a list of available servers, services, or ports. 



Double-click to select server.



Application options -- Button Bars tab:



Check to place folder history tool on toolbar (when toolbar is visible).



Check to place browse folder tool on toolbar (when toolbar is visible).    



Action Bar buttons appear as graphic symbols only, without text labels.



Action Bar buttons appear as graphic symbols and text labels describing their function. 



Check to place Quick Start button on action bar.



Check to place Remote Control button on action bar.



Check to place File Transfer button on action bar.



Check to place Online Services button on action bar.



Check to place Be a Host button on action bar.



Check to place Gateway button on action bar.



Check to place Remote Networking button on action bar.



Check to place Exit button on action bar.



Application options -- Remote Operation tab:



Sets maximum number of colors pcANYWHERE displays in remote control session.    Faster performance results when fewer 
colors display.



If this option is checked,    the pcANYWHERE32 application remains open to allow the remote to call more than one host.

To leave more memory available for your multiple sessions, leave this option unchecked. You can still quickly 
call multiple hosts by dragging your connection items to the desktop.



Specifies amount of disk space pcANYWHERE uses to store information locally on the remote PC, thus increasing Windows’ 
display speed.    Space used only during remote session.



Check to have remote session take over full screen of remote PC.



If checked, host’s screen image sized to fit within the remote PC’s window so that remote’s scroll bars and task bar remain 
available during session.



Check to improve performance by having remote PC use a local font that closely matches font used at host.    If text is not 
correctly displayed on remote, uncheck this (using online menu).



Check to improve performance by disabling the host PC’s wallpaper, screen saver, idle power-down options, and by preventing 
full window dragging.    (All options are restored at end of session.)

This feature disables a screensaver only if it appears in the Screensaver tab of Microsoft’s Display Properties 
dialog box after installation.



Specifies which keyboard handler to use during a session.    Can be changed during a session.



Check to provide best possible representation of DOS graphics.    Uncheck to improve speed.



Slows host application to the rate at which remote can display screen activity.



Click to determine the background and foreground colors to use during the session, as well as font style and size.



Check this option to lower the resolution on the host PC to match the resolution used on the remote PC. 

This option can also be enabled during a session from the Online Options menu.



This option automatically moves the remote view to a currently active window on the host PC. For example, an error message on
the host could appear out of the remote's viewing area, causing the remote caller to think the session has locked. If this option is 
checked, the remote view automatically displays the error message window allowing the remote caller to cancel the message.



Check this option to use the remote's mouse configuration on the host PC. For example, if the remote caller is using a left-hand 
mouse configuration, the host mouse adjusts to allow left-hand mouse control during the session.

This option can also be enabled during a session from the Online Options menu.



Application options: Remote Printing tab:



To print to the remote's printer during a session, add the remote's printer definition.

Note:    You must fist install    the remote's printer definition on the host PC using the Windows 95 or Windows NT 
control panel.



Application options:    System Setup tab:



Choose to use Windows’ computer name (determined at time of Windows’ installation) to identify this PC for pcANYWHERE.



Displays Windows’ computer name.



Choose to name PC yourself for pcANYWHERE sessions.



Type in name that will identify your PC in remote control sessions.



Click to enter information about your phone line and telephone number, calling card, and to disable call waiting.



Where you are dialing from.    (Click Dialing Properties to change this.)



A certificate store is created by the network administrator and contains certificate authorities. See your network administrator for 
the name of the Cryptographic certificate store.



Check this option to use the Windows NT Event Viewer to monitor the server security events.



Application options -- TCP/IP tab: 



Type name or number of TCP/IP host you want to add to the list below.



Lists TCP/IP hosts and subnets.



Click to add TCP/IP host to list.



Click to delete a TCP/IP host from the list to the left.    
(You must select the host you want to remove first.)



Application options – Host Operation tab: 



Change the default setting only if you experience video problems on the host PC.



Change the default setting only if you experience video problems on the host PC.



Application options: Terminal Emulation tab:



 Allows dynamic selection of the fonts used based on the size of displaying window.



Displays vertical and horizontal scroll bars.



Displays terminal’s status line.



Click to select file containing user-defined macro keys.



Click to select translation file, allowing advanced users to configure translation of incoming or outcoming characters.



Translation Table dialog box



Choose a code that you want to edit from this list.



Code you are editing.



Code as it is received.



Code as it is transmitted.



Macro Keys configuration 



Displays list of possible macro keys.



Choose so that selected macro keys to the left perform a function that sends text.



Choose so that selected macro keys to the left perform a function that executes a script.



Choose so that selected macro keys to the left perform a function that runs a program.



Enter name of file (text, script, or executable program) assigned to macro keys selected above.



Application options: File Transfer 



Displays file transfer protocols that can be customized.    Choose the one you want to customize.



Click to customize options for file transfer protocol you have selected to the left.



For file transfer protocols that do not prompt you for a specific download folder before each transfer.



Click to view available folders for file transfer downloads. 



Check to pause the remote control session during file transfers. If you want simultaneous remote control and file transfer 
functionality, leave this option unchecked. This option can also be enabled or disabled during a file transfer. 



pcANYWHERE protocol options dialog box (accessed through App Options, File Transfer, pcANYWHERE settings):



Set the file overwrite option to use when a duplicate filename is found.



Check to compress files during transfer. Files are compressed during transfer to improve speed, but are automatically 
uncompressed to their original state before being written to the destination drive.    
(Do not use for files that are already compressed.)



If file transfer is interrupted before completion, pcANYWHERE will continue the tranfer at point of interruption when connection is
re-established.    



ASCII protocol customization (accessed through App Options, File Transfer, ASCII settings):



Type the number of tenths of seconds to pause after a character is sent.



Type the number of tenths of seconds to pause after a line is sent.



Enter the ASCII value of the character that causes transmission to pause until the character is received.



Type    the maximum number of seconds of inactivity before transfer is terminated.



Select the way to handle a carriage return when sending files.



Select the way to handle a linefeed when sending files.



Select the way to handle a carriage return when receiving files.



Select the way to handle a linefeed when receiving files.



zmodem protocol customization (accessed through App Options, File Transfer, zmodem settings):



Check if you want 16-bit error checking.



Check if you want 32-bit error checking.



Check if you have a clean phone line.



Check if you have a noisy phone line.



Check if you have a noisy phone line and the 2K setting is not adequate.



When checked, if file transfer is interrupted before completion, you can reconnect and continue transferring the file from the point
of interruption.



When checked, the online service can transfer files without initiation from the remote user.



Gateway connection item, Settings tab:



Displays name of gateway connection item.



If checked, gateway allows both incoming and outgoing calls.    Leave unchecked to restrict gateway so that it allows only 
incoming or outgoing calls.



Specifies this gateway as part of a group of gateways, generally based on a shared modem speed.



Check to terminate sessions using this gateway after specified period of inactivity.



Specifies maximum period of inactivity allowed before gateway automatically ends an idle session. 



Activity log processing db



Choose a type of log file to create reports on or to archive and/or delete.



Click to create report using information in the log files you’ve selected in the list to the left.



Click to archive and/or to delete the log files you’ve selected in the list to the left.



Host & Remote Session Log Report dialog box



Formats data in columns, with title and column headings. Includes page numbers.



Choose to create a report displaying information in columns.



Formats data for use in a database application or other program that requires delimiters between fields. Each item is enclosed in 
double quotes, followed by a comma. Month, date and year are separated by slashes (/). Each entry is followed by a carriage 
return.



Each item is entered in a field of fixed size.



Type the year of the earliest session date to include in the log report.



Type the month of the earliest session date to include in the log report.



Type the day of the earliest session date to include in the log report.



Type the year of the latest session date to include in the log report.



Type the month of the latest session date to include in the log report.



Type the day of the latest session date to include in the log report.



Check to include comments typed by user at end of session.



Check to include the date and time that sessions began.



Logs host name.



Check to include information on any file transfers during sessions.



Logs name of registered pcANYWHERE host user.



Check to include name of host PC for each session included in the report.



Check to include date and time that sessions ended.



Logs name of the remote user.



Logs name of the remote computer.



Logs name of registered pcANYWHERE remote user.



Check to include the date and time that sessions began.



Check to include date and time that sessions ended.



Logs reason for disconnection.



Archive/Delete Host/Remote Log dialog box



Type year of earliest log files you want to archive and/or delete.



Type month of earliest log files you want to archive and/or delete.



Type day of earliest log files you want to archive and/or delete.



Type year of latest log files you want to archive and/or delete.



Type month of latest log files you want to archive and/or delete.



Type day of latest log files you want to archive and/or delete.



Check to delete log files between the dates above from this PC.



Check to archive log files between the dates above.



Online DOS Settings tab
HIDD Online DOS Blink Attribute
Check to allow blinking characters.    



Check to allow most accurate representation of DOS graphics possible.    Uncheck to improve screen display speed of an 
approximation of graphics is available.



Check to slow host application to the rate at which the remote can display screen activity.



Select keyboard handler in order to allow execution of host applications that handle keyboard input in a nonstandard fashion.



Online General tab



Determines where printing during online session occurs.



Click to configure printing setup. 



Check to prevent use of host PC’s keyboard during online session.



Check to prevent display on host PC’s screen during online session.



Check to remove scroll bars from display of host PC’s screen, scale display to fit your monitor.



Check to display remote online toolbar.



Choose the number of colors in which the host PC’s display appears.    Selection of fewer colors provides faster performances.



Choose the number of colors in which the host PC’s display appears.    Selection of fewer colors provides faster performances.



HIDD Online Misc Full Screen Display
Check to ensure full-screen display during online session.



 Transfer Clipboard db



Select to transfer host’s clipboard to remote’s clipboard.



Select to transfer remote control’s clipboard to host’s clipboard.



Check to transfer text in clipboard.



Check to transfer graphic in clipboard.



Containers, connection items



Begins Be a Host Quick Start Wizard.    Double-click to create a new Be a Host connection item.



Connection item for this PC as a pcANYWHERE host.    Double-click to wait for a call.



Displays connection items for this PC to use when acting as a host.    Right-click one to change its properties.    Double-click to 
wait for a call.



Begins Remote PC Quick Start Wizard.    Double-click to create a new Remote Control connection item.



Connection item for this PC as a remote PC.    Double-click to make a connection.



Displays host PCs that this PC can control.    Right-click one to change its properties.    Double-click to call that host.



Displays host PCs with which this PC can transfer files.    Right-click one to change its properties.    Double-click to call that host 
and initiate file transfer session.



Begins File Transfer Quick Start Wizard.    Double-click to create a new File Transfer connection item.



Connection item for this PC to begin file transfer session with host PC.    Double-click to make a connection.



Begins New Caller Quick Start Wizard.    Double-click to create a new individual caller.



Item containing login name, password, and security settings for an individual caller.      



List of callers that can connect to this host PC.    Right-click one to change its properties, including login name, password, and 
security options.



Begins Gateway Quick Start Wizard.    Double-click to create a new Gateway connection item.



Double-click to activate this gateway PC.



List of connection items for this PC to use when acting as a gateway.    Right-click one to change its properties.    Double-click to 
activate gateway.



Begins Online Service Quick Start Wizard.    Double-click to create a new Online Service item.



Connection item to call an online service.    Double-click to call online service.



List of connection items this PC uses to call online services.    Right-click one to change its properties.    Double-click to call the 
service.



Begins Remote Networking Quick Start Wizard.    Double-click to create a new Remote Networking connection item.



Connection item for Remote Networking.    Double-click to make a Remote Networking connection.



List of connection items for this PC to use dialing in to a network.    Right-click one to change its properties.    Double-click dial in 
to a network.



System menus
HIDD Be a Host System Menu
Options available only during a connection.
HIDD Remote Control System Menu
Options available only during a connection.



NASI controls



Type the name that you use to login to the NASI/NCSI server.    See your network administrator for this.



Type a name for this session.    This name is listed as an available workstation session after you log on to the server. 



Check to make this workstation session available to all callers connecting to the NASI server. 



NETBIOS control



You can enter the LAN Adapter Number (LANA) that is configured in the Windows 95 or Windows NT operating system



Scripts dialog box



Click to run a script you have selected in the list to the left.



Click to compile a script you have selected in the list to the left.



Click to edit a script you have selected in the list to the left.



Click to create a new script in the Script Editor.



Click to delete a script you have selected in the list to the left.



Displays list of existing scripts.



Displays folder containing scripts appearing in list above.    (Click Browse to change folders.)



Click to view or browse other folders.



Menu F1 pop-ups



Creates new connection item in the current pcANYWHERE mode.



Allows you to choose a printer and printing options.



Opens property sheets of selected connection item.



Opens property sheets to customize pcANYWHERE.



Closes pcANYWHERE.



Undoes last action.



Copies selected connection item to Clipboard.



Pastes connection item into current pcANYWHERE window, if appropriate.



Changes pcANYWHERE mode to Be a Gateway.



Changes pcANYWHERE mode to Be a Host PC.



Accesses caller items.



Makes a connection using selected connection item.



Changes pcANYWHERE mode to Call an Online Service.



HID_ACTION_CONTROLPANEL



Changes pcANYWHERE mode to File Transfer.



HID_ACTION_LAUNCH



Activates gateway.



Sets host to wait for a call.



Presents QuickStart Wizards.



Refreshes connection items in current window.    (Displays full names, etc.)



Provides context-sensitive help on the selected command or item.



Changes pcANYWHERE mode to Remote Networking.



Changes pcANYWHERE mode to Remote Control.



Starts file transfer session.



Waits for connection using selected connection item.



Automatically arranges connection items.



Arranges gateway connection items by their class.



Alphabetizes connection items in current window by connection device.



Alphabetizes connection items by terminal emulation.    (Terminal emulation chosen in Settings tab of each item.)



Alphabetizes connection items by name of network host.    (Host’s name entered in Settings tab of each item.)



Alphabetizes connection items in current window.



Arranges connection items by telephone number of host.    (Host’s phone number entered in Settings tab of each item.)



Alphabetizes connection items by file transfer protocol.    (Protocol chosen in Settings tab of each item.)



Alphabetizes host connection items in this window by caller folder (folder containing caller items for this host).



Accesses default application options.



Deletes selected connection item.



Creates log reports and archives log files.



Allows playback of recorded sessions.



Accesses Script Editor.



Converts configuration files from previous versions of pcANYWHERE.



Displays all details of connection items in current mode.



Displays connection items in current mode as large items.



Displays connection items in current mode in list.



Displays connection items in current mode as small items.



Toggles display of action bar.



Toggles display of status bar.



Toggles display of toolbar.



Displays help file’s table of contents.



Displays information about product’s version.



Activates Quick Start Wizard to create a host connection item.



Activates Quick Start Wizard to create a remote control connection item.



Activates Quick Start Wizard to create a file transfer connection item.



Activates Quick Start Wizard to create a gateway connection item.



Activates Quick Start Wizard to create an online service connection item.



Administrative options - when pcANYWHERE run with winaw32.exe /a



Check to allow display of folder tools on network users’ when viewing this mode.    Users can then select another folder in which 
to store and create their connection items.



Choose network folder in which to store pcANYWHERE connection items for users.    If option above is unchecked, this is the 
folder for all users’ items.



Click to view and select other folders.



Type password to access administrator features.



Allows you to change the administrator password required to access and change network options of pcANYWHERE.



Allows you to set location of connection items and network user privileges for all modes of pcANYWHERE.



list of waiting hosts



Lists hosts and gateways currently attached to your network.



File manager window



Lists files on your PC (or network drive connected to your PC).    Select files to transfer.



Click to change the drive on your PC displaying here.



Lists files on other PC (or network drive connected to that PC).    Select files to transfer.



Click to change drive on other PC displaying here.



Click to change direction of transfer.



Click to begin transfer.



Click to copy selected files to another folder on the same PC.



Click to delete selected files.



Click to rename selected file(s). 



Adds the selected folders or files to an AutoXfer procedure. 



Click to create a new folder within the selected one.



Click to change folder viewed here.



Click to synchronize two folders displaying in windows above.



Displays information about your PC.



Displays information about other PC with which you are exchanging files.



Displays name identifying your PC in pcANYWHERE sessions.



Displays name identifying the PC to which you are connected.



Playback Options dialog box



Check to manage playback from the Control Panel.



Choose the session to begin playing back.



Date of last recording.



Choose to stop playback after each session.



Choose to repeat the session you selected to start the playback.



Check to play all sessions and repeat them.



Choose speed of playback.



Playback Control Panel



Click to begin playback.



Click to reverse playback.



Click to fast-forward playback.



Click to stop playback in session.



Click to pause playback in session.



Click to ?



Choose speed of playback.



Click to save current screen of playback in a "screen shot".



Click to save session in a new file, either another record file or a raw binary file.



Group box names



Help is available for each item in this group.    Point directly at an item and right click, then left-click the What’s This option.



Help is available for each item in this group.    Point directly at an item and right click, then left-click the What’s This option.



Help is available for each item in this group.    Point directly at an item and right click, then left-click the What’s This option.



Help is available for each item in this group.    Point directly at an item and right click, then left-click the What’s This option.



Help is available for each item in this group.    Point directly at an item and right click, then left-click the What’s This option.



Display dialog box



If checked, pcANYWHERE automatically selects the font size displayed on the remote screen, based upon the size of the 
terminal window.



If checked, horizontal and vertical scroll bars display.



Displays line at bottom of terminal window containing current terminal type, communication port, data rate, parity, and flow 
control.



Hardware settings dialog box



The speed at which information is moved from one location to another; measured in bits per second, or bps.



The speed at which information is moved from one location to another; measured in bits per second, or bps.



Sets error-checking procedure.    Must be same for remote and online service.



Sets error-checking procedure.    Must be same for remote and online service.



Sets handshaking protocol.



Sets handshaking protocol.



File Transfer protocol db.



A commonly used file transfer protocol that transfers one file at a time in blocks of 128 bytes. Do not use when transferring files 
with CompuServe or over asynchronous outdial networks like Tymnet.



A modified version of the original XMODEM with better error correction. Do not use when transferring files with CompuServe or 
over asynchronous outdial networks like Tymnet. 



A modified version of the original XMODEM that transfers files in 1024 bytes. Do not use when transferring files with 
CompuServe or over asynchronous outdial networks like Tymnet.



A version of XMODEM 1K without error correction. Select only when both you and the Online Service are using error-correcting 
modems which use MNP or V.42 error correction. Do not use when transferring files with CompuServe or over asynchronous 
outdial networks like Tymnet.



Features high reliability, 1024 byte transfer packets and multiple file transfers with a single command (batch transfers).



Features 1024 byte transfer packets and multiple file transfers with a single command (batch transfers), without error correction. 
Select only when both you and the Online Service are using error-correcting modems which use MNP or V.42 error correction.



A very reliable feature packed file transfer protocol. Its extremely robust error correction make it an excellent choice where 
excessive line noise is a problem. Protocol options may be specified in the Settings Dialog group box.



Originally developed for communication between mainframe computers, this popular public domain protocol has been adapter 
for use on virtually every type of computer.



Refers to the transmission of plain text files using minimal error correction. Protocol options may be specified in the Settings 
Dialog group box. It is usually preferable to use a binary file transfer protocol (those listed above) if it is available.



Check to have any selected files downloaded automatically without initiation of a Receive command.



Choose settings for the ASCII protocol you’ve selected.



Choose settings for the ZMODEM protocol you’ve selected.



Pacing specifies a delay after each line or character that is sent.



Choose for this level of error correction.



Choose this option for highest level of error correction.



Enter the number of tenths of seconds to pause after a character is sent.



Enter the number of tenths of seconds to pause after a character is sent.



Enter the number of tenths of seconds to pause after a line is sent. 



Enter the number of tenths of seconds to pause after a line is sent. 



Enter the ASCII value of the character that causes transmission to pause until the character is received.



Enter the ASCII value of the character that causes transmission to pause until the character is received.



Choose error-checking options here.



Select None to halt transmission only when a negative acknowledgment (NAK) is received by the sending computer.



Use of a Data Window increases reliability, by pausing for an acknowledgment from the receiving computer after a specified 
amount of data has been sent. Select None to halt transmission only when a negative acknowledgment (NAK) is received by the 
sending computer.



download timeout



download timeout



Choose size of data window.



Choose size of data window.



When checked, if file transfer is interrupted before completion, you can reconnect and continue transferring the file from the point
of interruption.



Select the way to handle a carriage return.



Select the way to handle a carriage return.



Select the way to handle a linefeed.



Select the way to handle a linefeed.



When uploading files (transferring files to the online service), specify how to treat these characters.



When downloading files (transferring files to the online service), specify how to treat these characters.



Select the way to handle a carriage return.



Select the way to handle a carriage return.



Select the way to handle a linefeed.



Select the way to handle a linefeed.



Search for Text dialog box



Type search text.



Choose to search upwards from current location in terminal window.



Choose to search downwards from current location in terminal window.



Check to find only text that matches upper/lower case as you typed it in the Search text area above.



Terminal settings db



Choose a different emulation, as specified by your online service.



Click to change the font, font style and point size used to display characters in terminal window.



Check to have the lines of text continue on the next line when the text exceeds the width of the display window.    (If unchecked, 
the cursor remains on the same line until a line feed is received.)



Check to cause the Backspace key to delete characters as it passes over them.



Check to control what happens when text fills the entire screen.



Check if display does not scroll vertically as expected.    pcANYWHERE will advance one line when a carriage return is received. 



Check to enable macro keys you have defined.



Check to enable a translation table.



File manager dialog boxes:    Make folder



Displays folder on destination PC to which files will be sent.



Displays folder on PC from which files are transferred.



Choose or type folder you want to view.



Choose or type kind of file you want to select.    (Example: *.OSF)



Type name of folder you want to create.



Displays name of currently displayed folder.    Folder you create becomes a subfolder of this one.



Displays filename(s) of file(s) and folder(s) you have selected and are deleting.



Displays folder containing files you are deleting.



Check to delete any subfolders in folders you have selected for deletion.



Displays folder containing file(s) you are renaming.



Displays current name of file(s) you are renaming.



Type new name(s) of file you are renaming.



Displays folder containing file(s) you want to copy.



Displays name(s) of file(s) you want to copy.



Choose or type a folder where you want the file(s) above to be copied.    (This folder must be on the same PC where the files are 
currently located.)



Displays name of source folder you want to synchronize.



Displays name of destination folder that you want to synchronize.



Choose this option to synchronize all files in the selected folders.



Choose this option to synchronize only the files you have selected.



Check to include subfolders in the synchronization.



Choose to view all files in the current folder.



Choose this option to view only program (executable) files in the current folder.



Choose this option to view only document files in the current folder.



Choose this option to filter the current folder to display only a group of files. Then choose or type the group (such as *.OSF) that 
you want to view.



To filter the current folder to display only a group of files, choose or type the group (such as *.OSF) that you want to view.    (This 
selects the Custom option.)



Check to display subfolders in the current folder.



Displays source folder for cloning.    Files in this folder will be duplicated in the destination folder on the other PC.



Displays destination folder for cloning.    Files in this folder will be replaced by those in the source folder.



Check to include subfolders in the cloning procedure.    (Files and folders currently located on the destination PC that are not on 
the source PC will be deleted!)



Choose an option to determine pcANYWHERE’s behavior when a file already exists on the destination PC.
- Never Overwrite Duplicate Files maintains original file on destination PC.
- Always Overwrite Duplicate Files automatically overwrites original file on destination PC.
- Verify Before Overwriting prompts you whether to overwrite original file. (Do not use for unattended file transfer.)
- Always Ask For Destination prompts you where to place new file transferred from source PC.    (Do not use for unattended file
transfer.)
- Overwrite Older Files Only overwrites file on destination PC only if its date is earlier than that on source PC.



Choose an option to determine pcANYWHERE’s behavior when a file already exists on the destination PC.
- Never Overwrite Duplicate Files maintains original file on destination PC.
- Always Overwrite Duplicate Files automatically overwrites original file on destination PC.
- Verify Before Overwriting prompts you whether to overwrite original file. (Do not use for unattended file transfer.)
- Always Ask For Destination prompts you where to place new file transferred from source PC.    (Do not use for unattended file
transfer.)
- Overwrite Older Files Only overwrites file on destination PC only if its date is earlier than that on source PC.



Check to compress files during transfer. Files are compressed during transfer to improve speed, but are automatically 
uncompressed to their original state before being written to the destination drive.



Check to allow reconnection and continued file transfer from the point at which file transfer was interrupted.



Check to turn on SpeedSend option, sending only portions of files that are different if those files already exist on the destination 
PC.



windows system key pressed dialog box



Choose to execute keystrokes on your PC.



Choose to execute keystrokes on the host PC.



Choose to ignore keystrokes.



not implemented.



ISDN dialog box



 Check if you want pcANYWHERE32 to attempt to combine two available 64K channels providing 128K per second 
transmission.    



Enter Multiple Subscriber Number (MSN) extensions separated with a semi-colon, to restrict incoming calls to specific 
extensions. 



AUTOXFER pages



The AutoXfer procedure filename.



Click to add new file transfer commands to the AutoXfer procedure. 



Deletes the selected command from the procedure. 



Click to edit the selected command. 



Select a command and click Move Up to place it in the order you want it to run. Commands are run sequentially, from top to 
bottom. 



Select a command and click Move Down to place it in the order you want it to run. Commands are run sequentially, from top to 
bottom. 



A list of the file transfer commands in the AutoXfer procedure. 



File or folder is sent from the remote PC    to the host PC. 



File or folder is sent from the host PC to the remote PC.



Checks duplicate filenames and transfers the file with the latest date and time, overwriting the older file. 

If this AutoXfer procedure is to run unattended, be sure to choose an overwrite options not requiring user 
confirmation.



The folder or file on the remote PC. 



The folder or file on the host PC. 



Disconnects the session when the AutoXfer procedure ends. When this option is checked, file transfer errors are ignored and the
procedure continues with the next command. 



Scans downloaded files for viruses and deletes infected files.    



Improves file transfer performance by checking duplicate files and transferring only the data that is different in the source file. 



Check to override the file transfer options set in the Application Options, File Transfer property page.    The settings are changed 

only in this AutoXfer  session. 



Click to use the settings configured in the Application Options, File Transfer property page (displayed in grey). 



Closes this dialog box and runs the selected procedure. 



Click to view or modify the commands in this AutoXfer procedure. 



A list of the file transfer commands to be added to the procedure. 



The name of the AutoXfer procedure to run. 



The name of the AutoXfer procedure to add commands to. 



Keyboard handlers help you to send special key sequences to the remote computer. Some applications, such as terminal 
emulation programs, require a keyboard handler to communicate directly with the host keyboard. Without this support, some or 
all of the keys in this type of program may be disabled in the remote session.



Select a keyboard handler level if you experience problems running DOS applications. Level one works well with most 
applications. 



Slows the host application to the rate at which the remote can display screen activity.



Provides the best possible representation of DOS graphics. Uncheck to improve speed of session when an approximation of 
graphics is acceptable.



Determines background and foreground colors to use during the session as well as the font style and size.



A list of files in the selected folder on the Remote PC.



A list of files in the selected folder on the Host PC.



NT Caller Identification Tab



The workstation or domain this user is is a member of. 



The Windows NT user or group name of the selected caller. 



The caller is an individual user with a name, password, and individual rights and privileges.



The caller is part of a Windows NT group and has all rights and privileges assigned to that group.



Remote Printing tab
Remote printing allows the remote caller to print to the local printer during a session. Select the printers on the remote PC you 
want to print to during a remote control session. 

The remote’s printer definitions must first be installed on the host PC using the Windows 95 or Windows NT 
Control Panel.



Host Conference tab
A conference host allows multiple remote users to simultaneously connect and view the host’s activities. A conference host is 
remotely controlled by the first remote caller that connects. Other callers can connect and view the host session but they cannot 
control the actions on the host PC.
Check the following:

To enable conferencing for this host PC.

To automatically select an IP address from any valid Class D addresses.

To type an IP address for this host PC.

The IP address must be within the range of 225.1.1.1 and 239.254.254.254

To specify the number of routers and increase the broadcast area of this conference.

The first caller can use any connection device to connect to the conference host. All other callers must use 
TCP/IP network connections to the host.



DOS Sessions tab

When the host is running DOS in a full-screen window, or when the host user has exited to DOS, the remote may experience 
problems reading and displaying the host screen. The following options allow the remote user to make adjustments that allow 
correct viewing of these DOS display characters:

Special keyboard handler
Keyboard handlers help you to send special key sequences to the remote computer. Some applications, such as terminal 
emulation programs, require a keyboard handler to communicate directly with the host keyboard. Without this support, some or 
all of the keys in this type of program may be disabled in the remote session.
In pcANYWHERE, the Level 1 keyboard handler works well with most applications.

Synchronize display with host
Check to slow down the speed of application running on the host to match the rate at which the remote can receive and display 
all incoming screen data. If this option is unchecked and an application running on the host performs frequent screen updates, 
such as scrolling through text, some of the display lines may not appear on the remote screen. If the speed of an application is 
more important than a complete display of all characters, (such as with a lengthy database indexing procedure), uncheck this 
option.

Full graphics support
Check to display DOS graphics programs on the remote display as accurately as possible. Uncheck this option if speed is more 
important than a full graphical display.    

Font/Colors button
Click to access Fonts dialog box and set colors, fonts, for remote control sessions of hosts running DOS programs.



Remote Security Options tab

Set the level of encryption this connection item uses for every session.

Encryption Level
Public Key encryption: Provides the highest level of security and is used when a certificate authority makes public keys available 
to the Cryptographic Service Provider (CSP) on both host and remote sides of the session.
Symmetric encryption: Provides the next level of security and is used when there is no certificate authority available but there is 
a CSP.
PcANYWHERE encryption: Provides minimum encryption capability and is used when there is no CSP available. It is the only 
level compatible with pcANYWHERE versions 2.0, 5.0, and 7.x.



NT Caller Identification Tab

The Identification property page displays the configuration used for the selected caller and includes the caller’s domain name NT
User Account name.

This property page is for information only and cannot be edited. To change the configuration for this caller, click 
the Add User wizard to create a new caller item.



General tab

Set the following options for this session only:

· Whether or not the host screen reduces to fit in the remote’s terminal window: If left unchecked, the remote user must scroll to 
view portions of the screen.

· Whether or not the remote online toolbar displays on the remote PC.

· Whether or not the remote control system tray displays on the remote PC.

· In how many colors the host screen displays.

· Whether or not to reduce the host screen resolution to match the resolution used on the remote PC: 

· Whether to automatically move the remote’s view to any currently active windows on the host PC. For example, a remote caller 
could be unaware of an error message if it is displayed beyond the remote’s current viewing area. If this option is checked, the 
remote’s viewing area is automatically focused on the error message.

· Whether a user at the host PC can issue commands from the keyboard: 

· Whether the host PC’s screen can be seen.






